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Foreword
Stephen Chernicoff
EVERYBODY REMEMBERS How

revolutionary Apple's Macintosh computer was
when it first appeared in January 1984. One look was enough to tell you
that this was something new. The bright, lively screen, the high-resolution
graphics, the multiple fonts and type styles-not to mention that funny
little gadget with the button on top and the roller ball on the bottom-all
served notice that this was not just another boring old computer. Here at
last was a machine that met you on your terms instead of its own.
Gone were the days of enigmatic prompt characters, cryptic command
sequences, and incomprehensible error messages. In their place was a new
vocabulary of concepts, novel and yet reassuringly natural and intuitive:
windows and scroll bars, pull-down menus and dialog boxes, check boxes
and radio buttons, icons and desk accessories. Using a computer was
suddenly easy, comfortable, and above all fun. For most of us, it was love
at first sight.
But as great a boon as the Macintosh was to ordinary users, it held an
unprecedented gift for programmers as well. An integral part of the system
was the User Interface Toolbox, a body of tightly engineered, lovingly
handcrafted machine-language code built into every Macintosh in readonly memory (ROM). By implementing the features of the standard user
interface, the Toolbox gave programmers all the support they needed to
produce finished-quality software with the distinctive Macintosh "look and
feel."
Unfortunately, even with this considerable helping hand from Apple,
learning to program the Macintosh remained a formidable undertaking. All

ix

x

Foreword

that increased freedom and convenience for the user imposed a heavier
burden of discipline on the programmer, who had to master a new and
perhaps unfamiliar "event-driven" style of programming. The original
Toolbox included more than 400 different routines, and the latest models
add even more. Apple's own epic reference work on the Toolbox, Inside
Macintosh, was a prodigious brainful for any programmer to digest.
It was to help readers come to terms with this mass of material that I
wrote my Macintosh Revealed series of books back in 1984. My aim was to
present the fundamental ideas underlying the Toolbox in a more readable,
accessible way, along with an extensive, fully developed example program
showing how to put those ideas to practical use. I hoped to give my readers
a compass with which to chart their own course through the labyrinth of
Inside Macintosh. Still, the sheer scope of the subject remained daunting.
What was clearly needed was a good introductory book that could serve as
a stepping-stone to the level of Mac Revealed andlnside Mac.
Now, Dave Mark and Cartwright Reed have filled that need with their
Macintosh Programming Primer. Starting from the most basic concepts,
they take you by the hand and lead you step by step into the brave new world
of the Toolbox and event-driven programming. Instead of a single, allembracing programming example, Dave and Cart have taken a more
gradual approach. A series of smaller, more manageable programs focus on
specific aspects ofthe Toolbox: drawing simple text and graphics, displaying
and maintaining windows on the screen, defining menu commands,
managing scroll bars and dialog boxes. By the time you've worked through
all the examples, you'll be ready to combine the concepts to build full-scale
application programs of your own.
One of the great strengths of this book is its emphasis on the use of
resources as a way of structuring Macintosh programs. The Macintosh
Resource Manager is perhaps its boldest and most innovative contribution
to the state ofthe programming art, an idea whose versatility and power are
only beginning to be fully realized. Right from the start, Dave and Cart
show you how to use resources as a central organizing principle to make
your programming easier, cleaner, and more modular. Their chapter on
Apple's on-screen resource editor, ResEdit, is the best discussion I've seen
on this important program development tool.
If you're interested in learning to program the Macintosh, there isn't a
better place to start than with the book you're holding in your hands right
now.
Stephen Chernicoff
Berkeley, California
December 15, 1988
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Introduction
Macintosh Programming Primer is a
complete course in the art of Macintosh
programming. With this book and
Symantec's THINK C, you can learn to
program the Macintosh.

No OTHER COMPUTER is like the Macintosh.
The Mac is a new kind of computer. It's fast. It's different.
The Mac plays by a new set of rules. To program it, you need a new
rulebook. That's what the Mac Primer is.
At the heart of the Macintosh is the Toolbox, a collection of over 700
procedures and functions that give you access to the Macintosh interface.
The Mac Primer will teach you how to use the Toolbox, to add the power of
pull-down menus, windows, and scroll bars to your programs.
This book serves as a bridge to the Macintosh way of programming.

_J

The Macintosh Vision
Nowadays, the Macintosh line is successful, highly praised, and much
emulated. When the Macintosh was introduced in 1984, however, people
were perplexed: It was like no computer they had ever seen-a beige box
with a little screen and a mouse. People called the Macintosh a toy because
it had a graphic interface, and graphics were not the way normal computers
operated.
It was no sure thing.
At first, Apple did everything wrong. Macintoshes were incompatiblein both hardware and software-with every other computer in the field.
The screen, disk drive, and CPU board were all bundled together, unlike
the modular design of the IBM PC and the Apple II series. The Macintosh
had no internal bus and was difficult to expand. The mouse controlled a
user interface that was unfamiliar to everyone but Lisa owners.
The new computer should have failed, and would have if Apple had not
made an epochal machine. But it made the Mac, which was unique in three
ways:
• The interface: The graphic user interface was effective. People learned
to use computers faster. The dictum "powerful= hard to use" was no
longer valid.
• The Toolbox: Comprehensive routines were defined in the Macintosh
ROM that drove the interface and allowed software designers to write
powerful, easy-to-use applications.
• The use of resources: The building blocks for all software on the
Macintosh, resources store program information in a series of templates
in the program file, simplifying the creation and modification of Macintosh programs.
These three ingredients combined to make the Macintosh the basis for
one of the best selling microcomputer lines in history. Half a decade later,
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the vision holds strong. The Macintosh environment remains unique. The
careful planning that went into the original Mac has paid off handsomely,
as the Mac line continues to evolve and improve.
To write successful applications for the Macintosh, the would-be Macintosh programmer must understand how those three Macintosh ingredients-interface, Toolbox, and resources-work. First, let's look at th e most
visible of the three: the Macintosh user interface.

The Macintosh Interface
The Macintosh makes its first impression on users with its graphic
interface. Figure 1.1 shows some of the distinctive elements of th e Mac
"look." Because new user s understand and use the windows and menus of
Mac applications intuitively, the Macintosh interface represents an impressive improvement over the command-based interfaces common on
other systems. Each element of the interface-windows, menus, dialog
boxes, icons-has a specific function associated with it, and extensive
guidelines exist for the use of each element.

.,
Hard Dis
4 items

!]]
System Folder

LJ

Utilities

86,1681< in d

Restart
Shut Down

LJ

THINK C

3. 14 159
Windows

Figure 1.1 Some elements of the Macintosh interface.
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The Macintosh interface was appropriated from the Lisa, which lifted
it from the Xerox Alto machine. Each successive rendition of the
interface improved. In addition, every new version of the interface on
the Mac gets sleeker. To look at the Macintosh running Version 1 or
2 ofthe Finder, or to see the Lisa in operation (while not running under
Mac emulation) is rather like examining a '67 Mustang. The new
system software reflects Apple's ability to build on the old system
without modifying it beyond recognition. Most computer manufacturers have noted Apple's success. It's very uncommon for a new computer to show up without some version of the Macintosh icon/folder/
window interface.
Of course, pretty pictures aren't enough. The beauty of the Macintosh
interface lies in how it is created. Each part of the interface is manipulated
by a series ofroutines in the Macintosh ROM. For example, you can create
an application's window with one call to the Macintosh ROM.
The routines that underlie the interface-that build windows, control
printing, and draw menus-are collectively known as the Macintosh
Toolbox.

The Macintosh Toolbox
The Toolbox can be thought of as a series oflibraries that make it easy for
you to create those features indigenous to Macintosh applications. For
example, the Macintosh Toolbox call GetNewWi ndow() creates a new
window for use in your application.
Using the Toolbox calls to create your applications gives the results a
distinctive Macintosh look and feel. Operations common to most applications, such as cutting, copying, and pasting, are always handled in the same
·
way, which makes it easier to learn a new application.
The Toolbox routines are grouped functionally into Managers, each of
which is responsible for one part of the Macintosh environment (Figure
1.2).
The Macintosh Toolbox undergoes constant updating and modification;
each new system revision gives you some shiny new tools as well as the old
standbys to work with. As new routines are added to the Toolbox, Apple
cleans up problems with older routines.
The Macintosh graphic interface and the Toolbox are two of the features
that make the Mac unique. A third is the successfully introduced concept
of resources on the Macintosh.
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Figure 1.2 Parts of the Toolbox.

Although the Macintosh line has expanded greatly, the basic compatibility of the different. Macintosh models has been maintained. Yet,
more powerful machines always provide more choices-and more
decisions. When the only available Macintosh workstations were the
Macintosh and the Macintosh Plus, software developers thought they
had a certain flexibility about how they followed the Mac programming guidelines provided by Apple. Now, in the midst of machines
that support color, MultiFinder, math co-processor chips, and new
peripherals, the successful developer hews closely to the Macintosh
standards.

Resources
If the Toolbox is the library of routines that make up the Macintosh
interface, resources are the data that your program uses to execute the
library calls. GetNewWi ndow(), the Toolbox call that creates a new window, requires you to specify window parameters such as size, location, and
window type. To do this, you can supply a resource containing that
information, so the new window can be used in your application. Resources
come in various types, each serving as a "holder" for a particular kind of
data relating to windows, menus, and other parts of the Macintosh
interface. For example, a resource of type WI ND contains information for
one specific window in an application. There may be a number ofresources
of type WI ND, but there is only one WIND type, which is identical for all Mac
applications.
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Resources are integrated into the design of the Macintosh. Each Macintosh application file may possess dozens ofresources. This simplifies many
of the tasks of the applications programmer. For example, resources make
it easy to localize a program for a different area. If you want to sell your
program in, say, France, it is relatively easy to replace resources containing
English text with French equivalents.
Resources are also essential in developing the complex code that drives
the Macintosh interface and hardware. Because they can be easily copied
from one program to another, menus and dialog boxes need not be created
more than once. Once you have built up a collection of programs, creating
new ones may begin with a cut-and-paste session with your existing
programs.
To edit resources, Apple developed a program called ResEdit, which
allows you to edit any of the resources in Macintosh Primer programs. You
can also use them to explore other Macintosh applications-even system
files! Since these resources exist as part of the completed application, they
can be edited without recompilation.
We make extensive use ofResEdit throughout the Mac Primer. Ifyou've
never worked with ResEdit before, Chapter 8 contains a ResEdit tutorial
to get you up to speed.
The Macintosh interface, the Toolbox, and resources are the three
intertwined subjects that we'll cover using THINK C and ResEdit to create
standalone Macintosh applications. The next sections discuss our approach
to learning about these issues.

_J

About the Book
Most Macintosh reference books, such as Inside Macintosh and Macintosh
Revealed, are excellent texts for those who already understand the Macintosh programming paradigm. They can be frustrating, however, if you're
outside the Macintosh programming world, looking in. The Mac Primer
bridges the gap for those of you who are just learning the basics of Mac
programming.
Our aim is to help you write properly structured Mac applications. If
you're used to programming on a UNIX machine or on an IBM PC, the Mac
Primer is the perfect place to start your Mac programming education. Our
formative years were spent programming under UNIX, on machines like
the PDP-11 and the VAX-11/780; we've also spent a lot of time with IBM
PCs and compatibles. We wrote the Macintosh Programming Primer with
you in mind.
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What You Need to Know
There are only two prerequisites for reading this book. Before starting the
Macintosh Primer, you should already have basic Mac experience: You
should be able to run Macintosh applications and should have a good feel
for the Mac user interface. In addition, you should have some experience
with a programming language like C or Pascal. If you've never used C
before, we suggest a companion text, such as The C Programming Language by Brian W. Kernighan and Dennis M. Ritchie (Englewood Cliffs,
N.J.: Prentice-Hall, 1988), to supplement your instruction.
The Macintosh Programming Primer examples are all written in C,
using the THINK C development environment. Our general approach,
however, emphasizes the techniques involved in programming with the
Mac Toolbox. The skills you learn will serve you no matter what programming language you intend to use in the future.

Why We Chose THINK C
There are many development environments available to the Mac programmer. The Macintosh Programmer's Workshop (MPW) is a complex and
powerful development system written and marketed by Apple. Most of
Apple's internal development is done with MPW, and many of the large
Macintosh software development houses have made MPW their first
choice. MPW uses an "everything but the kitchen sink" approach to
software development. The basic system consists of an editor shell that
allows you to edit your source code as well as build and execute complex
command scripts. You can do just about anything in MPW, but it is
definitely not a system for beginners. In addition to learning the editor and
shell, you have to install, configure, and (oh, yes) pay for your choice of
compilers. You can buy C and Pascal compilers for MPW, as well as Fortran,
MacApp, and a few others. MPW is ideal for complex, multilanguage
development efforts, but not for learning to program the Macintosh.
We did our first Mac programming using the Aztec C development
system from Manx. Aztec C offers a UNIX-like shell and a very fast
compiler. Again, this is not a compiler for first-time Mac programmers. The
documentation is thorough but overwhelming. The shell is very much like
UNIX or DOS; too much up-front knowledge is required to build and run
your own applications.
When we decided to write the Macintosh Primer, we investigated other
Mac development environments. We settled on THINK C (also known as
Lightspeed C). THINK C is a development environment that is powerful
and friendly. It has concise, accurate documentation. For those inevitable
bugs, it has a source-level debugger.
Finally, THINK C is reasonably priced (see Figure 1.3).
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SO Lunches

20Lunches
TIDNK C

Macintosh
Programmer's
Workshop (MPW)

Figure 1.3
Lunch economics.

Using THINK C
THINK C is an integrated development environment. The source code
editor follows all the standard Macintosh conventions and is very easy to
use. The compiler is smart: It keeps track of the files you're currently
working with, noting which have been changed since they were last
compiled. THINK C recompiles only what it needs to.
THINK C has a well-thought-out Macintosh interface. For example, to
build a standalone application, pull down the Project menu and select
Build Application. Installation is simple: Just pull the floppies out of the
box, copy the files onto your hard drive,* and go!
THINK C's documentation consists of two clearly written manuals. The
User's Manual explains everything you need to know about developing
software using THINK C. THINK C also comes with a source-level debugger, a program that allows you to test-drive your program while you
monitor its progress in a window. The debugger is well designed and also
works with other Macintosh debugging tools like MacsBug and TMON. We
discuss the THINK C debugger in detail in Appendix D.

Inside TffiNK C
The Project file is unique to THINK C. It contains the names of all your
source code files, as well as the name you'll eventually give to your
*For those of you without a hard drive, there are complete instructions for running THINK
C on a floppy-based system in the THINK C user's manual.
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Figure 1.4 THINK C's Project window.

application. It also contains compilation information about each source file,
such as which files have been modified since their last compilation (see
Figure 1.4).
One of the best features of THINK C is its library of #inc 1 ud e files,
which allow THINK C to support the latest editions of the Macintosh
system software, as well as the latest ROMs. This means that you can use
THINK C to write programs that will run under MultiFinder, take full
advantage of the Macintosh II's color capabilities, and use AppleTalk. All
of these features are supported in the way Apple intended them to be.
THINK C also provides routines to support extensions to Apple's HyperCard.
THINK C also comes with a full complement of utilities, including
ResEdit, the resource editor we mentioned earlier, and with the full source
code to a sample text editor that you can use as the basis for your own text
editor.
For your convenience, we present a summary of the THINK C commands
in Appendix C, a summary of the commands for the source-level debugger
in Appendix D, and a description ofTHINK C's HyperTalk extensions with
a sample XCMD in Appendix F.
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Writing Macintosh Applications
Most Macintosh applications share a basic structure (Figure 1.5). They
start off by initializing the Toolbox data structures and routines that
support the Macintosh user interface. Then the application enters an event
loop and patiently waits for the user to do something-hitting keys, moving
the mouse, or some other action. Events outside the application are also
checked: Desk accessories may be used, or disks inserted. No matter how
complex the Macintosh program, this simple structure is maintained.
At the heart of the Macintosh Programming Primer is a set of fourteen
sample applications. Each builds on the basic program structure to provide
a successively more sophisticated use of the Macintosh Toolbox. Each new
chapter constructs a more powerful implementation of the basic program
structure. Chapter 3's programs show how to create windows and draw
inside them, Chapter 4 demonstrates how to handle events, Chapter 5
implements menus, and Chapter 6 makes use of dialogs. Chapter 7
presents WindowMaker,. a complete example of how a Macintosh application should work, from handling the interface and events to taking care of
error checking and memory management.
We present each Mac Primer example program as completely as possible, and discuss each program listing extensively. Nothing is left as an
"exercise for the reader." Each chapter contains complete instructions and
figures for entering, compiling, and running the programs using THINK C.

Chapter Synopsis
The Macintosh Primer is made up of nine chapters and seven appendices.
This introductory chapter provides an overview and starts you on your way.
Chapter 2 starts by going through the installation of THINK C and

Initialize
the
Toolbox

Retrieve
an Event
Exit the
Application

Perform
Other
Initializations

Process the
Event

Figure 1.5 How a Macintosh application works.
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ResEdit, step by step. Then, THINK C basics are introduced. We present
the THINK C manual's version of the classic Hello, World program (Figure
1.6), and discuss its drawbacks. After discussing C and Pascal differences,
we go on to illustrate the Macintosh and C programming conventions that
we will use in the Primer.
Chapter 3 starts with an introduction to the fundamentals of drawing on
the Macintosh using QuickDraw. The Window Manager and windows are
discussed. Then, we introduce resources and the Resource Manager.
QuickDraw, the Window Manager, and resources are very closely
related. Windows are drawn using QuickDraw commands from information stored in resource files.
Four programs are introduced in Chapter 3. The Hello2 program introduces some of the Quick.Draw drawing routines related to text; the Mondrian program (Figure 1.7) demonstrates Quick.Draw shape-drawing routines. ShowPICT (Figure 1.8) demonstrates how easy it is to copy a picture
from a program like MacDraw or MacPaint into a resource file, then draw
the picture in a window of our own. Finally, as a bonus for completing the
first three programs, we have included The Flying Line (Figure 1.9), an
intriguing program that can be used as a screen saver.

S
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EHit Window
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hello, world

I
Q]
''

Figure 1.6 THINK C's Hello, World.
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Figure 1.9 The Flying Line.

Chapter 4 introduces one of the most important concepts in Macintosh
programming: events. Events are the Macintosh's mechanism for describing the user's actions to your application. When the mouse button is clicked,
a key is pressed, or a disk is inserted in the floppy drive, the operating
system lets your program know by queueing an event. The event architecture can be found in almost every Macintosh application written. Here we'll
present the architecture ofthe main event loop and show how events should
be handled. EventTutor, Chapter 4's sole program (Figure 1.10), provides
a working model of the event architecture.
The Macintosh popularized pull-down menus (Figure 1.11). Chapter 5
shows you how to add the classic pull-down, hierarchical, and pop-up
menus to your own programs. Chapter 5's first program, Timer (Figure
1.12), uses both classic pull-down and hierarchical menus. We'll also show
you how to create and implement pop-up menus with a little program called
Zinger (Figure 1.13).
Chapter 6 introduces dialogs and alerts (Figure 1.14). Dialog boxes are
another instrinsic part of the Macintosh user interface. They provide a
vehicle for customizing your applications while they are running. Alerts are
simplified dialogs, used to report errors and give warnings to the user.
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Figure 1.10 EventTutor.

Figure 1.11 The classic pull down menu.
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Figure 1.12 Timer witp hierarchical menus.

.,

Figure 1.13 Zinger with pop-up menu.
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Figure 1.14 Dialog box and alert box.

The Reminder program in Chapter 6 (Figure 1.15) uses dialogs, alerts,
and the Notification Manager to allow you to set an alarm. The application
then starts a countdown and notifies you when it goes off-even if you are
running another application.
Chapter 7, our final programming chapter, contains a potpourri of
programs demonstrating concepts such as error checking, memory management, printing, generating sound, adding scroll bars to windows, and
file management. Each program explores a single topic and provides a
working example of reusable code. The WindowMaker program (Figure
1.16) at the beginning of the chapter, which shows how to keep track of
multiple windows, represents the most mature implementation of the
Macintosh interface of all the programs in the book.
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Figure 1.15 Reminder.
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Figure 1.16 WindowMaker.

Chapter 8 discusses the creation, modification, and use of r esources. It
starts with a ResEdit tutorial that covers ResEdit operation and demonstrates the creation of Fi nder resources (Figure 1.17).
Now that you've got a handle on the essentials of Macintosh programming, what's next? In Cha pter 9, we'll talk about some of the tools available
to help you with your development efforts. We'll look at Inside Macintosh
and some of the other Mac technical documentation. We'll look at software
tools, from compilers to debuggers. We'll also look at Apple's Certified
Developer Program and other Macintosh technical resources.
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Figure 1.17 ResEdit.

Appendix A is a glossary of the technical terms used in the Macintosh
Primer.

Appendix B contains a complete commented listing of each of the Mac
Primer applications, presented in the same order as they appear in th e

book.
Appendix C contains a THINK C command summary. Each THINK C
menu item is introduced, along with any accompanying dialog boxes and
alerts.
Appendix D contains a s ummary of the THINK C debugger. The
operation of the debugger is discussed, and each menu item and window is
detailed.
Appendix E covers some debugging techniques that will be particularly
helpful in the THINK C environment.
Appendix F contains a discussion ofHyperCard XC MDs, along with an
example written in THINK C, and a complete source code listing of the
THINK C XCMD source code.
For those of you who are not HyperCard aficionados, XCMDs are
procedures written in C or Pascal that can be called from within
HyperCard. XCMDs allow you to go beyond the limits ofHyperCard,
performing functions not normally available from within HyperCard.
Appendix G is a bibliography of Macintosh programming references.

_J

How to Use This Book
Each Macintosh Primer chapter is made up of the main text and tech
blocks. The main text is the narrative portion of this text. Read this first.
It contains the information you need to input and run the example
programs. Because we've placed a premium on getting you going immediately, we have you run the program before discussing how the code works.
Impatient programmers are invited to go directly to Appendix B, which
contains commented listings of all the programs discussed in the book. If
you have questions after typing in the programs, refer to the chapter in
which the program is discussed. If you prefer a more sedate pace, read a
chapter at a time, type in the programs and test them as you go. Try the
variants to the program if they sound interesting.
At some points, we expand on the narrative with a tech block, indicated
by a distinctive gray background. It's OK to ignore them during your first
read-through.
There are several important terms and conventions we make use of
Tech blocks will have this appearance in the main text. If you feel
comfortable with the subject discussed in the main text, read the tech
blocks for more detail. Otherwise, come back to them later.

throughout the Macintosh Primer. Whenever you see a notation like this:
(111:256-272)
we are referring to a volume of Inside Macintosh and a set of pages within
that volume. The example here refers to Volume III, pages 256 to 272.
References to Tech Notes, documentation from Apple's Macintosh Developers Technical Support Group, are annotated like this: (TN:78) (referring to
Tech Note 78). (See Chapter 9 to find out how to get Tech Notes.) These
references to Inside Macintosh and Tech Notes are intended to help readers
who are interested in a further discussion of a topic.
All of our source code is presented in a special font. For example:

while ( i < 20 )
PassTheParameters();
Toolbox routines and C functions are also in the code font when they are
described in the text.
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Whenever we refer to a function or procedure call, we place a pair of
parenthesesattheendoftheprocedureorfunctionname. GetNewWi ndow()
is an example of a function call.
Finally, we'll use boldface to point out the first occurrence of important
new terms.

_J

What You Need to Get Started
First, you need THINK C from Symantec. The examples from the book use
Version 3.0, which is the first version to have a source-level debugger. You'll
also need a Toolbox reference. Apple's Inside Macintosh series is the
authoritative reference on Macintosh software development. We suggest
that you purchase Volume I and Volume Voflnside Mac. Volume I contains
a description ofa majority of the Toolbox routines used in this book. Volume
V contains the latest changes to the Toolbox. Volumes II, III, and IV contain
helpful, but not indispensable, information about less commonly used
routines.
Buy Volumes I and V with your lunch money. Buy Volumes II through
IV with somebody else's lunch money.
You'll also need access to a Macintosh Plus, SE, or II. You can use this
book with anything from a Macintosh Plus with 1 megabyte of RAM and an
external drive to a fully loaded Macintosh IIx. We strongly recommend a
hard drive. The screen shots that accompany the text assume that you have
a hard disk.
Finally, use the latest system files with Mac Primer programs. Don't use
any system software older than Version 6.0 (preferably 6.0.2 or newer) in
this book.
The compiled, standalone programs that will be developed in this book
may or may not work in the 512Kand the 128KMacintosh. In general,
if we use a ROM call that is not supported by these Macintoshes, we
will mention it in a tech block and suggest alternatives (if there are
any) for programmers who wish to support the older machines.

_J

Ready, Set ...
When you finish this book, you'll be able to create your own Macintosh
applications.
Get all your equipment together, take the phone off the hook, and fire up
your Mac.
Go!
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Setting Up
This chapter will introduce you to the
software tools that we use in this book.
We also examine some issues that are
specific to the implementation
of Con the Macintosh.

THINK C Is the programming environment we'll use throughout the Macintosh Primer. First, we'll show you how to install it; then, we'll look at bow
to type in and run a sample program. We11 talk about the standards that
we'll be using in this book, and some of the rules you need to follow when
you use the Mac and THINK C together.

_J

Installing THINK C
Let's start by installing THINK C.
Create a folder called TH INK C at the top level of your hard disk. Then,
drag the contents of the two THINK C disks into the folder. The TH I NK C
folder should look something like Figure 2.1.

Source Code Files
Set up a place for your source code by creating a folder called my source
code, or something equally inspiring, inside the TH INK C folder. We called
our source code folder s re, in memory of our good old UNIX days. We'll
create a separate folder inside the s re folder for each Mac Primer application (see Figure 2.2).
r
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File

Edit

Uiew
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Special

THINK C

!!O

[jJ

~

THINK C THINK C Debugger

~

==---===========-

-=--~
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- ---~~
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CJ CJ CJ

LibrariH
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CJ ~ CJ
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Figure 2.1 The TH INK C folder.
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ResEdit
THINK C comes with a version ofResEdit on one of its disks. Check the
version of your copy of ResEdit. If you can, use version 1.2 or later for the
projects in this book (see Figure 2.3). There is no charge for this utility,
which is written and maintained by Apple. It's available on many BBSs, so
download it if you wish. You can get it from the Apple Programmer's and
Developer's Association (APDA), which also includes some documentation.
See Chapter 9 for more information about APDA. ResEdit versions consistently improve, which is a polite way of saying that some of the older
versions were rather exasperating. In this book, we use Version 1.2.
If you are unfamiliar with ResEdit, we strongly recommend that you
read Chapter 8, which discusses ResEdit operations on resources. It demonstrates how to install the resources you need to complete a standalone
program. (This includes the techniques you'll need to add an icon to your
own applications.)
Once you have THINK C and ResEdit together on your Macintosh, you're
one step away from starting to program. The next section discusses the
ground rules for running THINK C code: accessing the Toolbox, Macintosh/C topics, data types, parameter passing, and coding conventions .
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LJ

for QutcKtys user s

Utilities 2

..
Ill

26

Macintosh Programming Primer
Info
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ResEdit

Kind: application
Size: 275,007 bytes used, 270K on disk
Yhere: Hard Disk, SCSI
Created: Mon, Sep 19, 1988, 10:35 PM
Modified: Fri, Jan 6, 1989, 10:20 AM
Version: 1.2, ©Apple Computer, Inc.
1984-1988

Suggested Memory Size (K): 300
Application Memory Size (K):
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Figure 2.3
Get Info window from ResEdit 1.2.

Macintosh Programming Issues
Accessing the Toolbox with C
Built into every Macintosh Plus, SE, and Mac II is a set of over 700 routines,
collectively known as the Mac Toolbox. These include routines for drawing
windows on the screen, routines for handling menus, even routines for
changing the date on the real-time clock built into the Mac. The existence
of these routines helps explain the consistency of the Mac user interface.
Everyone uses these routines. When MacDraw pulls down a menu, it's
calling a Toolbox routine. When MacPaint pulls down a menu, it's calling
the same routine. That's why the menus look alike from application to
application, which has a rather soothing effect on users. This same
principle applies to scroll bars, windows, lists, dialog boxes, alerts, and so
on.
Ifyou look at Toolbox calls in the pages of Inside Macintosh, you'll notice
that the calling sequences and example code presented in each chapter are
written in Pascal. For example, the calling sequence for the function
GetNewWi ndow() (1:283) is listed as:
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FUNCTION GetNewWindow (windowID: INTEGER: wStorage:Ptr:
behind:
WindowPtr)
WindowPtr:
Each calling sequence starts with either the word FUNCTION or the word
PROCEDURE. FUNCTIONs return values; PROCEDURES don't. Here's
an example ofa call to GetNewWi ndow() written in C:

1!d e f i ne NI L

0L

WindowPtr
myNewWindow. myOldWindow:
Ptr
myStorage = NIL:
int
myWindowID = 400;
myNewWindow
GetNewWindow( myWindowID. myStorage.
myOldWindow );
In the Pascal calling sequence, the function GetNewWi ndow() returns a
value of type Wi nd ow Pt r. In our code, we receive this value in the variable
myNewWi ndow, which is declared as a Wi ndowPtr. Most of the data types
found in Inside Macintosh are automatically available to you in THINK C.
The exceptions are summarized in the following table:
Pascal Data Type
BOOLEAN
CHAR
INTEGER
LONGINT
PACKED ARRAY [1..4] OF CHAR

C Equivalent
Boolean
int
int
long
long

For example, the Pascal BOOLEAN data type corresponds to the THINK
C data type Boo l ea n. The Pascal calling sequence for the BLI t ton ( )
function can be found on page 259 of Volume I:

FUNCTION Button

BOOLEAN:

Here's an example of a call to BLI t ton ( ) in C:

Boolean

isButton;

isButton =Button();
if ( isButton ==TRUE ) SysBeep( 20 );
Although Pascal is not case-sensitive, C is: Boolean and BOOLEAN are
different. THINK C provides this Pascal type as a convenience to the
programmer. Even though Button ( ) has no parameters, you must use the
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parentheses. If you forget them, you'll get the compiler error message
"illegal use of in-line Macintosh function."
You can also pass literals directly as parameters. For example, our call
to GetNewWi ndow() can be rewritten as:

#define
WindowPtr
myNewWindow

NIL
OL
myNewWindow, myOldWindow;
GetNewWindow( 400, NIL, myOldWindow );

This code will work just fine. Passing literals as parameters, howeve~
doesn't necessarily make for readable code. At the very least, we suggest
limiting your literal parameters to #defined constants (as we did with
NI L). This brings up the next topic.

#include, #define, and extern statements
The /Ii n c 1 ude statement tells the C compiler to substitute the source code
in the specified file in place of the II i nc 1 ude statement. Here's an example:

#include "MyFile.h"
The //define statement tells the C compiler to substitute the second
argument for the first argument throughout the rest of the source code file.
For example:

#define MAXFILES 20
Most C compilers use two passes to compile source code. During the first
pass through a source code file, the compiler pulls in /Ii ncl ude files and
performs all the /Ide f i n e substitutions. The actual compilation occurs
during the second pass through the source code.
extern is a C key word used in variable and procedure declarations.
Here's an example of an extern variable declaration:

extern Boolean done:
This extern declaration doesn't cause any space to be allocated for the
variable done. Instead, references to done inside the extern declaration's
file are replaced with pointers to the "real" declaration of done:

Boolean done;
The absence of the extern keyword tells the compiler to allocate space
for the variable and tie all the ext e r n references to the variable to this
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allocated space. In the code of this book, every program is only one file, so
extern is not used. It makes sense to break down programs into modules
after they reach a certain size (for example, the Reminder program in
Chapter 6 could easily be broken down into three or four files). Ifyou'd like
to see how they're used in a program, examine the MiniEdit application on
the THINK C disks.

C and Pascal Strings
C and Pascal use different techniques to implement their basic string data
types. Pascal strings start out with a single byte, called the length byte,
that determines the length of the string. For example, the string He 11 o ,
Wo r 1d ! would be stored as a single byte with the value 13, followed by the
13 bytes containing the string:

The C version ofthis string starts off with the 13 bytes containing the string
and is terminated with a single byte with the value 0:

The Macintosh Toolbox uses Pascal strings, embodied by the St r 2 5 5
data type. Since a single byte can hold values from 0 to 255, Pascal strings
can be at most 255 bytes (not including the length byte).
Using Pascal strings in THINK C is easy. The THINK C compiler will
automatically convert C strings that start with the characters " \ p" to
Pascal format. Consider the calling sequence for the Toolbox routine

DrawStri ng () (1:172):
PROCEDURE

Drawstring

(S:

Str255):

You can call DrawSt ring () in C like this:

Drawstring( "\pHello. World!" >:
You can also use the two routines Ct o Pst r ( ) and Pt oC st r ( ) to translate
between C and Pascal string formats. These routines are provided as part
of THINK C. They are not part of the Macintosh Toolbox.
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Passing Parameters: When to Use the &
Here are three rules to guide your use of the & operator in Toolbox calls:
1. If the parameter is declared as a VAR parameter in the Pascal calling
sequence, precede it by an & • Here's the Pascal calling sequence for
Get FNum() (1:223):

PROCEDURE
INTEGER);

GetFNum

(fontName:

Str255;

VAR

theNum:

Here's a C code fragment that calls GetFNum():

int

myFontNumber;

GetFNum( "\pGeneva", &myFontNumber );
2. If the parameter is bigger than 4 bytes (as is the case with most Pascal
and C data structures), precede it by an & whether or not it is declared as
a VAR parameter. Here's the Pascal calling sequence for Uni onRect()
(!:175):

PROCEDURE
Rect);

UnionRect

(srcl.src2:

Rect;

VAR

dstRect:

Here's a C code fragment that calls Uni on Re ct ():

Rect
srcl, src2, dstRect;
UnionRect( &srcl, &src2, &dstRect );
If you're wondering where Rect came from, it's one of the data
structures defined in Inside Macintosh (1:141). ARectholds the upper

left and lower right points of a rectangle. We'll see more of these
"predefined" Mac data structures later on.
·
1

...:.

3. If the parameter is 4 bytes or smaller and is not declared as a VAR
parameter, pass it without the&. This rule applies even if the parameter is
a struct. This is the Pascal declaration of the routine PtToAngl e (1:175):

PROCEDURE
INTEGER ) ;

PtToAngle( r: Rect:

pt: Point;

Here's a C code fragment that calls Pt To Ang 1e ( ) :

Re ct
Point
int

r:

pt;
angle;

PtToAngle( &r, pt, &angle );

VAR angle:
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Notice that pt was passed without a leading&. This is because Points
are only 4 bytes in size. Most of the predefined Mac types are larger than
4 bytes in size. Poi nt is one of the few exceptions.

Conventions
The purpose of any standard is to ensure consistency and quality. With that
in mind, we present our standard for writing C code. We use this standard
and feel comfortable with it. Feel free to use your own standard or adapt
ours to your own personal style. The important thing is to pick a standard
and stick with it.
When discussing (i.e., arguing over) C standards, people fight most of all
over indentation style. Here's an example of our indentation standard:
ma i n C )
{

int i;

for
I

i=O; i<lO; i++ )
DoNastyStuff();

}

WrapltUpC);
DoNastyStuff{)
{

DoOneNastyThing();
Notice that all our curly brace pairs (I with its corresponding }) line up
in the same column. Some people like to put the open curly brace at the end
of the previous line, like this:
ma i n ( )
int i;

for C i=O; i<lO; i++ )
DoNastyStuff();
J

WrapltUp();
DoNastyStuff() I
DoOneNastyThing();
Hmmmm.
Well, do what you like, but be consistent.
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Generally, we name our variables and routines according to the standards in Inside Macintosh. This means that the names look like Pascal
names. The advantage of this is that you can use the same variable names
used by Inside Mac. This makes your code much easier to debug and
compare with Inside Mac. Our general rules for variable and routine
naming are as follows:
• If you're naming a variable, start with a lower-case letter and capitalize
the first letter of every subsequent word. This yields variables named i ,
myWi ndow, and bi gDataStructure.
• If you're naming a routine (function, procedure, subroutine, etc.), start
with a capital letter and capitalize the first letter of every subsequent
word. ThisyieldsroutinesnamedMa in Loop (),De 1 eteEverythi ng( ),
and PutThatDown ( ).

Most of the Toolbox routines are built right into the Macintosh, in
read-only memory, or ROM. The original Macintosh came with 64K
ROMs, the Mac Plus comes with 128KROMs, and the Mac SE, II, and
IIx each come with 256K ROMs. Many of the routines built into the
MAC II and Mac IIx ROMs are not found in the original Mac, Mac
Plus, or SE. Likewise, many routines found in the Mac Plus were not
found in the original Macintosh. The point is, things change. If you're
not careful, the programs you write on one machine might not work
on another. In the same vein, ifyou don't follow Apple's programming
guidelines, the program you write on today's machine may break on
tomormw's.

Resources
As we mentioned in Chapter 1, much ofa program's descriptive information
is stored in resources. Resources may be defined by their type and either
their resource ID number or their name.
Each resource has a certain type, and each type has a specific function.
For example, the resource type WIND contains the descriptive information
necessary to create a window; MENU resources describe the menus at the top
ofthe screen. Figure 2.4 gives a short list ofsome ofthe resource types you11
see in this book.
Each resource type is composed of four characters. Case is not ignored:
WI ND and wi nd are considered different resource types. Occasionally,
resource types may include a space-for example, ' s nd ' , where the fourth
character is a space.
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Actually, resource types are just long integers (4 bytes) represented in
ASCil format. Usually, the types are selected so the ASCil version is
readable (like WIND, MENU, and so on).

§0§ Primer Resource Types ~
BNDL
~

CODE
DITL

DLOG
FREF
ICN#

MBAR
MENU
PICT
~

\:·/IN[J

Figure 2.4
Some resource types used
in the Mac Primer.

Resource ID numbers are unique within their resource type and file. An
application can have several resources oftype DLOG, each ofwhich normally
has a unique resource ID within the application file. For example, the
program shown in Figure 2.5 has two DLOGs with ID= 400 and ID= 401.
The application also has a WI ND type resource with ID = 4 00. Thus, each
resource is uniquely identified by ID number and type.
If you prefer, you may also name your resources. All the examples we
present in the Mac Primer use the resource type and resource ID to specify
resources. When you create your resources, however, you might want to
specify resource names as well as resource IDs. This will make your
resource files easier to read in ResEdit.

ID numbers follow these conventions:

Range
-32,768 to -16,385
-16,384 to 127
128 to 32, 767

Use
Reserved by Apple
Used for system resources
Free for use

Certain kinds of resources may have additional restrictions; check
Inside Macintosh for further information.
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Figure 2.5 Resources in a sample application.

We'll be creating CODE resources in THINK C; most of the other resources
will be created using ResEdit.
CODE resources contain the actual code that is to be executed. You may
be used to an operating environment that allows you to segment your
executable code. The Mac supports segmentation as well. Each segment is stored in a separate C0 DE resource and is loaded and unloaded
as necessary. If you are interested in learning more about code
segmentation, an informative discussion begins on page 70 of the
THINK C User's Manual.

Data Forks and Resource Forks
Macintosh files, unlike files on most other operating systems, each contain
two parts: a data fork and a resource fork. The resource fork stores the
resources, and the data fork contains everything else. Most word processors
store a document's text in the document's data fork and use the resource
fork for storing the document's formatting information. HyperCard stacks,
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interestingly enough, have all their information on the data fork side. The
THINK C projects in this book will use the resource fork exclusively.
Now that we've covered these weighty and important topics, let's make
THINK C do something, right away!

_J

The Hello, World Program
Now you will key in your first THINK C program. It's the classic C program
listed in the THINK C User's Manual. Hello, World dra ws its na me in a
window.
Just to make things neat, put a new folder inside the s re folder you
created earlier. Call the new folder Hello. World. Keep all the files
associated with the Hello, World project in this folder.

Create a New Project
To create your first program, double-click on the THINK C application in
the THINK C folder (Figure 2.6). The first thing you'll see is the Open
Project dialog box. Click on the New button, and you should see the Name

la THINK cl
D
D
D
D
D
D
D
D

Bullseye Folder
Lib raries
Mac #inc lud es
Mac Libraries
MiniEdit Folder
src
Ut ilities I
Utilities 2

Figure 2.6 The Open Project dialog box.
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Project dialog box (Figure 2.7). Open up the s re folder by double-clicking
on it. Then open up the He 11 o . Wo r l d folder that you just created. Type
in He 11 o Proj in the project dialog box and click the OK button (or hit a
carriage return). The project window (titled He 11 o Pr oj) is empty (Figure
2.8), because you haven't added any files to the project yet. As you add files
to your project, they will be added to the project window, with the object
code size displayed in bytes.
Now, you're ready to type in your first program. First, open a new
document. Then, you can type in your program and save the file. Finally,
you can add any libraries that are needed to run the code.
The Project file acts as an information center for all the files involved
in building an application. It contains the names of all the source code
and resource files necessary to run the application. In addition, the
Project file contains information about the THINK C environment
like the preferred font and font size for printing source code. Projects
are a THINK C concept, not a Macintosh concept.

D MiniEdit Folder
D src

c:::i

Hard Disk

~

HllNK C
Hll NK C D<!tlll~HJ<!r
D Utilities 1
D Utilities 2
~

Figure 2.7 The Name Project dialog box.
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Figure 2.8 The Project window.

The Code
Enter the source code for the file he 11 o. c . Pull down the File menu and
select New. Figure 2.9 should show the result. Now that you have a blank
window, type in the following program:

/******* hello . c*****************/
#incl ud e <s tdi o.h >
ma in ( )
(

prin t f ( " hel l o, world\n ");
The THINK C compiler doesn't care how you use white space, such as
tabs, blanks, and spaces. Be generous with your white space-don't be
afraid to throw in a blank line or two ifit will improve the readability ofyour
code.
Check the code for typing errors. Ifeverything looks all right, then select
Save from the File menu. Call the file he 11 o . c. Then select the Add menu
item from the Source menu.
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Hello Proj

Figure 2.9 A new Source Code window.

Note that the he 11 o . c file is displayed in the project window (Figure
2.10). Now try running the program by choosing Run from the Project
menu, or by keying 3C R (pronounced "command-R''). Respond to the Update

Project dialog box by clicking Yes.
As you can tell, the program isn't quite ready to go. The message Link
Failed (Figure 2.11) should have appeared in a window at the top of the
screen, and another window with the words undefined pr in t f appeared
below it. Don't worry-this is a simple problem to fix. We're missing the
special link libraries that contain the definition of the pri ntf routine.
Get rid of the bug window, either by clicking on it or by pressing the
Return key. Next, close the Link Erro r s window by clicking in its close
box. To corrrect your problem, you need to add the two libraries Ma c Traps
and std i o to the project.
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Figure 2.12 Looking for s t dio .

Adding Libraries
Before you run Hello, World, you have to load two library files so that the
pr i ntf command will be recognized by the compiler. The first, stdio,
contains information about the standard inputJoutput commands of the C
language. To load s t di o, pull down the Source menu and select Add ...
(Figure 2.12).
When the Add File dialog box appears, open up the l i bra r i es folder
inside the TH I NK Cfolder and add the s td i o file. While you're here, add
the second library, MacTr aps . MacTraps is necessary if you want to use
anyToolboxcalls (which print f ( ) does). Ma cTraps is in the Mac Li bra r i es
folder inside the TH I NK C folder. Add Ma c Tr ap s by clicking on the Add
button. Since you don't want to add any more files to the project, click on the
Cancel button. st d i o and Mac Tr a ps should be displayed under he l l o . c
in the project window (Figure 2.13).
The difference between Add ... and Add in the source menu is that
Add... has you select the file that you desire, whereas Add automatically adds the file that you are currently working on to the project.
The Ma c Tr a ps library file is necessary for all the programs in the
Primer. If you are having difficulty with these operations, go back to the
THINK C User's Manual, or take a look at the THINK C Command
Summary in Appendix E.
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prinlf C"He l lo, Wor ld");

Figure 2.13 s t di o and Mac Traps added to Project.

Running Hello, World
Select Run from the Project menu. Respond to the Update Project dialog box
by clicking Yes. If you followed the instructions properly, you should get
something like Figure 2.14. The application will exit when you click the
mouse in the Exit window's close box (it's in the upper left-hand comer of
the window).

The Problem with Hello, World
We don't want to get you too excited about this version of Hello, World.
Although it does demonstrate how to use THINK C, it does not make use
of the Macintosh Toolbox. The first program in Chapter 3 is a Macintized
version of Hello, World called Hello2.
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Figure 2.14 Think's Hello, World.
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In Review
In Chapter 2, you installed THINK C and created your first project. In

Chapter 3, we'll look at the basics of Mac programming: QuickDraw,
windows, and resources. We'll also present four Macintosh applications
that demonstrate the versatility of the Macintosh.
It's almost too late to turn back. To all those who have come from other
environments: Beware! QuickDraw is addictive!

3

Drawing on the
Macintosh
On the Macintosh, the Toolbox routines
that are responsible for all drawing are
collectively known as QuickDraw. Now
that you have installed THINK C, you
can start programming. A good starting
point is with the unique routines that
define the Macintosh graphic interface.

_J

Introduction
QuickDraw is the Macintosh drawing environment. With it, you can draw
rectangles and other shapes and fill them with different patterns. You can
draw text in different fonts and sizes. The windows, menus, and dialogs
that are displayed on the Macintosh screen are all created using QuickDraw routines.
In this chapter, we'll show you how to create your own windows and draw
in them with QuickDraw. Let's start by examining the QuickDraw coordinate system, the mathematical basis for QuickDraw.

The QuickDraw Coordinate System
QuickDraw drawing operations are all based on a two-dimensional grid
coordinate system. The grid is finite, running from (-32, 767, -32, 767) to
(32,767, 32,767), as shown in Figure 3.1. Every Macintosh screen is
actually an array of pixels aligned to the grid. The lines ofthe grid surround
the pixels. The grid point labeled (0,0) is just above, and to the left of, the
upper left-hand corner of the Mac screen (Figure 3.2).
A screen measuring 32,768 pixels x 32,768 pixels with a screen
resolution ofl pixel= 1172 inch would be 38 feet wide and 38 feet tall.
The Mac Plus and SE monitors are 512 x 342 pixels. Apple's Mac II 13"
color monitor is 640 x 480 pixels.
( -32,767, -32,767 )

( 32, 767 I 32, 76"

Figure 3.1 The grid.
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Figure 3.2
The Macintosh screen on the grid.

The grid is also referred to as the global coordinate system. Each
window defines a rectangle in global coordinates. Every rectangle has a top,
left, bottom, and right. For example, the window depicted in Figure 3.3
defines a rectangle whose top is 80, left is 50, bottom is 220, and right is 300.
Interestingly, the window does not have to be set up within the
boundaries of the. scre~:m• .You can set up .a window whose left is -50,
top is 100, bottom is 200, and right is 800. On a Mac Plus, this window
would extend past the left and right sides of the screen (Figure 3.4)!
This is known as the big long window technique Use of the big long
window technique is disco~aged.
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Figure 3.3 A window on the grid.
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Big Long Window

Figure 3.4 A big long window.

When drawing inside a window, you'll always draw with respect to the
window's local coordinate system. The upper left-hand corner of a
window lies at coordinate (0,0) in that window's local coordinate system
(Figure 3.5). To draw a rectangle inside your window, specify the top, left,
bottom, and right in your window's local coordinates (Figure 3.6). Even if
you move your window to a different position on the screen, the rectangle
coordinates stay the same. That's because the rectangle was specified in
local coordinates.
Local coordinates are great. Suppose you write an application that
puts up a window, then draws a circle in the window (Figure 3.7).
Then, the user of your application drags the window to a new
position (Figure 3.8).
You still know exactly where that circle is, even though its window
has been moved. That's because you specified your circle in the
window's local coordinates.
On the Macintosh, text and graphics created by your programs will be
displayed in windows. Windows are the device that Macintosh programs
use to present information to a user.
Since we need windows to draw in, let's look more closely at windows and
the Window Manager.

I

l

(

0, 0 ) in Window's Lo la
Coordinate System

ISi

II III

Figure 3.5 Local coordinates.

I O, 0 ) in Window' s Local
Coordinate Syst em, (" 5 0 , 8 0 >l-+n~f-++-1-1-+4-4--~4-<"-l
Global Coordinates

HH

HH
HH
HH
HH
HH

( 20, 30 ) in Window's Loca ~
( ·10 , 110 Hi'!'1 '1--r.....-..-.-..,.-,-r+-t-+-I
Global Coordinates

Coord inate System ,

±1±± ±

Figure 3.6 Rectangle drawn in window's
local coordinates.

Drawing Window

( 20, 20)

Figure 3.7 Circle drawn in window's local coordinates.
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Still ( 20, 20 )

Figure 3.8 When window moves, local coordinates
stay the same.
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Window Management
When you draw graphics and text on the Macintosh, you draw them inside
a window. The Window Manager is the collective name of all the routines
that allow you to display and maintain the windows on your screen.
Window Manager routines are called whenever a window is moved, resized,
or closed.

Window Parts
Although windows can be defined to be any shape you choose, the standard
Macintosh window is rectangular. Figure 3.9 shows the parts of a typical
window.
The close box is used when you wish to close the window. The drag
region is where you grab the window to move it around the screen; this
region also contains the window's title. Scroll bars are used to examine
parts of the window content not currently in view. The grow box (also
known as the size box) lets you resize the window. The zoom box toggles
the window between its standard size and a predefined size, normally about
the size of the full screen.
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Figure 3.9 Window components.

There are several types of windows. The window in Figure 3.9 is known
as a document window. When you use desk accessories or print documents, you will notice other kinds of windows. These windows may not have
all the same components as the standard window, but they operate in the
same fashion.

Window Types
Six standard types of windows are defined by the Window Manager. Each
type has a specific use. In this section, each type is described and its use is
discussed.
This doc umentp r oc window, shown in Figure 3.10, is the standard
window used in applications. This one has a size box, so it is resizable; it has
a close box in the upper left-hand corner that closes the window.
The noGr owDocProc window (shown in Figure 3.11), is the standard
window without scroll bars or a grow box. Use this window for information
that has a fixed size. The rDoc Proc window (shown in Figure 3.12), has a
black title bar; it has no scroll bars or grow box. This window is most often
used with desk accessories.
The remaining three types of windows are all dialog box windows:
dBoxP r oe, pl a i nDBox, and alt DBox Proc (Figure 3.13). Dialog boxes will
be discussed in Chapter 6.
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The windows described here are the standard models. You can
customize them by adding a few options. For example, most of the
window types supported by the Mac can come either with or without
the close box (also known as the go-away box). You can specify whether
or not the window h as a size box (grow box). A zoom box can be a dded
to doc umentPro c and noG rowDo cPr oc windows (see Chapter 4).
We'll show you everything you need to know to create exactly the type
of window you want for your application.

~L

Window

jQ

~

lQl

E?l Q]

Figure 3.10 The documentProc window.

D

Window

Figure 3.11 The noGrowDocProc window.
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Figure 3.12 The rDocProc window.

Figure 3.13 The dBoxProc, pl a i nDBox, and al tDBoxProc.
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Setting Up a Window for Your Application
Ifyou plan to use one of the standard window designs for your applications,
creating a window is easy. First, build a WIND resource using ResEdit (if
you're not familiar with ResEdit, tum to Chapter 8). The WI ND resource
requires the information shown in Figure 3.14.Use this resource ID within
your application to refer to your WI ND resource.
Once your WI ND resource is built, you're ready to start coding. One of the
first things your program will do is initialize the Toolbox. The Window
Manager is initialized at this point.
Next, load your WIND resource from the resource file, using the
GetNewWi ndow() Toolbox routine:

pictureWindow = GetNewWindow( windowID. wStorage, behind);
GetNewWi ndow() loads the WI ND resource that has a resource ID of
Wi nd ow ID. The WI ND information is stored in memory at the space pointed
to by wStorage. The Window Manager will automatically allocate its own
memoryifyoupass NIL (orOL)asyourwStorage parameter.Fornow, this
technique is fine. As your applications get larger, you'll want to consider
developingyourownmemorymanagementscheme. Theparameter behind
determines whether your window is placed in front of or behind any other
windows. If the value is 0 L , it goes to the back, - 1 L puts it in front. For
example:

theWindow

=

GetNewWindow( 400, OL, -lL );

loads a window with a resource ID of 4 0 0, asks the Window Manager to
allocate storage for the window record, and puts the window in front of all
other windows. A pointer to the window data is returned in the variable
theWi ndow.
When you create the WI ND resource with ResEdit, you are given a choice
of making the window visible or not. Visible windows appear as soon as they
are loaded from the resource file with GetNewWi ndow(). If the visible flag
is not set, you can use Sh owW i n d ow ( ) to make the window visible:

ShowWindow( theWindow );
where theWi ndow is the pointer you got from GetNewWi ndow(). Most
applications start with invisible windows and use ShowWi ndow () when
they want the window to appear. The Window Manager routine
Hi deWi ndow() makes the window invisible again. In general, you'll use
ShowWi ndow() and Hi deWi ndow() to control the visibility of your windows.
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At this point, you've learned the basics of the Window Manager. You can
create a window resource using ResEdit, load the resource using
GetNewWindow( ) , and make the window appear and disappear using
ShowW i ndow() and Hi deWi ndow ( ). We'll demonstrate this technique
shortly. After you have put up the kind of window you want, you can start
drawing in it. The next section shows you how to use QuickDraw routines
in your window.

Drawing in Your Window:
The QuickDraw Toolbox Routines
There are many QuickDraw drawing routines. They can be conveniently
divided into four groups: routines that draw lines, shapes, text, and
pictures. These routines do all their drawing using a graphics "pen." The
pen's characteristics affect all drawing, whether the drawing involves
lines, shapes, or text.
Before starting to draw, you have to put the pen somewhere (Move To ( ) ),
define the size of the line it will draw (Pen Si z e ( ) ), choose the pattern used
to fill thick lines (Pen Pat ( ) ), and decide how the line you are drawing
changes what's already on the screen (PenM ode ( ) ). Figure 3.15 shows how
changing the graphics pen changes the drawing effect.
Every window you create has its own pen. The location of a window's pen
is defined in the window's local coordinate system. Once a window's pen
characteristics have been defined, they will stay defined until you change
them.
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Figure 3.15 Graphics pen characteristics.

Setting the Current Window
Because your application can have more than one window open at the same
time, you must first tell QuickDraw which window to draw in. This is done
with a call to Setport( ):
theWindow = GetNewWindow( 400 , OL , - l l ) :
SetPort( theWindow ) :

In this example, Setport () made theWi ndow the current window. Until

the next call to Set Port ( ) , all QuickDraw drawing operations will occur
in theWi ndow, using t heWi ndow's pen. Once you've called Set Port () and
set the window's pen attributes, you're ready to start drawing.
The basic data structure behind all QuickDraw operations is the
Gra f Port. When you call Set Port () ,you are actually setting the
current Graf Port (1:271). Since every window has a Graf Port data
structure associated with it, in effect you are setting the current
window. The Gra f Port data structure contains fields like pnSi ze
and pnl oc , which define the Gr a f Po r t pen's current size and location. QuickDraw routines like Pe n Si z e ( ) modify the appropriate
field in the current Graf Po r t data structure.
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Drawing Lines
The Li neTo() routine allows you to draw lines from the current pen
position (which you have set with MoveTo( )) to any point in the current
window. For example, a call to:
t heWi ndow = Get New Wi ndowC 400 , OL, - l l );
SetPo r t( the Wi ndow ) ;
Move To ( 39 . 47 ) ;
LineTo C 407 , 231 ) ;

would draw a line from (37 . 47) to ( 407 , 23 1 ) in the Wi nd ow's local
coordinate system (Figure 3.16).
It is perfectly legal to draw a line outside the current boundary of a

window. QuickDraw will automatically clip it so that only the portion
ofthe line within the window is drawn. QuickDraw will keep you from
scribbling outside the window boundaries. This is true for all the
QuickDraw drawing routines.
The last program in this chapter is The Flying Line, an extensive
example of what you can do using the QuickDraw line-drawing routines .

.,
~D

Window

Figure 3.16 Drawing a line with QuickDraw.
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Drawing Shapes
QuickDraw has a set of drawing routines for each of the following shapes:
rectangles, ovals, rounded-corner rectangles, and arcs. Each shape can be
drawn filled, inverted, or as an outline (Figure 3.17).
The current pen's characteristics are used to draw each shape, where
appropriate. For example, the current fill pattern will have no effect on a
framed rectangle. The current PenMode () setting, however, will affect all
drawing. The second program in this chapter, Mondrian, shows you how to
create different shapes with QuickDraw (Figure 3.18). It also demonstrates
the different pen modes.

Drawing Text
QuickDraw allows you to draw different text formats easily on the screen.
QuickDraw can vary text by font, style, , size, spacing, and mode. Let's
examine each one of the text characteristics.
Font refers to the typeface of the text you are using. Courier, Helvetica,
and Geneva are some of the typefaces available on the Macintosh. Style
refers to the appearance of the typeface, (bold, italic, underline, etc). The
size of text on the Macintosh is measured in points, where a point is equal
to 1172 inch. Spacing defines the average number of pixels in the space
between letters on a line of text. Figure 3.19 shows some ofthese characterics of QuickDraw text.

Figure 3.17
Some QuickDraw shapes.
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Figure 3.18 Mondrian.
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Figure 3.19 Examples of QuickDraw text.
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The mode of text is similar to the mode of the pen. The text mode defines
the way drawn text interacts with text and graphics already drawn. Text
can be defined to overlay the existing graphics ( s r c 0 r ); text can be inverted
as it is placed on the existing graphics (s rcXor); or text can simply paint
over the exising graphics ( s r c Copy). The other modes described in QuickDraw shapes (s re Bi c, notSrcCopy, notSrcOr, etc.) can also be used with
text. Figure 3.20 demonstrates how text mode affects appearance.

Drawing Pictures
QuickDraw can save text and graphics created with the drawing routines
as picture resources called PI CTs. You can create a picture (using a
program like MacPaint or MacDraw), copy the picture to the clipboard, and
paste it into a PI CT resource using ResEdit. Later in the chapter, you'll see
how to make use of PICT resources in the ShowPICT program.

About Regions
QuickDraw allows you to define a collection oflines and shapes as a region.
You can then perform operations on the entire region, as shown in Figure
3.21. Chapter 4 demonstrates some basic region-handling techniques.
By now most of you are probably itching to start coding. First, let's look
at the basic Mac programming structure used in this chapter's programs.
Then, we'll hit the keyboards!
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IsrcCopy j

IsrcOr j

Figure 3.20 The two most popular
QuickDraw text modes.
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Basic Mac Program Structure
We've looked at a general outline of the QuickDraw and Window routines
necessary to make a Macintosh application go. The basic algorithm we'll
use in each of the Chapter 3 programs goes something like this:

main ( )
{

ToolBoxinit();
Otherlnits();
DoPrimeDirective();
while ( !Button() )
Like most C programs, our program starts with the routine ma i n ( ) .

main () first initializes the Toolbox. Then, it takes care of any programspecific initialization, like loading windows or pictures from the resource
file. Next, it performs the prime directive. In the case of the Hello, World
program, the prime directive is drawing a text string in a window. Finally,
ma i n ( ) waits for the mouse button to be pressed. This format is very basic:
Except for clicking the button, there is no interaction between the user and
the program. We'll add this in the next chapter.
Danger! Normal Macintosh applications do not exit with a click of the
mouse button. Mac programs are interactive. They use menus, dialogs, and events. We'll add these features later. For the purpose of
demonstrating QuickDraw, we'll bend the rules a bit.

OffsetRgnl

InsetRgn

Figure 3.21 Two QuickDraw region operations.
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The QuickDraw Programs
The following programs each demonstrate different parts of the Toolbox.
The Hello2 program demonstrates some of the QuickDraw routines related to text; Mondrian demonstrates QuickDraw shapes and modes;
ShowPICT loads a PI CT resource and draws the picture in a window.
Finally, we present The Flying Line, an intriguing program that can be
used as a screen saver.
Let's look at another version of the Hello, World program presented in
Chapter 2.

_J

Hello2
The new Hello2 program will do the following:
•
•
•
•

Initialize the Toolbox.
Load a resource window, show it, and make it the current port.
Draw the string He 11 o , Wo r l d in the window.
Quit when the mouse button is pressed.

To get started, create a folder in the s re folder and call it He 11 o2. This
is where you'll build your first Macintosh application.
Create a resource of type WI ND. The WI ND resource allows you to define
a window with the appearance and size that you desire. Use the tutorial in
Chapter 8 if you feel hesitant about using ResEdit.
To build the WI ND resource, run ResEdit. Click on the window that
represents your hard disk, and open up the He 11 o 2 folder you just created
in the s re folder. (You will have to open some folders to get to the s re
folder.) Once you've opened the He 11 o 2 folder window, select New from the
Filemenutocreateanewresourcefile.NamethefileHel l o2 Proj. Rs re.,
as in Figure 3.22. Make sure to include the space between He 11 o2 and
Proj. Rs re.
Once you've named the new resource file, a window listing all of its
resources will appear automatically. Since you just created the file, no
resources are listed. Select New again to create a new resource. When
prompted, enter WI ND as the new resource type. Remember, case is
important: WI ND is not the same as wi nd. Select New yet again to create a
new WI ND resource, as in Figure 3.23.
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First, define the coordinates of the window. Pull down the WI ND menu
and choose the only selection: Display as Text. Then, fill out the fields as
shown in Figure 3.24. Next, select Get Info from the File menu (Figure
3.25). Set the window resource ID to 400.
Choose Quit from the File menu. When prompted to save the file, click
Yes. THINK C will automatically make the resource file you just created
available to your program.
As we discussed in Chapter 2, THINK C collects information about the
current program in a Project file. Whenever you run a program within
THINK C, THINK C looks for a file with the name xxx . Rs re, where
xxx is the name of the Project file. If it finds a file with that name,
THINK C opens the file and makes the resources found in that file
available to your program.
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Figure 3.24 The WIND type and size parameters.
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The Hello2 Code
Get into THINK C and create a new project in the He 11 o 2 folder. Ifyou need
help creating a new project, refer back to Chapter 2 or just review the
THINKC documentation. Call the project He 11 o2 Proj. Next, select New
from the File menu and type the following source code into the window that
appears.

#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRO NT
REMOVE_ALL_EVENTS

#define HORIZONTAL_PIXEL
#define VERTICAL_PIXEL
WindowPtr

400
OL
- lL
0

30
50

gHelloWindow ;

!*********************** Main

main()
I

Tool Boxlni t() ;
Wi ndowl nit () ;
while ( !Button()

*******~***** /
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/*********************************** ToolBoxlnit */
Tool Boxlni t()
InitGraf( &thePort ) ;
InitFonts() ;
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ) ;
InitWindows () :
InitMenus();
TEI nit( ) ;
lnitDialogs( NIL POINTER );
InitCursor() :
/*********************Windowinit**************/
Windowinit()
{

gHelloWindow= GetNewWindow( BASE_RES_ID ,
NIL_POINTER, MOVE_TO_FRONT ) ;
ShowWindow( gHelloWindow);
SetPort( gHelloWindow) ;
MoveTo( HORIZONTAL_PIXEL , VERTICAL_ PIXEL );
DrawString( " \pHello , World");
Select Save from the File menu and save your source code as He 1 1 o 2 . c.
Select Add from the Source menu to add He 11 o 2 . c to the project. Finally,
add MacTraps to the project. To do this, select Add. .. (not Add) from the
Source menu. When the Add File dialog box appears, find the Mac Traps
file in the Mac Libraries folder.When you're done, the Project window
should look like Figure 3.26.
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hel loi.Ji ndow;

/***********************

obj siz:.

Main

*************/

Too l Box lni l< >;
i.Jlndowlni l< >;
whl l e ( IBultonO ) ;

/******************* Too l Boxlnil*******************/
l nitGraf( &thePort >;
lni tFonts( >;
FlushEvent s( everyEvent, 0
l nl ti.Jindows< >;

>;

Figure 3.26 Hello2's Project window.
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Running Hello2
Now that your source code is typed in, you're ready to run Hello2. Select Run
fromtheProjectmenu.Whenaskedto Bring the project up to date? ,
click Yes.
You may get a complaint about a syntax error or two. If so, just retype
the line on which the cursor has been placed. If it still won't run, refer to
Appendix E on debugging techniques.
Ifyou make any changes to He l l o 2 . c, you'll be asked whether you'd like
to Sav e changes before runni ng? . Click Yes.
Once you've gotten Hello2 to compile without a hitch, it will automatically start running, as shown in Figure 3.27. Voila! The new Hello, World
should display a window with the text He 11 o , Wo r l d in it. Quit the
program by clicking the mouse button. Let's look at how the code works.
If Hello2 compiles, yet the Hello2 window fails to appear, it often
indicates a problem with the resource file. If the WIND resource has been
entered correctly, make sure that the resource file name matches up with
the project name (e.g. Hell o2Proj . Rsrc for the resource file, and
He 11 o 2 Pro j for the project file. Also make sure that both files are in the
He 11 o2 folder.

.,
Hello2 Window

Hello, World

Figure 3.27 The n ew Hello, World.
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Walking through the Hello2 Code
ThefirstfewlinesofHe 11 o2. c are1idefi nes. THINKC#defi nes arethe
same as those found in other C programming environments. During
compilation, THINK C takes the first argument of the #def i n e, finds each
occurrence in the source code, and substitutes the second argument. For
example in the first /ldefi ne, the number 400 will be substituted for each
occurrence of BASE_RES_I D:

#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

#define HORIZONTAL_PIXEL
#define VERTI CA L_P IX EL

400

OL

-ll

0
30
50

#def i n es don't actually modify your copy of the source code. THINK
C creates its own copy of the source code and makes the substitution
on its copy.
·

Next, declare your global variables. In this case, there is only one global,
gHe 11 oWi ndow, whichisdeclaredasapointertoawindow. GetNewWi ndow()
creates a window specified by your WI ND resource and returns a pointer to
the window in the variable gHe 11 oWi ndow.

WindowPtr

ghelloWindow;

The main() routine is next. main() calls ToolBoxlnit() and
Wi n d ow I n i t ( ) , then loops until the mouse button is pressed.
/*********************** Main *************/
ma i n ( )
{

ToolBoxinit();
Windowlnit();
while ( !Button() ) ;
Too 1 Box I n i t ( ) will remain unchanged throughout the entire book.
Although you won't always use all the data structures and variables
initialized by Too 1 Box I n i t ( ) , you are perfectly safe in doing so. It is much
easier and safer to initialize each of the Macintosh Toolbox managers than
to try to figure out which ones you'll need and which you won't.
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/*********************************** ToolBoxinit */

ToolBoxinit()
{

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent. REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();
Each call initializes a different part of the Macintosh interface. The call
to Ini tGraf() initializes QuickDraw.
The following global variables are initialized by InitGraf() and can be
used in your routines:
• thePort always points to the current GrafPort. Because it is the
first QuickDraw global, passing its address to I n i t Graf ( ) tells
QuickDraw where in memory all the QuickDraw globals are located.
• white is a pattern variable set to a white fill; black, gray,
1 tGray, and dkGray are initialized as different shades between
black and white.
• arrow is set as the standard cursor shape, an arrow. You can pass
arrow as an argument to QuickDraw's cursor-handling routines.
• screenBi ts is a data structure that describes the main Mac
screen. The field screenBi ts. bounds is declared as a Rect and
contains a rectangle that encloses the main Mac screen.
• randSeed is used as a seed by the Macintosh random number
generator (we'll show you how to use the seed in this chapter).

I ni t Fonts ( ) initializes the Font Manager and loads the system font
into memory. Since the Window Manager uses the Font Manager (to draw
the window's title, for example), you must initialize fonts first.
Fl ushEvents ()gets rid of all the events that are currently in the event
queue, such as mouse movement or keyboard actions. We'll talk about
events in Chapter 4. In i t Wi nd ow s ( ) initializes the Window Manager and
draws the desktop and the empty menu bar. I ni tMenus ()initializes the
Menu Manager so you can use menus. (Chapter 5 shows how to use the
Menu Manager.) I ni tMenus () also draws the empty menu bar.
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InitWindows() and InitMenus() bothdrawtheemptymenubar.
This is done intentionally by the ROM programmers for a reason that
is such a dark secret, they didn't even document it in Inside Macintosh.
TE In i t ( ) initializes TextEdit, the Text-Editing ManagerthatMiniEdit
uses (discussed in the THINK C User's Manual and in Inside Macintosh).
I ni tDi al ogs () initializestheDialogManager(demonstratedinChapter
6). I n i t Cursor ( ) sets the cursor to the arrow cursor and makes the cursor
visible.
As we said, it's not necessary to call each of these routines in every
program you'll ever write. Why, then, should you call Ini tMenus (),for
example, if you don't use menus? Well, suppose you decide to add menus
later. Calling Ini tMenus () now means you won't spend time later on
wondering why your program is crashing when all you did was add a new
menu-handling routine.
An additional reason to initialize all managers is more subtle. Routines
in one manager may employ routines in another manager. So, if one
manager is not initialized-even if you don't use its routines-your program may bomb. Use the Tool box I n i t ( ) routine in your programs.

Window Initialization Routine
Windowlnit() callsGetNewWindow() toloadtheWINDwithresourceID
= BASE_RES_ID from your resource file. GetNewWi ndow() returns a
pointer to the new window data structure. Then, Wi nd ow I n i t ( ) calls
Sh owW i nd ow ( ) to make the window visible. It is at this point that the
window actually appears on the screen. The call to Setport () makes
gHel l oWi ndow the current window. All subsequent QuickDraw drawing
operations will take place in gHe 11 oWi ndow. Next, gHe 11 oWi ndow's pen
is moved to the local coordinates 50 down and 30 across from the upper lefthand comer of g He 11 o Wi n d ow, and the Pascal string He 11 o , Wo r 1d is
drawn.

/*********************Windowlnit**************/
Windowlnit()
I

gHelloWindow= GetNewWindow( BASE_RES_ID . NIL_POINTER.
MOVE_TO_FRONT );
ShowWindow( gHelloWindow);
SetPort( gHelloWindow);
MoveTo( HORIZONTAL_PIXEL. VERTICAL_PIXEL );
DrawString("\pHello, World");
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The new Hello, World can easily be turned into a standalone application. Pull down the Project menu and select Build Application. When
the Build Application dialog box appears, type in the name of your
application and press return. THINK C will build a standalone
application out ofHello2. If you'd like to add a custom icon to Hello2,
take a quick tour through Chapter 8.

_J

Variants
We'd like to present some variants to the Hello2 program. We'll start by
changing the font used to draw He 1 1 o , Wor 1d. Next, we'll modify the style
of the text, using boldface, italics, and so on. We'll also show you how to
change the size of your text. Finally, we'll experiment with different
window types.

Changing the Font
Every window has an associated font. You can change the current window's
font by calling Text Font(), and passing an integer that represents the
font you'd like to use:

int
myFontNumber;
TextFont ( myFontNumber );
lftextisalreadydrawninthewindow, TextFont() won'taffectit-only
text drawn after the routine is called is affected. Macintosh font numbers
stat at zero and count up from there. THINK Chas predefined a number of
font names for you to experiment with. For example, mo naco is defined as
4, ti mes as 20. If you want to check out the whole list, open the file
FontMgr. h in the Mac #includes folder.
Did someone in the back ask, "How can you tell which fonts have been
installed in the system?" An excellent question! Not every Mac has the
same set of fonts installed. Some folks have the LaserWriter font set,
others a set of fonts for their ImageWriter. Some people might even
have a complete set offoreign language fonts. For the most part, your
applications shouldn't care which fonts are installed. There are,
however, two exceptions to this rule. All dialog boxes and menus are
drawn in the system font, which defaults to font number 0. The
default font for applications is called the application font, usually
font number 1. In the United States, the system font is Chicago, and
the applications font is Geneva.
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Fornow,putthe Text Font () callbeforeyourcall to DrawStri ng ()and
after your call to Set Port ( ) , and try different font numbers.

/*********************Windowlnit**************/
Windowlnit()
{

gHelloWindow= GetNewWindow( BASE_RES_ID • NIL_POINTER,
MOVE_ TO_FRONT ) :
ShowWindow( gHelloWindow);
SetPort( gHelloWindow):
MoveTo( HORIZONTAL_PIXEL. VERTICAL_PIXEL ):
TextFont( monaco );
I* Try other predefined constants <such as times.
if you have it installed) */
DrawString("\pHello. World"):

Changing Text Style
The Macintosh supports seven font styles: bold, italic, underline, outline,
shadow, condensed and extended, or any combination of these. In Chapter
5, we'll show you how to set text styles using menus. For now, try inserting
thecallTextFace( style ) before the call to DrawSt ring ().Here's one
example:
/********~************Windowlnit**************/

Windowlnit()
{

gHelloWindow= GetNewWindow( BASE_RES_ID . NIL_POINTER,
MOVE_TO_FRONT ):
ShowWindow( gHelloWindow):
SetPort( gHelloWindow);
MoveTo( HORIZONTAL_PIXEL. VERTICAL_PIXEL ):
TextFace( bold >:
I* Try the other styles */
DrawString("\pHello, World"):

Here's a list of predefined styles taken from the 1/i ncl ude file
QuickDraw.h:
·
•
•
•
•

bold
italic
underline
outline

• shadow
• condense
• extend
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You can also combine styles; try Text Fa c e ( bo 1d + i ta 1 i c ) or some
other combination.

Changing Text Size
It's also easy to change the sizeofthefonts, usingthe TextSi ze ()Toolbox
routine:

int
myFontSize:
TextSize< myFontSize ):
The number you supply as an argument to Text Si z e ( ) is the font size
that will be used the next time text is drawn in the current window. The
Font Manager will scale a font up to the size requested; this may result in
a jaggy character, as shown in Figure 3.28. The default size is 0, which
specifies that the system font size (normally 12 point) be used. Try this
variation.

/*********************Windowlnit**************/
Windowlnit()
{

gHelloWindow= GetNewWindow( BASE_RES_ID ,
NIL_POINTER, MOVE_TO_FRONT ):
ShowWindow( gHelloWindow):
SetPort( gHelloWindow):
MoveTo( HORIZONTAL_PIXEL. VERTICAL_PIXEL ):
TextSize( 24 );
I* Try other sizes like 1 or 255 (you may have to
change the VERTICAL_PIXEL #define to something
bigger) */
DrawString("\pHello, World");

Changing the Hello2 Window
Another modification you can try involves changing the window type from
0 to something else. Use ResEdit to change the WIND resource's pro c ID
from 0 to 1, as in Figure 3.29. (See the section on window types earlier in
this chapter for other possibilities.)
Now that you have mastered QuickDraw's text-handling routines, let's
exercise the shape-drawing capabilities of QuickDraw with our next program: Mondrian.
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Figure 3.28 The result of font scaling.
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Figure 3.29 Ch anging the window type.
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Mondrian
The Mondrian program opens a window and draws randomly generated
ovals, alternately filled with white or black. Like Hello2, Mondrian waits
for a mouse click to exit. The program, with its variants, demonstrates most
of QuickDraw's shape-drawing functionality.
Mondrian is made up of three steps:
• Initialize the Toolbox.
• Initialize the window.
• Draw random QuickDraw sha pes in a loop until the mouse button is
clicked.
First, create a new folder called Mondrian in the src folder. Next,
create the resources you need for the program, and then enter the code.

Resources
The Mondrian program needs a WIND resource, just as Hello2 did. In this
case, create a new resource file called Mond rian Proj . Rs re (don't forget
the space) in the Mond ri an folder you just made. Then create a WI NO with
size and title as shown in Figure 3.30. Before you close and save
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Figure 3.30 WI N0 parameters for Mondrian.
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Mondrian Proj. rs rc,gotoGetlnfo andchangetheresourceIDofthenew
WI ND to 4 0 0. Next, go into THINK C and create a new project called
Mondrian Proj inside the Mondrian folder. Add MacTraps to your
project. Then open up a new source code window and enter the program:

#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

WindowPtr
long

400
OL
-lL
0

gDrawWindow;
gFillColor = blackColor;

!******************************** main *********/

main()
{

Tool Boxlnit();
Wi ndow In it ( ) ;
Mai nloop();
!*********************************** ToolBoxlnit */

ToolBoxlnit()
{

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
Ini tCursor();
!******************************** Windowlnit *********/

Windowlnit()
{

gDrawWindow

GetNewWindow( BASE_RES_ID. NIL_POINTER.
MOVE_ TO_FRONT ) ;
ShowWindow( gDrawWindow );
SetPort( gDrawWindow );
=

/******************************** Mainloop *********/

Mainloop()
{

GetDateTime( &randSeed );
while ( ! Button() )
{

DrawRandomRect();
if ( gFillColor == blackColor )
gFillColor = whiteColor;
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else

gFillColor

blackColor;

/******************************** DrawRandomRect *********/
DrawRandomRect()
{

Rect

myRect;

RandomRect( &myRect. gDrawWindow );
ForeColor( gFillColor ):
PaintOval( &myRect );
/******************************** RandomRect *********/
RandomRect( myRectPtr. boundingWindow
Rect
*myRectPtr;
WindowPtr
boundingWindow;
{

myRectPtr->left = Randomize( boundingWindow->portRect.right
- boundingWindow->portRect.left );
myRectPtr->right =Randomize( boundingWindow->portRect.right
- boundingWindow->portRect.left );
myRectPtr->top = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top );
myRectPtr->bottom = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top );
/******************************** Randomize *********/
Randomize( range )
int
range;
{

long rawResult;
rawResult =Random();
if ( rawResult < 0 ) rawResult *= -1;
return( (rawResult * range) I 32768 );

Running Mondrian
Once you've finished typing in the code, save it as Mon d r i an • c and add it
to the project. Next, select Run from the Project menu. Click Yes to bring
the project up to date. If everything went correctly, you should see something like Figure 3.31. The window should fill with overlapping black and
white ovals until you click the mouse button. If you got a different result,
then check out your resource file; make sure the WI ND resource has the
correct resource ID. If your resource file is all right, go through the code
carefully.
Now let's walk through the Mondrian code.
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Mondrian

Figure 3.31 Running Mondrian.
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Walking through the Mondrian Code
The Mac Primer uses the convention of starting resource ID numbers at
400, adding one each time a new resource ID is needed. (In your own
programs you can use any number between 128 and 32, 767 .) The #def i n es
used in Mondrian are identical to those used in Hello2. The global variable
gOrawWi ndow is Mondrian's main window. Each shape you draw will be
filled with the color in gf i 11Co1 or, which is initialized as b 1ackCo 1or.

#define BAS~_RES_ID
#define NIL_POINTER
#define MOVE_TO_FRONT - l l
#define REMOVE_ALL_EVENTS
WindowPtr
long

400
OL
0

gDrawWindow ;
gFillColor = blackColor ;

The main routine is exactly the same as it was in Hello2:
!******************************** main *********/

main ( )
{

ToolBoxinit() ;
\~ i nd owr ni t ( ) ;
Mainloop() ;
The Toolbox initialization routine is also t he same as in Hello2.
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/*********************************** ToolBoxlnit */

ToolBoxlnit()
{

InitGraf( &thePort );
InitFonts():
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows():
InitMenus();
TEI nit();
InitDialogs( NIL_POINTER ):
Ini tCursor():
Wi nd ow In i t ( ) loads WI ND number 400 from the resource file, storing
apointertoitin gDrawWi ndow. Next, ShowWi ndow() is called to make the
window visible, and Set Port() is called to make gDrawWi ndow the
current window.

/******************************** Windowlnit

******~**/

Windowlnit()
{

gOrawWindow

GetNewWindow( BASE_RES_ID. NIL_POINTER.
MOVE_ TO_FRONT ) ;
ShowWindow( gDrawWindow );
SetPort( gDrawWindow );
=

Ma i n Loop ( ) starts by using the current time (in seconds since January
1, 1904) to seed the Mac random number generator. The QuickDraw global
rand Seed is used as a seed by the random number generator. Ifyou didn't
modify randSeed, you'd generate the same patterns every time you ran
Mondrian.
Ma i n Loop ( ) then sets up a loop that falls through when the mouse
button is pressed. In the loop, DrawRa ndomRect ( ) is called, which generates a random rectangular area in the window and then draws an oval in
the rectangle. Then, g Fi 11 Co 1or is flipped from black to white or from
white to black.

/******************************** Mainloop *********/

Mainloop()
{

GetDateTime( &randSeed );
while ( ! Button() )
{

DrawRandomRect();
if ( gFillColor == blackColor )
gFillColor
whiteColor;
else
gFillColor = blackColor;
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DrawRandomRect() controls the actual drawing of the ovals in the
window. RandomRect() generatesarandomrectangleinsidegDrawWi ndow,
Fore Col or ( ) sets the current drawing color to g Fi 1 1 Co 1 or, and Pa i n tOv al ( ) paints the oval.

/***************************** DrawRandomRect *********/
DrawRandomRect()
{

Re ct

my Re ct;

RandomRect( &myRect, gDrawWindow );
ForeColor( gFillColor );
PaintOval( &myRect );
RandomRect ( ) sets up the rectangle to be used in drawing the oval.
Each of the four sides of the rectangle is generated as a random number
between the right and left (or top and bottom, as appropriate) sides of the
input parameter, boundi ngWi ndO\'i.
The notation myStructPtr->myField refers to the field my Fi e 1d in the
st r u ct pointed to by my St r uct Pt r.
Every window data structure has a field named portRect that defines
the boundaryofthecontentregionofthewindow. Since boundi ngWi ndow
is a pointer to a window data structure, you use boundi ngWi ndow->
port Rec t to access this rectangle.

/******************************** RandomRect *********/
RandomRect( myRectPtr, boundingWindow
Rect
*myRectPtr;
WindowPtr
boundingWindow;
{

myRectPtr->left =Randomize( boundingWindow->portRect.right
- boundingWindow->portRect. left );
myRectPtr->right = Randomize( boundingWindow->portRect.right
- boundingWindow->portRect.left );
myRectPtr->top = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top );
myRectPtr->bottom = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top );
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Randomize ()takes an integer argument and returns a positive integer
greaterthan or equal to 0, and less than the argument. This is accomplished
via a call to the Rand om ( ) Toolbox utility, which returns a random number
in the range -32,767 through 32,767. You may find Randomize() helpful
in your own applications.

/******************************** Randomize *********/
Randomize( range )
int
range:
I

_J

long rawResult;
rawResult =Random();
if ( rawResult < 0 ) rawResult *= -1;
return( (rawResult *range) I 32768 );

Variants
Here are some variants of Mondrian. The first few change the shape of the
repeated figure in the window from ovals to some other shapes.
Your first new shape will be a rectangle. This one's easy: Just change the
Pa i nt 0 v a1 ( ) call to Pa i nt Rec t ( ) . When you run this, you should see
rectangles instead of ovals.
Your next new shape is the rounded rectangle. You'll need two new
parameters for Pa i n t Round Rec t ( ) : ova 1Wi d th and ova 1 He i ght. These
two parameters affect the curvature of the corners of the rectangle (I:l 79).
Try the following values for o v a1 Wi d th and ova 1 He i g ht:

#define OVAL_WIDTH
#define OVAL_HEIGHT

20
20

Now, change the DrawRandomRect ()routine, as follows:

/*************************** DrawRandomRect *******/
DrawRandomRect()
I

Rect

myRect:

RandomRect( &myRect, gDrawWindow );
ForeColor( gFillColor );
PaintRoundRect( &myRect, OVAL_WIDTH, OVAL_HEIGHT );
You should see something like Figure 3.32 if you run this variation.
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Figure 3.32 Mondrian with rounded rectangles.

Instead of filling the rectangles, try using FrameRoundRect ()to draw
just the outline of your rectangles:
/*************************** DrawRandomRect *********/

DrawRandomRect()
{

Rect

my Rect ;

RandomRect( &myRect, gDrawWindow ) ;
ForeColor( gFillColo r ) ;
FrameRoundRect ( &myRect , OVAL_W IDTH , OVAL_HEIGHT );
The framing function is more interesting if you change the state of your
pen: The default setting for your pen is a size of 1 pixel wide by 1 pixel tall,
and the pattern is black. Change it by modifying Wi nd ow I n i t ( ) as shown
in Figure 3.33.
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Figure 3.33 Mondrian with framed rounded rectangles.

/******************************** Wind owlnit *********/

Wi ndow In it ( )
{

gOrawWindow = GetNewWi ndow( BASE_RES_ID . NIL_POINTER ,
MOVE_TO_ FRONT );
ShowWindow( gDrawWindow ) ;
SetPort( gOrawWindow ) ;
PenSize( PEN_WIDTH , PEN_HEIGHT );
PenPat( gray ) ;
Here, you changed the pen pattern to gray. Don't forget to /Fd e f i n e
PEN_W I DTH and PEN_HEIGHT. We used valuesofl 0 and 2, respectively,for
Figure 3.33.
While you're at it, try using InvertRoundRe ctC) instead of
FrameRoundRect( ) . Inv ertRoundRect() will invert the pixels in its
rectangle. The arguments are handled in the same way (Figure 3.34).
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Figure 3.34 Mondrian with inverted rounded rectangles.

Next, try using FrameArc() in place of InvertRoundRect( ).
FrameArc() requires two new parameters. The first defines the arc's
starting angle, and the second defines the size of the arc. Both are expressed
in degrees (Figure 3.35). Change Dr awRandomRect() as follows:
/************************** DrawRandomRect

***~*****/

DrawRandomRect()
(

Rect

myRect :

RandomRect( &myRect , gDrawWindow ) :
ForeColor( gFillColor ) ;
FrameArc( &myRect , START_DEGREES , ARC DEGREES ) ;
Don't forget to ffdefi ne ST ART _DEGRE ES and ARC_DEGREES . Try u sing

values of O a nd 270 . Experiment with Pa in tArc() and I nve r tA r c()
also, if you wish.
The final Mondrian variation is more interesting with a color monitor.
Ifyou change the Fore Color ( ) arguments in Mai n ( ) , you can see colored
filled ovals (or whatever your program is currently producing). Modify your
Main Loop ( ) routine as follows:
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Figure 3.35 Figuring your arc.

/******************************** Mainloop *********/

Mainloop()
{

GetDateTime( &randSeed );
while ( ! Button() )
I

DrawRandomRect();
if ( gFillColor == redColor )
gFillColor
yellowColor;
else
gFillColor = redColor;

The following colors have already been defined for you: b 1 ack Co 1 or,
whiteColor, redColor,yellowColor,greenColor, blueColor, cyanCol or, and magenta Col or. These colors are part of Classic QuickDraw-the original, eight-color QuickDraw model that was part of the
original Macintosh. The Mac II supports a new version of QuickDraw called
Color QuickDraw, which supports millions of different colors. (We'll tackle
Color QuickDraw in our next volume.) The programs you write using the
eight colors of Classic QuickDraw will run on any Macintosh (even the
Macintosh II).
There are a million more possible variations to Mondran, but these
should get you familiarized with the richness of the QuickDraw environment. The next program demonstrates how to load QuickDraw picture resources and draw them in a window.

_J

ShowPICT
ShowPICT will take your favorite artwork (in the form of a PICT resource)
and display it in a window. You can create a PI CT resource by copying any
graphic to the Mac Clipboard, then pasting it into a PI CT resource with
ResEdit. We copied our artwork from the Scrapbook that comes with the
Macintosh System disks. If you're not familiar with the way that the
Scrapbook works, see your Macintosh user's manuals for more information.
ShowPICT is made up of five distinct steps:
•
•
•
•
•

Initialize the Toolbox.
Load a resource window, show it, and make it the current port.
Load a resource picture.
Center the picture, then draw it in the window.
Wait for the mouse button to be pressed.

Resources
Start by creating a new folder, called ShowPICT, in the s re folder. Next,
using ResEdit, create a new resource file called ShowP I CT Proj. Rs re in
the Sh ow PICT folder. Create a window as shown in Figure 3.36. Select Get
Info from the File menu and set the resource ID of your new WI ND to 4 0 0.
Next, create your PI CT resource. Close the WI ND list, so you get back to
the main ShowPICT Proj. Rs re window (Figure 3.37). Create a new
resource type by selecting New from the File menu. When prompted for a
resource type, select PICT. Pull down the S menu and select the Scrapbook.
Find a picture you like, pull down the Edit menu, and select Copy. Close the
Scrapbook, pull down ResEdit's Edit menu, and select Paste. The picture
should appear in the PI CT window. Select Get Info from the File menu and
set the resource ID of the PI CT to 4 0 0. Then quit ResEdit, and save your
changes to ShowP I CT Proj. Rs re.
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Next, go into THINK C and create a new project called S howP I CT Pr oj
inside the Sh ow PICT folder. Add MacTraps to your project. Then select New
from the File Menu and enter the following code:

#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

PicHandle
WindowPtr

400
OL
-lL
0

gThePicture:
gPictureWindow:

/******************************** main *********/

main ( )
I

Tool Box I nit():
Wi ndowlnit():
LoadPicture();
DrawMyPicture( gThePicture. gPictureWindow );
while ( !Button() ) ;

/*********************************** ToolBoxlnit */

Tool Boxlnit()
I

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent. REMOVE_ALL_EVENTS );
In i tWi ndows ( ) ;
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();

/******************************** Windowlnit *********/

Windowlnit()
I

gPictureWindow

GetNewWindow( BASE_RES_ID. NIL_POINTER.
MOVE_TO_FRONT );
ShowWindow( gPictureWindow );
SetPort( gPictureWindow );
=

!******************************** LoadPicture *********/

LoadPicture()
{

gThePicture

GetPicture( BASE_RES_ID );
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/******************************** DrawMyPicture *********/
DrawMyPicture( thePicture, pictureWindow
PicHandle
thePicture:
WindowPtr
pictureWindow;
{

Re ct

my Re ct;

myRect = pictureWindow->portRect;
CenterPict( thePicture, &myRect );
DrawPicture( thePicture, &myRect );
!******************************** CenterPict *********/
CenterPict( thePicture, myRectPtr
PicHandle
thePicture;
Rect
*myRectPtr;
{

Rect

windRect, pictureRect:

windRect = *myRectPtr:
pictureRect = (**( thePicture )).picFrame;
myRectPtr->top = (windRect.bottom - windRect.top CpictureRect.bottom - pictureRect.top))/ 2 +
wind Rect. top;
myRectPtr->bottom = myRectPtr->top +
CpictureRect.bottom - pictureRect.top);
myRectPtr->left = (windRect.right - windRect.left (pictureRect.right - pictureRect.left))/ 2 +
wi ndRect. 1eft;
myRectPtr->right = myRectPtr->left + (pictureRect.right pictureRect.left);

Running ShowPICT
After you've finished typing in the code, save the file as ShowP I CT. c and
add it to your project. Next, select Run from the Project menu. Ifeverything
went well, you should get something like Figure 3.38. Your PICT should
appear in your window. If it does not, check the resource ID of your PI CT.
Did your PICT make it into ShowPICT Proj. Rsrc? Check your WIND
resource and your code for typos.
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Walking through the ShowPICT Code
Take a look at your global variables. The global gThePi ctu re is a pointer
to apointer(also known as a handle) to a picture. gPi ctureWi ndow acts as
a pointer to the PI CT window.

#define
#define
#define
#define

BASE_RES_ ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

PicHandle
WindowPtr

400
OL
- lL
0

gThePicture ;
gPictureWindow;

Handles are pointers to pointers. For example, if you wanted to
declare a handle to an int, you'd do something like this:

int

**myHandle;

Handles are a necessary part of the Mac's memory management
scheme. They allow the Macintosh Memory Manager to relocate
blocks of memory as it needs to, without disturbing your program. If
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you depend on a pointer to an object, then, when the Mac moves the
object in memory, your pointer becomes invalid. If, however, you use
a handle (pointer to a pointer) to an object, then, when the Mac moves
the object, as long as it updates the pointer, your handle remains
valid.
We'll show you some ofthe basics ofusing handles, but we won't spend
a lot of time on them. You should read up on handles and the Mac
memory management scheme because eventually you'll want to write
code that takes advantage of handles.
In the case of gThe Pi ct ure, we declared a handle to a picture(pointer
to a pointer to a picture). We then set the handle to the value returned
by Get Picture ():

PicHandle pHandle:
pHandle = GetPicture( BASE_RES_ID ):
Like most of the Toolbox functions that return handles, Get Pi c tu re ( ) actually allocates the memory for the picture itself, as well as
the memory for the pointer to the picture. The great thing about
handles is that you hardly know they're there.
Ifyou'd like to know more about handles (and Mac memory management in general), read Chapter 3 ofVolume I ofInside Mac. As you get
into more advanced programming techniques, you'll want to have a
thorough grasp of this topic.

In ma i n ( ) , initialize the Toolbox and window as usual. Then load your
PI CT from the resource file and draw it in the window. Finally, wait for a
press on the mouse button to exit the program.

/******************************** main *********/

main()
{

Tool Box I nit():
Windowlnit();
LoadPicture();
DrawMyPicture( gThePicture. gPictureWindow );
while ( !Button() ) :
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The Toolbox initialization routine remains the same:
/*********************************** ToolBoxlnit */

ToolBoxlnit()

InitGraf( &thePort );
InitFonts():
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows():
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor():
The window initialization code is the same as Hello2. (Ifyou are cutting and
pasting, note that the variable name has changed to gPi ctureWi ndow.)
/******************************** Windowlnit *********/

Windowlnit()
{

gPictureWindow

GetNewWindow( BASE_RES_IO, NIL_POINTER,
MOVE_ TO_FRONT ) ;
ShowWindow( gPictureWindow );
SetPort( gPictureWindow );
=

The Lo ad Pi ct u re ( ) routine gets the handle for the PI CT resource that
you pasted into your resource file:
/******************************** LoadPicture *********/

LoadPicture()
{

gThePicture = GetPicture( BASE_RES_ID );
DrawMyPicture() sets up a Rect the size of pictureWindow (the
window passed in as a parameter). Then, it passes the Rect and the Pi ct u re
(anotherinputparameter)toCenterPi ct( ).Finally, DrawMyPi cture()
draws the Pi ct u re in the newly centered Rect.
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/******************************** DrawMyPicture *********/
DrawMyPicture( thePicture. pictureWindow
PicHandle
thePicture;
WindowPtr
pictureWindow;
{

Rect

myRect;

myRect = pictureWindow->portRect;
CenterPict( thePicture. &myRect );
DrawPicture( thePicture. &myRect );

Center Pi ct ( ) takes a Pi c Ha nd l e ( the Pi ct ure ) and a pointer to a
Rect (myRectPtr) as input parameters. thePicture is a handle to a
picture to be centered in the Rect pointed to by my Re ct Pt r. Center Pi ct()
constructs a new Rect the size of the Pi ct u re, centering it in the original
Rect.
Center Pi ct ( ) is used to center a picture in a window. The original Rect
is copied into the local variable wi nd Rec t. Then, the picture's frame Rect
is copied to the local variable pi ct ure Rec t. Finally, each field in the
original Rect is modified, based on the corresponding fields in wi ndRect
and pi ctureRect. For example, myRectptr->top is adjusted to become
the new top of the picture.
Center Pi ct ( ) is a good utility routine. You'll be seeing it again in other
chapters.
/******************************** CenterPict *********/
CenterPict( thePicture. myRectPtr
PicHandle
thePicture;
Rect
*myRectPtr;
{

Rect

windRect, pictureRect;

windRect = *myRectPtr;
pictureRect = (**( thePicture )).picFrame;
myRectPtr->top = (windRect.bottom - windRect.top (pictureRect.bottom - pictureRect.top))/ 2 +
windRect.top;
myRectPtr->bottom = myRectPtr->top +
(pictureRect.bottom - pictureRect.top);
myRectPtr->left = (windRect.right - windRect.left (pictureRect.right - pictureRect.left))/ 2
+ windRect.left;
myRectPtr->right = myRectPtr->left + (pictureRect.rightpictureRect. left);

_J

Variants
Try using different pictures, either from the Scrapbook or from MacPaint
or MacDraw files. With a little experimentation, you should be able to copy
and paste these files into your resource file. In Chapter 4, you'll see an
enhanced ShowP I CT program.

_J

Screen Saver: The Flying Line Program
The Flying Line is the last program in the QuickDraw chapter. Although
it does demonstrate the use of line drawing in QuickDraw, we included it
mostly because it's fun. The Flying Line draws a set of lines that move
across the screen with varying speeds, directions, and orientations. The
program can be used as a screen saver (we even show you how to hide the
menu bar).
The Flying Line program consists of four steps:
•
•
•
•

Initialize the Toolbox.
Set up the Flying Line window.
Initialize the Flying Line data structure, drawing it once.
Redraw the Flying Line inside a loop until a mouse click occurs.

Flying Line needs no resources. Go into THINK C and create a new project
called F1y i ng Li ne Pro j inside the F1y i ng Li ne folder. Select New from
the File menu to open a new window for the Flying Line source code:

#define
#define
#define
#define
#define
#define
#define
#define
#define

NUM_LINES
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS
NIL_STRING
NIL_TITLE
VISIBLE
NO_GO_AWAY
NIL_REF_CON

WindowPtr
Re ct
int
int
int
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50

OL
-ll

0
"\p"

NIL_STRING
TRUE
FALSE
NIL_POINTER

gLineWindow;
glines[ NUM_LINES ];
gDeltaTop=3, gDeltaBottom=3:
gDeltaleft=2. gDeltaRight=6:
gOldMBarHeight;
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/******************************** main *********/

main()
I

ToolBoxlnit();
Windowlnit();
Lineslnit();
Mainloop();

/*********************************** ToolBoxinit */

ToolBoxinit()
I

InitGraf{ &thePort );
InitFonts();
FlushEvents( everyEvent. REMOVE_ALL_EVENTS );
InitWindowsC);
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();

/******************************** Windowlnit *********/

Windowlnit()
Re ct
RgnHandle

totalRect. mBarRect;
mBarRgn;

gOldMBarHeight = MBarHeight;
MBarHeight = 0;
gLineWindow = NewWindow( NIL_POINTER. &CscreenBits.bounds).
NIL_TITLE. VISIBLE. plainDBox. MOVE_TO_FRONT. NO_GO_AWAY.
NIL_REF_CON );
SetRectC &mBarRect. screenBits.bounds.left, screenBits.bounds.top.
screenBits.bounds.right. screenBits.bounds.top+gOldMBarHeight);
mBarRgn = NewRgn();
RectRgn( mBarRgn. &mBarRect );
UnionRgn( gLineWindow->visRgn. mBarRgn. gLineWindow->visRgn );
DisposeRgn( mBarRgn ):
SetPort( gLineWindow );
FillRect( &CgLineWindow->portRect), black); I* Change black to
l tGray. *I
PenMode( patXor ); I*
<-and comment out this line */
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/******************************** Lineslnit *********/
Lineslnit()
{

int i ;
HideCursor();
GetDateTime( &randSeed );
RandomRect( &(glines[ 0 ]), glineWindow );
Drawline( 0 );
for ( i=l; i<NUM_LINES; i++
I

glines[ i J = gLines[ i-1 J:
Recalcline( i );
Drawline( i );

/******************************** Mainloop *********/
Mainloop()
I

int i :
while
I

! Button() )

Drawline( NUM_LINES - 1 );
for ( i=NUM_LINES-1; i>O; i- )
glines[ i J = glines[ i-1 J;
Recalcline( O );
Drawline( 0 );

}

MBarHeight = gOldMBarHeight;
/******************************** RandomRect *********/
RandomRect( myRectPtr, boundingWindow
Rect
*myRectPtr:
boundingWindow;
WindowPtr
I

myRectPtr->left =Randomize( boundingWindow->portRect.right
- boundingWindow->portRect.left );
myRectPtr->right = Randomize( boundingWindow->portRect.right
- boundingWindow->portRect.left );
myRectPtr->top = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top );
myRectPtr->bottom = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top );
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/******************************** Randomize *********/
Randomize( range )
int
range;
{

long

rawResult;

rawResult =Random();
if ( rawResult < 0 ) rawResult *= -1:
return( (rawResult *range) I 32768 );
/******************************** Recalcline *********/
Recalcline( i
int i ;
{

glines[ i ].top+= gDeltaTop:
if
( glines[ i ].top< glineWindow->portRect.top ) I I
( glines[ i ].top > gLineWindow->portRect.bottom ) )
gDeltaTop *= -1;
glines[ i ].top+= 2*gDeltaTop;
glines[ i ].bottom+= gDeltaBottom:
if ( ( glines[ i ].bottom< gLineWindow->portRect.top ) I I
( glines[ i ].bottom> glineWindow->portRect.bottom ) )
gDeltaBottom *= -1;
glines[ i ].bottom+= 2*gDeltaBottom;
glines[ i ].left+= gDeltaleft;
if ( ( glines[ i ].left< gLineWindow->portRect.left ) I I
( glines[ i ].left> glineWindow->portRect.right
gDeltaleft *= -1;
glines[ i ].left+= 2*g0eltaleft:
glines[ i ].right+= gDeltaRight;
if ( ( glines[ i ].right< glineWindow->portRect.left ) 11
( glines[ i ].right > gLineWindow->portRect.right ) )
gDeltaRight *= -1:
glines[ i ].right+= 2*gDeltaRight:

/******************************** Drawline *********/
Drawl i ne( i )
int
i;
{

MoveTo( glines[
LineTo( glines[

J. left, glines[ i ].top);
].right, glines[ i ].bottom );
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Running Flying Line
After you've finished typing in the code, save it as Flying Line. c. Add
MacTraps to the project, and select Run from the Project menu. If everything went well, you should see something like Figure 3.39. The window
will be completely black except for the flying line; the menu bar should be
hidden. Now, let's take a look at the code.

_J

Walking through the Flying Line Code
Most of Flying Line should be familiar to you. The biggest change is in
Wi nd ow I n i t ( ) , where you create a window from scratch and hide the
menu bar. We won't go into exhaustive detail on the Flying Line algorithm,
because it has little to do with the Toolbox. This one's just for fun!
NU M_ LI NE S defines the number oflines in the Flying Line. g Del ta Bott om,
gDel ta Top, gDel ta Left, and gDel taRi ght are all tuning parameters.
Play around with them until you get just the right Flying Line.
Draw the Flying Line in the g Li neW i nd ow. The array g Li n es holds all
of the individual lines in the Flying Line. Finally, gOl dMBa rHei ght saves
the menu bar height when you start, so you can restore it when the
application quits.

Figure 3.39 Running Flying Line.
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#define
#define
#define
#define
#define
#define
#def i ne
#define
#define

NUM_LINES
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS
NIL_STRING
NIL_TITLE
VI SIB LE
NO_GO_AWAY
NIL_REF_CON

WindowPtr
Re ct
int
int
int

50

OL

-ll
0
"\p ..

NIL_STRING
TRUE
FALSE
NIL_POINTER

glineWindow:
glines[ NUM_LINES ];
gDeltaTop=3, gDeltaBottom=3:
gDeltaleft=2. gDeltaRight=6:
gOldMBarHeight;

ma i n ( ) is unchanged from the earlier programs, except that Li nes In i t ( )
is called before the Main Loop ( ) .

/******************************** main *********/

main ( )
{

Tool Boxlnit():
Wi ndowlnit();
Lineslnit();
Mainloop();
The Toolbox initialization for Flying Line is the same as for the previous
program:
/*********************************** ToolBoxlnit */

ToolBoxlnit()
{

InitGraf( &thePort );
I nit Fonts():
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ):
InitWindows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
Ini tCursor():
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The window initialization code for Flying Line is unusual because the
window itself is unusual. Normally, Mac programs display a menu bar.
Flying Line, however, will not. Flying Line hides the menu bar (by making
it 0 pixels tall) and creates a window that covers the entire screen.
The call to NewWi ndow() is an alternative to GetNewWi ndow( ).
GetNewWi ndow() creates a window using the information specified in a
WI ND resource. NewW i ndow ( ) also creates a window, but gets the window
specifications from its parameter list:

FUNCTION NewWindow( wStorage : Ptr; boundsRect : Rect;
title : Str255; visible : BOOLEAN; procID : INTEGER;
behind : WindowPtr; goAwayFlag : BOOLEAN;
refCon : LONG I NT ) : Wi ndowPt r;
Specify the size of the window as a Rect, using the QuickDraw global
screenBi ts. bounds to create a window the size of the current screen.
/********************************

Wi~dowinit

*********/

Wi ndowl nit ()
{

Re ct
RgnHandle

totalRect. mBarRect;
mBarRgn;

gOldMBarHeight = MBarHeight;
MBarHeight = O;
gLineWindow = NewWindow( NIL_POINTER.
&CscreenBits.bounds).
NIL_TITLE, VISIBLE. plainDBox. MOVE_TO_FRONT,
NO_GO_AWAY, NIL_REF_CON );
The next bit of code is tricky. Call SetRect() to create a rectangle
surrounding the normal menu bar.Use this Rect to create a new region, and
then add this region to the visible region of your window. As a result of this
hocus-pocus, your window can overlap the menu bar, taking up the entire
screen. Ifthis makes you uncomfortable, don't panic. The call to NewW i nd ow ( )
is normally all you'll need in your applications. This extra code is just here
to allow your window to obscure the menu bar.

SetRect( &mBarRect, screenBits.bounds.left.
screenBits.bounds.top.
screenBits.bounds.right,
screenBits.bounds.top+gOldMBarHeight );
mBarRgn = NewRgn();
RectRgn( mBarRgn, &mBarRect );
UnionRgn( gLineWindow->visRgn, mBarRgn.gLineWindow->
visRgn );
DisposeRgn( mBarRgn );
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Next, call Se tp or t ( ) so all your drawing will occur in l i ne Wi nd ow ( ) .
Then, fill the window with the black pattern. Set the PenMode () to
pat Xor. Try some other pen modes, too. We suggest changing the second
Fi 11 Rec t ( ) parameter to 1 t Gray, and commenting out the call to
PenMode <).

SetPort( gLineWindow );
FillRect( &CglineWindow->portRect). black ); /* Try this:
Change black to ltGray and */
PenMode( patXor );
/*
<-comment out this line */
I

Don't be fooled by imitations. The second parameter to Fi 11 Rec t ( )
is a pattern, not a color. These are the fill patterns you normally
associate with the paint bucket in MacPaint, not the eight colors of
Classic QuickDraw. You can experiment with colors by using a call to
PaintRectC ).
Li nes I ni t ( ) starts off by hiding the cursor. Next, seed the random
number generator with the current date (a la Mondrian). Finally, generate
the first line of the Flying Line, draw it, then generate the rest of the lines
and draw them.

/******************************** Lineslnit *********/

Lineslnit()
I

int i ;
HideCursor<);
GetDateTime( &randSeed );
RandomRect( &Cglines[ 0 ]). gLineWindow );
Drawline( 0 );
for ( i=l; i<NUM_LINES; i++
I

glines[ i J = glines[ i-1 J;
Recalcline( i );
Drawline( i );

Main Loop () sets up a loop that falls through when the mouse button is
pressed. At the end of the loop, the menu bar height is restored. Ifyou don't
do this, you won't be able to pick from the menu bar when you exit the
program. (Ifthis does happen,just reboot the machine to reset MB a r He i ght • )
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Inside the loop, erase and redraw each line in the Flying Line. Erase lines
by redrawing them in exactly the same position. Since the pen mode is set
to pat Xor, this has the effect of erasing the line. Thus, the first call to
Draw Li ne ( ) in Ma i n Loop ( ) erases the last line in the g Li nes array. This
simulates the line moving across the screen.

/******************************** Mainloop *********/
Mainloop()
{

inti;
while

!

Button() )

{

Drawline( NUM_LINES - 1 ):
for ( i=NUM_LINES-1: i>O; i- )
glines[ i J = glines[ i-1 J:
Recalcline( O >:
Drawline( O >:
}

MBarHeight = gOldMBarHeight:
You've seen this routine in Mondrian:

!******************************** RandomRect *********/
RandomRect( myRectPtr. boundingWindow )
Rect
*myRectPtr:
WindowPtr
boundingWindow;
{

myRectPtr->left =Randomize( boundingWindow->portRect.right
- boundingWindow->portRect.left ):
myRectPtr->right = Randomize< boundingWindow->portRect.right
- boundingWindow->portRect.left >:
myRectPtr->top = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top ):
myRect Ptr->bottom = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top ):
You've also seen Randomize() routine in Mondrian:

/******************************** Randomize *********/
Randomize( range )
int
range:
{

1ong

rawResul t:

rawResult =Random();
if ( rawResult < 0 ) rawResult *= -1:
return( CrawResult * range) I 32768 ):
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The Re Cal c ( ) routine determines where to draw the next line:

/******************************** Recalcline *********/
Recalcline( i )
int i ;
{

glines[ i ].top+= gDeltaTop;
if ( ( glines[ i ].top< gLineWindow->portRect.top ) I I
( glines[ i ].top > glineWindow->portRect.bottom ))
gDeltaTop *= -1;
g Li nes [ i J . top += 2*gDe lt aTop ;
glines[ i ].bottom+= gDeltaBottom;
if ( ( glines[ i ].bottom< gLineWindow-'>portRect.top) II
( glines[ i ].bottom> gLineWindow->portRect.bottom ) )
gDeltaBottom *= -1:
glines[ i ].bottom+= 2*gDeltaBottom;
glines[ i ].left+= gDeltaleft:
if ( ( glines[ i ].left< glineWindow->portRect. left) I I
( glines[ i ].left> glineWindow->portRect.right ) )
gDeltaLeft *= -1:
g Li ne s [ i J . 1 e ft += 2*gDe lt a Left ;
glines[ i ].right+= gDeltaRight:
if ( ( glines[ i ].right< glineWindow->portRect.left ) I I
( glines[ i ].right > gLineWindow->portRect.right ) )
gDeltaRight *= -1:
glines[ i ].right+= 2*gDeltaRight;

Drawl i ne() draws line number i, using the coordinates stored in
g L; n es [ i J. Since the pen mode is set to pat Xor, this may actually have

the effect of erasing the line.

/******************************** Drawline *********/
Drawline( i )
int
i ;
{

MoveTo( glines[
LineTo( glines[

].left, glines[ i ].top );
].right, glines[ i ].bottom );

ONE OF THE basic differences between programming on the Mac and
programming on other machines lies in the use of events. Events are
descriptions of actions taken by the user of your application. For example,
when a key is pressed on the keyboard, a piece of the Mac operating system
(known as the Event Manager) captures some important information
about the keystroke in an EventRecord. As more keys are pressed, more
EventRecords are created and joined to the first, forming the event
queue (Figure 4.1).
The event queue is a FIFO (First In, First Out) queue: The event at
the front of the queue is the oldest event in the queue. As you can see
in Figure 4.1, different types of events live together in the same event
queue. All events, no matter what their type, pass under the watchful
eye of the Event Manager.
The Event Manager gets events from many different sources,
queues them up, and passes them to your application, one at a time.

Your application can get at this information by retrieving
EventRecords from the event queue, one at a time. If the retrieved
Event Record describes a keystroke, your application can jump to some
code that handles keystrokes. If it describes the pressing of the mouse
button, it can jump to some code that deals with the mouse button. Lefs
look at the mouse button case.
When the mouse button is pressed, what does it mean to the application?
Maybe the user wants to select from a menu. Maybe the user is clicking on
a window to bring it to the front, or has clicked in a scroll bar to move up
or down in the document. One way to tell what the user is trying to
accomplish is to compare the location of the mouse when its button was
pressed with the locations of the menu bar, the windows on the screen,
scroll bars, and so on.
If the user clicked in the menu bar, you can jump to some code that
handles menu selection. If the user clicked on a scroll bar, you can jump to
the scroll bar handling routine.

nullEvent

--..

.....
jmouseDowr

mouse Up

Figure 4.1 The Event queue.
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Event Types
The Event Manager handles 15 distinct events (V:249).
• nullEvent : This event is queued when the Event Manager has no other
events to report.
• mouseDown: mouseDown events are queued whenever the mouse
button is pressed. Note that the button doesn't have to be released for the
event to qualify as a mouse Down.
• mouseUp : mouse Ups are queued whenever the mouse button is
released.
• keyDown: key Down eventsarequeuedeverytimeakeyispressed.Like
mouse Downs, keyDowns are queued even if the key has not yet been
released.
• keyUp: key Ups are queued whenever a key is released.
• autoKey: autoKey events are queued when a key is held down for a
certain length of time (beyond the auto Key threshhold). Usually, an
autoKey event is treatedjust like a keyDown.

The autoKey threshholdrepresentsthetimefrom the first keyDown
until the auto Key event is generated. The default value is 16 ticks
(sixtieths of a second). The autoKey rate is the interval between
auto Keys. The default auto Key rate is 4ticks. The user can change
both of these from the control panel desk accessory. Their values are
stored in the system global variables Key Thresh and Key Rep Thresh.

• update Ev t: update Ev ts are queued whenever a window needs redrawing. They are always associated with a specific window. This usually
happens when a window is partially obscured and the obstruction is
moved, revealing more of the window, as shown in Figure 4.2.
• di s k Ev't: d i s k Ev ts are queued whenever a disk is inserted into a disk
drive, or when an action is taken that requires that a volume be mounted.
Don't worry too much about these right now. We'll tell you how to deal
with disks and files in Chapter 7.
• activateEvt: activateEvts are also associated with windows. An
act i vat e Ev t is queued whenever a window is activated (made to come
to the front) or deactivated (replaced as the frontmost window by another
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•
•

•

•

window). As you might guess, act i vat e Ev ts always occur in pairs (Figures 4.3 and 4.4).
networkEvt: networkEvts are no longer used.
dri verEvt: dri verEvts are used by device drivers to signal special
conditions. They (and device drivers in general) are beyond the scope of
this book.
appl Evt, app2Evt, app3Evt: These events are defined by your application and can be used for just about anything. With the advent of
MultiFinder, the use of application-defined events is discouraged.
app4Evt (Suspend/Resume/mouseMoved events): The app4Evt has
been reserved by Apple for use with MultiFinder. MultiFinder will post
an a p p4 Ev t just before it moves your application into the background
(suspends it) and just after it brings your application back to the
foreground (resumes it). You can also set your application up to receive
mouseMoved events. mouseMoved events are posted when the user
moves the cursor outside a predefined region (like a text-editing window)
or back in again. When your application receives a mouseMoved event,
it can change the cursor to one appropriate to that region. We'll discuss
a pp 4 Ev ts in more detail later in the chapter.

The next section discusses a new Macintosh application model based on
event handling. After that, we'll present Event Tutor, our first eventbased application.

Back Window

Back Window
.

Q)

Figure 4.2 FrontWindow is moved down and to the right, generating an
updateEvt for BackWindow.
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Front Window

Figure 4.3 BackWindow is selected, an act i va t e Ev t is generated to deactivate
FrontWindow, and an act i vateEvt is generated to activate BackWindow.

Figure 4.4 BackWindow is selected, an act i vat e Ev t is generated to deactivate
FrontWindow, an acti vateEvt is generated to activate BackWindow, and an
update Evt is generated to redraw BackWindow.

_J

The Structure of a Mac Program:
New and Improved
In Chapter 3, we presented a very primitive Macintosh application model
that looked like this:
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main ( )
{

ToolBoxlnit();
Otherlni ts ();
DoPrimeDirective();
while ( ! Button()
First, we initialized the Toolbox. Then, we took care of any programspecific initialization like loading windows or pictures from the resource
file. Next, we performed our "prime directive." In the case ofShowPict, our
prime directive was drawing a PI CT in the main application. Finally, we
waited for the mouse button to be pressed.
There is one basic problem with this model: It does not reflect reality.
Macintosh applications do not exit when the mouse button is pressed.
Clearly, we need a better model.
Our new model does things a little differently:

Event Record
Boolean

gTheEvent;
gDone:

ma i n ( )
{

ToolBoxlnit();
Other I nits();
Mainloop();
Mainloop()
{

gDone = FALSE;
while ( gDone ==FALSE
{

HandleEvent();

HandleEvent()
{

if ( waitNextEventlslnstalled )
WaitNextEvent( everyEvent, &gTheEvent, sleepValue,
mouseRgn );
else
{

SystemTask();
GetNextEvent( everyEvent, &gTheEvent );
}

switch( gTheEvent.what
{

case mouseDown:

if( .... ) gDone

TRUE;
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This model starts off the same way as the basic model, with calls to our
initialization routines. The difference lies in our call of Main Loop ( ) .
Main Loop ( ) contains the main event loop. The main event loop is part
ofthe basic structure ofany Mac program. Each time through the loop, your
program retrieves an event from the event queue, and processes the event.

As we'll explain in the next section, events are retrieved in one of two
ways. If the Toolbox routine Wai t Next Event ( ) is available (it isn't
on older systems), it gets called. If Wai t Next Event ( ) isn't available,
the older Toolbox routine, Get Next Event ( ) , is used.
Eventually, some event will cause Handl eEvent() to set gDone to
TRUE, and the program will end. This might be the result ofa mouse Down
in the menu bar (selecting Quit from the File menu) or a key Down (typing
the key sequence 88 Q). You can design your ending conditions any way you
like.
We should warn you that Apple has a little-known squad ofmercenaries who seek out and eradicate applications that don't meet the user
interface guidelines. Beware!

_J

Retrieving Events from the Event Queue
In the early days of Mac programming, the Toolbox routine Get Next Event ( )
was used to retrieve events from the event queue. GetNextEvent ()
worked just fine until MultiFinder was introduced. MultiFinder is a set of
operating system functions that extend the capabilities of the Macintosh.
Most notably, MultiFinder allows the Macintosh to run several applications at the same time.
Figure 4.5 shows MultiFinder in action. Notice that only one application
at a time can be "in front." Notice also that the Finder is one of the
applications under MultiFinder. To bring an application to the front, you
click on one of its windows.
One of the nicest features ofMultiFinder is its ability to run applications
in the background. Figure 4.5 shows the alarm clock desk accessory
running in the background. Even though the alarm clock window is not the
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Figure 4.5 MultiFinder in action.

frontmost window, the time is updated because the alarm clock is running
in the background.
GetNextEven t () was written with the Finder in mind. WhenMultiFinder was introduced, Apple added a new routine to the Toolbox to handle
things like background processing more efficiently. The new routine is
called WaitN extEve nt ( ).
As you'll see when you get to the EventTutor application, you should
always check to see if Wai tNextEvent () is installed before you call it. If
it isn't installed, call GetNextEvent ( )instead.

You may have noticed a call to the Toolbox routine SystemTask()
just before the call to GetN extE vent () in our new application model.
SystemTas k () gives the Mac operating system a slice of time to do
things like update desk accessories (like the alarm clock), process
AppleTalk messages, and so on. Wa i t Next Event ( ) has this funct ionality built right in, so an accompanying cal] to SystemTask()
isn't necessary.

111

The Event Mechanism

Calling GetNextEvent() and WaitNextEvent()
The first parameter to both Get Next Event ( ) and Wa i t Next Event ( ) is
an event mask, used to limit the types of events your program will handle.
Figure 4.6 contains a list of predefined event mask constants. If your
program needs only mouseDowns and key Downs, for example, you might
use the following call:

EventRecord
gTheEvent;
GetNextEvent( CmDownMask I keyDownMask). &gTheEvent )
In this case, GetNextEvent() will return only mouseOown, key Down,
or nu l l Event information. nu 11 Even ts are never masked out. To handle
all possible events, pass the predefined constant eve r y Event as the
event Mask parameter. Inside Mac recommends that you use every Event
as your event mask in all your applications unless there's a specific reason
not to.
Thesecondparametertoboth GetNextEvent ()and Wai tNextEvent ()
is gTheEvent, declared as an Event Record. Here's the type definition of
an EventRecord:

typedef struct EventRecord
{

int
long
long
Point
int
EventRecord;

what;
message;
when;
where;
modifiers;

#define mDownMask Ox2
#define mUpMask
Ox4
#define keyDownMask Ox8
#define keyUpMask Ox10
#define autoKeyMask Ox20
#define updateMask Ox40
#define diskMask Ox80
#define activMask Ox100
#define networkMask Ox400
#define driverMask Ox800
#define app1 Mask Ox1000
#define app2Mask Ox2000
#define app3Mask Ox4000
#define app4Mask Ox8000
#define everyEvent OxFFFF

Figure 4.6 Event masks
predefined in THINK C.

112

Macintosh Programming Primer

Here's a description of each of the fields:
• what:Whattypeofeventjustoccurred?Wasita null Event, key Down,
mouse Down, or updateEvt?
• message: This part of the Event Record is specific to the event. For
keyDown events, the message field contains information about the
actual key that was pressed (the key code) and the character that key
represents (the character code). For acti vateEvts and updateEvts,
the message field contains a pointer to the affected window.
• when: When did the event occur? The Event Manager tells us, in ticks
since the system was last started up (or booted).
• where: Where was the mouse when the event occurred? This information is specified in global coordinates (see Chapter 3).
• modifiers: This part of the Event Record describes the state of the
mouse button and the modifier keys (the shift, option, control, command,
and caps lock keys) when the event occurred.
The third parameter to WaitNextEvent() is the sleep parameter.
sleep is a long integer specifying the amount of time (in clock ticks) your
application is willing to not perform any background processing while
waiting for an event. By passing a sleep value of OL, you tell
Wa i t Next Event ( ) to regain control of the processor as soon as possible.
The fourth parameter to Wa itNextEvent() is the mouseRgn parameter, used to simplify cursor tracking. If your application requires different
cursors, depending on which part of the screen the cursor is in, the
mouse Rg n parameter is essential. With it, you can specify the screen region
appropriate to the current cursor. Whenever the mouse is outside that
region, the Event Manager queues up a mouseMoved event. When your
program receives the mouseMoved event, the region is changed to reflect
the new mouse position and is passed as a parameter to the next
Wa it Next Event ( ) call.
Calling Wai tNextEvent C) with asleep value of OL and a mouseRgn
of OLisexactlyequivalenttocallingSystemTask() andGetNextEvent().
The programs presented throughout the rest of the book will do just that.
The Programmer's Guide to MultiFinder includes a program that uses the
s l ee p and mouse Rg n parameters ofW a i t Next Event ( ) . The program was
written by Apple's Macintosh Technical Support Group. The Programmer's
Guide to MultiFinder, published by Apple, is essential reading for writing
truly MultiFinder-friendly applications.

Handling Events
Onceyou'veretrievedaneventviaGetNextEvent () orWa i tNextEvent ( ),
your next step is to process it. If the event is a mouse Down event, figure out
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where the mouse was clicked. If the mouse was clicked in a window's drag
region, as shown in Figure 4. 7, you can call a Toolbox routine that handles
window dragging. If the event is an update Ev t, you might want to redraw
the window pointed to by the Event. message.
If this sounds vague, don't worry. The concept of events may be unfamiliar to you, but it will be easier to understand once you see it in operation.
This chapter's program, EventTutor, will show you how all types of events
are handled.

_J

EventTutor: The Return of ShowPICT
Back in Chapter 3, we wrote a program called ShowPICT, which works like
this:
• It initializes the Toolbox.
• It loads a resource window, shows it, and makes it the current port.
• It loads a resource picture.
• It centers the picture, then draws it in the window.
• It waits for the mouse button to be pressed.

Our new program, EventTutor, adds a main event loop to this model.
EventTutor also adds a new window, gEventWi ndow. gEventWi ndow
keeps a scrolling list of events, updated as the events occur. You can also
drag both windows around the screen, as well as zoom and grow the picture
window. EventTutor works like this:
• It initializes the Toolbox.
• It loads the picture and event windows from the resource file, shows
them, and makes gEventWi ndow the current port.

Figure 4. 7 Arrow cursor in
window's drag region.
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• It loads a picture from the resource file.
• Wh i 1e ( gdone == FALSE ) , EventTutor handles events.
• Aseventsoccur,itdisplaystheirnamesingEventWi ndow, thencallsthe
appropriate routines to process them.

Setting Up the EventTutor Project
Start by creating a new project folder, called Event Tutor. Use ResEdit to
create a new file inside this folder called Event Tutor Pro j . Rs r c.

Resources
Create three new resources. The first two are WI NDs with resource IDs 4 00
and 401. Figure 4.8 shows the specifications for these WI NDs.
The third resource is a PI CT. In our example, we use the champagne
picture from the standard Scrapbook, but feel free to use any PI CT you'd
like. Make sure you change the resource ID to 4 0 0.
Next, start up THINK C. When prompted, create a new project inside the
EventTutor folder. Call it EventTutor Proj. Select New from the File
menu to create a new source code file. Type the code listing in and save the
file inside the EventTutor folder as EventTutor. c. Select Add from the
Source menu to add Event Tutor. c to the project. Finally, add MacTraps
to your project. The Project window should now look like Figure 4.9.

BOD WIND ID= 400 from Euentlutor Pro
Window title:
[ gPlctWindow
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Figure 4.8 EventTutor WIND specifications.
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Figure 4.9 EventTutor Project.

Here's the source code for EventTutor.c:

#define
#define
#define
#define

BASE_RES_ID
NIL_POIN TE R
MOVE TO FRONT
REMOVE_ALL_EVENTS

400
OL
-lL
0

#define LEAVE_WHERE_JT_ IS FALSE
#define NORMAL_UPOATE S
TRUE
#de fi ne
#define
#define
#define
#define
#define
#define

SLEEP
OL
NIL_MOUS E_RE GION OL
WNE_TRAP_NUM
Ox60
UNIMPL_TRAP_NUM
Ox9F
SUSPEND_RESUME_BITOxOOOl
ACTIVATING
1
RESUMING
1

#define TEXT_FONT_SIZE

12

#define
#define
#define
#define

DRAG_ THRESHOLD
MIN_WINDOW_HEIGHT
MIN_WI NOOW_WIOTH
SCROLL_BAR_P IXELS

30
50
50
16

#define
1/defi ne
#define
#define

ROWHEIGHT
LEFTMARGIN
STARTROW
HOR IZONTAL_OFFSET

15
10
0
0
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PicHandle
WindowPtr
Boolean
EventRecord
int
Re ct

gPictureHandle:
gPictWindow, gEventWindow:
gDone, gWNEimplemented;
gTheEvent;
gCurRow, gMaxRow:
gDragRect, gSizeRect;

/******************************** main *********/

main()
{

ToolBoxlnit();
Window In it ();
LoadPicture():
SetUpDragRect();
SetUpSizeRect();
Mainloop();
/*********************************** ToolBoxlnit */

Tool Boxlnit()
{

InitGraf( &thePort ):
Ini tFonts ():
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
In itWi ndows ( ) ;
InitMenus();
TEinit();
InitDialogs( NIL_POINTER ):
InitCursor();
/******************************** Windowlnit *********/

Wi ndowl nit ()
{

gPictWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER, MOVE_TO_FRONT):
gEventWindow = GetNewWindow( BASE_RES_ID+l, NIL_POINTER,
MOVE_ TO_FRONT ) ;
SetPort( gEventWindow );
SetupEventWindow();
ShowWindow( gEventWindow );
ShowWindow( gPictWindow );
SelectWindowC gEventWindow );
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/******************************** SetupEventWindow *********/

SetupEventWindow()
I

Rect

eventRect;

eventRect = gEventWindow->portRect;
gMaxRow = eventRect.bottom - eventRect.top - ROWHEIGHT;
gCurRow = STARTROW;
TextFont( monaco );
TextSize( TEXT_FONT_SIZE );
/******************************** LoadPicture *********/

LoadPicture()
I

gPictureHandle

=

GetPicture( BASE_RES_ID );

/******************************** SetUpDragRect *********/

SetUpDragRect()
{

gDragRect = screenBits.bounds;
gDragRect. left+= DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD;
gDragRect.bottom -= DRAG_THRESHOLD;
/******************************** SetUpSizeRect *********/

SetUpSizeRect()
{

gSizeRect.top = MIN_WINDOW_HEIGHT;
gSizeRect.left = MIN_WINDOW_WIDTH;
gSizeRect.bottom = screenBits.bounds.bottom - screenBits.bounds.top;
gSizeRect.right = screenBits.bounds.right - screenBits.bounds.left;
/******************************** Mainloop *********/

Mainloop()
I

gDone = FALSE;
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) );
while ( gDone == FALSE )
I

HandleEvent();
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/************************************* HandleEvent

*/

HandleEvent()
l

if ( gWNEimplemented
WaitNextEvent( everyEvent, &gTheEvent, SLEEP,
NIL_MOUSE_REGION );
else
l

SystemTask();
GetNextEvent( everyEvent, &gTheEvent );

switch ( gTheEvent.what )
l

case nullEvent:
/*DrawEventString( "\pnullEvent" );*/
I*
Uncomment the previous line for a burst of
flavor! */
break:
case mouseDown:
DrawEventString( "\pmouseDown" );
HandleMouseDown();
break;
case mouseUp:
DrawEventString( "\pmouseUp" );
break;
case keyDown:
DrawEventStringC "\pkeyOown" );
break;
case keyUp:
DrawEventString( "\pkeyUp" );
break;
case autoKey:
DrawEventString( "\pautoKey" );
break;
case updateEvt:
if ( (WindowPtr)gTheEvent.message == gPictWindow )
{

else

DrawEventString( "\pupdateEvt: gPictWindow" );
BeginUpdate( gTheEvent.message );
DrawMyPicture( gTheEvent.message,
gPictureHandle );
EndUpdate< gTheEvent.message );
DrawEventString( "\pupdateEvt: gEventWindow" );
BeginUpdate( gTheEvent.message );
I*

*
We won't handle updates to gEventWindow.
*but we still need to empty the gEventWindow
* Update Region so the Window Manager will stop
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* queueing UpdateEvts.
*
We do this with calls to
BeginUpdate()
*and EndUpdate().
*/

EndUpdate( gTheEvent.message ):

I

break:
case diskEvt:
DrawEventString( "\pdiskEvt" ):
break:
case activateEvt:
if ( CWindowPtr)gTheEvent.message == gPictWindow )
{

DrawGrowlcon( gTheEvent.message >:
if ( ( gTheEvent.modifiers & activeFlag ) ==
ACTIVATING )
{

DrawEventString(
"\pactivateEvt: activating gPictWindow" ):
}

else

DrawEventString(
"\pactivateEvt: deactivating gPictWindow" >:

else
if ( ( gTheEvent.modifiers & activeFlag )
ACTIVATING )

DrawEventString(
"\pactivateEvt: activating gEventWindow" ):

else

DrawEventString(
"\pactivateEvt: deactivatinggEventWindow"):

}

case
case
case
case
case

break:
networkEvt:
DrawEventString(
break;
driverEvt:
DrawEventString(
break:
applEvt:
DrawEventString(
break;
app2Evt:
DrawEventString(
break;
app3Evt:
DrawEventString(
break:

"\pnetworkEvt" );
"\pdriverEvt" );
"\papplEvt" );
"\papp2Evt" ):
"\papp3Evt" );

120

Macintosh Programming Primer

case app4Evt:
if ( (gTheEvent.message & SUSPEND_RESUME_BIT)
RESUMING )
DrawEventString( "\pResume event" );
else
DrawEventString( "\pSuspend event" );
break;

/**********************************

DrawEventString

*******/

DrawEventString( s )
Str255s;
{

if

gCurRow > gMaxRow

{

ScrollWindow();
}

else
{

gCurRow

+=

ROWHEIGHT;

}

MoveToC LEFTMARGIN, gCurRow );
Drawstring( s );
/**********************************

ScrollWindow *******/

ScrollWindow()
{

RgnHandle

tempRgn;

tempRgn = NewRgn{);
ScrollRect( &gEventWindow->portRect, HORIZONTAL_OFFSET,
-ROWHEIGHT, tempRgn );
DisposeRgn( tempRgn );
/************************************* HandleMouseDown */

HandleMouseDown()
WindowPtr
short int
long
Graf Ptr

whichWindow:
thePart;
windSize:
oldPort;

thePart
FindWindow( gTheEvent.where, &whichWindow );
switch ( thePart )
{

case inSysWindow
SystemClickC &gTheEvent. whichWindow );
break:
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case i nDrag :
DragWindowC whichWindow. gTheEvent.where. &gDragRect >:
break;
case inContent:
SelectWindow( whichWindow >:
break:
case inGrow:
windSize = GrowWindow( whichWindow.
gTheEvent.where.&gSizeRect >:
if windSize != 0 )
(

GetPort( &oldPort >:
SetPort( whichWindow );
EraseRect( &whichWindow->portRect );
SizeWindow( whichWindow. LoWordC windSize >.
HiWord( windSize ). NORMAL_UPDATES ):
InvalRect( &whichWindow->portRect );
SetPortC oldPort >:
}

break;
case inGoAway :
gDone = TRUE;
break;
case inZoomln:
case inZoomOut:
if ( TrackBoxC whichWindow. gTheEvent.where. thePart ) )
(

GetPort( &oldPort >:
SetPort( whichWindow );
EraseRectC &whichWindow->portRect >:
ZoomWindowC whichWindow, thePart.
LEAVE_WHERE_IT_IS );
InvalRect( &whichWindow->portRect >:
SetPortC oldPort >:
}

break;

/******************************** DrawMyPicture *********/

DrawMyPicture( drawingWindow. thePicture )
WindowPtr
drawingWindow;
PicHandle
thePicture:
(

Rec t d raw i ngC1i pRec t , my Rec t :
GrafPtr
oldPort:
RgnHandle
tempRgn:
GetPort( &oldPort >:
SetPortC drawingWindow );
tempRgn = NewRgn();
GetClipC tempRgn >:
EraseRect( &drawingWindow->portRect );
DrawGrowlcon( drawingWindow );
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drawingClipRect = drawingWindow->portRect;
drawingClipRect.right -= SCROLL_BAR_PIXELS;
drawingClipRect.bottom -= SCROLL_BAR_PIXELS;
myRect = drawingWindow->portRect;
CenterPict( thePicture, &myRect );
ClipRect( &drawingClipRect );
DrawPicture( thePicture, &myRect );
SetClip( tempRgn );
DisposeRgn( tempRgn );
SetPort( oldPort );
/******************************** CenterPict *********/
CenterPict( thePicture, myRectPtr
PicHandle
thePicture;
Rect
*myRectPtr;
I

Rect

windRect, pictureRect;

windRect = *myRectPtr;
pictureRect = (**( thePicture )).picFrame;
myRectPtr->top = CwindRect.bottom - windRect.top CpictureRect.bottom pictureRect.top)) I 2 + windRect.top;
myRectPtr->bottom = myRectPtr->top + (pictureRect.bottom pictureRect.top);
myRectPtr->left = (windRect.right - windRect.left (pictureRect.right - pictureRect. left))
I 2 + windRect.left;
myRectPtr->right = myRectPtr->left + (pictureRect.right pictureRect.left);

Running EventTutor
Now that your source code is entered, you're ready to run EventTutor.
Select Run from the Project menu. When asked to "Bring the project up to
date," click Yes. Ifyou run into any compilation problems, try the debugging
tips discussed in Appendix E.
Once the code compiles, you'll be asked whether you'd like to "Save
changes before running." Click Yes, and EventTutor will execute. Figure
4.10 shows EventTutor running under the Finder.
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Figure 4.10 EventTutor running under Finder.

EventTutor puts two windows up on the screen. The background window,
gPi ctWi ndow, should display your centered picture. The foreground
window, g EventWi ndow, should already list three events:
• act i vateEvt: activating gEventWi ndow: This event was caused by
your code. You called Se l ect Wi ndow( ) , requesting that g EventW i ndow
be made the frontmost window.
• updateEvt:gEventWindow,and
• updateEvt: gPi ctWi ndow:The Window Manager automatically generates an updateE vt for each of its windows as soon as they are drawn for
the first time.
When the Window Manager draws a window, it first draws the
window frame. The window frame includes the border, as well as a
drag region, zoom box, and a go-away box, if appropriate. Next, it
generates an upda t e Evt for the window, so the application will draw
the window contents.
Press the mouse button in the middle of g Ev e nt Wi nd ow.Now release the
mouse button. You should see first a mouse Oown and then a mouseU p
event. Press the mouse button in the g Eve nt Wi nd ow drag region (you'll see
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a mouseDown) and drag g Event Wi ndow down and to the right. You should
see an updateEvt for gPi ct Wi ndow. This is because you just revealed a
piece of g Pi ct Wi nd ow that was covered before. The reason you didn't get
a mouseUp when you released the mouse button is that the mo us eUp was
swallowed by the system routine that handles window dragging. This is
also true when you zoom or resize a window.
In Chapter 3 we established a standard of starting our program global
variable names with the letter g. This led to Wi nd owPtrs named
gEventWi ndow and gPi ctWi ndow. For clarity, we used these variable names as titles for their respective windows, but we could have
used any titles we wanted.
Click the mouse button in the center of g Pi ct Wi nd ow. You should see a
mouse Down, a deactivate event for gEventWi ndow, an activate event for
gPi ctWi ndow, an update event for gPi ct Wi ndow (assuming you clicked
on it while it was still at least partially covered by g Even tWi ndow), and a
mouseU p (Figure 4.11).
There is no such thing as a deact i vateEvt. We use the term
deactivateeventtoindicatean act i vate Evt with the act i veFl ag
cleared. There's an example ofthis in the code.
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Figure 4.11 After gPi ctWi ndow is activated.
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Try clicking in g Pi ct Wi nd ow ' s zoom box. The picture should remain
centered in gPi ctWi ndow. Click in the zoom box again. gPi ctWi ndow
should return to its original size. Resize g Pi ct Wi nd ow by clicking and
dragging the grow box. Keep an eye on g Event Wi nd ow. As you create
events, review the list of event types presented earlier in the chapter. All
these features were made possible by the use of events. Now, let's take a
look at the code.
Writing MultiFinder-friendly applications is not extremely difficult.
We will try to get the basics across in our code, but we again
recommend that you read the Programmer's Guide to MultiFinder
from Apple for a thorough background (oops!) in MultiFinder programming.
For starters, you can get your program to handle suspend and
resume events by selecting Set Project Type ... from the Project menu.
When the Set Project Type ... dialog box appears, use the MF Attrs popup menu to tum all three MultiFinder attributes on. Basically, you've
just set some bits_ in a resource of type SI ZEwith ID·= -1. Now, when
you run EventTutor, you get suspend and resume events when you
send EventTutor to the background and bring it back again under
MultiFinder.
In Chapter 5, you'll build a clock that runs in the background under
MultiFinder, and in Chapter 6, you'll build a countdown timer that
also runs in the background under MultiFinder.

_J

Walking through the EventTutor Code
EventTutor starts with a slew of #def i nes, some of which should be
familiar from Chapter 3. We'll discuss each #define as it appears in the
code:

#define BASE_RES_ID
#define NI L_PO INTER

400
OL

#define MOVE_TO_FRONT
#define REMOVE_ALL_EVENTS

0

#define
#define
#define
#define
#define
#define
#define
#define
#define

LEAVE_WHERE_IT_IS
NORMAL_UPDATES
SLEEP
NI L_MOUSE_REG ION
WNE_TRAP_NUM
UNIMPL_TRAP_NUM
SUSPEND_RESUME_BIT
ACTIVATING
RESUMING

- ll

FALSE
TRUE
OL
OL
Ox60
Ox9F
OxOOOl
1
1
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#define TEXT_FONT_SIZE

12

/fdefine
ffdefi ne
/fdefine
/fdefine

DRAG_ THRESHOLD
MIN_WINDOW_HEIGHT
MIN_WINDOW_WIDTH
SCROLL_BAR_PIXELS

30
50
50
16

#define
#define
#define
#define

ROWHEIGHT
LE FTMARG IN
STARTROW
HORIZONTAL_OFFSET

15
10
0
0

gPi ctureHandl e is the handle to your gPi ctWi ndow picture.
gPi ctWi ndowandgEventWi ndowarepointerstothetwoprogramwindows.
gDone is initialized to FALSE and checked each time through the main
event loop. If anyone sets gDone to TRUE, the program exits.
gWNE Imp 1 emented is a Boolean you'll set to TRUE if Wa itNextEvent() is
implemented in the current version of the system. g The Event is your
Event Record. Whenever you retrieve an event from the event queue, use
gThe Event to hold the event information. g Cu r Row holds the vertical pixel
coordinate (in gEventWi ndow's local coordinate system) for drawing the
next event string in gEventWi ndow. gMaxRow is the maximum value
allowed for gCurRow. If gCurRow gets bigger than gMaxRow, you'll scroll
the text in gEventWi ndow. gDragRect limits the dragging area of a
window, and g Si z e Rec t controls the size of a window.

PicHandle
WindowPtr
Boolean
EventRecord
int
Re ct

gPictureHandle;
gPictWindow, gEventWindow;
gOone, gWNEimplemented;
gTheEvent;
gCurRow, gMaxRow:
gOragRect, gSizeRect;

main ()starts bycallingtheToolboxand window initialization routines.
Then, ma i n ( ) calls Lo ad Pi ct u re ( ) to load the picture from the resource
file.Next, main() callsSetUpDragRect() andSetUpSizeRect() to set
up Rec ts for dragging and resizingourwindows(see Hand 1 eMo use Down ( ) ).
Finally, main () enters the main event loop by calling Main Loop ().
/******************************** main *********/

main ( )
{

Tool Boxlnit();
Windowlnit();
LoadPicture();
SetUpDragRect():
SetUpSizeRect();
Main Loop< ) ;
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Too 1 Box In it ( ) is the same as it was in Chapter 3. In fact, you'll use
the same Toolbox initialization routine throughout the book.
/*********************************** ToolBoxlnit */

Tool Boxlni t()
I

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
In it Wind ow s ( ) ;
InitMenus();
TEinit();
InitDial-0gs( NIL_POINTER );
Ini tCursor();

Wi nd ow In i t ( ) starts by loading the two windows from the resource file.
Next, gEventWi ndow is made the current window, and its attributes are
set via the call to Setup Event Wi nd ow ( ) . Both windows are made visible
with ShowWi ndow( ), and Sel ectWi ndow() is called to ensure that
gEventWi ndow is the frontmost window.
/******************************** Windowlnit *********/

Wi ndowlnit()
I

gPictWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER,
MOVE_ TO_FRONT ) ;
gEventWindow = GetNewWindow( BASE_RES_ID+l, NIL_POINTER,
MOVE TO FRONT );
SetPort( gEventWindow );
SetupEventWindow();
ShowWindow( gEventWindow );
ShowWindow( gPictWindow );
SelectWindow( gEventWindow );

Setup Event Wi n d ow ( ) sets some ofthe g Event Wi nd ow global variables.
eventRect is a placeholder for gEventWi ndow's boundary rectangle.
gMaxRow is set to the maximum row you'll draw into (in gEventWi ndow's
local coordinates). gCurRow holds the current row number (also in local
coordinates). g Event Wi n d ow's font is set to 12-point Monaco.
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!************************** SetupEventWindow *********/

SetupEventWindow()
I

Rect

eventRect:

eventRect = gEventWindow->portRect:
gMaxRow = eventRect.bottom - eventRect.top - ROWHEIGHT;
gCurRow = STARTROW;
TextFont( monaco );
TextSize( TEXT_FONT_SIZE );
Lo ad Pi ct u re ( ) loads your picture from the resource file into memory,
and g Pi ct LI re Ha nd l e is set to be a handle to the picture. For a refresher
on handles, check out the tech block on handles in Chapter 3.
/******************************** LoadPicture *********/

LoadPicture()
{

gPictureHandle

GetPicture( BASE_RES ID );

SetUpDragRect() setsupaboundingrectangletopasstoDragWi ndow()
(see Handl eMoLiseDown () ). Startoffwitharectanglethesizeofthemain
screen by using the system global variable, screen Bi ts . b o LI nd s. When
you click on the title bar of a window and drag it around the screen, the
bounding rectangle forces you to leave DRAG_THRESHOLD pixels of the
window on the screen. This will prevent the user from dragging all but a few
pixels of a window off the screen (making that window tough to find later
on). The reason you don't have to worry about the top of the drag rectangle
is that the drag region is on the top of the window.
/******************************** SetUpDragRect *********/

SetUpDragRect()
I

gDragRect = screenBits.bounds:
gDragRect.left += DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD;
gDragRect.bottom -= DRAG_THRESHOLD;

SetUpSi zeRect() sets up a res1zmg rectangle for your call to
GrowWi ndow ( ) (see Hand l eMoLiseDown ( ) ). gSi zeRect. top defines the
minimum number of pixels allowed for window height. gSi zeRect. 1eft
defines the minimum number of pixels allowed for window width.
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gSi zeRect. bottom defines the maximum number of pixels allowed for
window height, and gSi z e Re ct . r i g ht defines the maximum number for
width. Use the size of the main screen (from your old friend
screenBi ts. bounds) for these two.
/******************************** SetUpSizeRect *********/

SetUpSizeRect()
{

gSizeRect.top = MIN_WINDOW_HEIGHT;
gSizeRect.left = MIN_WINDOW_WIDTH;
gSizeRect.bottom = screenBits.bounds.bottom screenBits.bounds.top:
gSizeRect.right = screenBits.bounds.right screenBits.bounds.left;
Main Loop () starts by initializing gDone. Your application will exit
when gDone is set to TRUE. Next, check to see if WaitNextEvent() is
installed. Essentially, you're checking to see if Wai t Next Event ( ) and an
unimplemented Toolbox routine have the same address in memory. If so,
you know that Wai t Next Event ( ) is not implemented in the currently
booted system.

This piece ofcode has changed several times since Wai t Next Ev en t ( )
was first made available. To be on the safe side, get the very latest copy
of the Programmer's Guide to MultiFinder from APDA. In the back,
you'll see an example program that reflects Apple's current thinking
on Wai tNext Event ( ) .Byfollowingthisexample,you'llminimi:r.ethe
chances of your program breaking under future releases of the Mac
operating system.
Finally, Ma i n Loop ( ) loops on Hand 1e Event ( ) until gDone is set to
TRUE.
/******************************** Mainloop *********/

Mainloop()
{

gDone = FALSE:
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM,
ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM,
ToolTrap ) ) :
while
gDone == FALSE )
{

HandleEvent();
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Handl eEvent () starts with a call to either Wai tNext Event () (if it's
implemented), or SystemTask() and GetNextEvent(). Either way,
gThe Event gets filled with the latest event info. Each event is handled by
drawing the name of the event in gEventWi ndow using DrawEventStri ng ().If you uncomment the code in the nul 1 Event case, you'll get
a feel for the number of nu 11 Events the system generates.
nu 11 Events offer an excellent opportunity to do things like cursor
tracking and internal housekeeping. For example, Chapter 5's Timer
program updates a clock window when it gets a nu 11 Event.

/************************************* HandleEvent
HandleEvent()
I

*/

if ( gWNEimplemented )
WaitNextEvent( everyEvent, &gTheEvent, SLEEP,
NIL_MOUSE_REGION );
else
{

SystemTask();
GetNextEvent( everyEvent, &gTheEvent );
switch ( gTheEvent.what )
{

case nullEvent:
/*DrawEventString( "\pnullEvent" );*/
/*
Uncomment the previous line for a
burst of flavor! */
break;
case mouseDown:
DrawEventString( "\pmouseDown" );
HandleMouseDown();
break;
case mouseUp:
DrawEventString( "\pmouseUp" );
break;
case keyDown:
DrawEventString( "\pkeyDown" );
break:
case keyUp:
DrawEventString( "\pkeyUp" );
break:
case autoKey:
DrawEventString( "\pautoKey" );
break:
updateEvts are handled in a special way. First, figure out which
window the update Ev t is for. The Event Manager stores a pointer to the
window requiring updating in gTheEvent. message. By comparing this
pointer to gEventWi ndow and gPi ctWi ndow, you can tell which window
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the updateEvt is for. If the updateEvt is for gPi ctWi ndow, draw the
appropriate event string into g Event Wi ndow, and then call Beg i nUpdate ( ) .
Beg i n Update ( ) tells the Event Manager that you're about to take care
of the condition that caused the update. In this case, you'll redraw the
picture in gPi ctWi ndow using DrawMyPi cture( ). Finally, call EndUpdate () to let the Event Manager know you're done.
lfyoucommentedoutthecallsto BeginUpdate() and EndUpdate( ),
you'dgetanunendingstreamofupdateEvts forgPi ctWi ndow. TheEvent
Manager, thinking you were ignoring the ones you'd already retrieved,
would just keep generating them. Try it for yourself.
Every window has an update region associated with it. When a
previously covered section of a window is uncovered, the uncovered
area is added to the window's update region. The Window Manager is
constantly on the lookout for windows with nonempty update regions.
When it finds one, it generates an updateEvt for that window.
Beg i n Update ( ) , as part ofits processing, replaces the update region
of the specified window with the empty region. Therefore, ifyou don't
call Beg i n Update ( ) , you'll never empty the window's update region,
and the Window Manager will never stop generating update Ev ts for
the window.
If you have not done so already, you should absolutely read the
Window Manager chapter of Inside Macintosh (Volume I, Chapter 9)
The information presented in the Window Manager chapter is crucial
to writing proper Macintosh applications.
You won't redraw the contents of gEventWi ndow in response to
update Ev ts. Ifyou want to add this capability, add a data structure to the
program that keeps track of all the strings currently in the window, and
redraw them whenever an updateEvt occurs for gEventWi ndow. In this
version, you'll just call Draw Event St r i n g ( ) to add the update Ev t to
your list of events, and Beg i n Update ( ) and End Up d a t e ( ) to let the
Window Manager know that you've responded to the update Ev t.
Before Beg i n Update ( ) empties the update region, it first replaces
the visible region of the window (called the vi s Rg n) with the intersection of the vis Rgn and the update region (see Figure 4.12). The
application then redraws the contents of the window. Ifit wants to, it
can use this newly cropped vis Rgn to help reduce the amount of
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drawing necessary. For now, you'll just redraw the entire contents of
the window. Finally, End Update C) is called. End Update C) replaces
the original version of the vi s Rgn. A call to Beg i nUpdate C) without
a corresponding call to End Update ( ) will leave your window in a very
unpredictable state.

Vi.&Rgn

Update
Region

~ ~ LEJ ~

Qj L2J L[J L[J
Before the bottom
window is selected

After the bottom
window is
selected, but
before
BeginUpdate() is
called

After
BeginUpdate()
is called

After
EndUpdate()
is called

Figure 4.12 Begi nUpdate() in action.

case updateEvt:
if ( CWindowPtr)gTheEvent.message == gPictWindow )
{

else

DrawEventString(
"\pupdateEvt: gPictWindow" );
BeginUpdate( gTheEvent.message );
DrawMyPictureC gTheEvent.message,
gPictureHandle );
EndUpdate( gTheEvent.message );
DrawEventString(
"\pupdateEvt: gEventWindow" );
BeginUpdate( gTheEve~t.message );
I*

We won't handle updates to
*
gEventWindow,
*but we still need to empty the
gEventWindow
* Update Region so the Window Manager
wi 11 stop
* queing UpdateEvts.
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*

We do this with calls to
BeginUpdate()
*and EndUpdate().
*/

EndUpdate( gTheEvent.message ):

~

break:
case diskEvt:

DrawEventString( "\pdiskEvt" ):
break;

Another special case is the act i vateEvt. As you did with updateEvt,
first check to see which window the act i vat e Ev t was intended for. If the
a ct i va teEvt was for gPi ctWi ndow, call DrawGrow I con ( ) to redraw the
grow box and the empty scroll bar areas. The grow box looks different
depending on whether the window was activated or deactivated (see Figure
4.13). DrawGrowI con () is smart enough to draw the grow box correctly.
Next, check a bit in the modifiers field to see if the event was an activate
or a deactivate event. Remember, act i vat e Ev ts usually occur in pairs:
The frontmost window is first deactivated, and then the new front window
is activated. Also draw the appropriate strings for networkEvts,
d r i v er Ev ts, and a pp 1 through a pp 3 Ev ts, although you probably won't
get any of these.
Front Window

Figure 4.13 The grow box-activated and deactivated.
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case activateEvt:
if ( (WindowPtr)gTheEvent.message
gPictWindow )
DrawGrow!con( gTheEvent.message );
if
( gTheEvent.modifiers &
activeFlag ) ==ACTIVATING )
DrawEventString(
"\pactivateEvt:activatinggPictWindow"

);

}

else

DrawEventString(
"\pactivateEvt: deactivating gPictWindow):
} else
{

gTheEvent.modifiers &
activeFlag ) == ACTIVATING
DrawEventString(
"\pactivateEvt: activating gEventWindow" );
else
DrawEventString(
"\pactivateEvt:deactivatinggEventWindow");
if

< <

}

case
case
case
case
case

break;
networkEvt:
OrawEventString(
break:
driverEvt:
DrawEventString(
break:
applEvt:
DrawEventString(
break:
app2Evt:
DrawEventString(
break:
app3Evt:
DrawEventString(
break;

"\pnetworkEvt" ):
"\pdriverEvt" );
"\papplEvt" ):
"\papp2Evt".):
"\papp3Evt" );
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If you handle resume and suspend events, you'll get them in the form of
an app4Evt. The SUSPEND_RESUME_BIT is set ifthe event is a resume
event and cleared if the event is a suspend event.

case app4Evt:
if ( (gTheEvent.message & SUSPEND_RESUME_BIT)
RESUMING )
DrawEventStringC "\pResume event" );
else
DrawEventString( "\pSuspend event" );
break;

Draw Event St r i n g ( ) handles the text positioning in g Event Wi nd ow. If
the QuickDraw pen is near the bottom of the window, Scro 11 Wi n d ow ( ) is
called. The string is drawn with Draw St r i ng ( ) . R0WHE I GHT is the height
in pixels of a single row of text. LEFTMARGIN is the pixel coordinate (in
g Event Wi nd ow 's local coordinate system) of the left margin of the text in
gEventWi ndow.

/**************************** DrawEventString *******/

DrawEventString( s )
Str255 s:
{

if

gCurRow > gMaxRow

{

ScrollWindow();
}

else
I

gCurRow += ROWHEIGHT:

I

MoveTo( LEFTMARGIN, gCurRow );
Drawstring( s );
Scroll Window() calls Scroll Rect() to scroll the pixels in
gEventWi ndow up one row. Scroll Rect() scrolls the contents of the
current Graf Port (in this case, gEventWi ndow) within the rectangle
specified in the first parameter. The rectangle is scrolled to the right by the
number of pixels specified in the second parameter and down by the
number of pixels specified in the third parameter. Since you specified a
negative third parameter, the contents of g Event Wi nd ow will be scrolled
up.
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The last parameter to Scro 11 Re ct ( ) is a RgnHand 1 e, or a handle to a
region. Regions are collections of drawn lines, shapes, and curves, as
shown in Figure 4.14. After the pixels in the rectangle are scrolled,
Scro 11 Re ct ( ) will fill thevacatedareaoftherectanglewith the Graf Port's
background pattern. Then, these new areas are collected into the region
handled by RgnHandl e (Figure 4.15).
Many programs use this r egion as a guide to redrawing the window so
that they don't have to redraw the entire window. This is especially
useful if your window is extremely complex and takes a long time to
redraw. In that case, a handle to the window's UpdateRgn is passed
to Scro 1 l Rec t ( ) . Whenever the Window Manager detects that a
window's updateRgn is nonempty, the Window Manager generates
an updateEvt for the window. As part of its processing, Begi nUpd ate ( ) sets the specified window's update Rg n to the empty region.

Figure 4.14 A region.

updateRgn
filled with bkPat

Figure 4.15 FrontWindow's updateRgn after Scroll Rec t
( r, 10, 20, updateRgn).
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Since you're not redrawing g Event Wi nd ow in response to update Ev ts,
you'll use a temporaryregion(tempRgn)asaparameterto Scro 11 Re ct ( ).
Deallocate the tempRgn's memory by calling Di sposeRgn ().
/****************************

ScrollWindow *******/

Scroll Window()
(

RgnHandle

tempRgn;

tempRgn = NewRgn();
ScrollRect( &gEventWindow->portRect, HORIZONTAL_OFFSET,
-ROWHEIGHT, tempRgn );
DisposeRgn( tempRgn );

Handling mouseDown Events
When you receive a mouse Down event, the first thing to do is find out which
window the mouse was clicked in, by calling the Toolbox routine
Fi ndWi ndow( ). Fi ndWi ndow() takes, as input, a point on the screen and
returns, in the parameter whi chWi ndow, a Wi ndowPtr to the window
containing the point. In addition, Fi ndWi ndow () returns an integer part
code, describing the part of the window the point was in.
Once you have your part code, compare it to the predefined Toolbox part
codes (you can find a list of legal part codes in 1:287). The part code
i nSys Wi n d ow means that the mouse was clicked in a system window, very
likely, a desk accessory. (Since Event Tutor doesn't support desk accessories, you probably won't see any inSysWindow mouseDowns, but you will
see them in Chapter 5.) The appropriate thing to do in this case is to pass
the event and the Wi ndowPt r to the system so it can handle the event. Do
this with the Toolbox routine SystemCl i ck().
The part code i nDrag indicates a mouse click in whi chWi ndow's drag
region. Handle this with a call to the Toolbox routine DragWi ndow( ).
DragWi ndow() wants a Wi ndowPtr, the point on the screen where the
mouse was clicked, and a boundary rectangle. DragWi ndow() will allow
the user to drag the window anywhere on the screen as long as it's within
the boundary rectangle. Use gOragRect, which you initialized with the
routine SetUpDragRect( ).
The i n Content part code represents the part ofthe window in which you
draw. When you detect a mouse click i nContent, call Se l ectWi ndow( ).
If the mouse click was not in the frontmost window, Se 1 ectW ind ow ( )
deactivates the frontmost window and activates the clicked-in window. A
call to Sel ectWi ndow() usually results in a pair of act i vateEvts.
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/************************************* Handl eMouseDown *I
HandleMouseDown()
{

WindowPtr
short int
long
Graf Ptr

whichWindow:
thePart:
windSize:
oldPort;

thePart
FindWindow( gTheEvent.where, &whichWindow );
switch ( thePart )
{

case inSysWindow :
SystemClick( &gTheEvent, whichWindow ):
break:
case inDrag :
DragWindow( whichWindow, gTheEvent.where,
&gDragRect ):
break:
case inContent:
SelectWindow( whichWindow ):
break:
A click in the grow box is handled by a call to Gr owWi nd ow ( ) , which
takes the same arguments as Drag Wi n d ow ( ) but allows the window to
grow and shrink instead of move. Gr owW i nd ow () returns a long integer
composed of two words (four bytes) that define the number of pixels the
window will grow or shrink in each direction. These words are passed to
Si zeWi ndow(), causing the window to be resized accordingly. The last
parameter to Si z e Wi nd ow ( ) tells the Window Manager to accumulate any
newly created content region into the update region. This means that the
Window Manager will generate an update event whenever the window is
made either taller or wider.
Theupdateeventstrategyisfairlysimple. Usetheroutine I nva 1 Rect ()
to add the entire contents of the window to the window's updateRgn,
guaranteeing that an updateEvt will be generated whether or not the
window was grown. When you plan your applications, spend some time
working out an appropriate update strategy. If redrawing the contents of
your windows will be fairly easy and won't take too long, you may want to
use the Inv a 1 Rec t ( ) approach. But if the contents of your window are
potentially complex (as is true of many drawing and CAD packages), you'll
probably want to avoid the call to I nva 1 Rec t ( ) and, instead, use the shape
of the update region to aid you in updating your window efficiently.

case inGrow:
windSize = GrowWindow( whichWindow,
gTheEvent.where,&gSizeRect ):
if
windSize != O )
I

GetPort( &oldPort );
SetPort( whichWindow );

139

The Event Mechanism

EraseRect( &whichWindow->portRect );
SizeWindow( whichWindow. LoWord( windSize),
HiWord( windSize ),
NORMAL_UPDATES );
InvalRect( &whichWindow->portRect >:
SetPort( oldPort );
}

break;
A click in the go-away box ofeither window will result in gdone being set
to TRUE. This will cause the program to exit.

case inGoAway :
gDone = TRUE;
break;
A note from the thought police: A proper Macintosh application would
never think of exiting just because someone clicked in the close box of
a window! When we get to menu handling in Chapter 5, we'll show you
the correct way to Quit.
If the mouse is clicked in the zoom box, respond by calling Trac kB ox ( ) ,
which will return TRUE if the mouse button is released while the mouse is
still in the zoom box. ZoomWi ndow() zooms the window in or out, depending on the part code passed as a parameter. The constant
LEAV E_WHERE_IT_IS tells ZoomWi ndow() to leave the window in front if
it was in front when the zoom box was pressed or in back ifthe window was
in back when the zoom box was pressed. Just as you did with Si z eW i nd ow ( ) ,
call Inv a1 Rec t ( ) to guarantee that an update Ev t is generated when the
window is zoomed in or out.

case inZoomln:
case inZoomOut:
if ( TrackBox( whichWindow,
gTheEvent.where, thePart ) )
GetPort( &oldPort );
SetPort( whichWindow );
EraseRectC &whichWindow->portRect );
ZoomWindow( whichWindow, thePart,
LEAVE_WHERE_IT_IS );
InvalRectC &whichWindow->portRect );
SetPort( oldPort );
}

break;
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DrawMyPi cture() will draw the picture handled by the Picture in
the window pointed to by draw i ngWi nd ow, clipping the drawing so that the
scroll bar and grow areas aren't overwritten. Copy d raw i n gWi nd ow's
portRect to drawi ngCl i pRect, andadjusttheleftand bottom to clip the
two scroll bar areas. Use this new Rec t as a parameter to C1 i p Rec t ( ) so
that when you draw your picture, it gets clipped properly.
Start by saving a pointer to the current Graf Port in o 1d Port so you can
restore it at the end of DrawMyPi ctu re ().Next, make d rawi ngWi ndow
the current Graf Port so the picture will be drawn in the correct window:
/******************************** DrawMyPicture *********/

DrawMyPicture( drawingWindow, thePicture )
WindowPtr
drawingWindow;
PicHandle
thePicture;
{

Re ct
Graf Ptr
RgnHandle

drawingClipRect, myRect;
oldPort:
tempRgn;

GetPort( &oldPort );
SetPort( drawingWindow );
Then, allocate memory for a region to save a copy of the current clip
region. Call GetCl i p() to copy the current clip region into tempRgn.
NewRgn () allocates enough memory for the minimum-sized region.
Get C1 i p ( ) resizes the region to accommodate the current clip region.

tempRgn = NewRgn();
GetClip( tempRgn );
Ifyou created a region in the shape of a star, and used Set C1 i p ( ) to
set the clip region to your star region, all drawing in that window
would be clipped in the shape of a star. You can read more about
regions in Inside Macintosh (1:141-142and1:166-167).

Next, erase the whole window with a call to Er as e Re ct ( ) . You've just
erased the Grow I con, so call DrawGrowl con () to redraw it. Next, set up
your clipping Re ct, drawi ngCl i pRect, so that it excludes the right and
bottom scroll bar areas (and, as a result, the grow area). Then, set my Rec t
to the drawi ngWi ndow port Re ct. You'll use myRect as a parameter to
Center Pi ct(), where it will be adjusted to reflect the size of the picture,
centered in the input Rect.
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At this point, you have not changed the clip region of d raw i ng Wi nd ow.
You are about to. Call Cl i pRect () to set the clipping region to the
rectangle defined by drawi ngCl i pRect. Now, draw the picture with
DrawPi cture( ).

EraseRect( &drawingWindow->portRect ):
DrawGrowicon( drawingWindow );
drawingClipRect = drawingWindow->portRect:
drawingClipRect.right -= SCROLL_BAR_PIXELS;
drawingClipRect.bottom -= SCROLL_BAR_PIXELS:
myRect = drawingWindow->portRect;
CenterPict( thePicture. &myRect ):
ClipRect( &drawingClipRect );
DrawPicture( thePicture. &myRect );
Finally, reset the C1 i p Rec t to the setting saved in temp Rgn, release the
memory allocated to tempRgn, and set the current Graf Port back to the
original setting.

SetClip( tempRgn );
DisposeRgn( tempRgn ):
SetPort( oldPort );
CenterRect () is the same as in Chapter 3's ShowPict program:

/******************************** CenterPict *********/
CenterPict( thePicture. myRectPtr
PicHandle
thePicture;
Rect
*myRectPtr;
{

Rect

windRect. pictureRect:

windRect = *myRectPtr;
pictureRect = (**( thePicture )).picFrame:
myRectPtr->top = (windRect.bottom - windRect.top CpictureRect.bottom pictureRect.top)) I 2 + windRect.top;
myRectPtr->bottom = myRectPtr->top + (pictureRect.bottom
- pictureRect.top);
myRectPtr->left = CwindRect.right - windRect.left (pictureRect.right - pictureRect.left))
I 2 + windRect.left;
myRectPtr->right = myRectPtr->left + CpictureRect.right
- pictureRect.left);
Ifyou'd like to learn more about event handling, read the Toolbox Event
Manager chapter of Inside Macintosh (1:241-266).
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In Review
At the heart of every Macintosh application is the main event loop. Mac
applications are built around this loop. Each pass through the main event
loop consists of the retrieval of an event from the event queue and the
processing of the event.
The Window Manager plays an important role in the handling of events
by generating updateEvts as a means of getting the application to draw
(or update) the contents of a window. In addition, Window Manager
routines like Fi nd Wi nd ow ( ) offer a mechanism for linking an event to a
window.
An underlying theme of this chapter is a concern for good user interface
design. When you set out to build an application, concentrate on the user's
view of your application. Use the main event loop in this chapter as your
basic skeleton. Then, determine how you will handle each of the different
events your user might initiate.
In Chapter 5, you'll learn all about menus. You'll learn how to design and
implement regular menus, hierarchical menus, and pop-up menus!
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Management
This chapter explains the use of menus in
your programs. We'll show you how to
install menus via MB.AR, and MENU
resources, and describe the routines
available from the Menu Manager. We'll
also discuss the best way to support
desk accessories and do event
handling with menus.

MACINTOSH MENUS HAVEN'T been the same since the advent of the Mac SE
and the Mac II. The classic Mac menu was the pull-down menu-the strip
at the top of the screen with options that, when clicked on, displayed the
possibilities available to each program (Figure 5.1). The situation has
changed for the better with two additional menu types: the hierarchical
menu and the pop-up menu. We'll discuss and demonstrate both. But first,
let's look at the standard parts of all menu systems.

_J

Menu Components
Before we discuss the structure of menus, let's examine the parts of a menu
and their functions. Figure 5.2 shows the main parts of Macintosh menus.
We'll discuss the parts of the classic menu first, then discuss differences in
the new menu types in the section devoted to each type.
The menu bar displayed at the top ofthe Mac screen is normally 20 pixels
high. The font type and size are always the same as the system font. The
menu bar height may be changed, using the global variable MB a rHei ght,
as we saw in Chapter 3's screen saver program, The Flying Line.
On the menu bar, each list of choices is known as a menu. The , File,
and Edit menus are found in most Macintosh applications. Menus are
dimmed, or disabled, when none of their options is available.

.,

Windows

Hello2 Proj
obj sin
406

~!!.~.!!.~..................................................?..?.?..~..

Bring Up To Do te atlU
Check link
atl l
Build library ...
Build Application •.•

Figure 5.1 Classic pull down menu.
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/

Menu Bar

I

Edit Uiew Special
folth?'r ~}(tN
Open
380
Print
Dimmed Menu I tern
N(~W

[lose
Menu Item

~!tUJ

Get Info

Command Key Equiualent

0Uf)liC<l1<~

Put Hwa1_t
Page Setup •••
Prh~ t lHu~c1 ory ...

Ellipses ( ••. ) indicate that
further information will
be required to complete
the command.

Figure 5.2 Components of Macintosh menus.

Menu items are the choices that are available in a given menu. For
example, the File menu items in MacWrite are as shown in Figure 5.3.
A menu item is selected if the mouse button is released while the item
is still highlighted. Individual items may also be disabled (dimmed). An
icon or a check mark can be placed to the left of an item's text. The font and
size of the item may be varied; command key equivalents may be placed to
the right of a menu item. If a menu item list becomes too long for the screen,
not uncommon on a Mac Plus or SE, the last item that would normally be
seen is replaced with a downward-pointing arrow ['T']. If the user pulls the
mouse pointer down further, more menu items will scroll into view.
The S menu is different in several respects from the other menus in the
menu bar. By convention, the first item in the
menu is used by your
program to display information about your program. The remaining menu
items make up a list of available desk accessories (Figure 5.4).
Let's take a look at the classic pull down menu and how it works.

s

New
38N
Open...
HO
Close
sew
Saue
ses
Saue Rs •••
Page Setup •••
Print...
38P
Quit

380

Figure 5.3 MacWrite File menu.
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About the Finder •••
Rhum Clock
Calculator
Chooser
Control Panel
Find Fiie
Key Cops
Scrapbook

Figure 5.4 The S menu.
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The Pull Down Menu
The pull down menu, displayed at the top of the screen, is standard for
most Macintosh applications. Pull-down menus are created by the Menu
Manager, which also takes care of drawing the menu items; handling menu
selection (as well as command key equivalents); and, finally, restoring the
screen when the menu is released. All you have to do is provide the menu
information in the form of two resources, MBAR and MENU, and call them
with Menu Manager routines. The MBAR resource contains a list of the
menus that will be displayed on the menu bar. Each MENU resource contains
information about the individual menu items.
On the Mac II, menus and menu items can also be displayed in different
colors (V:235).
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The Hierarchical Menu
The hierarchical menu came on board in 1987, when it was added to the
Toolbox. It was needed for the new, complex programs that had become
available for the Mac. As more bells and whistles were added to Mac
applications, it became harder to find a place for them on the menu bar.
Hierarchical menus made it possible to put a whole menu into one item
without inconveniencing the user (Figure 5.5).
Menu items that have a hierarchical submenu associated with them
have a small right-pointing triangle(...,. ) on their right side. When the menu
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item is selected, the hierarchical submenu is displayed. The user then
moves the arrow over to the item desired on the hierarchical menu.
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The Pop-Up Menu
The pop-up menu is the only menu that can be placed anywhere on the
screen. This menu is similar to a hierarchical menu, except that pop-up
menus can be placed in windows, dialog boxes, even on the desktop.
A pop-up menu appears when a mouseDown occurs in an area defined by
an application (Figure 5.6). Once the pop-up menu appears, the user can
select an item by moving the cursor up or down. When the mouse button is
released, the selection is processed. Pop-up menu routines require a little
more work than the other menu types, but the additional functionality is
worth it. We will build a pop-up menu project at the end of this chapter.
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Other Kinds of Menus
As with most other parts of the interface, you can make your own unique
menus that use the same calls yet look very different from the three kinds
of menus already described. Building your own menus, however, is more
complicated than using the standards. And since many current applications don't even use the pop-up and hierarchical menus yet, there's no need
to rush out and create something new.

~./Chicago

Geneua
Heluetica
Monaco

Figure 5.5 Hierarchical menu.
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O Code Resource

~
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lflPMI

Sepurute STRS
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Figure 5.6 Dialog box with pop-up menu.

A fourth type ofMacintosh menu that has become quite popular recently
is the tear-off menu, which can be torn offthe menu bar and moved around
the screen like a window. Its use in HyperCard and MacPaint 2.0 have
probably guaranteed its eventual enshrinement in the Toolbox. We suggest
that you wait until it is available in the Toolbox before trying to make one
on your own.
Menu formats from MS-DOS programs or other non-Macintosh systems
are sometimes ported over to the Macintosh. A result of this might be
something like Figure 5.7. These MS-DOS style menus do not follow the
Macintosh user interface guidelines. Don't use them or associate with
developers that do.

Putting Menus into Your Programs
There are a number ofways to add menus to the applications you create: You
can insert menus at the end of the current menu bar (e.g., desk accessories
like QuickDex or DiskTop), you can build a new set of menus from scratch
right inside your program, or you can create your menus in ResEdit and
load them into your program. We're going to do it the last way, which makes
for clean programming and easy changes without recompiling.
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Figure 5.7 MS-DOS menu.

We'll use two menu resources: MENU and MBAR. The MBAR resource
contains a list of all ofthe MEN Uresources that will be used to draw the menu
bar. The MBAR resource also controls the order in which the menus are
drawn on the menu bar. Each MENU resource contains a menu title, a list of
the menu items, and detailed information about the display of each item.
Now, let's look at Timer, our first program with menus.

_J

Timer
Timer displays the current time in a window and refreshes the time once
per second. The standard S , File, and Edit menus are supported as well as
an additional menu, Special. The Special menu has two hierarchical
submenus, which allow you to change the display's font and style.
Timer's menu supports desk accessories. The File menu has a single
item, Quit. The Edit menu is disabled but is provided as a service to desk
accessories. Every Macintosh application you write should support the
standard Edit menu, as it is part of the Macintosh interface standards.
Timer works like this:
• It initializes the Toolbox.
• It loads the MBAR and MENU resources.
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• It initializes the Timer window.

• It displays the time in the window.
• It handles events for the menus and the window, refreshing the Timer
window once per second.

Setting Up the Project
Create a folder called Ti mer; keep your project and resource files inside the
folder.

Resources
Now, add the resources you'll need for your Timer program. Create a file in
your new Ti mer folder using ResEdit. Call it Ti mer Pro j . Rs r c. Then
build a WIND with ID= 400, with the specifications as shown in Figure 5.8.
Next, you need an MBAR resource, that lists the resource IDs of the four
MENUs that will be part of Timer's menu bar. Create a new MBAR resource
inside Ti mer Proj. Rs re. You should see something like Figure 5.9. Click
on the row of asterisks and select New from the File menu. A field for the
first menu should appear, as well as a new row of asterisks. Create three
more menu fields and fill all four as shown in Figure 5.10. Finally, change

§0§ WI ND ID

= 400

from Timer Proj.Rsrc

Window title:

ITimer
top

~bottom~

left

~right~

proclD

Io

D Uisible

IrefCon IO
181 goRwayFlag

Figure 5.8 Timer WI ND specifications.

I
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MBRR ID

#of menus

400 from Timer Proj.Rsrc

O

*****

Figure 5.9 A new MBAR resource.

D

MBRR ID

#of menus

400 from Timer Proj.Rsrc

4

*****
menu res ID

1400

*****
menu res ID

1401

*****
menu res ID

1402

*****
menu res ID

1403

*****
Figure 5.10 A complete MBAR resource.
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the MBAR resource ID to 400. Close the MBAR window. Now, you need to
create four MENU resources.
First, build the MENU resource as shown in Figure 5.11. When the MENU
resource is initially displayed by ResEdit, only the first seven fields are
displayed. When you have completed these fields, click on the row of
asterisks at the bottom of the window and select New from the menu to add
information for each subsequent menu item. You may encounter difficulties in generating the 9 character for this menu. The simplest way to get
the 9 is to go into another application with an 9 MENU resource, copy the
9 character and paste it into Timer's resources. Using the 9 is just a
convention; the program will run fine, if amateurishly, with any character.
Close the 9 MENU resource window and give it a resource number of 400.
Open a new MENU resource for the File menu information, and fill it in as
shown in Figure 5.12.

~~ MENU "Apple 11 ID = 400 from Timer Proj.Rsrc ~

menu ID

400

width

0

height

0

proclD

0

filler

0

enable Figs

$FFFFFFFB

•

title

"'"'"'"'"'
menu Item
icon#
key equiu
mark Char

"'"'"'"'"'
menu Item

key equiu
mark Char

Figure 5.11

I-

lo

icon#

style

D
D

lsoo

style

...............

IAbout Timer
lo I

D
D

lso1
0

Apple MENU specifications.
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MENU "File" ID= 40 from Timer Proj.Rsrc ~

menu ID

401

width

0

height

0

proclD

0

filler

0

enableflgs

SFFFFFFFF

title

File

*****
menu Item

louit

icon#

lo

key equiu

[!]

mark Char

D

style

*****

lsoo
0

Figure 5.12 File MENU specifications.

The MENU resource allows you to specify the appearance of the displayed menu in your program. The first seven items of the MENU
resource relate to the entire menu. The Memu ID field is the resource
ID of the ME NU, the en ab 1 e Fl gs field allows you to specify which
menu items are initially disabled (dimmed) so that the user cannot
select them. The ti t 1 e field contains the menu's title that is displayed on the menu bar. The other fields will be filied in for you by
ResEdit.
The en ab 1 e Fl gs field contains a set of flags for the Menu Manager. These flags tell the Manager which menu items are selectable
and which should be displayed in a dimmed state. In the menu,
$FFFFFFFB has been entered.
In binary, this becomes:

1111-1111-1111-1111-1111-1111-1111-1011
The rightmost bit corresponds to the MENU title, the second rightmost
to the first MENU item the third from the right corresponds to the
second MENU item,, and so on. $FF FF FF FB tells the Menu Manager to
make the second MENU item (the line under About Timer) unselectable.
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Close the File menu resource window and give it a resource number of
401. Now, open a new MENU resource for the Edit menu information. Fill it
in as shown in Figure 5.13. Then, close the Edit menu resource window and
give it a resource number of 4 0 2.
The Edit menu is a little different from the first two, in that the menu
ill~

MENU Edit ID = 402 from Timer Proj.Rsrc
11

11

menu ID

402

width

0

height

0

proclD

0

filler

0

enableflgs

$00000000

title

Edit

~

...............
menu Item
icon#
key equiu
mark Char
style

Iundo

D
lD
D
lsoo

...............
menultem

1-

::===:::::;-----------------------J

i c o n # I...._o_......
key equiu
mark Char
style

0
0

s=o=-o----------

~,

...............
menu Item

I Cut

=====:::::;------------------------'

i c o n # I...._o_......
key equiu
mark Char

~

0

===------------------------

sty Ie l.....s_oo____________.

.............

Figure 5.13 Edit MENU specifications.
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menu Item

Icopy

icon#

lo

key equiu

~

mark Char
style

D

jsoo

*****
menu Item

IPaste

icon#

lo

key equiu

~

mark Char
style

I

D

jsoo

*****
menu Item

IClear

icon#

lo

key equiu

D
D

mark Char
style

*****

I

lsoo
0

Figure 5.13 Edit MENU specifications (continued).

items in it have all been disabled. In fact, this application does not use the
Edit menu at all. So why add it? The reason is that although your
application may not use the Edit menu, the desk accesories that you
support may. Many desk accessories expect an Edit menu on Mac applications. If you don't put one there, the accessory may not be able to function
properly.
Now, add the.Special menu. Open up a new MENU resource and fill it as
shown in Figure 5.14. Close the Special menu and give it a resource ID of
403.
The next step is a little tricky. You may have wondered why the Font and
Style items each used a* in the key equiv field. In order to mark a menu
item as a hierarchical menu item, the key equiv field is filled with a special
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MENU "Special Io = 403 from Timer Proj.Rsrc
11

menu ID

1403

width

lo

height

0

proclD

0

filler

0

enableflgs

$FFFFFFFF

title

Special

~

*****
menu Item
icon#
key equiu
mark Char

IFont
lo

J

EJ

[!]

lsoo

style

*****
menu Item

IStyle

Icon#

lo

key equiu
mark Char

J

~

[!]

lsoo

style

*****

J

0

Figure 5.14 Special MENU specifications.

000000
000008
000010
000018
000020
000028
000030
000038
000040
000048
000050
000058
000060
000068

0193
0000
7065
6F6E
5374
0000

0000
FFFF
6369
7400
796C

0000
FFFF
616C
!1>4
6500

0000 DiDDDDDD
0753 DDDDDDDS
0446 pecialUF
0005 ont~DD
2A65 StyleD*e

DD

Figure 5.15 The Special menu, using
Open General.
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hex character, which, unfortunately, cannot be typed from the keyboard.
The * acts as a placeholder for this special character. Now, replace the *
with the hex character 1 B. To do this, highlight the Special MENU (ID = 4 0 3)
and select Open General from the File menu (Figure 5.15)
Find the first * on the right side of the window and the corresponding
hex code for* (2A) on the left side. Select the 2A. Notice that a rectangle
appeared around the * on the right. Key in the characters 1 B. Repeat this
procedure for the second * on the right side of the window, and compare
your result with Figure 5.16. Finally, close the Special MENU window,
reopen it normally, and compare it with Figure 5.17.
Notice that the * placeholders have been replaced by the ASCII version
ofhex lB. That's because a hex lB in a MENU item's key equiv field tells
the Menu Manager to look for a hierarchical submenu. The Menu Manager
uses the value in the item's ma r k Ch a r field to indicate the resource ID of
a MENU to use as a hierarchical submenu. The Font item has an ASCII d in
the mark Ch a r field. ASCII d is equivalent to hex 64 , or 100 decimal.
Therefore, the Menu Manager will look for a MENU with resource ID = 10 0
to use as the Font hierarchical submenu. In the same way, the Style item
has ASCII e (101 decimal) in its mark Char field, so the Menu Manager
will look for a MENU with resource ID = 1 01 for the Style hierarchical
submenu. Now let's build these submenus.

Here's why you don't use 404 and 405 instead of 100 and 101 for
hierarchical submenu resource IDs. The hierarchical menu structure
was defined in Volume 5 oflnside Macintosh. Only two bytes are used
as a pointer to the hierarchical menus in the menu structure. Since the
biggest two-digit hexadecimal number is FF, or 255 decimal, that's
the biggest hierarchical menu number that you can use.

§0§ MENU ID = 403 from Timer Proj.Rsrc i
0193 0000 0000 0000 DlDDDDDD
000000
~
0000 FFFF FFFF 0753 DDDDDDDS
000008
000010
000018
000020
000028
000030
000038
000040
000048
000050
000058
000060
000068

7065 6369 616C 0446 pecialDF
6F6E 7400 1864 0005 ontDDdDD
5374 796C 6500 1865 StyleDDe
ao
0000

r§
~

Figure 5.16 The completed Special menu, using Open General.
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MENU "Special ID = 403 from Timer Proj.Rsrc
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menu ID
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title
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Figure 5.17 Special menu, opened normally.
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Close the Special MENU window. Create a new MENU resource and fill it
as shown in Figure 5.18. Note that the Font MENU has no menu items. As
with the menu, the items will be inserted from system resources. Change
the Font MENU resource ID to 10 0. Create another new MENU resource and
fill it as shown in Figure 5.19. Change its resource ID to 101. When you're
finished with the Font MENU, close and save your work.
You've completed the resources necessary for the window and menus of
Timer. Now, you'll create an Alert that is displayed when About Timer is
selected from the menu. For the moment, don't worry too much about the
alert mechanism (the ALRT and DITL resources). We'll cover alerts in
Chapter 6.

§0~

MENU "Font" ID= 100 from Timer Proj.Rsrc

menu ID

I100

width

0

height

0

proclD

0

filler

0

enableFlgs

$FFFFFFFF

title

Font

*****

0

Figure 5.18 Font MENU specifications.
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MENU "Style" ID = 1O1 from Timer Proj.Rsrc ~

menu ID
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0
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enableFlgs
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title
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Figure 5.19 Style MENU specifications.
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menu Item
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Ioutline
lo
I

D
D

lsoe

menu Item

Ishadow

icon#

lo

key equiu

D
D

mark Char
style

*****

I

ls10
0

Figure 5.19 Style MENU specifications (continued).

Create a DI TL resource (select New, enter DI TL, and select New again).
The DI TL (for Dialog Item List) contains the list ofitems you want to appear
in your alert. By convention, the first item is always the OK button that the
user clicks to make the alert disappear. Create a new item by selecting New
from the File menu, making it look like Figure 5.20. Close the Item #1
window and create a second item, making it look like Figure 5.21.
Close the Item #2 window. Now, choose Get Info from the File menu and
change the DITL resource ID to 4 0 0.
Next, you'll create an alert template to display the DI TL items. From the
Timer Proj. Rs re's main window, create a new ALRT resource. A new
ALRT menu should appear in ResEdit's menu bar. Select Display as Text
from the ALRT menu. Change the alert fields so they look like those in
Figure 5.22. Finally, change the AL RT resource ID to 4 00. All the resources
are now done. Select Quit from the File menu and save your changes. You're
ready to code!
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§0§ DITL " About " ID= 400 from Timer Proj.~
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Figure 5.20 The OK button.
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Figure 5.21 The About Box text.
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§0§ Alert 11 About 11 ID

= 400 from Timer P
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Figure 5.22 The About Alert,
displayed as text.

Timer Code
Some ofthis code can be cannibalized from EventTutor. Just be careful with
variable names and the like.
Get into THINK C, and start a new project in the Timer folder. Call the
project Timer Proj. Add MacTraps to your project. Now, add the code.

#define
#define
#define
#define

BASE_RES_ID
NI L_POINTER
MOVE_ TO_FRONT
REMOVE_ALL_EVENTS

400

//define
I/define
//define
#define
#define
#define
I/define

PLAIN
PLAI N_ITEM
BOLD_ITEM
ITALIC_ITEM
UNDERLINE_ ITEM
OUTLINE_ITEM
SHADOW_ ITEM

0
1

I/define INCLUDE_SECONDS

OL

-1
0

2
3

4
5
6

lldefi ne ADD_CHECK_MARK
I/define REMOVE_CHECK_MARK

TRUE
'
TRUE
FALSE

//define DRAG_ THRESHO LO

30

#define MIN_SLEEP
#define NI L_MOUSE_REGION

OL
OL
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#define WNE_TRAP_NUM
lldef i ne UNIMPL_TRAP_NUM

Ox60
Ox9F

#define OUIT_ITEM
#define ABOUT_ITEM

1
1

#define
#define
#define
/idef i ne
/idefi ne

NOT_A_NORMAL_MENU
APPLE_MENU_ID
FILE_MENU_ID
FONT_MENU_ID
STYLE_MENU_IO

-1
BASE_RES_ID
BASE_RES_ID+l
100
101

#define CLOCK_LEFT
#define CLOCK_TOP
#define CLOCK_SIZE

12
25
24

#define ABOUT_ALERT

400

WindowPtr
Boolean
1 ong
EventRecord
MenuHandle
int
Re ct
Style

gClockWindow:
gDone. gWNEimplemented:
gCurrentTime. gOldTime:
gTheEvent:
gAppleMenu. gFontMenu. gStyleMenu:
gLastFont:
gOragRect:
gCurrentStyle = PLAIN:

!******************************** main *********/

main C )
{

ToolBoxlnit():
Window In it ( ) :
SetUpDragRect<>:
MenuBarinit{):
Mainloop{):

/*********************************** ToolBoxinit */

ToolBoxinit()
{

InitGraf{ &thePort >:
InitFonts<>:
FlushEvents( everyEvent. REMOVE_ALL_EVENTS ):
InitWindows():
InitMenus():
TEinit():
InitDialogs( NIL_POINTER ):
InitCursor{):
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!************************************ Windowlnit

*/

Windowlnit()
{

gClockWindow

GetNewWindow( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT );
SetPort( gClockWindow );
ShowWindow( gClockWindow );
=

TextSize( CLOCK_SIZE );

/******************************** SetUpDragRect *********/

SetUpDragRect()
{

gOragRect = screenBits.bounds;
gOragRect.left += DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD;
gDragRect.bottom -= DRAG_THRESHOLD;

/***********************************

MenuBarlnit

MenuBarlnit()
{

Handle

myMenuBar;

myMenuBar
GetNewMBar( BASE_RES_ID );
SetMenuBar( myMenuBar );
gAppleMenu = GetMHandle( APPLE_MENU_ID );
gFontMenu = GetMenu( FONT_MENU_ID );
gStyleMenu = GetMenu( STYLE_MENU_ID );
InsertMenu( gFontMenu, NOT_A_NORMAL_MENU );
AddResMen u( g FontMen u, 'FONT' ) ;
InsertMenu( gStyleMenu, NOT_A_NORMAL_MENU );
Checkltem( gStyleMenu, PLAIN_ITEM, TRUE );
AddResMenu( gAppleMenu, 'DRVR' );
DrawMenuBar();
glastFont = l;
HandleFontChoice( glastFont );

*/
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!******************************** MainLoop *********/

MainLoop()
{

gDone = FALSE;
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) );
while ( gDone == FALSE )
{

HandleEvent();

!************************************* HandleEvent

*/

HandleEvent()
{

char

theChar;

if ( gWNEimplemented )
WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION ):
else
{

SystemTask():
GetNextEvent( everyEvent, &gTheEvent ):

switch ( gTheEvent.what )
{

case nullEvent:
Handl eNul 1 <):
break;
case mouseDown:
HandleMouseDown();
break:
case keyDown:
case autoKey:
theChar = gTheEvent.message & charCodeMask;
if (( gTheEvent.modifiers & cmdKey ) != 0)
HandleMenuChoice( MenuKey( theChar ) );
break;
case updateEvt:
BeginUpdate( gTheEvent.message );
EndUpdate( gTheEvent.message );
break;
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/******************************** HandleNull *********/

Handl eNul l ()
{

GetDateTime( &gCurrentTime );
if
gCurrentTime != gOldTime
{

DrawClock( gClockWindow );

/******************************** DrawClock *********/

DrawClock( theWindow )
WindowPtr
theWindow;
{

myTimeString;

Str255

IUTimeString( gCurrentTime. INCLUDE_SECONDS. myTimeString );
EraseRect( &< theWindow->portRect ) );
MoveTo( CLOCK_LEFT. CLOCK_TOP );
Drawstring( myTimeString );
gOldTime = gCurrentTime;

/************************************* HandleMouseDown */

HandleMouseDown()
{

WindowPtr
short int
long int

whichWindow:
thePart;
menuChoice, windSize;

thePart = FindWindow( gTheEvent.where, &whichWindow );
switch ( thePart )
{

case inMenuBar:
menuChoice = MenuSelect( gTheEvent.where );
HandleMenuChoice( menuChoice );
break:
case inSysWindow :
SystemClick( &gTheEvent, whichWindow );
break:
case inDrag :
DragWindow( whichWindow, gTheEvent.where. &gDragRect);
break;
case inGoAway :
gDone = TRUE:
break;
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/************************************* HandleMenuChoice */

HandleMenuChoice( menuChoice
long int
menuChoice:
I

int
int
if
I

theMenu;
the Item;
menuChoice != O )
theMenu = HiWord( menuChoice );
theltem = LoWord( menuChoice );
switch ( theMenu )
I

case APPLE_MENU_ID :
HandleAppleChoiceC theltem );
break:
case FI LE_MENU_ID :
HandleFileChoice( the Item ) :
break;
case FONT_MENU_ID :
HandleFontChoice( the Item ) :
break;
case STYLE_MENU_ID:
HandleStyleChoice( theltem >:
break;

I

HiliteMenu( 0

) ;

/********************************

HandleAppleChoice

*******/

HandleAppleChoice( theltem )
int
the Item;
(

Str255
int
short int
DialogPtr

accName:
accNumber:
itemNumber;
AboutDialog;

switch ( theltem )
I

case ABOUT_ITEM
NoteAlert( ABOUT_ALERT. NIL_POINTER );
break;
default :
Getltem( gAppleMenu. theltem. accName );
accNumber = OpenDeskAcc( accName );
break;
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!********************************

HandleFileChoice

*******/

HandleFontChoice

*******/

HandleFileChoice( theltem
int
the Item:
{

switch ( theltem )
{

case QUIT_ITEM
gDone = TRUE:
break:

!********************************

HandleFontChoice( theltem
int
the Item:
{

int
f ontNumber:
St r255 f ontName:
Checkltem( gFontMenu, gLastFont, REMOVE_CHECK_MARK ):
Checkltem( gFontMenu, theltem, ADD_CHECK_MARK ):
gLastFont = theltem:
Getltem( gFontMenu . theltem . fontName >:
GetFNumC fontName , &fontNumber >:
TextFont( fontNumber >:

!********************************

HandleStyleChoice

HandleStyleChoice( theltem
int
the Item:
{

switch( theltem )
{

case PLAIN_ITEM:
gCurrentStyle c PLAIN:
break:
case BOLD_ITEM:
if ( gCurrentStyle & bold )
gCurrentStyle
bold:
else
gCurrentStyle I= bold:
break:
case ITALIC ITEM:
if ( gCurrentStyle & italic )
gCurrentStyle
italic;
else
gCurrentStyle I= italic:
break:

*******/
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if ( gCurrentStyle & underline )
gCurrentStyle
underline;
else
gCurrentStyle I= underline;
break;
case OUTLINE_ITEM:
if ( gCurrentStyle & outline )
gCurrentStyle
outline;
else
gCurrentStyle I= outline;
break;
case SHADOW ITEM:
if ( gCurrentStyl e & shadow )
gCurrentStyle
shadow;
else
gCurrentStyle I= shadow;
break;
}

CheckStyles();
TextFace( gCurrentStyle );

/********************************

CheckStyles

*******/

CheckStyles()
I

Checkltem(
Check!tem(
Check!tem(
Check!tem(
Check!tem(
Check!tem(

gStyleMenu.
gStyleMenu.
gStyleMenu.
gStyleMenu.
gStyleMenu.
gStyleMenu.

PLAIN_ITEM. gCurrentStyle ==PLAIN );
BOLD_ITEM. gCurrentStyle & bold );
ITALIC_ITEM. gCurrentStyle & italic );
UNDERLINE_ITEM. gCurrentStyle & underline);
OUTLINE_ITEM. gCurrentStyle & outline );
SHADOW_ITEM, gCurrentStyle & shadow );

Running Timer
Now that your source code is in, you're ready to run Timer. Select Run from
the Project menu. When asked to "Bring the project up to date," click Yes.
Ifyou run into any compilation problems, consult the debugging tips found
in the appendix. When asked to "Save changes before running," click Yes.
Timer should now be up and running (see Figure 5.23).
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Figure 5.23 Running Timer.

Timer should display the time in a window in the upper left-hand corner.
The menu bar should display the , File, Edit, and Special menus. Desk
accessories should work. The File Menu has just one option, Quit, which
should be operational. The Edit menu contains the standard menu items
but is dimmed. The Special menu contains two hierarchical menu items:
Font and Style. Ifyou select Font, the hierarchical Font submenu should be
displayed (Figure 5.24a). If you select Style, the hierarchical Style submenu should be displayed (Figure 5.24b). Both hierarchical menus should
show a check mark next to the currently used font and style. If you change
the style or font with the menus, the appearance ofthe timer window should
change appropriately. Selecting About Timer from the menu should bring
up the alert that you just created. Click on the OK button (or hit return) to
make the alert disappear.
Choose Quit from the File menu. Let's look at the code.
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Figure 5.24 Timer hierarchical menus.
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Walking through the Timer Code
Timer starts off with a set of#d e fi nes. The first global, gCl ockWi ndow,
is the pointer to Timer's clock window. gDone and gWN EI mpl emented are
the same as in Chapter4's EventTutor. gCurrentTi me and gOl dTi me are
used to determine when to change the clock display. You'll use g Appl e Menu
when you add desk accessories to the menu. You'll use gFontMenu and
gStyl eMe nu when you add and remove check marks from the Font and
Style menus. g La s tF on t is used to determine the current font number in
use, gDragRect is the Rec t used to limit the dragging area of the clock
window, and gCurrent Sty l e contains the current style used by Timer.
#define
#define
#define
ftdefine

BASE_RE S_I D
NIL_PO INTER
MDV E_ TO_FRONT
REMOV E_AL L_EV ENTS

#define
#define
#define
ftd efi ne
#define
ftdefi ne
1/define

PLAIN
PLAIN_ ITEM
BOLD_ITEM
ITALIC_I TE M
UNDERLINE_ I TEM
OUT LI NE_ I TEM
SHADOW_ ITEM

400
OL
- ll
0

0
1
2

3

4
5
6
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I/define INCLUDE_SECONDS

TRUE

I/define ADD_CHECK_MARK
I/define REMOVE_CHECK_MARK

TRUE
FALSE

I/define DRAG_ TH RES HO LO

30

I/define MIN_SLEEP
I/define NIL_MOUSE_REGION

OL
OL

I/define WNE_TRAP_NUM
/fdef i ne UNIMPL_TRAP_NUM

Ox60
Ox9F

#define QUIT_ITEM
#define ABOUT_ITEM

1
1

#define
/fdefi ne
I/define
I/define
I/define

NOT_A_NORMAL_MENU
APP LE_MENU_ID
FILE_MENU_ID
FONT_MENU_ID
STY LE_MENU_I D

-1

BASE_RES_ID
BASE_RES_ID+l
100
101

I/define CLOCK_LEFT
I/define CLOCK_TOP
I/define CLOCK_SIZE

12
25
24

I/define ABOUT_ALERT

400

WindowPtr
Boolean
long
Event Record
MenuHandle
int
Re ct
Style

gClockWindow:
gDone. gWNEimplemented:
gCurrentTime. gOldTime:
gTheEvent:
gAppleMenu. gFontMenu. gStyleMenu:
glastFont;
gDragRect:
gCurrentStyle = PLAIN;

main () should be familiar. It calls Too 1 Box I nit C), Wi ndowI nit (),
and SetUpDragRect ( ). ThemenubaristheninitializedinMenuBa r I nit ( ),
and then Main Loop () is run:

!******************************** main *********/

main ( )
{

Tool Box I nit():
Windowlnit():
SetUpDragRect<>:
MenuBarlnit():
MainLoop();
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Tool Boxlni t() is unchanged:
/*********************************** ToolBoxlnit */

Tool Boxlni t()
{

InitGraf( &thePort );
I nit Fonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
Ini tCursor();
Wi ndowlni t() hasafewnewlinesinit. gCl ockWi ndowiscreatedfrom
the WI ND resource, made visible, and set as the current port. Then, the
standard text size is set to CL0 CK_ S I ZE.
/************************************ Windowlnit

*/

Windowlnit()
{

gClockWindow

GetNewWindow( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT );
SetPort( gClockWindow );
ShowWindow( gClockWindow );
=

TextSize( CLOCK_SIZE );
SetUpOragRect() is the same as in Chapter 4.
/******************************** SetUpDragRect *********/

SetUpDragRect()
{

gDragRect = screenBits.bounds;
gDragRect.left += DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD;
gDragRect.bottom -= DRAG_THRESHOLD;
You now have an initialization routine called MenuBarlnit().
MenuBa r I nit () starts off by calling GetNewMBar() to load the MBAR
resource you created into memory. GetNewMBar() automatically loads the
individual MENUs pointed to by the MBAR.
Then Set Menu Ba r ( ) tells the system to use the MB AR handled by
myMenuBa r as the current menu bar. (The phrase, "xxx is handled by
my Menu Ba r" really means that my Menu Ba r is a handle to xxx.)
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!***********************************

MenuBarlnit()

MenuBarlnit

*/

{

Handle

myMenuBar:

myMenuBar
GetNewMBar( BASE_RES_ID );
SetMenuBar( myMenuBar );
gAppleMenu = GetMHandle( APPLE_MENU_ID );
gFontMenu = GetMenu( FONT_MENU_ID );
gStyleMenu = GetMenu( STYLE_MENU_ID );
InsertMenu( gFontMenu, NOT_A_NORMAL_MENU ):
Add Res Menu ( g Fon tMen u, ·FONT' ) ;
InsertMenu( gStyleMenu, NOT_A_NORMAL_MENU );
Checkltem( gStyleMenu, PLAIN_ITEM, TRUE );
AddResMenu( gAppl eMenu, • DRVR' ) ;
OrawMenuBar();
gLastFont = 1;
HandleFontChoice( glastFont );
After that, the globals gApp 1 eMenu, g FontMenu, and gStyl eMenu are
set to handle their respective MENU data structures. InsertMenLI() is
called to add the Font hierarchical submenu to the Menu Manager's list of
available menus. The NOT_A_NORMAL_MENU parameter tells the Menu
Manager not to place the Font menu directly on the menu bar. Add Res Men LI ( )
adds the name of all resources of type FONT to the Font menu. Next,
I n s e rt Men LI ( ) is called for the Style hierarchical submenu. A check mark
is placed next to the PLA I N item on the Style menu with the call to
Check I t em ( ).You use the handle to the
menu so you can add desk
accessories to it via the call to Add Res Menu (). All desk accessories are
resources of type DRVR. Add Res Men LI () looks for all resources of the
specified type (we specified DRV R) and adds the resource names found to the
specified menu.
Next, DrawMenuBa r () drawsthemenubar,and Handl eFontChoi ce ()
sets the current font to the first font on the Font menu.
Main Loop () is the same as in Chapter 4:
/******************************** Mainloop *********/

Mainloop()
{

gDone = FALSE;
gWNEimplemented
ToolTrap ) !=
ToolTrap) );
while ( gOone
I

NGetTrapAddress( WNE_TRAP_NUM,
NGetTrapAddress( UNIMPL_TRAP_NUM,
FALSE

Handl eEvent();
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Hand 1e Event ( ) is very similar to the version in Chapter 4. Start by
checking for the existence of Wai t Next Ev en t ( ) and then make the
appropriate call. Then, switch on gTheEvent. what. nul 1 Events are
handledbytheroutineHandl eNul 1 ( ).Asusual,mouseDowns are handled
by Handl eMouseDown( ). keyDown and autoKey events are handled by
the same code. In either case, check to see if the command 38 key was
depressed when the event occurred. If it was, convert the keystroke to a
menu selection via MenuKey() and pass that result to
Ha n d 1 e Menu Cho i c e ( ). Finally, handle update Ev t s by calling
Beg i n Update ( ) and End Update ( ) .
Since update Ev ts have a higher priority than nu 11 Ev t, itis imperative
that you respond to every update Ev t by calling Beg i n Update ( ) and
End Update ( ) . If you didn't, the Window Manager would keep
queueing update Ev ts, thinking you hadn't received them, and no
nu 11 Ev ts would ever make it into the event queue. One type of event
can prevent another from making it into the event queue because the
queue is finite. If the queue is big enough for 20 events, and 20
updateEvts are pending, there's no room for even one null Evt.

/************************************* HandleEvent

*/

HandleEvent()
{

char

theChar;

if ( gWNEimplemented )

else

WaitNextEvent( everyEvent. &gTheEvent, MIN_SLEEP.
NIL_MOUSE_REGION );

{

SystemTask();
GetNextEvent( everyEvent. &gTheEvent );
switch ( gTheEvent.what )
{

case nullEvent:
Handl eNul 1 ();
break;
case mouseDown:
HandleMouseDown();
break;
case keyDown:
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case autoKey:
theChar = gTheEvent.message & charCodeMask:
if CC gTheEvent.modifiers & cmdKey ) != 0)
HandleMenuChoice( MenuKey( theChar ) ):
break;
case updateEvt:
BeginUpdateC gTheEvent.message ):
EndUpdate( gTheEvent.message ):
break:

Hand 1 e Nu 1 1 ( ) is called whenever a nu 1 1 Event is retrieved from the
event queue. Hand 1 e Nu 11 ( ) checks the current time (in seconds) and
compares it to the last check performed. If the time has changed, the clock
window is refreshed.

/******************************** HandleNull *********/

Handl eNul 1 ()
{

GetDateTime( &gCurrentTime );
if
gCurrentTime != gOldTime
{

DrawClock( gClockWindow ):

DrawCl oc k () calls the International Utility I UTi me String () to get
the current time in a format suitable for display. Next, the window is
erased, the pen is positioned, and the new time string is drawn. Finally,
gOl dTi me is updated.

/******************************** DrawClock *********/

DrawClock( theWindow )
WindowPtr
theWindow:
{

Str255

myTimeString:

IUTimeString( gCurrentTime, INCLUDE_SECONOS,
myTimeString ):
EraseRect( &C theWindow->portRect ) ):
MoveTo( CLOCK_LEFT, CLOCK_TOP );
Drawstring( myTimeString ):
gOldTime = gCurrentTime;
Handl eMouseDown () issimilartoitsChapter4counterpart. Fi ndWi nd ow ( ) is called, returning a part code that indicates the part of the window
in which the mouseDown event occurred. In addition, Fi ndWi ndow () sets
whi chWi ndow to the window in which the mouseDown occurred.
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If the mouse Down occurred in the menu bar, MenuSel ect() is called,
allowing the user to make a selection from the menu bar. The user's
selection is passed on to Hand 1 eMenu Choi c e ( ) .
The rest of the part codes are handled as they were in Chapter 4.

!************************************* HandleMouseDown */

HandleMouseDown()
{

WindowPtr
short int
long int

whichWindow;
thePart;
menuChoice, windSize;

thePart = FindWindow( gTheEvent.where, &whichWindow );
switch ( thePart )
{

case inMenuBar:
menuChoice = MenuSelect( gTheEvent.where );
HandleMenuChoice( menuChoice );
break:
case inSysWindow :
SystemClick( &gTheEvent, whichWindow );
break;
case inDrag :
DragWindow( whichWindow, gTheEvent.where,
&gDragRect);
break:
case inGoAway :
gDone =TRUE;
break;

Hand 1 eMenu Choi c e ( ) takes a four-byte argument. The first two bytes
contain the menu selected, and the last two bytes contain the item selected
from that menu. First, the Men u is set to the first two bytes and the I t em
to the last two bytes. After that, th eMe nu is compared against the four MENU
resource IDs to find which one was selected. A different routine exists for
each of the four menus. When Menu Se 1 ect ( ) was called, the selected
menu title was left inverted. When you finish processing the menu selection, the menu title is uninverted with a call to Hi 1 i teMen u ( 0 ) (1:357).

!************************************* HandleMenuChoice */

HandleMenuChoice( menuChoice
long int menuChoice;
{

int
int

theMenu;
the Item;
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if

menuChoice != 0 )

{

theMenu = HiWord( menuChoice );
theltem = LoWord( menuChoice );
switch ( theMenu )
{

case APPLE_MENU_IO :
HandleAppleChoice( theltem );
break:
case FI LE_MENU_IO :
HandleFileChoice( the Item ) ;
break;
case FONT_MENU_IO :
HandleFontChoice( the Item ) ;
break;
case STYLE_MENU_ID:
HandleStyleChoice( theltem );
break:
}

HiliteMenu( 0

);

s

Ha nd 1eAppl eChoi c e ( ) handles all
menu selections. If the About
Timer menu item is selected, the alert with resource ID= ABOUT_ALERT is
drawn with NoteA 1ert ().Alerts are discussed in more detail in Chapter
6. Any other item selected is assumed to be a desk accessory. The name of
the desk accessory is retrieved with Get I t em ( ) • and the desk accessory is
opened with Open Des kAcc ().

/***************************HandleAppleChoice

*******/

HandleAppleChoice( theltem
int
the Item:
{

Str255
int
short int
DialogPtr

accName:
accNumber:
itemNumber;
AboutDialog;

switch ( theitem )
{

case ABOUT_ITEM :
NoteAlert( ABOUT_ALERT, NIL_POINTER );
break:
default :
Getitem( gAppleMenu. theltem, accName );
accNumber = OpenDeskAcc( accName );
break:
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Because there's only one item under the File menu, the code for
Handl eFi 1eChoi ce() is pretty simple. The global variable done is set to
TRUE if Quit is selected. The value of g Done is checked every time through
the main loop. When gDone =TRUE, the program knows that it's time to
exit.

/*************************

HandleFileChoice

*******/

HandleFileChoiceC theltem
int
the Item:
{

switch ( theltem )
{

case OUIT_ITEM :
gDone "" TRUE;
break:

The Edit menu is in this application only to support desk accessories. All
items were dimmed when you created the MENU resource. Since you don't
care what happens as far as your application is concerned, you need not do
anything.
Actually, we've only done half the job so far; although Timer allows
the use of desk accessoriest the cut, copy, paste commands are not yet
supported. We'll add this in Chapter 7's WindowMaker program.

The Font menu is displayed when the Font item in the Special menu is
selected. The first Check I tern ( ) call removes the check mark from whatever had been the last font selected. Then, the same call is used to place a
check mark on the newly selected font. Then, glastFont is set to the
selecteditemnumber.Next, the Get Item() callreturnsthe fontNamefor
the menu selection that you picked. Get FN um ( ) provides the font number
given the fontName, and finally the ont of the text is changed with the
Text Font() call, given the font ID number.

/************************** HandleFontChoice

HandleFontChoice( theltem
int
the Item;
I

int
fontNumber;
St r255 f ontName:

*******/
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Checkltem( gFontMenu, glastFont, REMOVE_CHECK_MARK );
Checkltem( gFontMenu, theltem, AOD_CHECK_MARK );
gLastFont = theltem;
Getltem( gFontMenu, theltem • fontName );
GetFNum( fontName, &fontNumber );
TextFont( fontNumber );

The Style hierarchical submenu controls gCurrent Sty l e. When a style
is selected, it must be checked against gCur rent Sty 1e. If the style is
currently in use, it must be removed, and vice versa. Check Sty 1 es ( ) is
then called to update the check marks on the Style menu. Finally,
Text Face() is called to implement the styles in gCurrentStyl e.
/************************** HandleStyleChoice

***/

HandleStyleChoice( theltem
int
the Item:
{

switch( theltem )
{

case PLAI N_ITEM:
gCurrentStyle = PLAIN;
break;
case BOLO_ITEM:
if ( gCurrentStyle & bold )
gCurrentStyle
bold;
else
gCurrentStyle I= bold:
break:
case ITALIC_ITEM:
if ( gCurrentStyle & italic )
gCurrentStyle
italic:
else
gCurrentStyle I= italic;
break;
case UNDERLINE_ITEM:
if ( gCurrentStyle & underline )
gCurrentStyle
underline;
else
gCurrentStyle I= underline;
break;
case OUTLINE_ITEM:
if ( gCurrentStyle & outline )
outline;
gCurrentStyle
else
gCurrentStyle I= outline;
break;
case SHADOW_ITEM:
if ( gCurrentStyle & shadow )
gCurrentStyle
shadow;
else
gCurrentStyle I= shadow:
break:
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case SHADOW_ITEM:

if ( gCurrentStyle

else
break;

& shadow )

gCurrentStyle

shadow;

gCurrentStyle I= shadow;

}

CheckStyles();
TextFace( gCurrentStyle );
CheckStyl es () steps through each item in the Style menu, placing a
check mark next to those styles set in gCurrent Sty l e:

!********************************

CheckStyles

*******/

CheckStyles()
{

Checkltem( gStyleMenu,
PLAIN ) ;
Checkltem( gStyleMenu,
Checkltem( gStyleMenu,
italic):
Checkltem( gStyleMenu,
underline);
Check!tem( gStyleMenu,
outline );
Checkltem( gStyleMenu,
shadow );

PLAIN_ITEM, gCurrentStyle ==
BOLD_ITEM, gCurrentStyle & bold);
ITALIC_ITEM, gCurrentStyle &
UNDERLINE_ITEM, gCurrentStyle &
OUTLINE_ITEM. gCurrentStyle &
SHADOW_ITEM, gCurrentStyle &

That's it for our discussion of Timer. With this code, you should be able
to add pull down and hierarchical menus to your programs. The last menu
type, pop-up menus, are explored in the next program.

_J

Zinger
Zinger opens a window on the desktop and implements a pop-up menu of
numbers inside the window. When a number is selected from the pop-up,
Zinger beeps that number of times and resets the value on the face of the
pop-up to reflect this selection.
Zinger works like this:
• It initializes the Toolbox, window, and drag Re ct.
• It initializes the pop-up menus, drawing the pop-up for the first time.
• It activates the pop-up menu when a mouseDown occurs in the menu
rectangle, and redraws the pop-up when an updateEvt occurs.
• Finally, Zinger quits when the window's close box is clicked.
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Since you've seen much of Zinger's code in previous chapters, we'll
concentrate on the code that makes the pop-up menu work. Start by
building a folder called Zi ng e r for the project files.
Next, create a resource file called Zinger Proj. Rsrc. Then, build a
resource of type MENU with ID= 400 and with the specifications in Figure
5.25 (see page 188). Build a WIND with the specifications of Figure 5.26 (see
page 189). Now, startanewprojectcalled Zinger Proj, add Ma cTraps to
it, and type in the following code:

#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

400
OL
-1 L
0

#define MIN_SLEEP
#define NIL_MOUSE_REGION

OL
OL

#define DRAG_ THRESHOLD

30

#define WNE_TRAP_NUM
#define UNIMPL_TRAP_NUM

Ox60
Ox9F

BASE RES_ ID
#define POPUP_MENU_ID
#define NOT_A_NORMAL_MENU -1
#define
#define
#define
#define
#define
#define
#define
#define
#define

POPUP_LEFT
100
POPUP_TOP
35
POPUP_RIGHT
125
POPUP_BOTTOM
52
SHADOW_PIXELS
1
RIGHT_MARGIN
5
4
BOTTOM_MARGIN
LEFT_MARGIN
5
PIXEL_FOR_TOP LI NE 1

Boolean
int
MenuHandle
EventRecord
Re ct

gDone, gWNEimplemented;
gPopUpitem = 1, gPopUpLabelWidth;
gPopUpMenu;
gTheEvent;
gPopUpRect. gLabelRect. gDragRect;

/*********************** Main *************/

ma i n( )
{

Tool Boxlni t();
Wi ndowlni t();
SetUpDragRect();
MenuBarinit();
DrawPopUp ( ) ;
Mainloop();
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/*********************************** ToolBoxinit */
Tool Box I nit()
{

InitGraf( &thePort );
InitFontsC);
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEI nit():
InitDialogs( NIL_POINTER );
Ini tCursor():

/*********************Windowlnit**************/
Windowlnit()
{

WindowPtr

popUpWindow:

popUpWindow = GetNewWindow( BASE_RES_ID , NIL_POINTER,
MOVE_TO_FRONT ) :
ShowWindow( popUpWindow );
SetPort( popUpWindow );
TextFont( systemFont );
TextMode( srcCopy );

/******************************** SetUpDragRect *********/
SetUpDragRect()
{

gDragRect = screenBits.bounds:
gDragRect.left += DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD:
gDragRect.bottom -= DRAG_THRESHOLD:

/*********************MenuBarlnit**************/
MenuBarlnit()
{

gPopUpMenu = GetMenu( POPUP_MENU_ID );
InsertMenu( gPopUpMenu, NOT_A_NORMAL_MENU );
Hlock( gPopUpMenu );
gPopUplabelWidth = StringWidth( (**gPopUpMenu).menuData );
HUnlock( gPopUpMenu );
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/********************* DrawPopUp **************/
DrawPopUp()
{

SetRect( &gPopUpRect. POPUP_LEFT. POPUP_TOP.
POPUP_RIGHT. POPUP_BOTTOM );
FrameRect( &gPopUpRect );
MoveTo( gPopUpRect.left+SHADOW_PIXELS. gPopUpRect.bottom );
LineTo( gPopUpRect.right. gPopUpRect.bottom );
LineTo( gPopUpRect.right. gPopUpRect.top+SHADOW_PIXELS );
MoveToC gPopUpRect.left - gPopUplabelWidth - RIGHT_MARGIN,
gPopUpRect.bottom - BOTTOM_MARGIN );
HLockC gPopUpMenu );
Drawstring( (**gPopUpMenu).menuData );
HUnlockC gPopUpMenu >:
gLabelRect.top = gPopUpRect.top + PIXEL_FOR_TOP_LINE;
gLabelRect.left = gPopUpRect.left - gPopUplabelWidth
- LEFT_MARGIN - RIGHT_MARGIN:
gLabelRect.right = gPopUpRect.left:
gLabelRect.bottom = gPopUpRect.bottom:
DrawPopUpNumber();

/********************* DrawPopUpNumber **************/
DrawPopUpNumber()
{

Str255 menu Item;
int
itemLeftMargin;
Getltem( gPopUpMenu. gPopUpltem. &menultem );
itemLeftMargin = ( gPopUpRect.right - gPopUpRect.left StringWidth( menultem ) ) I 2;
MoveToC gPopUpRect.left + itemLeftMargin,
gPopUpRect.bottom - BOTTOM_MARGIN );
Drawstring( menultem );

/******************************** Mainloop *********/
Mainloop()
{

gDone = FALSE;
gWNElmplemented
while ( gDone

==

NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM. ToolTrap ) );
FALSE )

= (

{

HandleEvent();
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!************************************* HandleEvent

*/

HandleEvent()
{

if ( gWNEimplemented )
WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
else
{

SystemTask();
GetNextEvent( everyEvent, &gTheEvent );
switch ( gTheEvent.what )
{

case mouseDown:
HandleMouseDown();
break;
case updateEvt:
BeginUpdate( gTheEvent.message );
DrawPopUp();
EndUpdate( gTheEvent.message );
break;

/************************************* HandleMouseDown */

HandleMouseDown()
{

WindowPtr
short int
1ong int
Point

whichWindow;
thePart, i;
theChoice;
myPoint, popUpUpperLeft;

thePart = FindWindow( gTheEvent.where, &whichWindow );
switch ( thePart )
{
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case inContent:
myPoint = gTheEvent.where:
GlobalTolocalC &myPoint ):
if ( PtlnRect( myPoint, &gPopUpRect ) )
{

InvertRect( &gLabelRect ):
popUpUpperleft.v = gPopUpRect.top +
PIXEL_FOR_TOP_LINE:
popUpUpperLeft.h = gPopUpRect.left:
LocalToGlobal( &popUpUpperleft >:
theChoice = PopUpMenuSelectC gPopUpMenu.
popUpUpperLeft.v. popUpUpperleft.h,
gPopUpltem >:
InvertRectC &gLabelRect >:
if ( LoWordC theChoice ) > O )
{

gPopUpltem = LoWord( theChoice >:
DrawPopUpNumberC>:
for < i=O: i <gPopUpltem: i++ )
SysBeepC 20 ):
}

break:
case inSysWindow:
SystemClick( &gTheEvent, whichWindow >:
break:
case inDrag:
DragWindow( whichWindow. gTheEvent.where. &gDragRect):
break:
case inGoAway :
gDone = TRUE:
break:
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Save your code as Zinger.c and add it to the project. When you run the
program, you should get a window with a pop-up box in it (Figure 5.27).
When you select a number on the menu, Sys Beep should sound for the
number of times that you selected. If you don't hear anything, check the
volume in the control panel. If it's all right, check your code.

_J

Walking through Zinger
Zinger starts, as usual, with 11 def i nes, followed by declaration ofits global
variables:

#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT -ll
REMOVE_ALL_EVENTS

400
OL
0

#define MIN_SLEEP
#define NIL_MOUSE_REGION

OL
OL

#define DRAG_ THRESHOLD

30

#define WNE_TRAP_NUM
#define UNIMPL_TRAP_NUM

Ox60
Ox9F

#define POPUP_MENU_ID
#define NOT_A_NORMAL_MENU

BASE_ RES_ID
-1

#define
#define
#define
#define
#define
#define
#define
#define
#define

POPUP_LEFT
POPUP_TOP
POPUP_RIGHT
POPUP_BOTTOM
SHADOW_P IX ELS 1
RIGHT_MARGIN
BOTTOM_MARGIN 4
LEFT_MARGIN
PIXEL_FOR_TOP_LINE

Boolean
int
MenuHandle
EventRecord
Re ct

100
35

125
52
5
5

1

gDone, gWNEimplemented;
gPopUpltem = 1, gPopUplabelWidth;
gPopUpMenu;
gTheEvent;
gPopUpRect, gLabelRect, gDragRect;
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,.

.,

Figure 5.27 Zinger!

ma i n ( ) is much like its Timer counterpart, except that it calls
DrawPopUp () before it enters the Main Loop () :
/*********************** Main *************/
main ( )
{

Tool Boxini t() ;
Wi ndowlni t() ;
SetUpDragRect() ;
MenuBarlnit() ;
DrawPopUp() ;
Mainloop() ;
Tool Box I n i t ( ) remains the same as in previous incarnations:
/******************************~****

Too lBox l nit */

Tool Boxlni t()
{

InitGraf( &thePort ) ;
InitFonts(l ;
FlushEvents( everyEvent . REMOVE_ALL_EVENTS ) ;
InitWindows();
InitMenus() ;
TEinit() ;
InitDialogs( NIL_ POINTER ) ;
Ini tCursor () ;
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Wi ndow In i t ( ) may give you a sense of deja vu, as well. The
popUpWi ndow ( ) is loaded, made visible, and made the current port. Next,
the font is changed to system Font, the same font used to draw the regular
pull-down menus. The s r c Copy text mode is used to simplify drawing ofthe
pop-up menu item. With s r c Copy enabled, text drawn in a window
overlays existing graphics.

/*********************Windowlnit**************/
Windowlnit()
{

popUpWindow:

WindowPtr
popUpWindow

GetNewWindow( BASE_RES_ID . NIL_POINTER.
MOVE_TO_FRONT ) :
ShowWindow( popUpWindow ):
SetPort( popUpWindow >:
TextFontC systemFont >:
TextMode( srcCopy ):
=

Set Up Dr agRec t ( ) is identical to the Timer version:

/******************************** SetUpDragRect *********/
SetUpDragRect()
{

gDragRect = screenBits.bounds:
gDragRect.left += DRAG_THRESHOLD:
gDragRect.right -= DRAG_THRESHOLD:
gDragRect.bottom -= DRAG_THRESHOLD;
In Menu Ba r I n i t ( ) , just as you did with the hierarchical menus in '
Timer, you load the MENU and add it to the menu list via the call to
I nse rtMenu ( ) . Next, get the pop-up label from the menu data structure
and calculate its width in pixels. You'll use this information later.

/*********************MenuBarlnit**************/
MenuBarlnit()
{

)

:

gPopUpMenu = GetMenu( POPUP_MENU_ID );
InsertMenu( gPopUpMenu. NOT_A_NORMAL_MENU ):
HLock( gPopUpMenu );
gPopUplabelWidth = StringWidth( (**gPopUpMenu).menuData
HUnlock( gPopUpMenu ):
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DrawPopUp() will draw the pop-up outline, its one-pixel drop shadow,
the pop-up label, and set g La be 1 Rec t, which you'll invert when the popup is selected. DrawPopUp() will also be called to handle updateEvts.
After the background is drawn, call DrawPopUpNumber() to draw the
current menu value-in this case, a number.

/********************* DrawPopUp **************/
DrawPopUp()
{

SetRect( &gPopUpRect. POPUP_LEFT. POPUP_TOP.
POPUP_RIGHT. POPUP_BOTTOM );
FrameRect( &gPopUpRect );
MoveTo( gPopUpRect.left+SHADOW_PIXELS. gPopUpRect.bottom );
LineTo( gPopUpRect.right. gPopUpRect.bottom );
LineTo( gPopUpRect.right. gPopUpRect.top+SHADOW_PIXELS );
MoveTo( gPopUpRect.left - gPopUplabelWidth - RIGHT_MARGIN.
gPopUpRect.bottom - BOTTOM_MARGIN );
Hlock( gPopUpMenu );
Drawstring( (**gPopUpMenu).menuData );
HUnlock( gPopUpMenu );
glabelRect.top = gPopUpRect.top + PIXEL_FOR_TOP_LINE;
gLabelRect.left = gPopUpRect.left - gPopUpLabelWidth
- LEFT_MARGIN - RIGHT_MARGIN:
gLabelRect.right = gPopUpRect.left:
gLabelRect.bottom = gPopUpRect.bottom:
DrawPopUpNumber();
DrawPopUpNumber() gets the menu item corresponding to gPopUp It em, calculates the margin, and draws it:

/********************* DrawPopUpNumber **************/
DrawPopUpNumber()
{

Str255 menuitem;
int
i temleftMa rg in;
Getitem( gPopUpMenu. gPopUpitem. &menultem );
itemleftMargin = ( gPopUpRect.right - gPopUpRect.left StringWidth( menultem ) ) I 2;
MoveToC gPopUpRect.left + itemleftMargin.
gPopUpRect.bottom - BOTTOM_MARGIN );
Drawstring( menuitem );
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Main Loop ( ) works as it did in Timer:

!******************************** MainLoop *********/

MainLoop()
{

gOone == FALSE:
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) ):
while ( gDone == FALSE )
{

HandleEventC>:

/************************************* HandleEvent

*/

HandleEvent()
{

if C gWNEimplemented >
WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
else
{

SystemTask();
GetNextEventC everyEvent. &gTheEvent >:
switch C gTheEvent.what )
(

case mouseDown:
HandleMouseDown():
break:
When Zinger gets an updateEvt, it redraws the pop-up menu:

case updateEvt:
BeginUpdate( gTheEvent.message ):
DrawPopUp ():
EndUpdate( gTheEvent.message ):
break:

If the mouse was clicked in the window, copy the Point, convert it to the
window's local coordinate system, and check to see ifit's inside gPop Up Rec t.
Ifso ...
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/******************************** HandleMouseDown */

HandleMouseDown()
{

WindowPtr
short int
long int
Point

whichWindow;
thePart, i;
theChoice;
myPoint, popUpUpperleft;

thePart = FindWindow( gTheEvent.where, &whichWindow );
switch ( thePart )
{

case inContent:
myPoint = gTheEvent.where;
GlobalTolocalC &myPoint );
if ( PtinRect( myPoint, &gPopUpRect ) )
{

... invert the label and use gPop Up Rec t to determine where the pop-up
menu should appear. Since PopUpMenuSel ect() works with global coordinates, call Loe al ToGl oba l () to convert popUpUpperleft. Next, call
Pop Up Menu Se l e ct ( ) to implement the pop-up menu. Then, uninvert the
label. Finally, handle the selection by calling Sys Beep ( ) the selected
number of times. gPopUpitem is set to the selected item number, so the
next time the pop-up appears, g Pop Up I t em will be the default.
Some versions of Apple's system software experiences problems with
the SysBeep() call. If you experience problems with Zinger, do not
adjust your set. The problem may be with your system.

InvertRect( &glabelRect );
popUpUpperleft.v = gPopUpRect.top +
PIXEL_FOR_TOP_LINE;
popUpUpperleft.h = gPopUpRect.left:
LocalToGlobal( &popUpUpperleft ):
theChoice = PopUpMenuSelect( gPopUpMenu,
popUpUpperleft.v, popUpUpperleft.h,
gPopUpitem );
InvertRect( &gLabelRect );
if C LoWordC theChoice > > O )
I

}

break;

gPopUpitem = LoWord( theChoice );
OrawPopUpNumber();
for C i=O; i<gPopUpitem; i++ )
SysBeepC 20 );
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case inSysWindow:
SystemClick( &gTheEvent, whichWindow );
break:
case inDrag:
DragWindow( whichWindow. gTheEvent.where. &gDragRect):
break:
case inGoAway :
This is not the way "proper" Macintosh applications exit. You would
normally use a Quit item in the File menu.

gDone = TRUE:
break:

_J

In Review
Menus are an intrinsic part of the Macintosh interface. Designing them
correctly allows the developer to take advantage of the familiarity of users
with standard Mac menus. The standard pull-down menu does the job for
many applications, and hierarchical and pop-up menus bring freshness to
the interface.
In Chapter 6, you'll learn about another essential part of the Mac
interface: creating and controlling dialog boxes. While you're there, you'll
also look at one of the newest managers on the Macintosh: the Notification
Manager.

6

Working with
Dialogs
In a dialog box, the computer presents a
list of alternatives for the user to choose
from. Alerts are simplified dialogs, used
to report errors and give warnings to
the user. Chapter 6 discusses both of
these, along with the Notification
Manager, Apple's new background
notification mechanism.

DIALOGS ARE AN important part of the Macintosh interface; they provide
a friendly, standardized way of communicating and receiving feedback
from the user. Some dialogs ask questions of the user, as in Figure 6.1.
Others offer the user the opportunity to modify current program parameters (Figure 6.2). Some dialogs are the direct result of a user menu
selection. For example, when you select Print... from within an application, the Print Job dialog appears (Figure 6.3).
Dialogs that appear as a direct result of menu commands give you a
chance to change your mind (with the Cancel button), to continue on as
planned (with the OK button), or to change things around a bit before
continuing.

By convention, menu items that spawn dialog boxes always end with

an ellipsis( ... ). For example, the Print... item on the File menu brings
up a print dialog box.
Another important part of the Mac Interface is the alert mechanism.
Alerts (Figure 6.4) are simplified dialogs, used to report errors and give
warnings to the user. From a programmer's point of view, alerts are easier
to deal with than dialogs, so we'll use them when we can.

Please Type In Your Name:

IBill

11

11

P.H. Wagonbakerl

Cancel

OK

Figure 6.1 "Whzt's Your Name?" dialog box.
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Figure 6.2 Page Setup dialog box.
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Figure 6.3 Print Job dialog box.
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memory to edit another
document.

ll

OK

ll

Figure 6.4 An Alert!

Chapter 6 also presents the Notification Manager, Apple's newest
addition to the Toolbox. The Notification Manager is designed to work with
MultiFinder, so that a program not currently in the foreground has a way
of notifying the user of an important event.

_J

How Dialogs Work
Dialog boxes consist of a window and a list of dialog items. When the dialog
first appears, each item on the dialog item list is drawn. Typical dialog
items include check boxes, radio buttons, and push buttons. These items
are called controls. In addition, static text fields, editable text fields, PICT s,
and IC 0 Ns may also be part of an item list (Figure 6.5). Every dialog box has
at least one exit item (by convention, most dialog boxes offer an OK button
for this purpose). There are two different kinds of dialogs: modal dialogs
and modeless dialogs.

Modal Dialogs
A modal dialog is one to which the user must respond before the program
can continue. Modal dialogs are used for decisions that must be made
immediately. They represent the vast majority of dialog boxes.

200

Macintosh Programming Primer

[

Selected Radio Button

L

J

[ Radio Button

~

I mageWrite;z
Paper:
®us Letter
0 US Legal
O Computer Paper
Special Effects:
Orientation

z

Static Teat
]

Copies:
Paper Feed:

~

(Cancel )

D Tall Adjusted

I

Checked Check Boa

J
[

J

I mageWri1er
Page Range:

OK

3 Reduction
No 6ops Between Pages

l Check DOH J

Quality:

([

v2.7

O A4 Letter
O International Fanfold

L1815D
i

·~
[

J

v2,1

QBest
@All

D

®Automatic

0 Faster
O From:

D

OHondFeed

Button

((

®Draft
To:

D
~

OK

J
l)

( Cancel )

" l

Editable Teat

Figure 6.5 Dialog items.

The Macintosh is generally a modeless machine. This means that
most of the operations performed by an application are available to
the user most of the time. For example, most of the operations
performed by THINK Care available via pull-down menus. Modal
dialogs come into play when you must focus the user's attention on a
specific task or issue. Alerts are always modal. Dialog boxes aren't
always modal.

Modeless Dialogs
Modeless dialogs act more like regular windows; they appear to the user
like any other window and can be brought to the front with a mouse click,
or even dragged around the screen. Whereas modal dialogs require an
immediate response from the user, modeless dialogs may be set aside until
they are needed. The algorithms used to implement modal and modeless
dialogs are quite different.
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The Modal Dialog Algorithm
• First, load the dialog (including the dialog's item list) from the resource
file using GetNewDi a1 og ( ) .
• Then, make the dialog window visible (just as you would a new window).
• Next, enter a loop, first calling Mod a1Dia1 og () to find out which item
the user selected, then processing that item. When an exit item (like OK
or Cancel) is selected, exit the loop.

The Modeless Dialog Algorithm
• First, load the dialog and make it visible (as was done with the modal
dialog).
• As an event is returned by GetNextEvent () or Wai tNextEvent ().
pass it on to I s Di a 1 og Event ( ) .

• If Is Di al ogEvent() returns FALSE, the event is not related to the
dialog and should be handled normally. Otherwise, the event should be
passed to Di a 1ogSe1 ect ( ) .
• Di a1 o g Se 1 e ct ( ) returns a pointer to the dialog box whose item was
selected, as well as the number of the item selected by the user. Process
the item as you would with Modal Di al og ().
Let's look at the types of items found in dialogs.

_J

Dialog Items: Controls
One of the most important types of dialog items is the control. Controls are
items that exist in at least two different states. For example, the check box
can be checked or unchecked (Figure 6.6).Although controls may be defined
by the program designer, four controls are already defined in the Toolbox.
They are: buttons, check boxes, radio buttons, and dials.
These controls fall under the jurisdiction of the Control Manager,
which handles the creation, editing, and use of controls.

D Check
181 Check

n

boH # 1
BoH #2

OK

D
Figure 6.6 The Checkbox.
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Buttons
The classic example of a button is the OK button found in most dialog boxes
(Figure 6. 7). When the mouse button is released with the cursor inside the
button, the button's action is performed. For example, clicking an OK
button might start a print job or save an application's data. Those ofyou who
are familiar with HyperCard should note the similarity of HyperCard
buttons to Toolbox buttons. Toolbox buttons are generally rounded-corner
rectangles, whereas HyperCard buttons have more variation in shape and
appearance.

Check Boxes
Check boxes are generally used to set options or arguments of an action.
For example, you might use a check box to determine whether the user
wants sound turned on or off in an application (Figure 6.8).

Radio Buttons
Radio buttons are similar to check boxes in function, in that they also are
used to set options or choices in a dialog box. Figure 6.9 shows some radio
buttons. The difference between radio buttons and check boxes is that the
choices displayed in radio buttons are mutually exclusive. Radio buttons
appear in sets, and one and only one radio button in a set may be on (or
highlighted) at any given time (Figure 6.10).

Scale selection to:

1-13
( Cancel )
Figure 6. 7 The Button.

Options Set: [81 Sound On
[81 Aduanced Leuel

n

OK

D
Figure 6.8 Check box example.
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Measurement Type
®inch

Qcm

([

JJ

OK

Figure 6.9 Radio button example.

Your Order:

How Much Do You Make?

® Hamburgers
® French Fries
®Coca-Cola

O I make a lot of money
O I make enough money
® Got a nickel?

OK

OK

Wrong Way: radio buttons
should indicate mutually
eHclusiue options.

Right Way: Only one of the
options would reasonably
be picked.

Figure 6.10 Radio button pointers.

Dials
Dials are different from other controls: They display and supply qualitative instead of off/on information. The only dial controls predefined in the
Toolbox are scroll bars (Figure 6.11), which are an integral part of many
Mac application windows. In Chapter 7, we'll show you how to set up a scroll
bar.
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Figure 6.11 Scroll bar example (from Pager in Chapter 7).
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Other Dialog Items
Controls are only one type of item used in dialogs. You can also display
PI CTs and I CO Ns in dialog boxes. You can also add static and editable text
fields, as well as user items, to your dialogs (Figure 6.12). User items
designate an area of the dialog box that will be drawn in by a user I t em
procedure. Ifthe procedure draws outside the user item Re ct, the drawing
is clipped. For example, you can define a clock-drawing procedure that gets
updated each time Mod a1Dia 1og () is called.
ResEdit makes it easy to define dialog item lists. Figure 6.13 shows how
ResEdit allows you to graphically edit the appearance of a dialog and the
items within it.
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Working with Alerts
Alerts are very much like dialogs: You build them using ResEdit, and they
consist of a window and a dialog item list. But there are some differences.
Alerts are completely self contained. While Mod a1Dia1 og ( ) is called
repeatedly inside a loop, the alert procedures are called once. Each alert
routine takes care of its own housekeeping.
There are three standard types of alerts: stop alerts, note alerts, and
caution alerts (Figure 6.14). Stop alerts indicate a critical situation, like
a fatal error, that must be brought to the user's attention. Note alerts have
a more informative tone. Caution alerts tell the user that the next step
taken should be considered carefully, as it may lead to unexpected results.

Another fine program from the
Mac Programming Primer!
©1989, D. Mark & C. Reed!!!

n

OK

I

You haue lost another 30,000
Quatloos. Further losses may
result in the total destruction
of this planet.

n

Gee!

D

Tri-Dimensional Desktop
Professional Uersion 2.01 a
requires 84 Megabytes of
RRM. Please purchase and
install immediately.

nAargh! D
Figure 6.14 Note, caution, and Stop alerts.
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Each alert exists in stages. The first time an alert is presented, it is a
stage 1 alert; the second time, a stage 2 alert; the third time, a stage 3 alert;
the fourth and subsequent times, a stage 4 alert. You can design your alerts
so that stage 1 alerts are silent but stage 2, 3, and 4 alerts beep when the
alert is presented. You can also specify whether or not the alert is presented
at different stages.

The Alert Algorithm
Working with alerts is easy. Build your alert with ResEdit by creating an
AL RT and a DI TL. Unlike regular dialogs, the only type ofcontrol you should
put in your alert dialog item list is a button.
• Load and present the alert with a call to StopA 1ert( ), NoteA 1ert ( ),
or Ca uti on A1er t ( ) .
• Use the value returned from each of these functions to determine which
item was hit (i.e., which button was pressed).

_J

Adding Dialogs to Your Programs
In this chapter, we'll show you how to build modal dialog boxes and alerts
through the use ofDLOG and DITL resources.Although we could create the
dialog structure in THINK C instead, we choose to emphasize the resourcebased approach.
As we stated in the dialog algorithm, to put a dialog box in your
application, you do the following things: (1) initialize the Dialog Manager
and get your dialog box resources; (2) call Modal Di a 1og ( ) ; and(3) respond
to the events that occur in the dialog box window.
Here's an outline of the procedure. First, initialize the Dialog Manager:

InitDialogs( NIL_POINTER );
Then, load a dialog from your resource file with the GetNewDi al og ( )
routine:

myDialog = GetNewDialog( resource ID.
NIL_POINTER, MOVE_TO_FRONT );
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Now, initialize each of your controls. Each control has a unique item
number, defined in the DITL resource (Figure 6.15.). Use GetDitem() to
get a handle to each control item in the dialog box; then use Set Ct 1Va 1ue ( )
to set the buttons, radio buttons, and check boxes to their initial values. For
example, the following routine will fill the first radio button and clear the
second radio button in a dialog box:

#define
#define
#define
#define

FIRST_RADIO
SECOND_RADIO
ON
OFF

2
3
1
0

GetDltem( myDialog, FIRST_RADIO, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, ON );
GetDltem( myDialog, SECOND_RADIO, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, OFF );
FI RST_RADIO and SECOND_RADIO are the radio button item numbers
defined in the DI TL resource. The first radio button will be set to 0 N, the
second to 0 FF (Figure 6.16).

~§ DIll

11

Alarm 11 ID = 400 from RemimJ

1n·i·arm
. g·c;·0s··"C;·1fin·1rttJ1rs·tic·ci"n·a·s. !
~ ........................................................:~! ............................;
fffs·a·:. 1

D Sound on
D Rotate I con
D Display Alert
(

1................ 1

0
0

Saue

Seconds
Minutes

(Cancel )

Figure 6.15 A sample DI TL.

® First Radio Button
O Second Radio Button

n OK

D

Figure 6.16 Radio buttons #1 and #2.
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Here's an example of initialization of a series of check boxes. This code
fragment clears the first check box and checks the second and third check
boxes (Figure 6.17).

#define FIRST_CHECKBOX
#define SECOND_CHECKBOX
#define THIRD_CHECKBOX

4
5
6

#define ON
#define OFF

1
0

GetDitem( myDialog, FIRST_CHECKBOX, &itemType,
&itemHandle, &itemRect );
SetCtlValue( itemHandle, OFF );
GetDitem( myDialog, SECOND_CHECKBOX, &itemType,
&itemHandle, &itemRect );
SetCtlValue( itemHandle. ON );
GetDitem( myDialog, THIRD_CHECKBOX, &itemType,
&itemHandle, &itemRect );
SetCtlValue( itemHandle, ON );
If you plan on drawing in the dialog box with QuickDraw (which you
might want to do with a user I tern procedure), make it the current port:

SetPort( myOialog );

When you create your DLOG in ResEdit, make sure the Visible box is
unchecked. That way, ifyou load your dialog at the beginning of your
program, it won't appear until you're ready.

D First Check BoH
181 Second Check BoH
181 Third Check Bou
((

OK

)J
Figure 6.17 Three check boxes.
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Make the dialog visible by calling ShowWi ndow( ) . You're now ready to
call Mod a1 Di a1 o g ( ) to handle the events that occur in the dialog window.

dialogDone = FALSE;
ShowWindow( myDialog );
while ( dialogDone == FALSE
{

ModalDialog( NIL_POINTER, &itemHit );
switch ( itemHit )
{

case OK_BUTTON:
dialogDone = TRUE;
break;
case FIRST_RADIO:
HandleRadio( SECOND_BUTTON );
break;

case THIRD_CHECKBOX :
HandleCheck( THIRD_CHECKBOX );
break;
l

HideWindow< myDialog );
When the user clicks the OK button, the dialog loop exits and the dialog
window is made invisible again.
If you 're dealing with more than one window, make sure you are
aware ofroutines like Sel ectWi ndow( ), which brings the window
specified in the parameter to the front. You may also want to consider
hiding your other windows while your dialog box is visible, then
showing them when you drop out of the dialog loop.
Dialog items are either enabled or disabled. If an item is disabled,
Mod a 1Dia1 og () will not report mouse clicks in the item. In general,
clicking I C0 Ns and PI CT s in a dialog box has no special significance, so
disable both of these types of items.
Static text fields are usually disabled, although you may change them in
response to other events. For example, a timer might display the time in
minutes or seconds, depending on the value of a set ofradio buttons (Figure
6.18). If the Seconds radio button is clicked, the static text field could read
Seconds. Ifthe Minutes radio button is clicked, the static text field could be
changed to read Minutes. Use the routines Get IT ext ( ) and Set IT ext ( )
to read and set the values of static text fields.
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~ Minutes

Static TeHt

O Seconds
®Minutes

([

OK

D

Figure 6.18 Static text.

Pa ram Text ( ) allows you to create a set of four default strings that can
be substituted in your static text fields. To specify them, call Pa ram Text ( )
with four Str255s:

ParamText( "\pthe tiny republic of Togo", "\pporkpie
hats", "\pbabar", "\pAltarian dog biscuits" );
From now on, whenever the strings "AO", "Al", "A2", or "A3" appear in a
static text item, they will be replaced by the appropriate Pa ramText ()
parameter. We use Pa ramText ()in Chapter 7's error handling routines.

You can store Pa ram Text ( ) strings in your resource file as resources
of type 'STR ' or inside a single 'STR/I' resource, read the strings in
with GetResource() or GetStri ng( ), and then pass them to
Pa ram Text ( ) . If, during the course of running your program, you
decide to change the values of your strings, you can write them back
outtotheresourcefilewith Wr i teResou rce ( ) . This is a little tricky,
but it gives you a great way to store program defaults. The mechanism
for modifying resources is covered in Inside Macintosh, Volume I,
pages 122-127.

Get IT ext ( ) and Set IT ext ( ) can also be used to modify the contents
of an editable text field. Here's an example:

GetDitem( myDialog, TEXT_FIELD, &itemType, &itemHandle,
&itemRect );
GetIText( itemHandle, &myString );
SetIText( itemHandle, "\pI've been replaced!!!");
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The last three arguments to Ge tD It em ( ) are placeholders. That is,
they won't always be used, but you always need to provide a variable
to receive the values returned. In the previous example, i t emH and 1 e
was used, but i temType and i temRect were not.

__j

The Notification Manager
The Notification Manager contains calls that allow applications running in
the background to communicate with the user. The Notification Manager
was first implemented in System 6.0. Because the Notification Manager is
not described in Inside Macintosh, we've provided the following tech block.
We should warn you, though, that this is an experimental, highly classified,
multipage Tech Block. Take your time. Remember, read all the directions
before you start.

How the Notification Manager Works
The Notification Manager alerts the user that a background application requires the user's attention. The following notification techniques can be used. First, a small diamond-shaped mark (+) may be
placed on the notifying application's item in the menu.
Next, the small icon may be rotated with another icon (see Figure
6.19). Then, the user may be notified of the event by a sound
designated by the background application. Finally, an alert can be
displayed with a message regarding the event (see Figure 6.20). After
the user clicks on the Alert button, a response procedure defined in the
notifiying application can be called.
·
The Notification Manager will still run, even ifyour program is not
running under MultiFinder. Since your program can't run in the
background, however, the Notification Manager's functionality will
be limited.

r

•

r

*

r

•

File

Edit

Uiew

Special

File

Edit

Uiew

Special

File

Edit

Uiew

Special

Figure 6.19 Small icon rotation
in the menu bar.
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,. ''/$

File

.,

Edi1

An euent has taken place that
requires your attention ...

n

OK

D

Figure 6.20 Alert message from the Notification Manager.

The Notification Manager Structure
Each call to the Notification Manager makes use of the NM Rec data
structure:

typedef st ru ct NM Rec
{

QE l emPtr
s hort
s hort
long
short
s hort

ql i nk ;
qTy pe;
nmFlags ;
nmPrivate ;
nmReserved ;
nmMa r k;

Handle
Ha ndle

nmSicon ;
nmSound ;

Str i ng Ptr

nmStr ;

ProcPtr

nmResp ;

l ong
NMR ec ;

nm RefCon;

/* the next queue ent ry*/
*/
I* queue type
I* reserved
*I
/* reservedPoint
*I
I* reserved
*I
/* Appl i cation ID to
mark in Apple Menu *I
/* handle to small icon*/
I* handle to sound
record*/
I* stri ng to appea r i n
alert
*I
/* pointer to response
routine
*I
I* for appl ic at i on use*/
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Here's an explanation of the NM Rec fields:
• ql; nk, qType, nmFl ags, nmPri vate, and nmReserved are either
reserved or contain information about the notification queue; you
won't adjust these values.
• nmMa rk: IfnmMa r k is 0, the (+)willnotbe displayed in the menu
when the notification occurs; if nmMa r k is 1, then the application
that is making the notifying call receives the mark. If you want a
desk accessory to be marked, use the ref n um of the desk accessory.
Drivers should pass 0.
• nmS I con: If nm S I con is NI L_P 0 I NT ER, no icon is used; otherwise,
the handle to the small icon ( • SIC N' resource) to be used should be
placed here.
• nmSound: if nmSound is 0, no sound is played; -1 will result in the
system sound being played. To play an ' s n d ' sound resource, put
a handle to the resource here. The handle must be nonpurgeable.
• nmS tr contains the pointer to the text string to be used in the Alert
box. Put in NI L_PO INTER for no Alert box.
• nm Resp is a pointer to a response procedure that gets called once the
notification is complete. We'll set nmRespto -1, which removes the
request from the notification queue once the notification is complete.
There are only two calls in the Notification Manager. The first,
NM I n st a 11 ( ) , adds the notification request to the Notification Queue,
which is checked periodically:

OSErr NM!nstall( QElemPtr );
QEl emPtr nmReqPtr:
The second, NM Remove ( ) , removes the notification from the Notification Queue:

OSErr NMRemoveC nmReqPtr: OElemPtr );
OElemPtr nmReqPtr:

The next section lists and describes Reminder, the biggest and most
complex program in this book. Reminder will show you how to put together
all the pieces we've talked about so far: windows, events, menus, fonts,
dialogs, alerts, and the Notification Manager.

_J

Reminder
Reminder sets a countdown timer and, when the time runs out, alerts the
user of the event via the Notification Manager. Reminder also supports a
dialog box that allows you to change some ofits settings. Here's a quick look
at the Reminder algorithm:
• It initializes the Toolbox.
• It checks for System 6.0 or later. If not, it puts up an alert and exits.
• It loads and initializes the settings dialog.
• It loads the , File, and Edit menus.
• It initializes the Notification Manager data structure.
• It handles events.
• If the Change Settings menu item is selected, it handles the settings
dialog box.
• If the Start Countdown menu item is selected, it pulls the number of
seconds from the settings dialog, loads and shows the countdown
window, counts down, and sets the notification.
• Ifthe Kill Notification menu item is selected, it removes the notification
from the Notification Queue.
• If the Quit menu item is selected, it exits.
Warning: This is the longest of all of the Primer programs. You can
save a little time by using resources and code from Chapter 5, but it's
still going to take a while. You may wish to take a brief recess.

Setting Up the Project
Start by creating your project files. You can save some time by copying your
Timer folder from Chapter 5 and renaming it Reminder. But remember, if
you do this, you'll need to change the source code file name, the project file
name, and the resource file name. We'll assume you're starting from
scratch.
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Making the Resources for Reminder
Go into ResEdit and create a file named Reminder Proj. rs re. Create a
DITL with the Get Info information shown in Figure 6.21. This DITL will
have eleven items. The table in Figure 6.22 lists the values for these items.
Next, create a DI TL with the Get Info information shown in Figure 6.23.
You'll use this DI TL in your About box alert. The About DI TL has two items.
Create them from the table shown in Figure 6.24.
Finally, create a DI TL with the Get Info information shown in Figure
6.25. This DI TL belongs to the alert shown for a system earlier than Version
6.0. The Bad System DI TL also has two items. Create them from the table
in Figure 6.26.
§0§ DITL "Alarm 11 ID

= 400

from Remin~

..........................-...............................~r......-...-................

1seconds I

!Alarm goes off in ! 1 O
; ............................................................:

ffi'se·:·. 1

D Sound on
D Rotate I con

D Display

:.............................;

i................I

0
0

Alert

Saue

Seconds
Minutes

(Cancel )

Figure 6.21 Settings DIT L appearance.

Item#

Type

Enabled

top

1

Button

Yes

2

Button

Yes

3

Static Text

Yes

left

bottom

right

130

50

150

120

Save

130

160

150
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Cancel

20

20

40

138

Text/Resource ID

Alarm goes off
In

4

Edltable Text

Yes

20

142

40

184

10

5

Static Text

Yes

20
55
75

189
20

40

249
102

seconds

95
54

20
157

75
95

170

6

Check Box

Yes

7

Check Box

Yes

8
9
10

Check Box

Yes

Radio Button

Yes

Radio Button

Yes

11

Static Text

Yes

20

170

75
95
115
74
95
115

Figure 6.22 Item specifications for settings 0 IT L .

Sound on

122

Rotate Icon

130
192

Dlsplay Alert

Use:

247

Seconds

249

Minutes
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§0§ DITL About

11

ID == 401 from Reminder Pr

fn·n·0Iil·e·r:··1rn"ii. .ii"ro·,;;-r:a·iii··1r·o-rii.Iil·e. l
!

!Mac Programming Primer!
!@1988, D. Mark & c. Reed!!!

!

i........................................................................................................J

OK

J

Figure 6.23 About box DI TL Get Info window.

Item#

Type

Enabled

top

left

bottom

right

Text/Resource ID

1

Button

Yes

71

117

91

177

OK

2

Static Text

Yes

7

70

61

280

Another fine
program from the
Mac
Programming
Prlmerl ©1989,
D.Mark&C.

Reed Ill

Figure 6.24 Item specifications for About DI TL .

§0§ Dill "Bad System 11 ID== 402 from Remin

ffil'e. .N.otiri·c·af.-O'i•··M·a·n·a·g·0·r:1s·"il'oll
!supported in this uersion of the!
!system software. Get 6.0! ! ! I
I.......................................................................................................;

OK
Figure 6.25 Bad system DI TL Get Info window.
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Enabled

Type

Item#

1

Button

2

Static Text

Yes
Yes

top

left

bottom

right

Text/Resource ID

71

117

91

177

OK

7

70

61

280

The Notification
Manager Is not
supported In this
version of the
System software.
Gets.om

Figure 6.26 Item specifications for Bad System DI TL .

Create an ALRT resource with ID= 401 that matches Figure 6.27. This
snapshot was made by selecting Display as Text from the AL RT menu that
appears when the ALRT is opened. Don't forget to set the i terns ID field to
401. This links the ALRT to DITL 401.
Next, create an ALRT resource with ID= 402 that matches the table in
Figure 6.28.
You're now ready to create your Settings dialog box. Create a DL0 Gwith
ID= 4 0 0 that matches Figure 6.29. Remember to set the pro c I Dto 1. This
tells the Dialog Manager to draw a classic modal dialog type window.
Next, we'll create two ' ST R ' resources to use in the Settings dialog. The
first contains the default value to use when the time is displayed in seconds.
The second contains the default value to use when the time is displayed in
minutes. Figure 6.30a shows the value for 'ST R' 401, and Figure 6.30b
shows the value for 'STR' 402.

~§

Alert "About" ID= 401 from Remind

top
left

~bottom~
~right

itemslOl 401
stage 1
stage 2
stage 3
stage 4

I

D 2 bold
D 2 bold
D 2 bold
D 2 bold

E==i
sound

181 drawn
181 drawn
181 drawn
181 drawn

Figure 6.27 The About Box AL RT,
displayed as text.

~

fil]§ Alert 11 Bad System 11 ID

= 402 from R

~bottom~
~right ~

top
left
items

ml 402 I

D 2 bold
D 2 bold
D 2 bold
D 2 bold

stage 1
stage 2
stage 3
stage 4

sound

181 drawn
181 drawn
181 drawn
181 drawn

~

Figure 6.28 The Bad System AL RT,
displayed as text.
§0§ Dialog 11 Alarm" ID = 400 from Remin

Window title:

IAlarm

I

top

~bottom~

left

~right

proclD

I1

~

IrefCon IO
I

itemslD 1400

D Uisible

I

D goAwayFlag

Figure 6.29 The Settings DL0 G,
displayed as text.

§0§ STR "Def. Secs." ID= 401 from Copy of Reminder Proj.

theStr

a

Data

~0§

b

$

I~=========================:
1O

STR "Def. Mins." ID

= 402 from Copy of Reminder Proj.

theStr
Data

$

Figure 6.30 Default time 'ST R' resources.
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Setting Up the Notification Manager Resources
Now that you've finished with the dialog and alert resources, you need to
add three resources for the Notification Manager: a string, a sound, and a
small icon. First, create another ' ST R' resource, with ID =4 0 0, that the
Notification Manager will use in the alert that is presented to the user
(Figure 6.31).
Now, add the sound. There are a number of different sound resource
types. The resource type to use is ' s nd ' (space at the end), with resource
ID =4 0 0. Ifyou have a favorite sound from a HyperCard stack, you can cut
it out using ResEdit and paste it into Reminder Proj. rs re.

A good check on whether the sound will work properly is to use the
play it option in the ' snd ' menu, which shows when you are editing
's nd ' resources. If that works, then the Notification Manager should
be able to use it. If your's nd ' is a large file, you may have some
problems. Start with a small 's nd ' resource.

Figure 6.32 shows the 'snd' resources found in System 6.0.2. Open up
the system file and copy the ' s nd ' of your choice into your Resource file if
you don't have any other good sounds. Change the ID of the ' s nd ' to 4 00.
The final resource for the Notification Manager is the small icon that
rotates with the menu icon. Ours is a little bell. Use it or create your own
small icon. Create a resource of type 'SI CN ',with ID= 400. Figure 6.33 is
a snapshot of our S I CNediting session.
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-o

STR ID

theStr

400 from Reminder Proj.Rsrc

lizounds ! ! ! It's time...

I

Data

Figure 6.31 The 'STR' resource for the Notification Manager.
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Hard Disk
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Figure 6.32 System 6.0.2 ' s nd' resources.
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.,

S File Edit
Hard Disk
THINK C
src
Reminder
Reminder Proj.Rsrc
SICNs from Reminder Proj .

...............
.......
.. ....
..............
............
......
Figure 6.33 The S I CN resource for the Notification Manager.

Adding the Menu Resources
Add the two menu resources. The first, MBAR, contains the three menu IDs
(400, 401, and 402). Create a resource of type MBAR, with ID= 400 (Figure
6.34). Remember, to add a new menu to the list, click on the asterisks and
select New from the File menu.
D

MBAR ID

#of menus

400 from Reminder Proj.Rsrc

3

*****
menu res ID

1400

*****
menu res ID

1401

*****
menu res ID

1402

*****

Figure 6.34 MBAR resource.
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Now you need to create each menu with its items. Create the MENU, ID
= 4 0 0, and make it look like the window in Figure 6.35. Ifyou have trouble
typing the
MENU.

symbol, open up an existing application and copy it from their

§0§ MENU 11 Apple 11 ID = 400 from Reminder Proj.Rsrc §§

menu ID

400

width

0

height

0

proclD

0

filler

0

enableflgs

$FFFFFFFB

title

*****
menu I tern
icon#
key equiu
mark Char
style

*"'"'"'"'
menultem
icon#
key equiu
mark Char
style

*****
Figure 6.35

IAbout Reminder
lo I

D

D

1.--s=-00-----------,

lI.....o_

J

~==::::;---------------------------------'

D
D

__.

s=o=-1- - - - - - - - - - - - - - ,

i=I

0
MBAR resources.
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Next, create the File MENU, ID =401, and make it look like the window
in Figure 6.36. Finally, create the Edit MENU, ID= 4 0 2, and make it look like
the window in Figure 6.37 (see page 226). The Edit menu is disabled and
is provided only as a courtesy for desk accessories.

~D~

MENU "File" ID= 401 from Reminder Proj.Rsrc ~

menu ID

401

width

0

height

0

proclD

0

filler

0

enableFlgs

$FFFFFFF7

title

File

*****
menu Item
icon#

IChange Settings
lo I

key equiu

[£]

mark Char

D

style

lsoo

*****
menu Item
icon#

IStart Countdown
lo I

key equiu

[]

mark Char

D

style

lsoo

*****
Figure 6.36 File MENU resource (stretched).
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menu Item
icon#
key equiu

IKill Notification
lo
I
~

mark Char

D

style

lsoo

*****
menu Item

louit

icon#

lo

key equiu

[!]

mark Char

D

style

lsoo

*****

0

Figure 6.36 (continued)
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§0§§ MENU "Edit" ID

= 402

menu ID

402

width

0

height

0

proclD

0

filler

0

enableflgs

$FFFFFF08

title

Edit

**"'*"'
menu Item

Iundo

icon#

lo

key equiu

[]

mark Char

D

style

from Reminder Proj.Rsrc ~

lsoo

*****
menu Item

I-

icon#

lo

key equiu

D
D

mark Char
style

*"'**"'

lsoo

menu Item

Icut

icon#

lo

key equiu

El

mark Char
style

D

lsoo

*****
Figure 6.37 Edit MENU resource (stretched).
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menu Item

!copy

icon#

lo

key equiu

[D

mark Char

D

style

lsoo

*****
menu Item

IPaste

icon#

lo

key equiu

[!]

mark Char

D

style

lsoo

I

*****
menu Item

lc1ear

icon#

lo

key equiu

D
D

mark Char
style

*****

I

lsoo
0

Figure 6.37 (continued)

The Home Stretch
Finally, add the old WIND resource for your countdown window. Create a
WI ND, ID= 400, with the specifications in Figure 6.38. When you're done,
save the resource file (whew!). Then, check it to see if you have all the
resources listed in Figure 6.39. If you don't, go back and add them.
This is, by far, the biggest set of resources in the book. It is not uncommon
at this point to start making mistakes (like mangling your motherboard
and switching on the TV), so you might want to take a break before you start
entering the code.

*****
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WIND ID= 400 from Reminder Proj.

Window title:

ITime Remaining

I

top

~bottom~

left

~right

proclD lo
D Uisible

~

lrefCon lo
D

I

goRwayFlag

Figure 6.38 WI ND resource for
countdown window.

,. S File

Edit

Figure 6.39 Reminder resources completed.
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The Reminder Code
If you haven't done so already, go into THINK C, create a new project file

named Reminder Proj,andaddMacTraps toit.Next,createanewsource
code file named Reminder. c, and add it to the project as well.
Some of the Reminder code can be copied from Chapter 5's Timer. Just
be careful with variable names and the like.

#define
#define
#define
I/define
I/define
I/define

BASE_RES_ID
ABOUT_ALERT
BAD_SYS_ALERT
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

400
401
402

OL

-ll

0

I/define MIN_SLEEP
I/define NI L_MOUSE_REGION

OL
OL

I/define DRAG_ TH RESHO LO

30

//define
I/define
I/define
I/define
//define
I/define
I/define
#define
#define

SAVE_BUTTON
CANCEL_BUTTON
TIME_FI ELD
S_OR_M_FIELD
SOUND_ON_BOX
ICON_ON_BOX
ALERT_ON_BOX
SECS_RADIO
MINS_RADIO

1

2
4
5

6
7
8
10
11

#define DEFAULT_SECS_ID
I/define DE FAUL T_MINS_ID

401
402

I/define ON
I/define OFF

1
0

0
I/define SECONDS
1
#define MI NU TES
//define SECONDS_PER_MINUTE60

#define TOP
#define LEFT

25
12

//define MARK_APPLICATION

1

//define APPLE_MENU_ID
#define FILE_MENU_ID
#define ABOUT_ITEM_ID

BASE_RES_ID
BASE_RES_ID+l

//define CHANGE_IT EM
I/define START_STOP_ITEM

1

1
2
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#define KILL_ITEM
#define QUIT_ITEM

3
4

#define SYS_VERSION

1

DialogPtr
Re ct
Boolean
char
StringHandle
NM Rec
MenuHandle
Event Record

gSettingsDialog;
gDragRect:
gDone. gCounting, gNotify_set:
gSeconds_or_minutes =SECONDS;
gNotifyStrH. gDefaultSecsH, gOefaultMinsH:
gMyNMRec;
gAppleMenu. gFileMenu;
gTheEvent;

struct
I

Str255 timeString;
int
sound:
int
icon:
int
alert;
int
secsRadi o:
int
minsRadio:
savedSettings;

/******************************** main *********/

ma i n ( )
I

Tool Box I nit():
if< Sys60rlater()
I

Dialoglnit();
MenuBarlni t():
SetUpDragRect();
Notifylnit();
Mainloop();

/*********************************** ToolBoxlnit */

Tool Boxlnit()
I

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEI nit();
InitDialogs( NIL_POINTER );
Ini tCursor():
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/******************************** Sys60rlater *********/

int

Sys60rlater()

{

OS Err
SysEnvRec

status;
SysEnvData;

status= SysEnvirons( SYS_VERSION, &SysEnvData );
if (( status != noErr ) I I ( SysEnvData.systemVersion < Ox0600 ))
I

StopAlert( BAD_SYS_ALERT, NIL_POINTER );
return( FALSE ) ;

}

else

return( TRUE ) ;

/******************************** Dialoglnit *********/

Dialoglnit()
I

int
Re ct
Handle

itemType;
itemRect;
itemHandle:

gDefaultSecsH = GetString( DEFAULT_SECS_ID );
gDefaultMinsH = GetString( DEFAULT_MINS_ID );
gSettingsDialog

GetNewDialog( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT );
GetDitem( gSettingsDialog, SECS_RADIO, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, ON );
GetDitem( gSettingsDialog, SOUND_ON_BOX, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, ON );
GetDitem( gSettingsDialog, ICON_ON_BOX, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, ON );
GetDitem( gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, ON );
=

232

Macintosh Programming Primer

/***********************************

MenuBarlnit

*/

MenuBarlnit()
{

Handle

myMenuBar;

myMenuBar = GetNewMBar( BASE_RES_ID ):
SetMenuBar( myMenuBar );
gAppleMenu = GetMHandleC APPLE_MENU_ID ):
AddResMenu( gAppleMenu, 'DRVR' );
gFileMenu = GetMHandle( FILE_MENU_ID ):
DrawMenuBarC):

/******************************** SetUpDragRect *********/

SetUpDragRect()
{

gDragRect = screenBits.bounds:
gDragRect.left += DRAG_THRESHOLD:
gDragRect.right -= DRAG_THRESHOLD:
gDragRect.bottom -= DRAG_THRESHOLD:

/******************************** Notifylnit *********/

Notifylnit()
{

gNotifyStrH = GetString( BASE_RES_ID );
gMyNMRec.qType = nmType;
gMyNMRec.nmMark
MARK_APPLICATION:
gMyNMRec.nmResp = NIL_POINTER:

!******************************** MainLoop *********/

Mainloop()
{

gDone = FALSE:
gCounting = FALSE:
gNotify_set = FALSE:
while ( gDone == FALSE
{

HandleEvent():
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/************************************* HandleEvent

*/

HandleEvent()
I

char

theCha r;

WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
switch ( gTheEvent.what )
I

case mouseDown:
HandleMouseDown();
break;
case keyDown:
case autoKey:
theChar = gTheEvent.message & charCodeMask;
if (( gTheEvent.modifiers & cmdKey ) != O )
HandleMenuChoice( MenuKey( theChar ) );
break;

/************************************* HandleMouseDown */

HandleMouseDown()
I

WindowPtr
short int
long int

whichWindow;
thePart;
menuChoice, windSize;

thePart = FindWindow( gTheEvent.where, &whichWindow );
switch < thePart >
I

case inMenuBar:
menuChoice = MenuSelect( gTheEvent.where );
HandleMenuChoice( menuChoice );
break;
case inSysWindow :
SystemClick( &gTheEvent, whichWindow );
break;
case inDrag :
OragWindow( whichWindow, gTheEvent.where, &gDragRect);
break;
case inGoAway :
gDone = TRUE;
break:
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/************************************* HandleMenuChoice */

HandleMenuChoice( menuChoice
long int
menuChoice;
{

int
int
if
l

theMenu;
the Item;
menuChoice != 0 )
theMenu = HiWordC menuChoice );
theltem = LoWordC menuChoice );
switch C theMenu )
{

case APPLE_MENU_ID :
HandleAppleChoice( theltem );
break;
case FILE_MENU_ID :
HandleFileChoice( theltem );
break:
}

Hi l iteMenu( 0 ) ;

/********************************

HandleAppleChoice

*******/

HandleAppleChoice( theltem )
int
the Item;
{

Str255
int
short int

accName;
accNumber;
itemNumber;

switch ( theltem )
I

case ABOUT_ITEM_IO :
NoteAlert( ABOUT_ALERT, NIL_POINTER );
break;
default :
GetitemC gAppleMenu, theltem, accName );
accNumber = OpenDeskAcc( accName );
break;
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/********************************

HandleFileChoice

*******/

HandleFileChoice( theltem
int
the Item;
{

Str255
long
int
Rec t
Handle

timeString;
countDownTime;
i temType;
i temRect;
i temHandl e:

switch ( theltem )
I

case CHANGE_ITEM
HandleDialog();
break;
case START_STOP_ITEM :
if ( gCount i ng )
I

Setltem( gFileMenu,theltem,"\pStart Countdown");
gCounting = FALSE;
else
HiliteMenu( 0 );
GetDltem( gSettingsDialog, TIME_FIELD,
&itemType, &itemHandle, &itemRect );
GetIText( itemHandle, &timeString );
StringToNum( timeString, &countDownTime );
Disableltem( gFileMenu, CHANGE_ITEM );
Setltem( gFileMenu, theitem,"\pStop Countdown");
CountDown( countDownTime );
Enableltem( gFileMenu, CHANGE_ITEM );
Setltem( gFileMenu,theltem,"\pStart Countdown");

I

break:
case KI LL_ITEM :
NMRemove( &gMyNMRec );
HUnlock( gNotifyStrH );
Disableltem( gFileMenu, KILL_ITEM );
gNotify_set = FALSE;
break;
case QUIT_ITEM :
gCounting = FALSE;
gDone = TRUE:
break;
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!******************************** HandleDialog *********/

HandleDialog()
{

int
long
St r255
int
Rect
Handle

itemHit, dialogDone
alarmDelay;
de l aySt ring;
i temType;
itemRect:
itemHandle;

FALSE;

ShowWindow( gSettingsDialog );
SaveSettings();
while ( dialogDone == FALSE
{

ModalDialog( NIL_POINTER, &itemHit );
switch ( itemHit )
{

case SAVE_BUTTON:
HideWindow( gSettingsDialog );
dialogDone = TRUE:
break:
case CANCEL_BUTTON:
HideWindow( gSettingsDialog );
RestoreSettings();
dialogDone =TRUE;
break;
case SOUND_ON_BOX:
GetDitem( gSettingsDialog, SOUND_ON_BOX,
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle.
! GetCtlValue< itemHandle )
break;
case ICON_ON_BOX:
GetDitem( gSettingsDialog, ICON_ON_BOX.
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle,
! GetCtlValue( itemHandle )
break;
case ALERT_ON_BOX:
GetDitem( gSettingsDialog, ALERT_ON_BOX,
&itemType, &itemHandle. &itemRect
SetCtlValue( itemHandle,
! GetCtlValue( itemHandle )
break:
case SECS_RAD IO:
gSeconds_or_minutes =SECONDS;
GetDitem( gSettingsDialog, MINS_RADIO,
&itemType. &itemHandle, &itemRect
SetCtlValue( itemHandle. OFF );
GetDitem( gSettingsDialog, SECS_RADIO.
&itemType, &itemHandle. &itemRect

);
);

);
);

);
);

);
);
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SetCtlValue( itemHandle, ON );
GetDitem( gSettingsDialog, S_OR_M_FIELD,
&itemType, &itemHandle, &itemRect
SetIText( itemHandle, "\pseconds" );
GetDitem( gSettingsDialog, TIME_FIELD,
&itemType, &itemHandle, &itemRect
Hlock( gDefaultSecsH );
SetIText( itemHandle, *gDefaultSecsH );
HUnlock( gDefaultSecsH );
break;
case MINS_RADIO:
gSeconds_or_minutes = MINUTES;
GetDitem( gSettingsDialog, SECS_RADIO,
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle, OFF );
GetDitem( gSettingsDialog, MINS_RADIO,
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle. ON );
GetDitem( gSettingsDialog, S_OR_M_FIELD,
&itemType. &itemHandle, &itemRect
SetIText( itemHandle. "\pminutes" );
GetDitem( gSettingsDialog, TIME_FIELD,
&itemType, &itemHandle. &itemRect
HLock( gDefaultMinsH );
SetIText( itemHandle. *gDefaultMinsH );
HUnlock( gDefaultMinsH );
break;

);
);

);
);
);
);

/************************************* SaveSettings */

SaveSettings()
I

int
i temType:
Rect itemRect:
Handle i temHandl e:
GetDitem( gSettingsDialog, TIME_FIELD, &itemType, &itemHandle,
&itemRect ):
GetIText( itemHandle. &CsavedSettings.timeString) );
GetDitem( gSettingsDialog, SOUND_ON_BOX. &itemType. &itemHandle.
&itemRect ):
savedSettings.sound = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, ICON_ON_BOX. &itemType, &itemHandle,
&itemRect ):
savedSettings.icon = GetCtlValue( itemHandle ):
GetDitem( gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle,
&itemRect );
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savedSettings.alert = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, SECS_RADIO, &itemType, &itemHandle,.
&itemRect );
savedSettings.secsRadio = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, MINS_RADIO, &itemType, &itemHandle,
&itemRect );
savedSettings.minsRadio = GetCtlValue( itemHandle );

!************************************* RestoreSettings */

RestoreSettings()
{

int
itemType;
Rect itemRect;
Handle itemHandle;
GetDitem( gSettingsDialog, TIME_FIELD, &itemType, &itemHandle,
&itemRect );
SetIText( itemHandle, savedSettings.timeString );
GetDitem( gSettingsDialog, SOUND_ON_BOX, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.sound );
GetDitem( gSettingsDialog, ICON_ON_BOX, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.icon );
GetDitem( gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.alert );
GetDitem( gSettingsDialog, SECS_RADIO, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.secsRadio );
GetDitem( gSettingsDialog, MINS_RADIO, &itemType, &itemHandle,
&itemRect ) ;
SetCtlValue( itemHandle, savedSettings.minsRadio );
if

savedSettings.secsRadio == ON )

{

else

GetDitem( gSettingsDialog, S_OR_M_FIELD, &itemType,
&itemHandle, &itemRect );
Set!Text( itemHandle, "\pseconds" );
GetDitem( gSettingsDialog, S_OR_M_FIELD, &itemType,
&itemHandle, &itemRect );
Set!Text( itemHandle, "\pminutes" );
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/********************************

CountDown

*******/

CountDown( numSecs
long numSecs;
{

long
Str255
WindowPtr

myTime. oldTime. difTime;
myTimeString;
countDownWindow:

countDownWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT );
SetPort( countDownWindow );
ShowWindow( countDownWindow );
TextFace( bold );
TextSize( 24 );
GetDateTime( &myTime );
oldTime = myTime;
if ( gSeconds_or_minutes ==MINUTES )
numSecs *= SECONDS_PER_MINUTE;
gCounting = TRUE;
while ( ( numSecs > 0 ) && ( gCounting ) )
I

HandleEvent();
if ( gCounti ng )
{

MoveTo( LEFT, TOP );
GetDateTime( &myTime );
if ( myTime != oldTime )
{

difTime = myTime - oldTime;
numSecs = numSecs - difTime;
oldTime = myTime;
NumToString( numSecs . myTimeString );
EraseRect C &(countDownWindow->portRect) );
Drawstring( myTimeString );
}

if

gCounting )
SetNotification();
gCounting = FALSE;
HideWindow( countDownWindow );
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/********************************

SetNotification

*******/

SetNotification()
{

int
i temType;
Rect itemRect;
Handle itemHandle;
if

gNotify_set )

{

NMRemove( &gMyNMRec );
HUnlock( gNotifyStrH );
GetDltem( gSettingsDialog. ICON_ON_BOX. &itemType. &itemHandle.
&itemRect ) :
if ( GetCtlValue( itemHandle ) )
gMyNMRec.nmSicon
GetResource( 'SICN'. BASE_RES_ID );
else
gMyNMRec.nmSicon = NIL_POINTER:
GetDitem< gSettingsDialog, SOUND_ON_BOX, &itemType. &itemHandle.
&itemRect );
if ( GetCtlValue( itemHandle ) )
gMyNMRec.nmSound
GetResource( 'snd '. BASE_RES_ID ):
else
gMyNMRec.nmSound = NIL_POINTER;
GetDitemC gSettingsDialog, ALERT_ON_BOX, &itemType. &itemHandle.
&itemRect ) :
if
GetCtlValue( itemHandle )
I

MoveHHi( gNotifyStrH );
Hlock( gNotifyStrH );
gMyNMRec.nmStr
*gNotifyStrH;

}

else
gMyNMRec.nmStr = NIL_POINTER;
NMinstall( &gMyNMRec );
Enableltem( gFileMenu. KILL_ITEM );
gNotify_set = TRUE;
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Running Reminder
Now that your source code is updated, you're almost ready to run Reminder.
First, we'll show you how to set the MultiFinder attributes that will allow
Reminder to continue executing, even in the background.
Pull down the Project menu and select Set Project Type.... The Project
Type dialog box will appear (Figure 6.40). Click the mouse on the MF Attrs
pop-up menu, selecting items until all three have a check mark next to them
(Figure 6.41). Click the OK button. Now you're ready to run Reminder.

® Application
O Desk Accessory
O Deuice Driuer
O Code Resource

File Type

IAPPL

Creator

D Separate STRS

Partition (K) ~
MF Attrs

~ 1seoo I
(

OK

Cancel

)

Figure 6.40 Project Type dialog box.

® Application

O Desk Accessory

File Type

IAPPL
ltR'"I

O Deuice Driuer

Creator

O Code Resource

D Separate STRS

Partition (K) ~

jseoo

Figure 6.41 Project Type dialog with
MultiFinder attributes set.

I
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Creating applications that are MultiFinder-friendly is very important. We've touched on the basics ofMultiFinder friendliness by using
Wa i t Next Even t ( ) and handling Suspend/Resume events, but there's
a lot more to learn. Ifyou want to write MultiFinder-friendly applications, read the Programmer's Guide to MultiFinder from Apple and
APDA.

To be truly MultiFinder-friendly, Reminder would have to worry
about things like scrap conversion (we discuss the scrap in Chapter 7),
mouse regions, sleep times, and much more.
Select Run from the Project menu. When asked to Bring the project up
to date, click Yes. If you run into any compilation problems, consult the
debugging tips found in Appendix E. When asked to Save changes before
running, click Yes. Reminder should be up and running (Figure 6.42).
Reminder does not display any windows initially. The File menu should
display four menu items: Change Settings, Start Countdown, Kill Notification, and Quit. If Change Settings is selected, the Settings dialog box
appears (Figure 6.43). You can select the countdown time in minutes or
seconds, and choose the method or methods by which you wish to be
notified. Save will keep t he settings and close the dialog box. Cancel will
restore the last saved settings and close the dialog box.

r

S File Edit

Figure 6.42 Running Reminder.

.,
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.,

r

Alarm goes off

r8J Sound on
181 Rotate Icon
181 Display Alert

in ~ seconds
Use:
®Seconds
Minutes

0

Figure 6.43 Using the Change Settings dialog box.

Start Countdown will begin the countdown: The countdown window is
displayed, and the timer will count down in seconds. In the File menu, Start
Countdown is changed to Stop Countdown, and may be selected to cancel
the countdown a nd close the countdown window. During countdown, the
Change Settings item is dimmed. When the countdown reaches zero, up to
three methods will be used to notify you tha t the time has been reached
(Figure 6.44).
Once the notification is set, the Kill Notification item under the File
menu will become available. When it is used to cancel a notification, it will
become dim again.
If you are running under MultiFinder, use Change Settings to set the
countdown time to 20 seconds, then start the countdown. Before time runs
out, click on another application's window (like the Finder) so that the
countdown window is in the background. The countdown should continue
and, when it reaches zero, you should be notified. Ifthis doesn't work,check
your MF Attrs in the Set Project Type dialog box. Make sure all three bits
are turned on. Of course, Reminder works fine in the regular Finder, but is
somewhat less useful there.
Choose Quit from the File menu. Let's take a look at the code.

244

Macintosh Programming Primer

.,

I'S

Zounds!!! It's time ...

Figure 6.44 The Notification Manager comes through.

_J

Walking Through the Reminder Code
First, set up your #defines. Most of them relate to the Settings dialog box.
Each dialog item is given an appropriate name. SA VE_BU TTON is dialog
item number 1, CANCE L_BUTTON is dialog item number 2, and so on.
DEFAULT_ SECS_ ID and DEFAULT_ MINS_ID are the resource IDs of the
' ST R ' resources used as second and minute defaults in the Settings dialog.
ON and OFF are set to 1 and 0 foreaseofuse in setting controls. SY S_V ERS I ON
is set to 1. You use this in the Sys 60 r Later ( ) function to indicate which
version of Sys Env i ron s ( ) to call.
Sys En vi r on s ( ) fills out a record that describes the Mac operating
environment. Most important, we can use it to tell what version of the
system is running and, therefore, whether or not Toolbox routines like
Wa it Ne x tE vent ( ) or the Notification Manager are present.
Sys Environs () is completely described in Inside Macintosh (V:5).
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#define
#define
#define
#define
#define
#define

BASE_RES_ID
ABOUT ALERT
BAD_SYS_ALERT 402
NIL_POINTER
MOVE_TO_FRONT -IL
REMOVE_ALL_EVENTS

400
401
OL
0

#define MIN_SLEEP
#define NIL_MOUSE_REGION

OL
OL

#define DRAG_THRESHOLD

30

#define
#define
#define
#define
#define
#define
#define
#define
#define

1

SAVE_BUTTON
CANCEL_BUTTON
TIME_FIELD
S_OR_M_FIELD
SOUND_ON_BOX
ICON_ON_BOX
ALERT_ON_BOX
SECS_RADIO
MINS_RADIO

2
5
6
8

4
7
10
11

#define DEFAULT_SECS_ID
#define DEFAULT_MINS_ID

401
402

#define ON
#define OFF

1
O

#define SECONDS
0
#define MINUTES
1
#define SECONDS_PER_MINUTE

60

#define TOP
#define LEFT

25
12

#define MARK_APPLICATION

1

#define APPLE_MENU_ID BASE_RES_ID
#define FILE_MENU_ID BASE_RES_ID+l
#define ABOUT_ITEM_ID 1
#define
#define
#define
#define

CHANGE_ITEM
START_STOP_ITEM
KILL_ITEM
QUIT_ITEM

#define SYS_VERSION

1
2
3
4
1

The variable gSett i ngs Di al og will point to your Settings dialog.
Remember, you can treat a Di a 1 ogPtr just like a Wi ndowPt r. For
example,youcouldpass gSett i ngsDi a 1 og as an argument to Set Port ( ).
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When gDone is set to TRUE, the program will exit. gCount i ng is TRUE
only when the countdown window is displayed. gNot i f y _set is TRUE
whenanotificationhasbeenset. gSeconds_or _minutes issetto SECONDS
or MI NUTE S, depending on the setting in the Settings dialog. It is reset to
FALSE when Kill Notification is selected from the File menu.
gDef aul tSecsH and gDefaul tMi nsH are handles to the default time
'STR • resources.dialog items. gNot i fySt rH and gMyNMRec are used by
the Notification Manager.
gAppl eMenu and gFi l eMenu are handles to their respective menus.
You need the handle to the Apple menu so you can add desk accessories. You
need the handle to the File menu so you can change menu items.
The s a v ed Sett i ngs st r uct is used to hold all the settings from the
Settings dialog box, in case they need to be restored (if the user clicks the
Cancel button).

DialogPtr
Re ct
Boolean
char
StringHandle
NM Rec
MenuHandle
EventRecord

gSettingsDialog;
gDragRect:
gDone, gCounting, gNotify_set:
gSeconds_or_minutes =SECONDS;
gNotifyStrH, gDefaultSecsH. gDefaultMinsH;
gMyNMRec;
gAppleMenu. gFileMenu;
gTheEvent;

struct
I

Str255 timeString;
int
sound;
int
icon:
int
alert;
int
secsRadio;
int
minsRadio:
savedSettings;

main () starts by initializing the Toolbox, using the same routine you
always have. Then, test to see if System 6.0 or later is installed. If it is, you
can use the Notification Manager. Initialize your dialogs, your menus, and
the notification data structure.
Finally, enter your main event loop.

/******************************** main *********/

ma i n ( )
I

Tool Box I nit();
if ( Sys60rlater()
I

247

Working with Dialogs

Dialoglnit();
MenuBarlnit():
SetUpDragRect():
Noti fylni t():
Mainloop():

Tooffioxlnit()
This routine is the same routine you've been using all along.
!******************************** ToolBoxlnit */

ToolBoxlnit()
{

InitGraf( &thePort ):
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ):
InitWindows();
InitMenus():
TEI nit():
InitDialogs( NIL_POINTER ):
Ini tCursor():
Sys60rlater() will return TRUE if System Version 6.0 or later is
installed. Otherwise, it returns FALSE. The key to this function lies in the
call to SysEnvi rons ().Pass in the version number of SysEnvi rons ()
that you'd like to use. In this case, use SYS_VERSION, which is set to 1.
Apple will eventually add new features to the Sys En v i r on s ( ) call, but
they'll always provide compatibility with older versions via the version
parameter.
SysEnvData isadatastructurethatgetsfilledby Sys Environs ().One
of the fields, system Ve rs i on, gets filled with the current system version
number. The first two bytes get the major version number, and the last two
bytes get the minor version number. (In Version 5.3, the major version
number is 5, and the minor version number is 3.) As long as the version
number is greater than Ox0600 (hex for 6*256), you know you have a
system with a major version greater than 6.0.
If there is a problem, call Stop A1 e rt ( ) to put up your ''You don't have
version 6.0 or later" alert.
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/******************************** Sys60rlater *********/

int

Sys60rLater()

{

OS Err status:
SysEnvRec
SysEnvData:
status= SysEnvirons( SYS_VERSION. &SysEnvData );
if (( status != noErr ) I I ( SysEnvData.systemVersion < Ox0600 ))
{

StopAlert( BAD_SYS_ALERT. NIL_POINTER );
return( FALSE ) :
I

else

return( TRUE);
Di a 1 o g I n i t ( ) starts by loading the default second and minute settings
into the Stri ngHandl es gDefaul tSecsH and gDefaul tMi nsH. The
Settings dialog is then loaded from the resource file. When you designed the
dialog box in ResEdit, you set it up to be invisible. When the time is right,
you can call Sh owW i n d ow ( ) to make it visible.
Call GetDitem() and SetCtl Value() inpairstosetthe SECS_RADIO,
SOUND_ON_BOX, I CON_ON_BOX, and ALERT _ON_BOX items to ON.

/******************************** Dialoglnit *********/

Dialoglnit()
{

int
Re ct
Handle

itemType;
itemRect:
itemHandle:

gDefaultSecsH = GetString( DEFAULT_SECS_ID );
gDefaultMinsH = GetString( DEFAULT_MINS_ID );
gSettingsOialog

GetNewDialog( BASE_RES_IO, NIL_POINTER,
MOVE_TO_FRONT );
GetDitem( gSettingsDialog. SECS_RADIO. &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle. ON );
GetDitem( gSettingsDialog. SOUND_ON_BOX, &itemType. &itemHandle,
&itemRect );
SetCtlValue( itemHandle, ON );
GetDitem( gSettingsDialog, ICON_ON_BOX. &itemType. &itemHandle,
&itemRect );
SetCtlValue( itemHandle, ON );
GetDitem( gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, ON );
=
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Menu Ba r I n i t () is similar to the earlier menu routines you've seen.
First, you load your MBA Rresource, and then you get a handle to the menu
so you can add all the desk accessories to it. Next, you get a handle to the
File menu so you can change menu items later on. Finally, you draw the
menu bar:

/******************************

MenuBarinit

*/

MenuBarinit()
{

Handle

myMenuBar;

myMenuBar
GetNewMBar( BASE_RES_ID );
SetMenuBar( myMenuBar ):
gAppleMenu = GetMHandle( APPLE_MENU_ID ):
AddResMenu( gAppleMenu, 'DRVR' );
gFileMenu = GetMHandle( FILE_MENU_ID );
DrawMenuBar():
SetUpDragRect() is the same as always:

/******************************** SetUpDragRect *********/

SetUpDragRect()
{

gDragRect = screenBits.bounds:
gOragRect.left += DRAG_THRESHOLD:
gDragRect.right -= DRAG_THRESHOLD:
gDragRect.bottom -= DRAG_THRESHOLD;

The MacintOsh operating system, like most other operating systems,
supports a set of operating system queues. You're already familiar
with the Event Manager's queue. The Notification Manager maintains a queue, as well. Under MultiFinder, several applications might
post notifications at the same time. Each notification request is
handled by the operating system and posted on the Notification
Manager's queue.
In Not i f y In i t ( ) , load the ' ST R' you want to appear in the notification
alert with Get String ().Then, qType is set to nmType. This tells the part
of the operating system that manages queues that this request is destined
for the Notification Manager's queue.
Next, nmMa rk is set to MARK_APPLI CATION, whichmeansthe(+)willbe
placed next to Reminder in the Menu (if you're in MultiFinder). NM Resp
is set to NI L_PO INTER, whichmeansyouhavenoresponseroutineafterthe
notification has been successfully made.
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/******************************** Notifylnit *********/

Notifylnit()
I

gNotifyStrH = GetString( BASE_RES_IO );
gMyNMRec.qType = nmType;
gMyNMRec.nmMark
MARK_APPLICATION;
gMyNMRec.nmResp = NIL_POINTER;

Mainloop() initializes gDone, gCounting, and gNotify_set and
then loops on Ha nd l e Event ( ) .
/**************************** MainLoop *********/

Main Loop()
I

gDone = FALSE;
gCounting = FALSE;
gNotify_set = FALSE;
while ( gDone == FALSE
I

HandleEvent();

The Handl eEvent() routine is set up much like Handl eEvent() in
Chapter 5. Call WaitNextEvent() to see what is in the event queue.
(Because you're running System 6.0 or later, you know that
Wa i t Next Event ( ) is installed.) Use a switch to find out what the event
was. Ifthe mouse button is depressed, the Hand l e Mouse Down ( ) routine is
called. If a keyd own or auto Key event occurs, check to see if the command
key was depressed. If so, the Handl eMenuChoi ce() routine is called. If
you don't check for a keyd own event first, you won't ever see the command
key sequence (for example, when you type 38 Q to Quit).
We've left out some of the standard event handling, like update Ev ts, to
simplify the code. Don't worry-Reminder will work just fine without the
extra code.
/********************************* HandleEvent

*/

HandleEvent()
I

char

theChar;

WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
switch ( gTheEvent.what )
I
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case mouseDown:
HandleMouseDown();
break;
case keyDown:
case autoKey:
theChar = gTheEvent.message & charCodeMask;
if (( gTheEvent.modifiers & cmdKey ) != 0 )
HandleMenuChoice( MenuKey( theChar ) );
break;

Hand 1eMouseDown () is the same as its Chapter 5 counterpart:

/************************************* HandleMouseDown */

HandleMouseDown()
I

WindowPtr
short int
long int

whichWindow;
thePart:
menuChoice, windSize;

thePart = FindWindow( gTheEvent.where, &whichWindow );
switch ( thePart )
{

case inMenuBar:
menuChoice = MenuSelect( gTheEvent.where );
HandleMenuChoiceC menuChoice );
break;
case inSysWindow :
SystemClick( &gTheEvent, whichWindow );
break;
case inDrag :
DragWindowC whichWindow, gTheEvent.where, &gDragRect);
break;
case inGoAway :
gDone = TRUE;
break;
Handl eMenuChoi ce() is also the same as its Chapter 5 counterpart:
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/********************************** HandleMenuChoice */

HandleMenuChoice( menuChoice
long int
menuChoice;
{

int
int
if

theMenu;
the Item;
menuChoice != 0 )

{

theMenu = HiWord( menuChoice );
theltem = LoWord( menuChoice );
switch ( theMenu )
{

case APPLE_MENU_ID :
HandleAppleChoice( theltem );
break;
case FILE_MENU_ID :
HandleFileChoice( theltem );
break;
}

HiliteMenu( O );
Guess what?
/********************************

HandleAppleChoice

*******/

HandleAppleChoice( theltem
int
the Item;
{

Str255 accName;
int
accNumber;
short int
itemNumber;
switch

<

theltem )

{

case ABOUT_ITEM_ID :
NoteAlert( ABOUT_ALERT, NIL_POINTER );
break:
default :
Getltem( gAppleMenu, theltem, accName );
accNumber = OpenDeskAcc( accName );
break;
Handl eFi 1 eChoi ce() takescareofthefouritemsundertheFilemenu.
If Change Settings is selected call Handl eDi al og( ). If Start Countdown (or its counterpart, Stop Countdown) is selected, check to see ifyou

are currently counting down. Ifyou are, then the menu item must have been
Stop Countdown, so change the item back to Start Countdown and set
gCount i ng to FALSE to stop the countdown.
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If you were not counting down, Start Countdown was the item selected.
In this case, unhighlight the File menu (try commenting this line to get a
feel for why this is necessary). Then, pull the countdown time from the
settings dialog and convert it to a number. Dim the Change Settings item
(you don't want to change the settings while you're actually counting down),
and change the Start Countdown menu item to Stop Countdown. Next, call
CountDown (). When Count Down () returns, reenable the Change Settings item and change Stop Countdown to Start Countdown.
If the menu item selected was Kill Notification, call NM Remove () to
remove the notification from the Notification Manager's queue. Then,
unlock the notification string you locked in Set Not i f i cat i on ( ) . (We
discuss handle locking and unlocking in a tech block a little later on.) Also,
dim the Kill Notification item, since the notification is no longer active.
Finally, set g Not i f y _set to FA LS E, so everyone else knows that the
notification is no longer active.
If Quit is selected, set g Count i n g to FALSE so you'll drop out of the
counting loop (if the selection was made during the countdown). In addition, set gDone to FALSE.

!*****************************

HandleFileChoice

*******/

HandleFileChoice( theltem
int
the Item;
{

Str255
long
int
Rect
Handle

timeString;
countDownTime;
i tern Type:
i temRect;
itemHandl e;

switch ( theltem )
{

case CHANGE_ITEM :
HandleDialog();
break;
case START_STOP_ITEM :
if ( gCounting)
I

Setltem( gFileMenu,theltem,"\pStart Countdown");
gCounting = FALSE;
else
Hi 1iteMenu( 0 ) ;
GetDitem( gSettingsOialog, TIME_FIELD,
&itemType, &itemHandle. &itemRect );
GetIText( itemHandle. &timeString );
StringToNum( timeString, &countDownTime );
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Oisableltem( gFileMenu, CHANGE_ITEM );
Setltem( gFileMenu, theitem,"\pStop Countdown");
CountDownC countDownTime );
Enableltem( gFileMenu, CHANGE_ITEM );
Setltem( gFileMenu,theltem,"\pStart Countdown");
}

break;
case KI LL_ITEM :
NMRemove( &gMyNMRec );
Hunlock( gNotifyStrH );
Disableltem( gFileMenu, KILL_ITEM );
gNotify_set = FALSE;
break;
case QUIT_ITEM :
gCounting = FALSE;
gDone = TRUE;
break;

As with Chapter 5's Timer, we still haven't added support for copy, cut,
and paste operations to desk accessories. Look at WindowMaker in
Chapter 7 to see how to support desk accessories with the Edit menµ.

Hand 1 e Di al o g ( ) is the key to Reminder's modal dialog. As we discussed in the beginning of the chapter, modal dialogs are implemented in
a loop. First Mod a1Dia1 og () is called, returning the number of the
selected item. The selected item is processed and, ifit was an exit item, the
loop ends.
Ha nd 1 e Di a1 o g ( ) is a very long routine, but it is not complex. Most of it
is a big switch with cases for most of the items in the dialog.
Start by making the Settings dialog visible and saving the settings you
start off with (in case the user clicks on the Cancel button). You then enter
the Modal Di a 1 o g ( ) loop. If the user selects an exit item (in this case, Save
or Cancel), di a1 ogDone is set to TRUE. If the user selects the Save button,
make the dialog window invisible and set d i a1 o gDone to TR UE.
If the user selects the Cancel button, make the dialog window invisible
and restore the old settings. (We made the window invisible first because
we didn't want the user to watch as we changed the items back. It's not a
prettysight.)Agaip, set dial ogDone to TRUE todropoutofthewh i le loop.
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/***************************** HandleDialog *********/

HandleDialog()
{

int
1ong
Str255
int
Rect
Handle

itemHit, dialogDone
al armDel ay:
del ayStri ng:
i temType:
i temRect:
i temHandl e:

FALSE:

ShowWindow( gSettingsDialog );
SaveSettings();
while ( dialogDone == FALSE
{

ModalDialog( NIL_POINTER, &itemHit );
switch ( itemHit )
{

case SAVE_BUTTON:
HideWindow( gSettingsDialog );
dialogDone =TRUE:
break:
case CANCEL_BUTTON:
HideWindow( gSettingsDialog );
RestoreSettings();
dialogDone =TRUE;
break;
If the user clicks in the sound, icon, or alert check box, set them to 0 FF
if they were 0 N or to 0 N if they were 0 FF. Note that ( ! Get Ct 1 Va 1 ue (
i temHandl e ) ) returns the setting opposite to i temHandl e's current
setting.

case SOUND_ON_BOX:
GetDitem( gSettingsDialog, SOUND_ON_BOX,
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle,
! GetCtlValue( itemHandle )
break;
case ICON_ON_BOX:
GetDitem( gSettingsDialog, ICON_ON_BOX,
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle,
! GetCtlValue( itemHandle )
break:
case ALERT_ON_BOX:
GetDitem( gSettingsDialog, ALERT_ON_BOX,
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle.
! GetCtlValue( itemHandle )
break;

);
);

);
);

);
);
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If the user clicks in the Seconds radio button, change the global
gSeconds_or _minutes to SECONDS, tum off the Minutes radio button,
and tum on the Seconds radio button. (It's important to tum off the old
button and then tum on the new one, so the user never sees two radio
buttons on at the same time.) Next, set the static text field to read seconds,
and place the default value loaded into g Def au 1 t Secs Hin the editable text
field (the resource was loaded in Di a 1 og In it ()).Lock the string handle,
since you're passing a pointer to the string and not the string's handle to
SetIText().

Remember, a handle is a pointer to a pointer, allowing the system to
move the data around in memory without changing the value of the
handle. In this case, we need to use a pointer to our string instead of
ahandle to it, so we can't afford to let the system move our data around
(relocate it). We can solve this problem in one oftwo ways. We can loek
the handle and its data with Hlock() or we can make a copy of the
data and dispose ofthe handle. Each ofthese techniques has its place.
For simplicity, we used the HLoe k ( ) method, but this method is not
necessarily the best. For more information, read about the Memo&
Manager in Inside Macintosh, Volume II, pages 9-51.
If the user clicks in the Minutes radio button, you will go through a
similar exercise, using a default value in g Def au 1 tM ins Hin the editable
text field.

case SECS_RADIO:
gSeconds_or_minutes =SECONDS;
GetDitem( gSettingsDialog, MINS_RADIO,
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle, OFF );
GetDitem( gSettingsDialog, SECS_RADIO,
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle, ON );
GetDitem( gSettingsDialog, S_OR_M_FIELD,
&itemType, &itemHandle, &itemRect
SetIText( itemHandle, "\pseconds" );
GetDitem( gSettingsDialog, TIME_FIELD,
&itemType, &itemHandle. &itemRect
Hlock( gDefaultSecsH );
SetIText( itemHandle, *gDefaultSecsH );
HUnlock( gDefaultSecsH );
break;
case MI NS_RADIO:
gSeconds_or_minutes =MINUTES;
GetDitemC gSettingsDialog, SECS_RADIO,
&itemType, &itemHandle, &itemRect
SetCtlValueC itemHandle, OFF );

);
);
);
);

);
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GetDitem( gSettingsDialog, MINS_RADIO.
&itemType. &itemHandle. &itemRect );
SetCtlValue( itemHandle. ON );
GetDitem( gSettingsDialog, S_OR_M_FIELD,
&itemType, &itemHandle. &itemRect ):
SetIText( itemHandle, "\pminutes" );
GetDitem( gSettingsDialog, TIME_FIELD,
&itemType, &itemHandle, &itemRect ):
Hlock( gDefaultMinsH ):
SetIText( itemHandle. *gDefaultMinsH >:
HUnlock( gDefaultMinsH );
break:

SaveSettings() uses GetDitem() and either GetIText() or
Get Ct l Value ()to fill the savedSett i ngs data structure with the values
currently set in the settings dialog items.

/************************************* SaveSettings */
SaveSettings()
{

int
itemType;
Rect itemRect:
Handle i temHandl e;
GetDitem( gSettingsDialog, TIME_FIELD. &itemType, &itemHandle,
&itemRect ) ;
GetIText( itemHandle, &CsavedSettings.timeString) );
GetDitem( gSettingsDialog, SOUND_ON_BOX. &itemType, &itemHandle,
&itemRect );
savedSettings.sound = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, ICON_ON_BOX, &itemType, &itemHandle.
&itemRect );
savedSettings.icon = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle,
&itemRect ) :
savedSettings.alert = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, SECS_RADIO. &itemType, &itemHandle.
&itemRect ):
savedSettings.secsRadio = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, MINS_RADIO, &itemType, &itemHandle,
&itemRect ) :
savedSettings.minsRadio = GetCtlValue( itemHandle );

Re s t o re Set t i n g s ( ) uses Get DI t em ( ) , Set IT ext ( ) , and
Set Ct l Va l ue ( ) to restore the settings dialog items to the values saved in
the saved Sett i ngs data structure. Use the value saved in
s a ve d Sett i ngs . secs Rad i o to determine if the static text field should
read seconds or minutes.
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/************************************* RestoreSettings */

RestoreSettings()
{

int
i temType:
Rect itemRect;
Handle itemHandle;
GetDitem( gSettingsDialog, TIME_FIELD, &itemType, &itemHandle,
&itemRect );
SetIText( itemHandle, savedSettings.timeString );
GetDitem( gSettingsDialog, SOUND_ON_BOX. &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.sound );
GetDitem< gSettingsDialog, ICON_ON_BOX, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.icon );
GetDitem( gSettingsDialog, ALERT_ON_BOX. &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.alert );
GetDitem( gSettingsDialog, SECS_RADIO, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.secsRadio );
GetDitem< gSettingsDialog, MINS_RADIO, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.minsRadio );
if

savedSettings.secsRadio == ON )

{

else

GetDitem( gSettingsDialog, S_OR_M_FIELD, &itemType,
&itemHandle, &itemRect );
SetIText( itemHandle, "\pseconds" );
GetDltem( gSettingsDialog, S_OR_M_FIELD, &itemType,
&itemHandle, &itemRect );
SetIText( itemHandle, "\pminutes" );

CountDown () takes the number of seconds (or minutes) to count down
as its only argument, puts up the countdown window, and goes to it.
Start by loading the countdown window from the resource file. Set the
current GrafPort to the countdown window, make it visible, and set the
current font's size to 24 point. Make the current font appear in boldface.

/********************************

CountDown

CountDown( numSecs
long numSecs;
{

long
Str255
WindowPtr

myTime, oldTime, difTime;
myTimeString;
countDownWindow;

*******/
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countDownWindow

GetNewWindow( BASE_RES_ID. NIL_POINTER.
MOVE_ TO_FRONT ) :
SetPort( countDownWindow );
ShowWindow( countDownWindow );
TextFace( bold );
TextSize( 24 );
=

Your next step is to get the current time (in seconds since midnight,
January l, 1904), and to convert the countdown time from minutes to
seconds, if necessary. Also, set the global gCount i ng to TRUE.

GetDateTime< &myTime );
oldTime = myTime:
if ( gSeconds_or_minutes == MINUTES )
numSecs *= SECONDS_PER_MINUTE;
gCounting =TRUE:
While you count down, call Hand 1 e Event ( ) . This lets the user drag the
countdown window around the screen or make menu selections while you
count down. This is very important because it keeps your program from
falling into a mode. Users won't feel as though they're in countdown mode
because they'll be able to pull down desk accessories and, if they're in
MultiFinder, switch to other applications.
Every time myTi me changes, a second has passed, and you have to
redraw the countdown time. Call Er as e Rec t ( ) to clear the window and
redraw the time.
< numSecs > O ) && ( gCounting ) )

while
I

HandleEvent();
if ( gCounting )
I

MoveTo( LEFT, TOP );
GetDateTime( &myTime );
if ( myTime != oldTime )
I

difTime = myTime - oldTime;
numSecs = numSecs - difTime;
oldTime = myTime;
NumToString( numSecs . myTimeString );
EraseRect ( &CcountDownWindow->portRect) );
Drawstring( myTimeString );
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If g Count i ng is still TRUE, then no one interrupted the countdown, and
you can set your notification. Finally, set g Count i n g to FALSE and hide the
countdown window.

if ( gCounting )
SetNotification();
gCounting = FALSE;
HideWindow( countDownWindow );
If a notification is already set, remove it so you can set a new one. If
appropriate, load the small icon ( ' S I CN• ) from the resource file and put its
handle in the notification data structure. Do the same for the ' s nd '
resource and the string you loaded earlier.
Then, call NM I nst a11 ( ) to set the notification. Also turn on the Kill
Notification item in the File menu. Finally, set gNoti fy_set to TRUE.
!*****************************

SetNotification

*******/

SetNotification()
{

int
i temType;
Rect itemRect;
Handle itemHandl e;
if

gNotify_set )

{

NMRemove( &gMyNMRec );
HUnlock( gNotifyStrH );
GetDitem( gSettingsDialog, ICON_ON_BOX, &itemType. &itemHandle,
&itemRect );
if ( GetCtlValue( itemHandle ) )
gMyNMRec.nmSicon
GetResource( 'SICN'. BASE_RES ID );
else
gMyNMRec.nmSicon = NIL_POINTER:
GetDitem( gSettingsDialog, SOUND_ON_BOX. &itemType, &itemHandle.
&itemRect );
if ( GetCtlValue( itemHandle ) )
gMyNMRec.nmSound = GetResource( 'snd ' BASE_RES_ID );
else
gMyNMRec.nmSound = NIL_POINTER:
GetDitem( gSettingsDialog, ALERT_ON_BOX. &itemType, &itemHandle,
&itemRect ) :
if ( GetCtlValue( itemHandle ) )
{

261

Working with Dialogs

MoveHHi( gNotifyStrH );
Hlock( gNotifyStrH );
gMyNMRec.nmStr = *gNotifyStrH;
}

else

gMyNMRec.nmStr

=

NIL_POINTER;

NMinstall( &gMyNMRec );
Enableitem( gFileMenu, KILL_ITEM );
gNotify_set = TRUE;
Note that the routine MoveHH i ()was called before gNot i fySt rH was
locked. Normally, before you work with a pointer to a handled object, you
HLo c k ( ) the handle. When you're done with the pointer, you HU n 1 o ck ( )
the handle again. As we mentioned earlier, HLo c k ( ) creates an obstruction
in the middle of the application heap. Ifthe handle will only be HLocked for
a short period of time (a few lines of code), this won't be a problem. In
Reminder, you keep g Notify St rH HLoe ked from the time the notification
is installed until the notification is removed. That's too long to keep a
handle locked in the middle of the heap. Move HHi ( ) reduces this problem
by relocating the handled memory as high in the heap as possible. Locking
the handle at this point creates an obstruction at one end of the heap
instead of in the middle.
The topic of memory management on the Macintosh is important, but
beyond the scope of this book. Inside Macintosh, Volume II, Chapter 1
contains a complete description of the Memory Manager. As your
programs get larger and more sophisticated, you'll make more and more
use of this part of the Toolbox.

_J

In Review
This chapter examined some of the oldest parts of the Macintosh toolbox
(dialog boxes), together with some of the newest parts (SysEnvi rons ()
and the Notification Manager). You built an application that used most of
the Toolbox routines presented in the previous three chapters.
In Chapter 7, we'll address some of the programming issues that we have
not touched on so far, like error handling, managing multiple windows,
using the clipboard, printing, and working with scroll bars. We'll end with
a brief sojourn into the Macintosh Sound Manager.
Congratulations! The toughest part of the book is behind you.

7

Toolbox
Potpourri
Congratulations! Now that you have the
Macintosh interface under your belt,
youll see how to implement other traits
that Mac programs should possess: multiple window handling, error checking,
the Clipboard, file and print management, scroll bars, and sound.

THE FIRST APPLICATION, WindowMaker, shows you how to manage a dynamic windowing environment. In addition to supporting window creation,
movement, and disposal, WindowMaker introduces an error-handling
mechanism that you can use in your own applications.
Next, the desk scrap, more commonly known as the Clipboard, is
introduced. The Scrap Manager utilities that support cut, copy, and paste
operations are discussed. The second application, ShowClip, uses these
routines to display the current scrap in a window.
The third application, PrintPICT, introduces the File Manager and the
Printing Manager. You'll learn how to support the standard Open, Save,
and Save As... File menu options in your own code.
Next, we present a discussion on the use of scroll bars. The fourth
application, Pager, uses the Control Manager, as well as the Resource
Manager, to build a kinescopic display of PI CT resources.
For the piece de resistance, we present Sounder, an alternative to the
dreary world of Sys Beep ( ) .

_J

Keeping Track of Windows: WindowMaker
Most applications on the Macintosh allow you to open more than one
window at a time. WindowMaker lets you create as many windows as you
desire. After they are created, you can select, move, and close any window.

WindowMaker Specifications
Here's how WindowMaker works:

• It initializes the Toolbox.
• It initializes the menu bar.
• It loads a PI CT resource.
• It enters the Main Event Loop and performs the following functions.
• It creates a new window whenever the New menu item is selected,
centering the PI CT in the window.
• It closes the currently selected window whenever the Close menu item
is selected.
• It handles events for moving and updating windows.
• It quits when the Quit menu item is selected.
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WindowMaker is the first Primer program that does error checking.
Every time a Toolbox function is called, there is the possibility that it may
not execute properly. For example, if you call GetMenu ()to load a MENU
resource, and the operating system can't find the resource, the call returns
an error code. Your program should check for and respond to these error
codes. If you ignore Toolbox error code, you do so at your own risk. Check
Toolbox calls the way we do it in WindowMaker and the other programs in
this chapter. WindowMaker also fully supports desk accessory editing
operations.
Because WindowMaker uses the concepts of the previous chapters and
also handles error checking and multiple windows, you should consider
using it as the model for your own applications.

Setting up the WindowMaker Project
Create a folder called Wi nd owM a k er in your source code folder. Then use
ResEdit to create a new file inside the new folder called WindowMaker
Proj. Rs re. Build a WI ND with an ID of 400. Figure 7.1 shows the specifications of the WI ND you need.

§0§ WI ND ID

= 400

from WindowMaker Proj.Rsrc

Window title:
j WindowMaker

I

top

@::==J bottom~

left

~right

~

proclD

14

lo

D Uisible

lrefCon

I

181 goAwayFlag

Figure 7.1 WIND resource for WindowMaker.
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Now, create the menu resources. First, build the MBA R resource (Figure
7.2). Change the MBAR resource ID to 400. Now build the individual MENU
items. Figure 7.3 displays the S, File, and Edit menus for WindowMaker.
(The Edit menu is the same as Chapter 5's Timer program and Chapter 6's
Reminder program; copy resources from the older programs whenever
possible.)

D

MBRR ID

# of menus

400 from WindowM aker Proj .Rsrc
3

*****
menu res ID

1400

*****
menu res ID

140 1

*****
menu r es ID

1402

*****

Figure 7.2 MBA R resource for WindowMaker.

~
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§0~

MENU "Apple" ID

= 400 from Reminder Proj.Rsrc

menu ID

400

width

0

height

0

proclD

0

filler

0

enableflgs

$FFFFFFFB

title

*****
menu Item
icon#
key equiu
mark Char

•

IAbout WindowMaker
lo I

D
D

lsoo

style

...............
menu Item

I-

D

icon#
key equiu
mark Char

D
D

style

lso1

*****

0

Figure 7.3

MENU resources for WindowMaker.

~
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§0§ MENU "File Io
11

= 401

menu ID

401

width

0

height

0

proclD

0

filler

0

enableflgs

$FFFFFFFF

title

File

*****
menu Item
icon#
key equiu
mark Char
style

INew
lo
~

D

lsoo

*****
menu Item
icon#
key equiu
mark Char
style

IClose
lo I
~

D

lsoo

*****
menu Item
icon#
key equiu
mark Char
style

*****

Iaun
lo
[]

D

lsoo
0

Figure 7.3 (continued)

from WindowMaker Proj.Rsrc §
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§0§ MENU 11 Edit 11 ID = 402 from Reminder Proj.Rsrc ~

menu ID

402

width

0

height

0

proclD

0

filler

0

enableFlgs

$00000001

title

Edit

*****
menu Item
icon#

Iundo
lo

key equiu

[]

mark Char

D

style

lsoo

*****
menu Item
icon#
key equiu
mark Char
style

Ilo

D
D

lsoo

*****
menu Item

Icut

icon#

lo

key equiu
mark Char
style

~

D

lsoo

*****
Figure 7.3 (continued)
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menu Item

Icopy

icon#

lo

key equiu

[£]

mark Char

D

style

lsoo

*****
menu Item

IPaste

icon#

lo

key equiu

@]

mark Char

D

style

I

lsoo

*****
menu Item

IClear

icon#

lo

key equiu

D
D

mark Char
style

*****

I

lsoo
0

Figure 7.3 (continued)

Next, create the two DI TL resources, one for the about box, the other for
the new error-checking routines. Change the resource IDs to the ones
shown in Figure 7.4. To frame those two DI TL resources, build the two AL RT
resources shown in Figure 7.5.
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§0§ DITL

"About ID = 400 from WindowMak
11

!ii"iiot'iie·r:. 1.-ri·0·. ii·ro·jJ'ra'in. .f"ro'in. .H1·0··i
!Mac Programming Primer!
i
~

1©1989, D. Mark & C. Reed!!!

i.......................................................................................................j

OK

Item#

Type

Enabled

lop

left

bottom

right

Text/Resource ID
OK

1

Button

Yes

71

117

91

1n

2

Static Text

Yes

7

70

61

280

Another fine
program from the
Mac
Programming
Primer! ©1989,
D.Mark&C.
Reedf!I

§0§ Dill "Fatal Error" ID= 401 from Windou

!iin. .lnc·r:0·a·1·ii·iii··-ra·i·a1··0·r:r:o·r:. il·a·s···. . . . . 1
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AL RT resources for WindowMaker.

All you need now are the PI CT resources that you'll display in the
WindowMaker windows and the STR resources that will be used in the
error-checking routine. Use Chapter 3's ShowPICT PI CT resource, or just
cut and paste a picture from the Scrapbook. Be sure the resource ID for the
PI CT is 400. Finally, add the four STR resources shown in Figure 7.6 to the
Wi ndowMa ker Proj. Rs re file. Again, make sure to change the resource
IDs of each resource to those shown in the figure. When you're done, the
resource window ofWi ndowMa ker Proj. Rs re should look like Figure 7.7.
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Now, you're ready to launch THINK C. When prompted for a project to
open, create anew project in the Wi ndowMa ke r folder called Wi ndowMa ke r
Pro j. Make sure to add the Mac Traps library to your project. Create a new
source file (call it Wi ndowMa ker. c), and add it to Wi ndowMa ker Proj.
Here's the source code for Wi ndowMa ke r. c:

#define
#define
#define
/fdef i ne

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

400
OL

#define
#define
#define

APPLE_MENU_ID
FI LE_MENU_ID
ED IT _MENU_ID

400
401
402

#define
#define
#define

ABOUT_ITEM
ABOUT_ALERT
ERROR_ALERT_ID

1
400
401

#define
#define
#define
#define

NO_MBAR
NO_MENU
NO_PICTURE
NO_WIND

BASE_RES_ID
BASE_RES_ID+l
BASE_RES_ID+2
BASE_RES_ID+3

#define
#define
#define

NEW_ITEM
CLOSE_ITEM
OUIT_ITEM

1
2
3

#define
#define
#define
#define
#define

UNOO_ITEM
CUT_ITEM
COPY_ITEM
PASTE_ ITEM
CLEAR_ITEM

1
3
4

#define

DRAG_ THRESHOLD

30

//define
#define
#define

WINDOW_HOME_LEFT
WINDOW_HOME_TOP
NEW_WINDOW_OFFSET

45

#define
/fdefi ne

MIN_SLEEP
NIL_MOUSE_REGION

OL
OL

#define

LEAVE_WHERE_IT_IS

FALSE

#define
#define

WNE_TRAP_NUM
UNIMPL_TRAP_NUM

Ox60
Ox9F

#define
#define

NIL_STRING
HOPELESSLY_FATAL_ ERROR

-ll

0

5
6

5

20

"\p''

"\pGame over, man!"
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Boolean
Event Record
MenuHandle
PicHandle
Re ct
int

gDone, gWNEimplemented;
gTheEvent:
gAppleMenu. gEditMenu:
gMyPicture:
gDragRect;
gNewWindowleft = WINDOW_HOME_LEFT, gNewWindowTop
WINDOW_HOME_TOP:

/******************************** main *********/

main()
{

Tool Boxini t():
MenuBarinit();
LoadPicture();
SetUpDragRect();
Mainloop();

/*********************************** ToolBoxinit */

Tool Box I nit()
{

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
Ini tMenus ();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();

/***********************************

MenuBarlnit

*/

MenuBarlnit()
{

Handle

myMenuBa r;

if ( ( myMenuBar = GetNewMBar( BASE_RES_ID ) )
ErrorHandler( NO_MBAR );
SetMenuBar( myMenuBar );
if ( ( gAppleMenu = GetMHandle( APPLE_MENU_ID
ErrorHandler( NO_MENU );
AddResMen u( gApp l eMen u. . ORV R' ) ;
if ( ( gEditMenu = GetMHandle( EDIT_MENU_ID )
ErrorHandler( NO_MENU );
DrawMenuBar():

==

)

NIL_POINTER )
==

NIL_POINTER

NIL_POINTER
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/******************************** LoadPicture *********/

LoadPicture()
{

if ( ( gMyPicture = GetPicture( BASE_RES_ID ) )
ErrorHandler( NO_PICTURE );

NI L_PO INTER

/******************************** SetUpDragRect *********/

SetUpDragRect()
{

gDragRect = screenBits.bounds;
gDragRect.left += DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD:
gOragRect.bottom -= DRAG_THRESHOLD;

/******************************** MainLoop *********/

MainLoop()
{

gOone = FALSE:
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap) );
while ( gOone == FALSE )
{

HandleEvent();

/************************************* HandleEvent

*/

HandleEvent()
{

char

theCha r:

if ( gWNEimplemented
WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
else
I

SystemTask();
GetNextEvent( everyEvent, &gTheEvent ):

switch ( gTheEvent.what )
I
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case mouseDown:
HandleMouseOown();
break;
case keyDown:
case autoKey:
theChar = gTheEvent.message & charCodeMask;
if (( gTheEvent.modifiers & cmdKey ) != 0)
{

AdjustMenus();
HandleMenuChoice( MenuKey( theChar ) );
}

break:
case updateEvt:
BeginUpdate( gTheEvent.message );
DrawMyPicture( gMyPicture. gTheEvent.message );
EndUpdate( gTheEvent.message ):
break:

!************************************* HandleMouseDown */

HandleMouseDown()
{

WindowPtr
short int
long int

whichWindow;
thePart:
menuChoice, windSize;

thePart = FindWindow( gTheEvent.where, &whichWindow ):
switch ( thePart )
{

case inMenuBar:
AdjustMenus();
menuChoice = MenuSelect( gTheEvent.where );
HandleMenuChoice< menuChoice );
break:
case inSysWindow:
SystemClick( &gTheEvent, whichWindow );
break:
case inDrag:
OragWindow( whichWindow, gTheEvent.where. &gOragRect );
break;
case inGoAway:
DisposeWindow( whichWindow );
break:
case inContent:
SelectWindow( whichWindow );
break:
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/************************************* AdjustMenus *I

AdjustMenus()
{

if

IsDAWindow( FrontWindow()

)

)

{

Enable Item(
Enable Item(
Enableltem(
Enableltem(
Enable Item(

gEditMenu,
gEditMenu,
gEditMenu,
gEditMenu,
gEditMenu,

UNDO_ITEM ) ;
CUT _ITEM ) ;
COPY _ITEM ) ;
PASTE_ITEM ) ;
CLE AR_ ITEM ) :

l

else
{

Disableltem(
Disableltem(
Di sabl eltem(
Disableltem(
Disable Item(

gEditMenu,
gEditMenu,
gEditMenu,
gEditMenu,
gEditMenu,

UNDO_ITEM ) ;
CUT_ITEM ) ;
COPY _ITEM ) :
PASTE_! TEM ) :
CLEAR_ITEM ) ;

/************************************* IsDAWindow */

IsDAWindow( whichWindow )
WindowPtr
whichWindow;
{

if ( whichWindow == NIL_POINTER )
return( FALSE ) ;
else /* DA windows have negative windowKinds */
return( ( (WindowPeek)whichWindow )->windowKind < 0 );

/************************************* HandleMenuChoice */

HandleMenuChoice( menuChoice
long int
menuChoice:
{

int
int
if

theMenu;
the Item;
menuChoice != O )

{

theMenu = HiWord( menuChoice );
theltem = LoWord( menuChoice );
switch ( theMenu )
{
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case APPLE_MENU_ID :
HandleAppleChoice( theitem );
break;
case FILE_MENU_ID :
HandleFileChoice( theltem );
break;
case EDIT MENU ID :
HandleEditChoice( theltem );
break;
}

HiliteMenu( 0 );

!********************************

HandleAppleChoice

*******/

HandleAppleChoice( theitem )
int
the Item;
{

Str255
int
switch

accName;
accNumber:
theitem )

{

case ABOUT_ITEM
NoteAlert( ABOUT_ALERT, NIL_POINTER );
break:
default :
Getitem( gAppleMenu, theitem. accName );
accNumber = OpenDeskAcc( accName );
break;

/********************************

HandleFileChoice

*******/

HandleFileChoice( theitem )
int
the Item;
{

WindowPtr
whichWindow:
switch ( theltem )
{

case NEW_ITEM :
CreateWi ndow();
break:
case CLOSE ITEM :
if (( whichWindow = FrontWindow()) != NIL_POINTER
DisposeWindow( whichWindow );
break;
case OUIT_ITEM :
gDone = TRUE;
break:
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/********************************

HandleEditChoice

*******/

HandleEditChoice( theltem )
int
the Item;
{

SystemEdit( the!tem - 1 );

!************************************ CreateWindow */

CreateWindow()
{

WindowPtr
if
if
11

)

theNewestWindow;

theNewestWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT ) ) == NIL_POINTER
ErrorHandler( NO_WIND );
( (screenBits.bounds.right - gNewWindowLeft) < DRAG_THRESHOLD )
( ( screenBits.bounds.bottom - gNewWindowTop) < DRAG_THRESHOLD

)

gNewWindowLeft = WINDOW_HOME_LEFT;
gNewWindowTop = WINDOW_HOME_TOP;
MoveWindow( theNewestWindow, gNewWindowLeft,
gNewWindowTop,LEAVE_WHERE_IT_IS );
gNewWindowLeft += NEW_WINDOW_OFFSET;
gNewWindowTop += NEW_WINDOW_OFFSET;
ShowWindow( theNewestWindow );

/******************************** DrawMyPicture *********/

DrawMyPicture( thePicture, pictureWindow
thePicture;
PicHandle
WindowPtr
pictureWindow;
{

Rect

myRect:

myRect = pictureWindow->portRect;
CenterPict( thePicture, &myRect ):
SetPort( pictureWindow );
DrawPicture( thePicture, &myRect );
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/******************************** CenterPict *********/
CenterPict( thePicture, myRectPtr
PicHandle
thePicture:
Rect
*myRectPtr:
{

Rect

windRect, pictureRect:

windRect = *myRectPtr:
pictureRect = (**( thePicture )).picFrame:
myRectPtr->top = (windRect.bottom - windRect.top CpictureRect.bottom - pictureRect.top))
I 2 + windRect.top;
myRectPtr->bottom = myRectPtr->top + (pictureRect.bottom pictureRect.top);
myRectPtr->left = (windRect.right - windRect.left (pictureRect.right - pictureRect.left))
I 2 + windRect.left:
myRectPtr->right = myRectPtr->left + (pictureRect.right pictureRect.left);

/******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum:
{

StringHandle errorStringH;
if ( ( errorStringH = GetString( stringNum ) ) == NIL_POINTER
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING,
NIL_STRING,NIL_STRING );
else
{

Hlock( errorStringH );
ParamText( *errorStringH, NIL_STRING, NIL_STRING, NIL_STRING );
HUnlock( errorStringH );
I

StopAlert( ERROR_ALERT_ID, NIL_POINTER );
Exi tToShel l ():

Running WindowMaker
Now that your source code is done, you're ready to run WindowMaker.
Select Run from the Project menu. When asked to Br i n g the project up
to date, click Yes. If you run into any compilation problems, consult the
debugging tips found in Appendix E. When asked to Save changes before
running, click Yes. The menu bar should display the , File, and Edit
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menus. Desk accessories should work. The File menu should contain t hree
new menu items: New, Close, and Quit. The Edit menu contains the
standard menu items but is dimmed. Select New from the File menu a few
times: You should see something like Figure 7.8.
Each window can be selected and dragged around the screen. Selecting
Close closes the currently selected window.
Try selecting New about a dozen times (or until you've created enough
windows to cause window wrap). You should see something like Figure 7.9.
Each new window is placed below and to the right of the previous window.
When the new windows reach the bottom or the right of the screen, the
window wraps back to the top left corner. Select a window and drag it
partially off and then back onto the screen. An updateEvt will cause the
PI CT to be redrawn. Click in the close box of a window to close it. Now,
choose Quit from the File menu. Let's take a look at the code.
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Figure 7.8 Running WindowMaker .
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How WindowMaker Works
Wi ndo\vMa ker . c starts off with the :/fdefi ne statements. BASE_RES_ I D,
NI L_ PO INTER, MOVE_ TO_ FRONT, and REMOV E_ ALL_ EV ENTS are the familiar assignments used in the initialization phase of the program.
APP LE_MENU_l D, ED IT_ MENU_I D, and FI LE_ MENU_I Dare the resource ID
numbers for the MENU resources. ABOUT_ITEM, ABOUT_ALERT, and
ERROR_ ALERT _ID are used for the alert section and resources. The names
NO_MBA R, NO_ MENU, NO_ PICTURE, and NO_WIND are used to identify the
resource ID ofthe four strings used in the error-handling routine. NEW_ ITEM,
CLOSE_ ITEM, and OU IT_ITEM are used in the case statement in the menuhandlingroutines. UNDO_ITEM, CUT_ITEM, COPY _ ITEM, PASTE_ITEM, and
CLEAR_ ITEM will be used to control the Edit menu items for desk accessories. The DRAG_ THRESH 0 LD is used to set the distance from the edge, in
pixels, that the windows may be moved or new windows created.
WI NDOW_HOME_LEFT and WI NDOW_ HOME_ TOP are the default positions for
a new window on the screen. The NEW_WINDOW_OFFSET is set to the
number of pixels that a new window will be offset from the previous
window. MIN_SLEEP and NIL_ MOUSE_ REGIONS are the parameters for
Wai tN ext Event ( ) ; LEAV E_WH ERE_I T_ I SisaconstantforM oveW i ndow ( ) .
WN E_TRAP _ NUM and UNI MP L_TRAP NUM are used to determine the availability ofW a it Next Event ( ) on the user's Mac. Finally, set up NI L_STR I NG
and HOPE LESSLY_ FAT AL_ ERROR for use in the error-handling alert.
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#define
#define
/ldefi ne
#define

BASE_RES_ID
NI L_PO INTER
MOVE TO FRONT
REMOVE_ALL_EVENTS

400
OL
-ll
0

#define
#define
#define

APPLE_MENU_ID
FILE_MENU_ID
EDIT_MENU_ID

400
401
402

#define
/ldefi ne
/ldefi ne

ABOUT_ ITEM
ABOUT_ALERT
ERROR_ALERT_ID

400
401

#define
/fdefi ne
#define
/fdefi ne

NO_MBAR
NO_MENU
NO_PICTURE
NO_WIND

BASE_RES_ID
BASE_RES_ID+l
BASE_RES_ID+2
BASE_RES_ID+3

#define
If define
If define
#define
#define
If define
#define
#define

NEW_ITEM
CLOSE_ITEM
QUIT_ITEM
UNDO_ITEM
CUT_ITEM
COPY_ITEM
PASTE_ITEM
CLEAR_ITEM

2
3
1
3
4
5
6

#define

DRAG_ THRESHOLD

30

#define
#define
#define

WINDOW_HOME_LEFT
WINDOW_HOME_TOP
NEW_WINDOW_OFFSET

5
45
20

#define
/ldefi ne

MIN_SLEEP
NI L_MOUSE_REGION

OL
OL

/ldefi ne

LEAVE_WHERE_IT_IS

FALSE

#define
#define

WNE_TRAP_NUM
UNIMPL_TRAP_NUM

Ox60
Ox9F

#define
#define

NIL_STRING
HOPELESSLY_FATAL_ ERROR

1

1

"\p"
"\pGame over. man!"

Then define your global variables:

Boolean
Event Record
MenuHandle
PicHandle
Re ct
int

gDone. gWNEimplemented:
gTheEvent:
gAppleMenu. gEditMenu;
gMyPicture:
gDragRect:
gNewWindowleft = WINDOW_HOME_LEFT. gNewWindowTop =
WI NDO\LHOME_ TOP:
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gDone, as always, is used as a flag for program completion.
gWNEimpl emented is the flag used when evaluating whether
Wai tNext Event ()is available. gApp 1 eMenu and gEdi tMenu are handles
to the MENU resource; gMy Pi ct ure, the handle to the PI CT resource.
gDragRect is the rectangle within the user's screen in which the window
can be dragged around. gNewWi ndowleft and gNewWi ndowTop are the
left and top coordinates for new windows, and are initialized for the first
window.
main () startswiththefamiliarcallsto Too 1 Box I nit ( ) and Menu I nit ( );
then Load Picture() loads your PICT resource, and SetUpDragRect()
defines the dragging limits for windows. Next, go to Main Loop ( ) .

main ( )
(

Tool Boxlnit();
MenuBarlnit();
Load Picture();
SetUpDragRect();
Mainloop();
You haven't made any changes to Too 1 ~ox In it ( ) :

/*********************************** ToolBoxlnit */

Tool Box I nit()
(

InitGraf( &thePort );
In it Fonts ();
FlushEvents( everyEvent. REMOVE_ALL_EVENTS );
InitWindows();
InitMenusC);
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();
In Menu Bar In it ( ) , load your menu resources and draw the menu bar.
Everything is standard operating procedure except for the new error
handling. If GetNewMBa r ( BASE_RES_I D) returns a NI L_PO INTER, it indicates that the operating system could not find the MBA Rresource in your
resource file; the error-handling routine, Error Hand 1 er ( ) , will then
display an alert containing the string ( ' ST R ' ) resource with an ID number
of NO_M BAR. The same thing happens ifthe S or Edit menu resource cannot
be found:
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/***********************************

MenuBarinit

*/

MenuBarinit()
{

Handle

myMenuBar;

if ( ( myMenuBar = GetNewMBar( BASE_RES_ID ) ) == NIL_POINTER )
ErrorHandler( NO_MBAR ):
SetMenuBar( myMenuBar ):
if ( ( gAppleMenu = GetMHandle( APPLE_MENU_ID
== NIL_POINTER
ErrorHandler( NO_MENU ):
AddResMenu( gAppl eMenu. • DRVR' ) :
if ( ( gEditMenu = GetMHandle( EDIT_MENU ID
NIL_POINTER
ErrorHandler( NO_MENU ):
DrawMenuBar():
Lo ad Pi ct u re ( ) gets the PI CT resource out of your resource file. This
version of Lo ad Pi ct u re ( ) also checks to see if the resource was available.
If not, the error-handling routine is run with the ' ST R' resource string
possessing ID number NO _PICTURE.

!******************************** LoadPicture *********/

LoadPicture()
{

if ( ( gMyPicture = GetPicture( BASE_RES ID ) )
ErrorHandler( NO_PICTURE ):

NI L_PO INTER

Set Up Drag Rec t ( ) initializes the region within which windows can be
dragged and new windows created. The initial Re ct is set to the size of the
screen (screenBi ts. bounds); the left, right, and bottom of the Rect are
then decremented by DRAG_THRESH 0 LD. (Try changing DRAG_ THRESH 0 LD
to a number other than 3 0 and see what happens to the application.)

!******************************** SetUpDragRect *********/

SetUpDragRect()
{

gDragRect = screenBits.bounds:
gDragRect.left += DRAG_THRESHOLD:
gDragRect.right -= DRAG_THRESHOLD:
gDragRect.bottom -= DRAG_THRESHOLD:
Main Loop ( ) checks to see if Wai tNext Event ( ) is implemented.
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/******************************** MainLoop *********/

MainLoop()
{

gDone = FALSE;
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM. ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) );
while ( gDone == FALSE )
{

HandleEvent();

Ha nd l e Event ( ) is similar to the earlier event handlers, except that cut,
copy, and paste operations are now supported in desk accessories.
AdjustMenus () is now called if a command key equivalent event has
occurred, to change the state of the Edit menu. updateEvts are handled
with a call to DrawMyPi cture().

/************************************* HandleEvent

*/

HandleEvent()
{

char

theCha r;

if ( gWNEimplemented
WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
else
{

SystemTask();
GetNextEvent( everyEvent. &gTheEvent );
switch ( gTheEvent.what )
{

case mouseDown:
HandleMouseDown();
break;
case keyDown:
case autoKey:
theChar = gTheEvent.message & charCodeMask;
if (( gTheEvent.modifiers & cmdKey ) != 0)
{

AdjustMenus();
HandleMenuChoice( MenuKey( theChar ) );
}

break;
case updateEvt:
BeginUpdate( gTheEvent.message );
DrawMyPicture( gMyPicture. gTheEvent.message );
EndUpdate( gTheEvent.message );
break:
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Now, Hand l eM ouse Down ( ) supports desk accessory use of the Edit
menu. AdjustMenus() is also called to activate the Edit menu if a
mouse Down has occurred in the menu bar. Clicking in the close box calls
Di s po s eW i nd ow ( ) , which will close and free up the memory used for the
window.

/************************************* HandleMouseDown */

HandleMouseDown()
{

WindowPtr
short int
long int

whichWindow;
thePart;
menuChoice, windSize:

thePart = FindWindow( gTheEvent.where, &whichWindow ):
switch ( thePart )
{

case inMenuBar:
AdjustMenus();
menuChoice = MenuSelect( gTheEvent.where );
HandleMenuChoice( menuChoice ):
break:
case inSysWindow:
SystemClick( &gTheEvent, whichWindow );
break:
case inDrag:
DragWindow( whichWindow, gTheEvent.where, &gDragRect );
break:
case inGoAway:
DisposeWindow( whichWindow ):
break:
case inContent:
SelectWindow( whichWindow );
break:

AdjustMenus() and IsDAWindow() work together: AdjustMenus()
enables and disables the items in the Edit menu, depending on whether the
current window is a desk accessory window or a WindowMaker window. To
determine this we look into the structure of the current window: One of the
fields ofa window, wi ndowKi nd, is positive if the window is an application
window and negative ifit is a desk accessory window. So, in I s DAW i nd ow ( ) ,
FALSE is returned if there is no window, or if the window belongs to
WindowMaker, and all items in the Edit menu are disabled (dimmed). If
TRUE is returned, the Edit items are enabled so that desk accessories can
use them.
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/************************************* AdjustMenus */

AdjustMenus()
{

if

IsDAWindow( FrontWindow()

)

)

{

Enableltem(
Enable Item(
Enable Item(
Enable Item(
Enable Item(

gEditMenu,
gEditMenu,
gEditMenu,
gEditMenu,
gEditMenu,

UNDO_ITEM );
CUT _ITEM ) :
COPY _IT EM ) :
PASTE_ITEM ) :
CLEAR_ITEM ) :

I

else
I

Disableltem(
Disableltem(
Disableltem(
Disableltem(
Disable Item(

gEditMenu,
gEditMenu,
gEditMenu,
gEditMenu,
gEditMenu,

UNDO_ITEM ) :
CUT_ITEM );
COPY _ITEM ) :
PASTE_ITEM ) :
CLEAR_! TEM ) :

/************************************* IsDAWindow */

IsDAWindow( whichWindow )
WindowPtr
whichWindow:
{

if ( whichWindow == NIL_POINTER )
return( FALSE ):
else /* DA windows have negative windowKinds */
return( ( (WindowPeek)whichWindow )->windowKind < 0 );
Hand 1eMe nu Choi c e ( ) hasn't changed from the earlier programs with
menus, except that you now handle Edit menu selections:

/************************************* HandleMenuChoice */

HandleMenuChoice( menuChoice
long int
menuChoice:
I

int
int
if
I

theMenu:
the Item:
menuChoice != O )
theMenu = HiWord( menuChoice );
theltem = LoWord( menuChoice );
switch ( theMenu )
{
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case APPLE_MENU_ID :
HandleAppleChoice( theltem );
break;
case FILE_MENU_ID :
HandleFileChoice( theltem ):
break:
case EDIT_MENU_ID :
HandleEditChoice( theltem );
break;
J

HiliteMenu( 0 );

Handl eApp 1 eChoi ce() works the same way as Chapter 6's Reminder
program. The about item calls Note Al er t ( ) , which displays the AL RT and
the DI TL you set up for the about box.

/********************************

HandleAppleChoice

*******/

HandleAppleChoice( theltem )
int
the Item;
{

Str255
int
switch
I

accName:
accNumber:
theltem )
case ABOUT_ITEM :
NoteAlert( ABOUT_ALERT. NIL_POINTER );
break:
default :
Getltem( gAppleMenu, theltem, accName );
accNumber = OpenDeskAcc( accName );
break;

Ha nd l e Fi 1 e Cho i c e ( ) takes care of the File menu choices. The New
menu item runs the routine CreateWi ndow( ), and the Close menu item
closes the active window by calling Di sposeWi ndow( ). Using the Close
menu item is the same as clicking in the active window's close box. Quit sets
gDone to TRUE, which halts execution of the main event loop.

291

Toolbox Potpourri

/********************************

HandleFileChoice

*******/

HandleFileChoice( theltem )
int
the Item;
{

WindowPtr
whichWindow:
switch ( theltem )
I

case NEW_ITEM :
CreateWindow();
break:
case CLOSE_ITEM :
if ( ( whichWindow = FrontWindow() ) != NIL_POINTER
DisposeWindow( whichWindow );
break;
case QUIT_ITEM :
gDone = TRUE;
break:

Hand l e Ed i t Choi c e ( ) calls System Ed i t ( ) . If the active window belongs to a desk accessory, System Ed i t ( ) passes the appropriate edit
command to the accessory. Otherwise, it returns FALSE, and your application should then handle the edit command. Since the Edit menu items are
disabled in WindowMaker, Hand l e Ed i t Choi c e ( ) just takes care of desk
accessories.

******************************** HandleEditChoice

*******/

HandleEditChoice( theltem )
int
the Item:
I

SystemEdit( the Item - 1 ) ;
Cre ate Wi ndo w( ) controls the creation and placing of new windows for
WindowMaker. First, use Get NewW i nd ow ( ) with your WIND resource to
create a new window. If the WI ND is missing, GetNewWi ndow() returns a
NI L_PO INTER, so you can call ErrorHandl er ()with a 'STR ' resource
of NO_WI ND.

/************************************ CreateWindow */

CreateWindow()
{

WindowPtr

theNewesUJi ndow;

if ( ( theNewestWindow = GetNewWindow( BASE_RES_ID. NIL_POINTER.
MOVE_TO_FRONT ) ) == NIL_POINTER
ErrorHandler( NO_WIND );

292

Macintosh Programming Primer

Next, check to see if the left edge or the top of the new window is within
DRAG_ TH RESH 0 LD pixels of the edge of the screen. If so, reset
gNewWi ndowleft and gNewWi ndowTop to the home position.

if ( ( (screenBits.bounds.right - gNewWindowleft)
< DRAG_THRESHOLD
( ( screenBits.bounds.bottom - gNewWindowTop)
< DRAG_THRESHOLD

II

gNewWindowleft = WINDOW_HOME_LEFT;
gNewWindowTop = WINDOW_HOME_TOP;
MoveWindow( theNewestWindow, gNewWindowleft,
gNewWindowTop,LEAVE_WHERE_IT_IS );
gNewWindowleft += NEW_WINDOW_OFFSET;
gNewWindowTop += NEW_WINDOW_OFFSET;
ShowWindow( theNewestWindow );
Normally, you'd use the position of a window as specified in the WI ND
resource. In this case, however, the position of each new window is defined
by the globals gNewWi ndowleft and gNewWi ndowTop. Whenever a new
window is defined, MoveWi ndow() is called to move the window from the
original WIND-based position to the position described by g NewW i n d ow Left
andgNewWi ndowTop. ThefinalparametertoMoveWi ndow() isa Boolean
that determines whether the window, once moved, is moved to the front of
all other windows or is left in the same layer. LE AV E_W HERE_ IT_ I S tells
Move Wi n d ow ( ) not to move the window to the front. Since the window was
created in the front, this parameter will have no effect.
Next, gNewWi ndowleft and gNewWi ndowTop are incremented by
NEW_W I NDOW_ 0 FF SET, so the next new window won't appear directly on top
of the previous one. Finally, the window is made visible.
Dr a wMy Pi ct u re ( ) passes g My Pi ct u re to Cent e r Pi ct ( ) and then
draws the centered PICT in pi ctureWi ndow.

The real value of parameter passing is seen here. By passing the
Wi ndowPtr embedded in gTheEvent. message as a parameter to
Dr a wMy Pi ct u re ( ) , you avoid hard-coded variable names that would
limit the flexibility of this routine.
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/******************************** OrawMyPicture *********/
OrawMyPicture( thePicture, pictureWindow
PicHandle
thePicture:
WindowPtr
pictureWindow:
{

Rect

myRect:

myRect = pictureWindow->portRect:
CenterPict( thePicture, &myRect ):
SetPort( pictureWindow );
OrawPicture( thePicture, &myRect );
Center Pi ct ( ) is the same routine you've used in your other PI CT

drawing programs:

/******************************** CenterPict *********/
CenterPict( thePicture, myRectPtr
PicHandle
thePicture;
Rect *myRectPtr:
(

Rect

wi ndRect, pi ctureRect;

windRect = *myRectPtr;
pictureRect = (**( thePicture )).picFrame;
myRectPtr->top = (windRect.bottom - windRect.top (pictureRect.bottom - pictureRect.top))
I 2 + windRect.top;
myRectPtr->bottom = myRectPtr->top + (pictureRect.bottom pictureRect.top);
myRectPtr->left = (windRect.right - windRect.left (pictureRect.right - pictureRect.left))
I 2 + windRect.left;
myRectPtr->right = myRectPtr->left + (pictureRect.right pictureRect.left):
Finally, there's the ErrorHandl er() routine. ErrorHandl er() takes
an error ID as input, loads the 'STR' resource with that ID, and uses
Stop A1 e rt ( ) to display the error message. If the program can't find the
'STR' resource it needs, it calls StopA le rt () with the
HOPELESSLY _FATAL_ERROR string defined at the beginning ofWindowMaker (Game Over. Man), to inform the user that the situation is
exceedingly grim.
Finally, Exit To She 11 ( ) returns control of the Macintosh to the Finder.
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/******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum;
{

StringHandle errorStringH;
if ( ( errorStringH = GetString( stringNum ) ) == NIL_POINTER
ParamText( HOPELESSLY_FATAL_ERROR. NIL_STRING.
NIL_STRING.NIL_STRING );
else
{

Hlock( errorStri ngH ) ;
ParamText( *errorStringH. NIL_STRING. NIL_STRING. NIL_STRING );
HUnlock( errorStringH );
}

StopAlert( ERROR_ALERT_ID. NIL_POINTER );
Exi tToShel 1 <);
There are many solutions to error handling on the Macintosh. Whenever
you make a Toolbox function call, check to see if an error has occurred. This
is called passive error handling. Sometimes this is good enough, sometimes
it's not.
You can also go out of your way to avoid errors by checking everything
you can possibly check. For example, take another look at this code
fragment from the Menu I n i t ( ) routine:

MenuBarinit()
{

Handle

myMenuBar;

if ( ( myMenuBar = GetNewMBarC BASE_RES_ID ) ) == NIL_POINTER )
ErrorHandler( NO_MBAR );
SetMenuBar( myMenuBar );
if ( ( gAppleMenu = GetMHandle( APPLE_MENU_ID ) ) == NIL_POINTER
ErrorHandler( NO_MENU );
AddResMenu( gAppleMenu. 'DRVR' );
DrawMenuBar();
Although you check the return codes from both function calls in Menu1n i t ( ) , you still missed something. What happens if the File or Edit MENU
resources are not found? The program will not function properly and will
most probably crash. Checking all your resources may be time-consuming,
but in the end, it's well worth it.
Here's a version of Menu In i t ( ) with proactive error handling:
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MenuBarinit()
{

Handle

myMenuBa r:

if

( myMenuBar = GetNewMBar( BASE_RES_ID ) )
ErrorHandler( NO_MBAR );
if
( gAppleMenu = GetMHandle( APPLE_MENU_ID
ErrorHandler( NO_MENU );
if
( gFileMenu = GetMHandle( FILE_MENU_ID
ErrorHandl er( NO_MENU ) :
if
( gEditMenu = GetMHandle( EDIT_MENU_ID
ErrorHandler( NO_MENU );
AddResMenu( gAppleMenu, 'DRVR' );
SetMenuBar( myMenuBar );
DrawMenuBar();

==

)

NIL_POINTER )
==

NIL_POINTER

NIL_POINTER
NIL_POINTER

You can take error handling one step further and also check your
resources just before you use them. For example, you could call
Get MHa nd 1 e ( ) immediately before Menu Se 1 e ct ( ) in case the MEN Uwas
somehow corrupted.
You'll decide on the appropriate amount of error handling to perform.
Error handling bulks code up but provides a higher level of reliability for
your program. We highly recommend the inclusion of error-handling code
early in the programming cycle.

_J

The Scrap Manager
Whenever you use the Mac's copy, cut, or paste facilities, you're making use
of the Scrap Manager. The Scrap Manager manages the desk scrap,
more commonly known as the Clipboard. The second program, ShowClip,
will use the Scrap Manager Toolbox routines to open the Clipboard and
display the contents in a window.

Scrap Manager Basics
Data copied to the desk scrap is stored in two basic flavors, TEXT and PI CT.
Data stored in TEXT format consist of a series of ASCII characters. Data
stored in P I CT format consist ofa QuickDraw picture. ShowClip will handle
both TEXT and PI CT data types.
The Sera p Manager consists of six routines: I n fo Sc r a p ( ) ,
Un l o ad Scrap ( ) , Lo ad Scrap ( ) , Zero Scrap ( ) , Put Scrap(), and
Get Sc r a p ( ) . Each of these functions returns a long integer containing a
result code (1:457).
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InfoScrap()
InfoScrap() isafunction(oftype PScrapStuff) that returns information about the desk scrap in a struct of type ScrapStuff:
typedef struct ScrapStuff
I

1ong
scrapSize:
scrapHandle:
Handle
int
scrapCount:
scrapState:
int
StringPtr
scrapName:
ScrapStuff, *PScrapStuff:

The scrap Si z e field contains the actual size, in bytes, ofthe desk scrap.
The scrap Hand l e field contains a handle to the desk scrap (if it currently
resides in memory). The scrapCount field is changed every time
ZeroScra p () iscalled(we'llgetto ZeroScrap() in a bit). The scrapState
field is positive if the desk scrap is memory resident, zero if the scrap is on
disk, and negative if the scrap has not yet been initialized. The scrap Na me
field contains a pointer to the name of the scrap disk file (usually called the
Clipboard file).

UnloadScrap() and LoadScrap()
If the scrap is currently in memory, Un l oad Scrap ( ) copies the scrap to
disk and releases the scrap's memory. If the scrap is currently disk-based,
Unl oadScrap() does nothing.
If the scrap is currently on disk, Lo ad Scrap ( ) allocates memory for the
scrap and copies it from disk. If the scrap is currently memory-resident,
LoadScrap() does nothing.

ZeroScrap()
If the desk scrap does not yet exist, Zero Scrap ( ) creates it in memory. If
it does exist, Zero Sc r a p ( ) clears it. As we mentioned before, Ze r oScrap ( )
always changes the scrapCount field of the ScrapStuff struct.

PutScrap()
PutScrap() puts the data pointed to by source into the scrap:
long PutScrap( length, theType, source )
1ong
1ength:
ResType theType:
Ptr
source:
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The parameter length specifies the length of the data, and theType
specifies its type (whether it's PI CT or TEXT data). You must call
ZeroScrapC) immediately before each call to PutScrap( ).

GetScrap()
GetScrap ()resizes the handle hDest and stores acopyofthescrapin this
resized block of memory:

long GetScrap( hDest, theType, offset )
Handle hDest;
ResType theType:
long
*offset;
Specify the type of data you want in the parameter theType. The
offset parameter is set to the returned data's offset in bytes from the
beginning of the desk scrap. GetScrap() returns a long containing the
length of the data in bytes.
You can actually put and get data types other than TEXT and PI CT to
and from the scrap (1:461). For the most part, however, the TEXT and PI CT
data types should serve your needs.

_J

ShowClip
The ability to use the Clipboard is basic to Mac applications. ShowClip
shows you how to add this capability to your applications. Ifyou cut or copy
text or a picture in an application or in the Finder and then run ShowClip,
it will display the cut or copied text in a window.

ShowClip Specifications
The structure of ShowClip works like this:
• It initializes the Toolbox.
• It initializes a window.
• It puts whatever is in the Clipboard into the window.

• It quits.
ShowClip also does error checking. It warns if the WI ND resource is
missing, or if the scrap is empty.
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Setting Up the ShowClip Project
Start by creating a folder for this project, called ShowClip. Use ResEdit to
create a new file called ShowClip Proj.Rsrc and, within that, a WI ND with an
ID of 4 00. Figure 7.10 shows the specifications of this WI ND.
Add the DI TL in Figure 7.11 (this is the same AL RT as the "hopelessly
fatal" DI TL in WindowMaker, so use the WindowMaker DI TL if you have
it.

~U§

WIND ID= 400 from ShowClip Proj.Rsrc

Window title:

I

jshowClip
top

~

~bottom~

left

E=:J right

~

proclD

jo

jo

D Uisible

lrefCon

I

D goAwayFlag

Figure 7.10 WIND resource for ShowClip.

§0§

DITL "Fatal Error" ID= 401 from ShowCI
~n·n··Iilc·r:e·Ci-ril'fy

. .iafare·r·r·ci'r. il"a"S. . . . . . .~

µust occurred: "O

j

1..........................................................................................................1
( Gasp! )
Figure 7.11 0 IT L resource for ShowClip.
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Type

Item#

Enabled

top

left

bottom

right

Text/Resource ID

1

Button

Yes

86

117

106

1n

Gasp I

2

StaUcText

Yes

5

67

71

283

An Incredibly
fatal error has
Just occurred: 110

Figure 7.11

DI TL resource for ShowClip (continued).

Next, create an ALRT resource for your new error-checking routines
(Figure 7.12). Add the two 'STR' resources shown in Figure 7.13 to the
ShowCl i p Proj. rs re file. Again, be sure to change the resource IDs of
each resource to those shown in the figure. When you're done, the resource
ShowCl i p Proj. rs re should look like Figure 7.14.
§0§ Alert Fatal Error ID= 401 from ShowClip Pr
11

11

~bottom~
left
~right ~
items IOI 401
I
sound
top

stage 1
stage 2
stage 3
stage 4

D 2 bold
D 2 bold
D 2 bold
D 2 bold

.-

18] drawn
18] drawn
18] drawn
18] drawn

Figure 7 .12 DIT L resource for ShowClip.

1

1---

1
1---

1

1---

1

1....--
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STR ID
theStr

= 400 from

ShowClip Proj.Rsrc

ICan't load the WI ND resource! ! !

Data
sL...-1- - - - - - - - -

theStr
Data

IClipboard is Empty!!!

srL---_____

I
___.J

Figure 7.13 STR resources for ShowClip.

§0

ShowClip Proj.Rsrc

~

ALRT
DITL
STR
WIND

to

Figure 7.14 ShowClip
resources completed.

Now you're ready to launch THINK C. When prompted for a project to
open, create a new project in the ShowCl i p folder and call it ShowCl i p
Pr o j . Add Ma c Traps to your project. Create a new source file called
ShowCl ip.c and add it to ShowCl ip Proj. Here's the source code for
ShowCl i p. c:

#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_ TO_FRONT
REMOVE_ALL_EVENTS

#define
#define
#define

ERROR_ALERT_ID
NO_WIND
EMPTY_SCRAP

BASE_RES_ID+l
BASE_RES_ID
BASE_RES_ID+ 1

#define
#define

NIL_STRING
HOPELESSLY_FATAL_ ERROR

"\pGame over. man!"

WindowPtr

gClipWindow;

400

OL
-ll
0

.. \ p"
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!******************************** main *********/

main()
I

Tool Boxlnit();
Windowlnit();
Mainloop();

/******************************** ToolBoxlnit *********/

ToolBoxinit()
I

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
Ini tMenus ():
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();

/******************************** Windowinit *********/

Wi ndowl nit ()
I

if ( ( gClipWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT ) ) == NIL_POINTER )
ErrorHandler( NO_WIND );
ShowWindow( gClipWindow );
SetPort( gClipWindow >:

/******************************** Mainloop *********/

Mainloop()
I

Re ct
Handle
1ong int

myRect;
clipHandle;
length, offset;

clipHandle
NewHandle( 0 );
if
( length= GetScrap( clipHandle, 'TEXT', &offset ) ) < O )
I

if (
else
I

length= GetScrap( clipHandle, 'PICT'. &offset ) ) < 0 )
ErrorHandler( EMPTY_SCRAP );
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myRect = gClipWindow->portRect;
CenterPict( clipHandle, &myRect );
DrawPicture( clipHandle, &myRect ):
}

else
{

Hlock( clipHandle ):
TextBox( *clipHandle, length, &(thePort->portRect),
teJustleft );
HUnlock( clipHandle );
while ( !Button() ) :

/******************************** CenterPict *********/
CenterPict( thePicture. myRectPtr
thePicture:
PicHandle
Rect *myRectPtr:
I

Rect

windRect, pictureRect:

windRect = *myRectPtr:
pictureRect = (**( thePicture )).picFrame;
myRectPtr->top = (windRect.bottom - windRect.top (pictureRect.bottom - pictureRect.top))
I 2 + windRect.top;
myRectPtr->bottom = myRectPtr->top + (pictureRect.bottom pictureRect.top);
myRectPtr->left = CwindRect.right - windRect.left (pictureRect.right - pictureRect.left))
I 2 + windRect.left;
myRectPtr->right = myRectPtr->left + {pictureRect.right pictureRect.left);

!******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum;
{

StringHandle errorStringH;
if (
else
{

errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING,
NIL_STRING );

303

Toolbox Potpourri

HLock( errorStringH );
ParamText( *errorStringH, NIL_STRING, NIL_STRING,
NIL_STRING );
HUnlock( errorStringH );
}

StopAlert( ERROR_ALERT_ID, NIL_POINTER );
Exi tToShel l ();

Running ShowClip
Now that your source code is done, you're ready to run ShowClip. Before you
run the program, however, do a cut or copy operation on the ShowCl i p. c
file, or copy a picture from the Scrapbook; otherwise, you'll get an alert
telling you that the scrap is empty. Now run ShowClip. It should immediately display the text or picture that you cut or copied (Figure 7.15).
Quit by clicking the mouse. Try copying varying sizes of text, or different
pictures and running ShowClip again. This code should point out the ease
with which you can add the Clipboard functions to your applications.
Now, let's see how it's done.

ShowClip
Semple Copied Text

Figure 7.15 Running ShowClip.
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How ShowClip Works
ShowClip.c starts off with the //define constants that you'll be using. (You

saw these in WindowMaker already.) Next, declare your only global variable:

#define
#define
If define
#define

BASE_RES_ID
NI L_PO INTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

400

#define

ERRO R_ALERT _ID

BASE_RES_ID+l

#define
ff define

NO_WIND
EMPTY _SCRAP

BASE_RES_ID
BASE_RES_ID+l

/fdefi ne
#define

NIL_STRING
HOPELESSLY_FATAL_ ERROR

OL
-ll
0

"\p"
"\pGame over. man!"

gCl i pWi ndow is the pointer to the window you'll use to display your
scrap.

WindowPtr

gClipWindow;
ma i n() calls Too 1 Box I n i t ( ) , Wi nd ow I n i t ( ), and then Ma i n Loop ( ) .
No excitement here.

/******************************** main *********/

main ( )
I

ToolBoxlnit();
Windowlnit():
Mainloop();
There aren't any changes in Too 1 Box In it ():

/******************************** ToolBoxlnit *********/

ToolBoxlnit()
I

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent. REMOVE_ALL_EVENTS );
I nitWi ndows ();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
Ini tCursor();
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In Window In it ( ) , use GetNewWi ndow ()to get gC l i pWi ndow from the
resource file. Then call ShowWi ndow() to make gCl i pWi ndow visible, and
Set Port () so that all drawing is done in gCl i pWi ndow:
/******************************** Windowlnit *********/

Windowlnit()
{

if ( ( gClipWindow

GetNewWindow( BASE_RES_ID, NIL_POINTER.
MOVE_TO_FRONT ) ) == NIL_POINTER )
ErrorHandler( NO_WIND );
ShowWindow( gClipWindow );
SetPort( gClipWindow );
=

Main Loop ( ) is where the action is. You use NewHa nd le ( ) (II:32) to
create minimum-size blocks of storage for your PICT and TEXT data.
Remember, Get Scrap ( ) will resize these memory blocks for you, as
needed.
/******************************** Mainloop *********/

Mainloop()
{

Re ct
Handle
long int

myRect;
clipHandle;
length, offset;

clipHandle

NewHandle( 0 );

Now, call GetScrap (),looking first for some TEXT data. Ifthere are no
TEXT data in the scrap, call GetScrap () to look for PI CT data. If you find
no PICT data, call ErrorHandl er() with the EMPTY_SCRAP string. lfyou
do find PI CT data, call CenterPi ct ( ) tocenterthepicturein gCl i pWi ndow,
and then call Draw Pi ct u re ( ) to draw the picture:

if

length= GetScrap( clipHandle, 'TEXT'. &offset ) ) < O )

{

if ( (

length= GetScrap( clipHandle, 'PICT', &offset) ) < 0)
ErrorHandler( EMPTY_SCRAP );

else
{

myRect = gClipWindow->portRect;
CenterPictC clipHandle, &myRect );
DrawPicture( clipHandle, &myRect );
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Ifyou found the TEXT datain the scrap, lock c 1 i pH and le with H1 oc k ( ) ,
then call TextBox() to draw the text in gCl i pWi ndow.

else
I

Hlock( clipHandle );
TextBox( *clipHandle. length. &CthePort->portRect), teJustleft

);

HUnlock( clipHandle );
Finally, wait for a mouse click to exit the program:

while ( !Button() ) :
Cent e r Pi ct ( ) is the same routine you've used in the other Primer P I CT
drawing programs:

/******************************** CenterPict *********/
CenterPict( thePicture, myRectPtr
PicHandle
thePicture;
Rect
*myRectPtr;
{

Rect

windRect. pictureRect;

windRect = *myRectPtr;
pictureRect = (**( thePicture )).picFrame:
myRectPtr->top = (windRect.bottom - windRect.top -(pictureRect.bottom
- pictureRect.top))
I 2 + windRect.top;
myRectPtr->bottom = myRectPtr->top + (pictureRect.bottom pictureRect.top);
myRectPtr->left = (windRect.right - windRect. left (pictureRect.right - pictureRect.left))
I 2 + windRect.left;
myRectPtr->right = myRectPtr->left + (pictureRect.right pictureRect.left);
ErrorHandler() is the same routine that's part of WindowMaker.
Here, you get the string you need, then display it with StopAl ert( ).
Ex i t To She 1 1 ( ) halts program execution and brings up the Finder.

/******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum;
I

StringHandle errorStringH;
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if ( ( errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR. NIL_STRING. NIL_STRING,
NIL_STRING );
else
I

HLock( errorStringH );
ParamText( *errorStringH, NIL_STRING. NIL_STRING. NIL_STRING );
HUnlock( errorStringH );

I

StopAlert( ERROR_ALERT_ID. NIL_POINTER );
Exi tToShel 1 ();

_J

Inside the Printing and File Managers
The next program, PrintPICT, makes use ofboth the Printing Manager
and the File Manager. PrintPICT uses the Standard File Package
(IV:71)topromptforthename ofa PI CT file to print. It opens the file, reads
in a chunk of data, builds a page, and sends the page to the current printer.
The power of the File and Printing Managers makes this task a simple one.
Let's take a look at the Standard File Package.

The Standard File Package
The Standard File Package is used by most Macintosh applications to
support the Open, Save, and Save As ... File menu items. Figure 7.16 shows
examples of calls to SFGetFil e() and SFPutFil e( ). SFGetFi 1e() is
used to get a file name from the user. It can be called with a list offile types,
limiting the user's choices to files of the types specified on the list.
PrintPICT prints a single PI CT file. By calling S FGet Fi 1e ( ) , PrintPICT
allows the user to select the print file from a list limited to PI CT files.
The File Manager was totally remade when the Mac Plus came out.
The original Macintosh Filing System (MFS) was inadequate to
handle the number of files that hard disks could hold. The Hierarchical Filing System (HFS) replaced it, and Volume IV details the new
Toolbox calls. So, if you need information about the File Manager, use
Chapter 19 ofVolume IV, not Chapter 4 ofVolume II, which has been
superseded.
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IG=> Hard Disk I
Cl
Cl
Cl
Cl

Rpps
System Folder

IA

I!:!

E=> Hard

Disk

THINK C
Utilities

Driue

IO

Cancel

'--~~~~~~~~~---1...:....i

IE=> Hard

Disk

I

Cl Rpps
CJ System Folder
Cl THINK C
Cl Utilities

Saue this document as:

E=> Hard

Disk

Driue

Saue
Cancel

Figure7.16 SFGetFile()and SFPutFile().

Here's the calling sequence for SFGetFi 1 e( ):

SFGetFile( where, prompt, fileFilter, numTypes. typelist,
dlgHook, reply );
Point
where:
Str255
prompt;
ProcPtr fileFilter;
int
numTypes:
typelist;
SFTypelist
ProcPtr dlgHook;
SFReply *reply;
SF Get Fi 1 e ( ) displays the standard open dialog on the screen at the
point where. Thepromptstringisignored. numTypes and typel i st allow
you to specify up to four distinct file types (like PI CT or TEXT ) for the user
to choose from.
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Actually, you can specify as many file types as you like by creating
your own data type, instead of SFTypeli st. SFGetFil e() looks in
type Li st for numTypes types.
f i 1eFi1 ter is a pointer to a filtering routine called by SF Get Fi 1e ( )
after the file list is built from the type List. This filtering routine can
modify the file list before it's displayed to the user.
dl gHook also points to a function. The dl gHook function you write
allows you to add extra items (like pop-up menus) to the standard open
dialog.
Once the user selects a file, SFGet Fi 1e ( ) fills in the st r u ct pointed to
by reply with information about the selected file:

typedef st ruct SFRep l y
{

good;
char
copy;
char
/* array[l .. 4] of char; */
fType;
long
vRefNum;
int
version;
int
unsigned charfName[64J;
SFReply;
The good field contains FA LS E if the user pressed the Cancel button,
TRUE otherwise. The copy field is not currently used. The fType field
contains the file type selected (if the good field contains TRUE). The
version field always contains 0. The vRefNum and fName fields specify
the selected file. You11 see how to use these last two fields in the next
section.

Using the File Manager
Once the user has picked a file to open (via SF Get Fi l e ( ) ), you'll use the
File Manager routines FS0 pen ( ) to open the file, FSR ea d ( ) to read a block
of data, and FSC l o s e ( ) to close the file.
There are a few key terms you should know before you use the File
Manager. Volwnes are the media used to store files. When the user presses
the Drive button in the SFGet Fi 1 e ( ) dialog box, they look at the files on
the next available volume. Macintosh floppy and hard disks are both
examples of volumes. In the original Macintosh (the one with 64K ROMs),
all the files on a volume were organized in a flat file format called the
Macintosh File System (MFS) (Figure 7.17).
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The concept of folders existed on these "flat" Macs, but internally the
files on a volume were all stored in one big list. The folders were an illusion
maintained by the Finder. On flat volumes, users can't have two files with
the same name, even ifthey're in different folders. The Mac Plus (with 128K
ROMs) introduced a new method for organizing files: the Hierarchical File
System (HFS) (Figure 7.18).
Within each HFS volume is a set of files and directories. Within each
directory, there can be still more files and directories. You'll use the
File Manager Toolbox calls to open, read, write, and close these files
and directories.
FS0 pen ( ) opens the specified file for reading and/or writing, depending
on the file's open permission:

DODOO

Figure 7 .17 Flat files.

Figure 7.18 Hierarchical files.
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OS Err
Str255
int

FSOpen( fileName. vRefNum. refNum )
fileName:
vRefNum, *refNum;

SFGetFi 1 e() translatestheuser'sfileselectioninto a vRefNum and
an f Na me. The v Ref Num specifies the file's volume and directory, and
the fName specifies the file name. FSOpen () gets open permission
from a file control block stored on the file's volume.

Use the f i 1e Name and v Ref nu mfields of the reply record returned by
SFGet Fi l e ( ) as parameters to FS0 pen ( ). FS0 pen ( ) will return a path
reference number in the ref Num parameter that you can use in FSRe ad ( ) :

OSErr FSRead( refNum. count, buffPtr )
int
refNum:
long
*count:
Ptr
buffPtr;
The ref Nu m returned by FSO pen ( ) is known as an access path,
specifying the file's volume and the file's location on the volume all in
one variable.
Specify the file to be read from using the parameter ref Num, and specify
the number of bytes to be read using the parameter count. The bytes will
be read into the space pointed to by the parameter buff Pt r (make sure you
allocate the memory to which buff Pt r points), and the number of bytes
actually read will be returned in count.
Finally, close the file by calling FSC 1 o s e ( ) :

OSErr FSClose( refNum )
int
refNum;
Specify the file to be closed via the parameter ref Nu m.
For a detailed discussion of the File Manager, tum to Inside Macintosh
(Volume IV, Chapter 1) and Tech Notes 47, 77, 80, and 190. You'll need this
for any substantial development effort.
Now, let's take a look at the Printing Manager.

_J

Using the Printing Manager
Prepare the Printing Manager for use by calling PrOpen ( ). Then,
allocate a new print record using NewHa nd 1 e ( ) . The print record contains
information the Printing Manager needs to print your job, including page
setup information and information specific to the print job.
You can prompt the user to fill in the page setup information by calling
PrStl Di al og( ). Prompttheuserforjob-specificinformation via a call to
Pr Job Di a1 o g ( ) . Each of these routines displays the appropriate dialog
box and fills the newly allocated print record with the results.
Then, call PrOpenDoc() to set up a printing graf Port. The printing
grafPort is made up of pages. PrOpenDoc() calls SetPort( ), so you
don't need to do so. You'll call Pr 0 pen Page ( ) to start a new page, then
make a set of QuickDraw calls (like Draw Pi ct u re ( ) ) to fill the page with
graphics. Next, call Pr C1 os e Page ( ) to close the current page. Call
PrOpenPage () and Pr Cl osePage () for each page you want to create.
When you've drawn all your pages, close the document with a call to
PrCl oseDoc ().Now, it's time to print our document. Do this with a call to
PrPi cFil e(). When you're done with the Printing Manager, call

PrCl ose().
The Printing Manager is described in detail in Inside Macintosh, Volume
II, Chapter 5. If you plan on writing an application that supports printing,
read this chapter thoroughly.
Now, let's look at PrintPICT.

_J

PrintPICT
Since the "paperless society" seems to be rapidly receding into the distance,
it's reasonable to expect a Mac application to be able to print. PrintPICT
shows you how to print PI CT files.
PrintPICTreads in the contents ofa PI CT file. Reading in the contents
ofa TEXT file is no different. Instead ofinterpreting the data as a PI CT,
you would run the data through a parser that handles pagination, line
breaks, hyphenation, and so on, before you draw it on the print

graf Port.
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PrintPICT Specifications
PrintPICT works like this:
• It initializes the Toolbox.

• It uses the Standard File Package to locate a file of type PI CT.
• It uses the File Manager to open a file of type PI CT .
• It uses the Printing Manager to print the PI CT file.
• It quits.

PrintPICT also has error checking. It puts up an alert if the printing
operation goes astray at a number of different points.

Setting Up PrintPICT Resources
Start by creating a folder for this project, called Pri ntPICT. Then, use
ResEdit to create a new file called PrintPICT Proj.Rsrc.
Create a DI TL resource for your error alert (Figure 7.19). Add the same
old ALRT (Figure 7.20). Next, add the six' STR' resources shown in Figure

§0§ Dill "Fatal Error" ID= 401 from PrintPI

1a11··111c·r:e·e1·1·iiiy. laltii···e·r:r:o·r:-il·a·s. . . . . . .1
Uust occurred: "O
!

L. -.. ·-·-· ·---··--··. -.. -.. -_.J
Gasp!

Item•

1
2

Type
Button
St11t1c Text

to~

Eneble~

left

rt~ ht

bolt ~m

Yes

86

117

106

177

Yes

5

67

71

283

Text/Resourc1
Gas pl
An tncredtbly
fetel error
hes Just
occurred:

Figure 7.19 DI TL Resource for PrintPICT.

·o
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7.21 to the PrintPICT resource file. Be sure to change the resource IDs of each
resource to those shown in the figures. When you're done, the resource
window of Pr i nt PI CT Pro j . rs r c should look like Figure 7.22.
Once again, it's time to code.

Setting Up the PrintPICT Project
Start up THINK C. Create a new project in the Pr i nt PICT folder. Call
it Pri ntPICT Proj. Make sure to add the MacTraps library to your
project. Create a new source file called Pr i nt PI CT • c and add it to
Pri ntP ICT Proj. The source code for Pri ntPICT. c followsonpage316.

1§10§ Alert "Fatal Error" ID= 401 from PrintPICT Pr
top

~bottom~

left

~right

itemslDI 401

I

stage 1

D 2 bold

stage 2

D

~

181drown
181 drown
stage 3 D 2 bold 181 drawn
stage 4 D 2 bold 181 drawn

Figure 7.20

2 bold

sound

~
1
1
1

ALRT resource for PrintPICT.

D

STR ID

theStr
Data

402 from PrintP I CT Proj .Rsrc

lThe file header was less than 512
bytes long!!!

IQ

st
~

0

STR ID - 403 from PrintPICT Proj.Rsrc

theStr
Data

Could not allocate enough
memory for the PI CT!!!

$
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§[]= PrintP I CT Proj.Rsrc
ALRT
DITL
STR

~

~

Figure 7.22 PrintPICT
resources completed.

#include "'PrintMgr.h"
#define
/fdefi ne
#define
#define

HEADER_SIZE
NI L_PO INTER
BASE_RES_ID
REMOVE_ALL_EVENTS

512
OL
400

#define
#define
#define
/fdef i ne
#define
#define
/fdefi ne

ERROR_ALERT_ID
CANT_OPEN_FILE
GET_EOF _ERROR
HEADER_TOO_SMALL
OUT_OF_MEMORY
CANT_READ_HEADER
CANT_READ_PICT

BASE_RES_IO+l
BASE_RES_IO
BASE_RES_IO+l
BASE_RES_I0+2
BASE_RES_I 0+3
BASE_RES_I 0+4
BASE_RES_I0+5

#define
#define
/fdef i ne

NIL_PRPORT
NI L_IOBU FFER
NIL_DEVBUF

NIL_POINTER
NI L_ P0 I NT ER
NIL_POINTER

/fdefi ne
#define
//define
#define
#define
#define

Nll_STRING
IGNORED_STRING
Nll_FILE_FILTER
NIL_OIALOG_HOOK
OONT_SCALE_OUTPUT
HOPELESSLY_FATAL_ERROR

Boolean
THPri nt

DoDialogs();
gPrintRecordH;

0

"\p"
NIL_STRING
NIL_POINTER
NIL_POINTER
NIL_POINTER
"'\pGame over. man!"
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/******************************** main *********/

main()
{

SFReply

reply:

ToolBoxlnit():
Printlnit():
GetFileName( &reply >:
if ( reply.good ) /* The User didn't hit Cancel */
{

if

DoDialogs() )

{

PrintPictFile( &reply );

/*********************************** ToolBoxlnit */

ToolBoxlnit()
(

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();

/******************************** Printlnit *********/

Printlnit()
{

gPrintRecordH = (THPrint)NewHandle( sizeof( TPrint ) );
PrOpen();
PrintDefault( gPrintRecordH );
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/********************************

GetFileName

*******/

GetFileName< replyPtr >
SFReply
*replyPtr;
(

Point
SFTypelist
int

myPoint;
typelist;
numTypes;

my Point. h = 100;
myPoint.v = 100;
typelist[ 0 ] = 'PICT';
numTypes = 1;
SFGetFile( myPoint, IGNORED_STRING, NIL_FILE_FILTER, numTypes,
&typelist, NIL_DIALOG_HOOK, replyPtr );

!********************************
Boolean

DoDialogs

*******/

DoDi a 1ogs ()

(

PrStlDialog( gPrintRecordH >:
return( PrJobDialog( gPrintRecordH ) );

!********************************

PrintPictFile*******/

PrintPictFile( replyPtr )
SFReply
*replyPtr:
{

int
TPPrPort
TPrStatus
PicHandle
char
1 ong

srcfile:
printPort:
printStatus:
thePict:
pictHeader[ HEADER_SIZE ];
pictSize, headerSize:

if< FSOpen( (*replyPtr).fName, (*replyPtr).vRefNum, &srcfile) !=
noErr )
ErrorHandler( CANT_OPEN_FILE );
if

<

GetEOF( srcfile, &pictSize ) != noErr
ErrorHandler( GET_EOF_ERROR );

headerSize = HEADER_SIZE:
if ( FSRead( srcfile, &headerSize, pictHeader
ErrorHandler( CANT_READ_HEADER );
if

( pictSize -= HEADER_SIZE ) <= 0 )

{

ErrorHandler( HEADER_TOO_SMALL );

!= noErr )
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if

( thePict = CPicHandle)NewHandle( pictSize ) )

NI L_POI NTER

{

ErrorHandler( OUT_OF_MEMORY );
HLockC thePict );
if ( FSRead( srcFile. &pictSize. *thePict
ErrorHandler( CANT_READ_PICT );

!= noErr )

FSCloseC srcFile );
printPort = PrOpenDoc( gPrintRecordH, NIL_POINTER. NIL_POINTER );
PrOpenPage( printPort. DONT_SCALE_OUTPUT );
DrawPicture( thePict. &C**( thePict )).picFrame );
PrClosePage( printPort );
PrCloseDoc( printPort );
PrPicFile( gPrintRecordH. NIL_PRPORT, NIL_IOBUFFER, NIL_DEVBUF.
&printStatus );
}

/******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum:
{

StringHandle errorStringH:
if ( ( errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR. NIL_STRING. NIL_STRING.
NIL_STRING );
else
{

Hlock( errorStringH );
ParamText( *errorStringH, NIL_STRING. NIL_STRING. NIL_STRING );
HUnlock( errorStringH ):
}

StopAlert( ERROR_ALERT_ID. NIL_POINTER );
ExitToShel 1():
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Running PrintPICT
Now that your source code is entered, you're ready to run PrintPICT.
PrintPICTwill bring up the SFGetFi 1 e() dialogbox(Figure 7.23).
Select a PI CT file to be printed. The Page Setup dialog box will then be
displayed (Figure 7.24). After you click OK, the Print Job dialog box
appears (Figure 7.25). If you click on OK, or press <RETURN>, PrintPICT
will print your PI CT file and quit. Let's see how it's done.

la PrintPICTI
~

D My Test PICT

6=:> Hard

Disk

Driue
Open
Cancel

Figure 7.23 SF Get Fi l e () dialog box.

=La=s=e=r=w=ri=te=r=P=a=g=e=s=e=tu=p=====================s=.2~n OK
Poper: ® US Letter O R4 Letter O Tabloid
O us Legel O BS Letter
( Cancel
Reduce or
Enlarge:

1Hmil%

Orientation

-~

Printer Effects:
1:81 Font Substitution?
1:81 TeHt Smoothing?
1:81 Graphics Smoothing?
181 Faster Bitmap Printing?

D
)

(Options)
( Help )

Figure 7.24 PrintPICT calls the Page Setup dialog box.

LaserWriter "LoserWriter"
Copies:liMI
Couer Page:

Pages:® Rll
® No O First Page

Paper Source: ® Poper Cassette

n OK D
0 From: D To: D (Cancel )
5.2

0 Last Page

O Manual Feed

Figure 7.25 PrintPICT calls the Print Job dialog box.

( Help ]
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How PICTPrinter Works
Start by /!incl ude-ing the Printing Manager's /Ii ncl ude file. THINK C '
normally #i n c 1 ud es everything you'll need, but there are a few exceptions.
In this case, # i nc 1 ude Pr i n t Mgr . h.

#include "PrintMgr.h"

Here's a list of files that are not included automatically:
#include
#include
#include
#include
#include
#include
#include
#include
/Ii ncl ude
#include
#include
#include
#include
#include
#include
#include

"Appletalk.h"
"nAppletalk.h"
"Color.h"
"ColorToolbox.h"
"DeskBus.h"
"DiskDvr.h"
"PrintMgr.h"
"ScriptMgr.h"
"SCSIMgr .. h"'
"SerialDvr.h"
"SlotMgr.h"
"SoundDvr.h"
"SoundMgr.h"'
"StartMgr.h"
"TimeMgr.h"
"VRetraceMgr.h"

How can you tell ifyou need to #include one of these? If you get a
compilererror,like i nva 1 id de cl a rat i on,anditreferstoaTHINK
C defined global or type, check your code for typos. If the problem still
exists, look through these #include files (use the Find command)
until you find the type or variable's declaration. Finally, #include
that file.
Next come your #defines:
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#define
#define
#define
#define

HEADER_SIZE
NIL_POINTER
BASE_RES_ID
REMOVE_ALL_EVENTS

512
OL
400

#define
#define
#define
#define
#define
#define
#define

ERROR_ALERT _ID
CANT_OPEN_FILE
GET _EOF _ERROR
HEADER_ TOO_SMALL
OUT_OF_MEMORY
CANT_READ_HEADER
CANT_READ_PICT

BASE_RES_ID+l
BASE_RES_ID
BASE_RES_IO+l
BASE_RES_ID+2
BASE_RES_ID+3
BASE_RES_ID+4
BASE_RES_ID+5

#define
#define
#define

NIL_PRPORT
NIL_IOBUFFER
NIL_DEVBUF

NIL_POINTER
NIL_POINTER
NIL_POINTER

#define
#define
//define
#define
#define
#define

NIL_STRING
I GNO RED_STR I NG
NIL_FILE_FILTER
NIL_DIALOG_HOOK
DONT_SCALE_OUTPUT
HOPELESSLY_FATAL_ERROR

0

"\p"

NIL_STRING
NIL_POINTER
NI L_POINTER
NIL_POINTER
"\pGame over, man!"

HEADE R_ SI ZE is used for removing the header at the top of PI CT files.
BASE_RES_ID, NI L_PO INTER, and REMOV E_ALL_EV ENTS are the initialization-related #defines you've seen earlier. ERROR_ALERT _ID,
CANT_OPEN_FILE,GET_EOF_ERROR,HEADER_TOO_SMALL,OUT_OF_MEMORY,
CANT _READ_H EADER, and CANT _READ_P I CT are all used for the
appropriate error strings in the error-handling routines. NI L_PRPORT,
NI L_IOBUFFER, NI L_DEVBUF, NI L_STRING, IGNORED_STRING,
NIL_FILE_FILTER, NIL_DIALOG_HOOK, and DONT_SCALE_OUTPUT are
the arguments in the Printing Manager routines. Finally,
H0 PE LESS LY_ FAT AL_ ERR 0 Ris for your AL RT of last resort.
Next, declare your globals:

char
DoDialogs();
THPrint gPrintRecordH;
DoDi al ogs ()returns either TRUE or FALSE, so declare it to be of type
Boo l ea n. g Pr i n t Rec o rd His the handle to the print record you'll create.
As usual, main ( ) starts off with a call to Tool Box In it ( ) . Then,
Pr i nt In i t ( ) is run and SF Get Fi l e ( ) is invoked. Ifthe user doesn't click
on the Cancel button, DoDi al ogs () is called.
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/******************************** main *********/

main()
{

SFReply

reply;

Tool Boxlni t();
Printlnit();
GetFileName( &reply );
if ( reply.good ) /* The User didn't hit Cancel */
{

if

DoDialogs() )

{

PrintPictFile( &reply );

ToolBoxlnit() is the same as always:
/*********************************** ToolBoxlnit */

Tool Boxlnit()
{

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows():
InitMenus():
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();

The information entered by the user in the Page Setup and Print Job
dialog boxes is stored in a print record. Pr i nt Default ( ) fills the
print record with default print values. A handle to the print record is
passed to Pr Pi cFi 1 e(.) at print time.
Pri ntini t() uses NewHandl e() toallocateablockofmemorythesize
of a print record, and makes gPri ntRecordH a handle to that memory.
Call PrOpen () tostartupthePrintingManager, thensetthedefaultprint
record to gPri ntRecordH by calling Pri ntDefaul t( ). Doing this ensures that any changes you make to the Page Setup and Job dialogs will be
implemented when you print.
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/**************************** Printinit *********/
Printinit()
{

gPrintRecordH = CTHPrint)NewHandle( sizeof( TPrint ) );
PrOpen ( ) :
PrintDefault( gPrintRecordH );
Get Fil eName() sets up the arguments and calls SFGetFi le().
numTypes was defined as l, so you need to set up a single entry in the
type Li st array. Display only files of type PI CT. The pointer to the reply
from SF Get File () will be placed in rep l yPtr:
/*****************************

GetFileName

*******/

GetFileName( replyPtr )
SFReply
*replyPtr:
{

Point
SFTypelist
int

myPoint;
typelist;
numTypes;

my Po i nt. h = 100 :
myPoint.v = 100:
typelist[ 0 ] = 'PICT';
numTypes = 1:
SFGetFile( myPoint, IGNORED_STRING, NIL_FILE_FILTER, numTypes.
&typelist, NIL_DIALOG_HOOK, replyPtr ):
Do Di al ogs ()calls Pr St 1 Di al og ()to do the Page Setup dialog, then
calls PrJ ob Di al og ( ) to do the Job dialog.If the user hits the cancel button
in the Print Job dialog box, DoDi a 1 ogs () returns FALSE. The value returned by Pr Job Di a 1 o g ( ) is returned by Do Di a l ogs ( ) .
Normally, your application would bring up the Page Setup dialog in
response to a Page Setup... menu selection and the Print Job dialog in :
response to a Print... menu selection. PrintPICT calls both dialogs for
demonstration purposes only

!********************************
Boolean

DoDialogs

DoDialogs()

{

PrStlDialog( gPrintRecordH >:
return< PrJobDialog( gPrintRecordH ) );

*******/
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Pr i n t Pi ct Fil e ( ) starts off with a call to FS0 pen ( ) to get the access
path of the file selected by S FGet Fi l e ( ) . If the file can be opened,
Get E0 F ( ) is called, returning the size ofthe file in the parameter pi ct Si z e.
Next, FSR ea d ( ) attempts to read the 512-byte header that describes the
rest ofthe file. The actual number ofbytes read is returned in the parameter
header Si z e. If less than 512 bytes was read, or if you run out of memory
while trying to read the picture in, call the Er r or Hand l er ( ) . Since
PrintPICT won't need the 512-byte PICT header, pi ctSi ze is decremented by 512. This reduced version of pi ct Si z e will be used to read in
the headerless PI CT.

/********************************

PrintPictFile*******/

PrintPictFile( replyPtr )
SFReply
*replyPtr;
I

int
TPPrPort
TPrStatus
PicHandle
char
long

if
noErr )
if

srcFile;
printPort;
printStatus;
thePict;
pictHeader[ HEADER_SIZE ];
pictSize, headerSize:

FSOpen( (*replyPtr).fName, (*replyPtr).vRefNum, &srcFile ) !=
ErrorHandler( CANT_OPEN_FILE ):
GetEOF( srcFile, &pictSize ) != noErr
ErrorHandler( GET_EOF_ERROR );

headerSize = HEADER_SIZE:
if ( FSRead( srcFile, &headerSize, pictHeader
ErrorHandler( CANT_READ_HEADER );
if
I

if
I

!= noErr )

( pictSize -= HEADER_SIZE ) <= 0 )
ErrorHandler( HEADER_TOO_SMALL );
( thePict

=

CPicHandle)NewHandle( pictSize ) )

NI L_POINTER

ErrorHandler( OUT_OF_MEMORY ):

Ifyou've passed through these trials successfully, you're ready to read in
the P I CT data. Since FSR ea d ( ) requires a pointer to the read buffer, and
you allocated a handle (the Pi ct), you'll have to HLock ( ) the handle before
you pass its pointer(*thePi ct)to FS Read ( ) . Call FSRead ()to read in the
PI CT. If this fails (IV: 109), Er r o r Ha n d 1er ( ) is run yet again. Assuming
that you finally have the PI CT in memory at this point, close the PI CT file
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with FSCl ose( ). Next, PrOpenDoc() is called, returning a pointer
(pri ntPort) to the printing graf Port. Open a new page with
Pr 0 pen Pa ge ( ) , and draw the PI CT with Draw Pi ct u re ( ). When you're
done PrCl osePage () closes the page, and PrCl oseDoc () closes the
printing g ra f Port.
Finally, print the file with Pr Pi c Fi 1 e ( ) .

Hlock( thePict );
if ( FSRead( srcFile, &pictSize. *thePict
ErrorHandler( CANT_READ_PICT );

!= noErr )

FSClose( srcFile );
printPort = PrOpenDoc( gPrintRecordH, NIL_POINTER, NIL_POINTER );
PrOpenPage( printPort, DONT_SCALE_OUTPUT );
DrawPicture( thePict, &(**( thePict )).picFrame );
PrClosePage( printPort );
PrCloseDoc( printPort );
PrPicFile( gPrintRecordH, NIL_PRPORT, NIL_IOBUFFER, NIL_DEVBUF,
&printStatus );

Error Hand 1 er ( ) is the same as in the earlier programs. Take the alert
string resource ID and set up Pa ram Text ( ) with it. Then, display the alert
with StopAlert() and quit with ExitToShel l ().
/******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum;
{

StringHandle errorStringH;
if ( ( errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING,
NIL_STRING );
else
{

Hlock( errorStringH );
ParamText( *errorStringH, NIL_STRING, NIL_STRING, NIL_STRING );
HUnlock( errorStringH ) ;
l

StopAlert( ERROR_ALERT_IO, NIL_POINTER );
ExitToShel l ();

_J

Scroll Bars! We're Gonna Do Scroll Bars!
Scroll bars are a common control used in Macintosh applications. This
section shows you how to set one up to control paging between a series of
pictures in a window.

Making Use of Scroll Bars
Scroll bars are a common control used in Macintosh applications (Figure
7.26). The routines that create and control scroll bars are part ofthe Control
Manager. NewCo nt r o l ( ) is used to create a new control:

FUNCTION NewControl( theWindow : WindowPtr : boundsRect : Rect :
title : Str255 ; visible : BOO LEAN ;
value : INTEGER : min .max
INTEGER ;
proc IO : INTEGER ; ref Con : LONG I NT )
Control Hand l e;

Pager

111111

••

!!!Ill

~Ii

Figure 7.26 Window with scroll bar (P ager).
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The parameter pro c I D specifies the type of control to be created. To
createanewscrollbar,passtheconstantscrol l BarProctoNewControl ( ).
Every scroll bar has a minimum, maximum, and current value. For
example, a scroll bar may go from 1 to 2 0, and currently be at 10 (Figure
7.27).
Once the scroll bar is created, call Dr a we on t ro 1s ( ) to draw it in your
window:

PROCEDURE DrawControls( theWindow

WindowPtr );

As the calls to Window Manager routines (such as Sh owW i n d ow ( ) or
Move Wi n d ow ( ) ) do not redraw controls in a window, Dr a wC on tr o 1 s ( )
must be called whenever the window receives an update event.

When a mouseDown event occurs Fi ndWi ndow() is called, returning a
part code describing the part of the window in which the mouse Down
occurred. If the mouseDown was i nContent, call Fi ndControl ( ).

FUNCTION FindControl( thePoint : Point; theWindow: WindowPtr;
VAR whichControl : ControlHandle ) :
INTEGER;

Position 1

I

111-1
:-:·:· --1,..._T_h_u_m_b_a_t_P_o_s-it-io_n_l_O.....,

l l _~. .

-P-o-s-it_i_o_n_2_0_

Figure 7.27 Scroll bar positioning.
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Like Fi ndWi ndow ( ) , Fi ndCont ro l ( ) returns a part code. This time,
the part code specifies which part of the scroll bar was clicked in (Figure
7.28).Passthepartcodereturnedby Fi ndContro l ()to TrackContro l ().

FUNCTION TrackControl( theControl : ControlHandle;
startPt : Point; actionProc : ProcPtr ) :
INTEGER:
Tr ack Cont r ol ( ) will perform the action appropriate to that part of the
scroll bar. For example, ifthe mouse Down was in the thumb ofthe scroll bar,
an outline ofthe thumb is moved up and down (or across) the scroll bar until
the mouse button is released. Once Track Control ( ) returns, take the
appropriate action, depending on the new value of the scroll bar.
Next, let's look at Pager, a program that uses a scroll barto page between
PICT drawings in a window.

_J

Pager
Pager demonstrates the use of scroll bars in a Macintosh application. It
works like this:
• It initializes the Toolbox.
• It initializes a window.

• It creates a new scroll bar, using the number of available PI CT resources
to determine the number of position in the scroll bar.
• When a mouse Down occurs in the scroll bar, it loads the appropriate
PI CT and displays it in the window.
• It quits when the close box is clicked.
Pager also warns if the WI ND or PI CT resources are unavailable.

Setting Up the Pager Project
Start by creating a folder for this project, called Pager. Use ResEdit to
create a new file called Pager Pro j . Rs r c. You might want to save some
time by just copying and pasting the WI ND, AL RT, and DI TL resources from
the Wi ndowMaker Proj. Rsrc file.
The WI ND resource info appears in Figure 7.29.
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Figure 7.28 Parts of scroll bars.
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Window title:
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Figure 7.29 WI ND resource for Pager.
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Next, create a DITL resource (Figure 7.30). Add the ALRT (Figure 7.31).
Then, add the three ' ST R' resources shown in Figure 7.32 to the Pager
Pro j . Rs r c. Change the resource IDs ofeach resource to those shown in the
figures.
Next, create some PI CT resources from your favorite clip art and paste
them into the Pager Pro j . Rs r c. Paste in as many as you like. Don't worry
about changing resource IDs for the PI CT resources. We'll display every
available PI CT, regardless ofrace, creed, or resource ID. When you're done,
the resource window of Pa ger Pro j . Rs r c should look like Figure 7.33.

g0§ DITL "Fatal Error" ID= 401 from Pager

inn···1·nc:-r·edfii.i'!ff'alar0·r·r·o·r·. h'a·s·. . . . . . .!
!

Just occurred: "'O

l...._. ,_,,,_,,,_.,_. .,. ._,___,,,_,,,_,,_,,,,.,_J
Gasp!

Type

Item#

Enabled

top

left

bottom

right

Text/Resource ID
Gasp!

1

Button

Yes

86

117

106

177

2

Static Text

Yes

5

67

71
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Figure 7.30

DI TL resource for Pager.

§0§ Alert "Fatal Error ID= 401 from PrintPICT Pr
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Figure 7.31 ALRT resource for Pager.
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Now you're ready to launch THINK C. Create a new project in the Pager
folder. Call it Pager Proj. Make sure to add the MacTraps library to your
project. Create Pager.c and add it to Pa g e r Pr o j . Here's the source code for
Pager. c:

/ldefine
/ldefine
/ldefine
I/define
#define
#define
#define

BASE_RES_ID
NI L_PO INTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS
SCROLL_BAR_PIXELS
DRAG_ THRESHOLD
NI L_ACTION_PROC

0
16
30
NIL - PO INTER

I/define
#define

MIN_SLEEP
NIL_MOUSE_REGION

OL
OL

#define
#define

WNE_TRAP_NUM
UNIMPL_TRAP_NUM

Ox60
Ox9F

#define
#define
#define
#define

ERROR_ALERT _ID
NO_WIND
NO_PICTS
CANT_LOAD_PICT

BAS E_RES_IO+ 1
BASE_RES_ID
BASE_RES_IO+l
BASE_RES_ID+2

I/define
#define
//define
#define
I/define
#define
#define

NIL_STRING
NI L_TITLE
VISIBLE
START_VALUE
MIN_VALUE
NIL_REF_CON
HOPELESSLY_FATAL_ ERROR

400
OL
-ll

.. \p"
NIL_STRING
TRUE
1
1
NI L_PO INTER
"\pGame over, man!"

WindowPtr
gPictWindow:
ControlHandlegScrollBarHandle:
Boolean
gDone, gWNEimplemented:
EventRecord gTheEvent:
Rect
gDragRect;
pascal void ScrollProc():
!******************************** main *********/

main ( )
{

Tool Boxlni t():
Wi ndowl nit ():
SetUpDragRect();
SetUpScrollBar();
MainLoop();
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!*********************************** ToolBoxinit */

ToolBoxinit()
{

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent. REMOVE_ALL_EVENTS );
InitWi ndows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();

!******************************** Windowlnit *********/

Windowlnit()
{

if ( ( gPictWindow = GetNewWindow( BASE_RES_ID. NIL_POINTER.
MOVE_TO_FRONT ) ) == NIL_POINTER )
ErrorHandler( NO_WIND );
SelectWindow< gPictWindow );
ShowWindow( gPictWindow );
SetPort( gPictWindow );

/******************************** SetUpDragRect *********/

SetUpDragRect()
{

gDragRect = screenBits.bounds;
gDragRect.left += DRAG_THRESHOLD:
gDragRect.right -= DRAG_THRESHOLD;
gDragRect.bottom -= DRAG_THRESHOLD;
/**********************************

SetUpScrollBar

*******!

SetUpScrollBar()
{

Rect
int

vScrollRect;
numPictures;

numPi ctures = Count Resources ( •PICT" ) ) <= 0 )
ErrorHandler( NO_PICTS );
vScrollRect = gPictWindow->portRect:
vScrollRect.top -= 1;
vScrollRect.bottom +=l;
vScrollRect.left = vScrollRect.right-SCROLL_BAR_PIXELS+l;
vScrollRect.right += 1;
gScrollBarHandle = NewControl( gPictWindow. &vScrollRect.
NIL_TITLE. VISIBLE. START_VALUE. MIN_VALUE.
numPictures. scrollBarProc. NIL_REF_CON);

if ( (
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/******************************** MainLoop *********/

MainLoop()
{

gDone = FALSE:
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM. ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM. ToolTrap ) ):
while ( gDone == FALSE )
{

HandleEvent():

/************************************* HandleEvent

*/

HandleEvent()
{

if ( gWNEimplemented
WaitNextEvent( everyEvent. &gTheEvent. MIN_SLEEP.
NIL_MOUSE_REGION ):
else
{

SystemTask():
GetNextEvent( everyEvent. &gTheEvent );
switch ( gTheEvent.what )
{

case mouseDown:
HandleMouseDown();
break;
case updateEvt:
BeginUpdate( gTheEvent.message );
DrawControls( gTheEvent.message );
UpdateMyWindowC gTheEvent.message );
EndUpdate( gTheEvent.message );
break:

/************************************* HandleMouseDown */

HandleMouseDown()
{

WindowPtr
whichWindow;
short int
thePart:
Point
thePoint;
ControlHandletheControl:
thePart = FindWindow( gTheEvent.where. &whichWindow );
switch ( thePart )
{
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case inSysWindow :
SystemClick( &gTheEvent, whichWindow );
break;
case inDrag :
OragWindow( whichWindow, gTheEvent.where, &gDragRect );
break:
case inContent:
thePoint = gTheEvent.where;
GlobalToLocal( &(thePoint) );
thePart = FindControl( thePoint, whichWindow,
&theControl ) ;
if
theControl == gScrollBarHandle
{

if

thePart == inThumb )

I

thePart = TrackControl( theControl.
thePoint, NIL_ACTION_PROC );
UpdateMyWindow( whichWindow );

}

else
{

thePart = TrackControl( theControl,
thePoint, &ScrollProc );
UpdateMyWindow( whichWindow );
}

break;
case inGoAway :
gDone =TRUE;
break:

/**********************************

ScrollProc

*******/

pascal void ScrollProc(theControl, theCode)
ControlHandle
theControl;
int
theCode;
I

int

curControlValue, maxControlValue, minControlValue;

maxControl Value
GetCtl Max( theControl ) :
curControlValue = GetCtlValue( theControl );
minControlValue = GetCtlMin( theControl );
switch ( theCode )
I

case inPageDown:
case inDownButton:
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if

curControlValue < maxControlValue

{

curControlValue

+= l;

}

break;
case inPageUp:
case inUpButton:
if ( curControlValue > minControlValue
{

curControlValue -= 1:
}

SetCtlValue( theControl. curControlValue );

/**********************************

UpdateMyWindow

*******/

UpdateMyWindow( drawingWindow )
WindowPtr
drawingWindow:
{

PicHandle
Re ct
RgnHandle

currentPicture:
drawingClipRect, myRect:
tempRgn;

tempRgn = NewRgn();
GetCl i p( tempRgn ) ;
myRect = drawingWindow->portRect;
myRect.right -= SCROLL_BAR_PIXELS;
EraseRect( &myRect );
currentPicture = (PicHandle)GetlndResource( 'PICT', GetCtlValue(
gScrollBarHandle ) ):
if ( currentPicture == NIL_POINTER )
ErrorHandler( CANT_LOAD_PICT );
CenterPict( currentPicture, &myRect );
drawingClipRect = drawingWindow->portRect;
drawingClipRect.right -= SCROLL_BAR_PIXELS;
ClipRect( &drawingClipRect );
DrawPicture( currentPicture, &myRect );
SetClip( tempRgn );
DisposeRgn( tempRgn );
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/******************************** CenterPict *********/
CenterPict( thePicture, myRectPtr
thePicture;
PicHandle
Rect
*myRectPtr;
{

Rect

windRect, pictureRect;

windRect = *myRectPtr;
pictureRect = (**( thePicture )).picFrame;
myRectPtr->top = (windRect.bottom - windRect.top (pictureRect.bottom -pictureRect.top))
I 2 + windRect.top;
myRectPtr->bottom = myRectPtr->top + CpictureRect.bottom pictureRect.top);
myRectPtr->left = (windRect.right - windRect.left (pictureRect.right - pictureRect.left))
I 2 + windRect.left;
myRectPtr->right = myRectPtr->left + (pictureRect.right pictureRect.left);

/******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum;
I

StringHandle errorStringH;
if ( ( errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING,
NIL_STRING );
else
I

Hlock( errorStringH ) ;
ParamText( *errorStringH, NIL_STRING, NIL_STRING, NIL_STRING );
HUnlock( errorStringH );

I

StopAlert( ERROR_ALERT_ID, NIL_POINTER );
Exi tToShel 1 ();

Running Pager
When you've finished typing in your source code, run Pager. You should see
something like Figure 7.26, except with the PI CT s that you put in the Pager
Pro j . Rs r c. The scroll bar should allow you to page back and forth between
the PI CTs. Clicking in the close box ends Pager's execution.

How Pager Works
You've seen most of this program before. You'll create a window with
GetNewWi ndow() and get and handle events just as you did in WindowMaker. Now, let's look at the code.
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Pager starts off with #defines and global variable declarations. We11
discuss these in context.

#define
#define
#define
#define
//define
#define
#define

BASE_RES_ID
NI L_PO INTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS
SCROLL_BAR_PIXELS
DRAG_ THRESHOLD
NI L_ACT ION_P ROC

400

#define
#define

MIN_SLEEP
NIL_MOUSE_REGION

OL
OL

#define
#define

WNE_TRAP_NUM
UNIMPL_TRAP_NUM

Ox60
Ox9F

#define
//define
#define
#define

ERROR_ALERT _ID
NO_WIND
NO_PICTS
CANT_LOAD_PICT

BAS E_RES_ID+ 1
BASE_RES_ID
BASE_RES_ID+l
BASE_RES_ID+2

#define
#define
#define
#define
#define
#define
#define

NIL_STRING
NIL_ TITLE
VISIBLE
START_VALUE
MIN_VALUE
NIL_REF_CON
HOPELESSLY_FATAL_ERROR

OL
-ll

0
16

30

NIL_POINTER

"\p"
NIL_STRING
TRUE
1
1

NIL_POINTER
"\pGame over, man!"

WindowPtr
gPictWindow;
ControlHandlegScrollBarHandle;
gDone, gWNEimplemented;
Boolean
EventRecord gTheEvent;
Rect
gDragRect;
pascal void ScrollProc();
Main() calls the Tool boxlni t() and Wi ndowlni t() routines, uses
Set Up Drag Rec t ( ) to set the bounds for moving the window around on the
screen and Set Up Scro l l Ba r ( ) to initialize the scroll bar control, and then
runs Main Loop ()to start the main event loop.
!******************************** main *********/

main ( )
{

Tool Boxlni t();
Wind ow In it ( ) ;
SetUpDragRect();
SetUpScrollBar();
Mainloop():
Nope. Still looks the same.
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/*********************************** ToolBoxinit */

Tool Box I nit()
{

InitGraf( &thePort );
InitFonts():
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ):
InitWindows():
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor():
Wi ndo wI nit ( ) is uneventful. The WI ND resource is loaded and displayed, with the customary call to Error Hand 1er ( ) if the WI ND resource
is missing.

/******************************** Windowlnit *********/

Windowlnit()
{

if ( ( gPictWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT ) ) == NIL_POINTER
ErrorHandler( NO_WIND );
SelectWindow( gPictWindow ):
ShowWindow( gPictWindow );
SetPort( gPictWindow );
Asyousawin WindowMaker, SetUpDragRect ()sets up the bounds for
the dragging routine used in the Hand 1e Event ( ) loop.
/******************************** SetUpDragRect *********/

SetUpDragRect()
{

gDragRect = screenBits.bounds;
gDragRect.left += DRAG_THRESHOLD:
gDragRect.right -= DRAG_THRESHOLD;
gDragRect.bottom -= DRAG_THRESHOLD:
SetUpScrol l Bar() calls Count Resources () to fmd out how many
PI CT resources are available.
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Every application has access to resources from two different places:
the resource fork of the application itself and the resource fork of the
system file. In addition, an application may use the Resource Manager
to open additional resource files. When looking for a resource, the
Resource Manager searches the most recently opened resource file
first.
If no PI CT resources are available, the Error Hand 1 er ( ) is called.
Otherwise, SetUpScrol l Bar() creates a Rect the proper size for your
scroll bar, then creates the scroll bar with a call to NewCont ro 1 ().The
scroll bar ranges in value from MI N_VALU E to numPi ctures, the number
of available PI CT resources. START _VALUE is the initial value of the scroll
bar and determines the initial position of the scroll bar thumb. The final
parameter is a reference value available for your application's convenience.
You can use these four bytes as scratch pad space.

!**********************************

SetUpScrollBar

*******/

SetUpScrollBar()
{

Rect
int

vScrollRect;
numPictures;

if ( ( numPictures = CountResources( 'PICT' ) ) <= 0 )
ErrorHandler( NO_PICTS );
vScrollRect = gPictWindow->portRect:
vScrollRect.top -= l;
vScrollRect.bottom +=l;
vScrollRect.left = vScrollRect.right-SCROLL_BAR_PIXELS+l;
vScrollRect.right += 1:
gScrollBarHandle = NewControl( gPictWindow, &vScrollRect,
NIL_TITLE, VISIBLE, START_VALUE. MIN_VALUE,
numPictures. scrollBarProc. NIL_REF_CON);
Ma i n Loop ( ) sets the flag for Get Next Event ( ) or Wa i t Next Even t ( ) ,
then calls Hand 1 e Event ( ).

/******************************** MainLoop *********/

MainLoop()
{

gDone = FALSE;
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) );
while ( gDone == FALSE )
{

HandleEvent();
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Pager handles two different events. mouseDowns are handled by
Handl eMouseDown (). updateEvts are handled in line. First,
Begi nUpdate () is called. Then, DrawCont ro 1 s () draws the scroll bar
with the thumb in the proper position. Finally, EndUpdate() is called.
!************************************* HandleEvent

*/

HandleEvent()
{

if ( gWNEimplemented )
WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
else
{

SystemTask();
GetNextEvent( everyEvent, &gTheEvent );
switch C gTheEvent.what )
{

case mouseDown:
HandleMouseDown();
break:
case updateEvt:
BeginUpdateC gTheEvent.message );
DrawControls( gTheEvent.message );
UpdateMyWindow( gTheEvent.message );
EndUpdate( gTheEvent.message );
break;

Handl eMouseDown ()looks the same at the start:

/************************************* HandleMouseDown */

HandleMouseDown()
{

WindowPtr
whichWindow:
short int
thePart:
Point
thePoint;
ControlHandletheControl;
thePart = FindWindow( gTheEvent.where, &whichWindow );
switch C thePart )
I

case inSysWindow :
SystemClick( &gTheEvent, whichWindow );
break;
case inDrag :
DragWindow( whichWindow, gTheEvent.where, &gDragRect );
break;
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The big change comes when a mouseDown occurs in the content region
nContent) of a window. The mouse Down's location (gEvent. where) is
translated into the window's local coordinate system. The localized point is
passed to Fi nd Cont r o 1 ( ) , which returns a Handle to the selected control
(in the parameter the Cont r o 1) and a part code indicating what part of the
control was selected. If theCont ro 1 is your scroll bar, find out if it was in
the thumb. If it was, call Track Cont r o 1 ( ) to drag an outline of the thumb
up and down the scroll bar. When the thumb is released, update the window
using the new scroll bar value. If any other part of the control was used, call
TrackControl () withapointertoScrol l Proc( ). Scroll Proc() scrolls
the scroll bar until the mouse button is released.
(i

Call Track Cont r o 1 ( ) with a pointer to an action procedure if you
want the control to change while the mouse button is still down. Ifyou
pass a NI L_ACT I 0 N_P ROC, the control will animate, but its value will
not change until the mouse button is released.

case inContent:
thePoint = gTheEvent.where;
GlobalTolocal( &CthePoint) );
thePart = FindControl( thePoint, whichWindow,
&theControl ) ;
if
theControl == gScrollBarHandle
I

if

thePart

I

==

inThumb )

thePart = TrackControl( theControl.
thePoint, NIL_ACTION_PROC );
UpdateMyWindow( whichWindow );

l

else
I

}

break;
case inGoAway :
gDone = TRUE;
break;

thePart = TrackControl ( theControl,
thePoint, &ScrollProc );
UpdateMyWindow( whichWindow );
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Scroll Proc() handles mouseDowns in the page up, page down, up
button, and down button regions of the scroll bar. max Cont r o l Va l ue,
curControlValue, and minControlValue are set to the maximum,
current, and minimum values of the Control . If the mouse click was
i nPageDown or i nDownButton, increase the value of the control. If the
mouse click was i n Page Up or i n Up Button areas were pressed, decrease
the value of the control. Finally, update the control to this new value with
SetCtl Value().
!**********************************

ScrollProc

*******/

pascal void ScrollProc(theControl, theCode)
ControlHandletheControl:
int
theCode:
{

int

curControlValue, maxControlValue, minControlValue:

GetCtlMax< theControl );
maxControlValue
curControlValue = GetCtlValue( theControl );
minControlValue = GetCtlMin( theControl ):
switch
I

C

theCode )

case inPageDown:
case inDownButton:
if ( curControlValue < maxControlValue
I

curControlValue

+=

l;

)

break;
case inPageUp:
case inUpButton:
if ( curControlValue > minControlValue
{

curControlValue -= l;
)

SetCtlValue( theControl, curControlValue );
UpdateMyWi ndow() works in a similar fashion to the DrawPi cture ()
routine in EventTutor (Chapter 4). The algorithm works so: Temporarily
reset the window's clipping region so it does not include the area covered by
the scroll bar. Center the picture, draw it, and reset the original clip region.
The call to Get I n d Res o u r c e ( ) uses the current value of the scroll bar
(Get Ct 1 Va l u e ( g Sc r o l l Ba r Ha n d l e )) to load the appropriate P I CT resource.
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For example, ifthere were 3 0 PICT resources available, the scroll bar
would run from 1 to 3 0. If the current thumb setting was 10, the call
to GetlndResource() would return a handle to the tenth PICT
resource. Since Get I nd Resource ( ) returns a handle, you can use
C's type-casting mechanism to convert it to a Pi cHandl e.

Note that only one PI CT at a time is ever loaded into memory. When the
scroll bar's value changes, a replacement PI CT is loaded, not an additional
one.

/**********************************

UpdateMyWindow

*******/

UpdateMyWindow( drawingWindow )
WindowPtr
drawingWindow:
I

PicHandle
Re ct
RgnHandle

currentPicture:
drawingClipRect, myRect:
tempRgn;

tempRgn = NewRgn();
GetC lip ( tempRgn ) :
myRect = drawingWindow->portRect;
myRect.right -= SCROLL_BAR_PIXELS:
EraseRect( &myRect ):
currentPicture
gScrollBarHandle ) ):

=

(PicHandle)GetlndResource( 'PICT'. GetCtlValue(

if ( currentPicture == NIL_POINTER )
ErrorHandler( CANT_LOAD_PICT ):
CenterPict( currentPicture, &myRect );
drawingClipRect = drawingWindow->portRect:
drawingClipRect.right -= SCROLL_BAR_PIXELS;
ClipRect( &drawingClipRect ):
DrawPicture( currentPicture, &myRect );
SetClip( tempRgn );
DisposeRgn( tempRgn );
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Center Pi ct ()is the same as it ever was.

!******************************** CenterPict *********/
CenterPict( thePicture, myRectPtr
PicHandle
thePicture;
Rect
*myRectPtr;
{

Rect

windRect, pictureRect;

windRect = *myRectPtr;
pictureRect = (**( thePicture )).picFrame;
myRectPtr->top = (windRect.bottom - windRect.top (pictureRect.bottom -pictureRect.top))
I 2 + windRect.top;
myRectPtr->bottom = myRectPtr->top + (pictureRect.bottom pictureRect.top);
myRectPtr->left = CwindRect.right - windRect.left (pictureRect.right - pictureRect.left))
I 2 + windRect.left;
myRectPtr->right = myRectPtr->left + (pictureRect.right pictureRect.left):
}

Err o r Ha nd 1 e r ( ) should be familiar by now. Pa ram Text ( ) to
Stop A1 er t ( ) to Ex i tT o She 1 1 ( ) , leaving nothing to chance.

/******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum:
{

StringHandle errorStringH;
if ( ( errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING,
NIL_STRING );
else
I

Hlock( errorStringH );
ParamText( *errorStringH, NIL_STRING, NIL_STRING, NIL_STRING );
HUnlock( errorStringH );

}

StopAlert( ERROR_ALERT_ID. NIL_POINTER );
ExitToShel 1 ():

_J

The Sound Manager
If you're tired of the same old Sys Beep ( ) , there is an alternative. Within
the system file is a set of ' s nd ' resources, commonly known as beep sounds.
The ' snd ' with resource ID = 1 is the familiar Beep. The current system
comes with three additional 'snd 's: Monkey, Clink-Klank, and Boing.

Hundreds more are available on electronic bulletin boards throughout the
country.
Using the Sound Manager, you can add these sounds to your applications. The final Mac Primer application, Sounder, shows you how.

_J

Sounder
Sounder works like this:
• It initializes the Toolbox.

• It loads the ' SN D' resources from the system file.
• It plays them (assuming you have the volume set above 0).
• It quits.
Sounder also performs error checking. It puts up an alert if the 'SND'
resources can't be accessed.

Setting Up the Sounder Project
Start by creating a folder for this project, called Sounder. Use ResEdit to
createanewfilecalled Sounder Proj. Rs re. Sounder uses the same DITL
and AL RT resources as all the other Chapter 7 programs, so you can cut and
paste ifyou've typed in the other programs. Ifnot, use Figures 7.34 and 7.35
for those resources. Add the four ' ST R' resources shown in Figure 7.36 to
the Sound e r Pro j . Rs r c file. Again, be sure to change the resource IDs of
each resource to those shown in the figure. When you're done, the resource
window of Sounder Proj. Rs re should look like Figure 7.37.
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Now you're ready to launch TIDNK C. Create a new project in the Sounder
folder. Call it Sounder Pr oj. Be sure to add the Mac Traps library to your
project. Create a new source file (Sounder. c), and add it to Sounder Proj.
Here's the source code for Sounder.c:

#define
#define
#define
#define
#define

NIL_POINTER
BASE_RES_ID
REMOVE_ALL_EVENTS
NIL_SOUND_CHANNEL
SYNCHRONOUS

#define
#define
#define
#define
#define

ERROR_ALERT _ID
CANT_LOAD_BEEP_SND
CANT_LOAD_MONKEY_SND
CANT_LOAD_KLANK_SND
CANT_LOAD_BOING_SND

BASE_RES_ID+l
BASE_RES_ID
BASE_RES_ID+l
BASE_RES_ID+2
BASE_RES_ID+3

#define
#define

NIL_STRING
HOPELESSLY_FATAL_ERROR

"\p"
"\pGame over, man!"

#define
#define
#define
#define

BEEP_SND
MONKEY_SND
KLANK_SND
BOING_SND

2
3

OL
400
0

NIL_POINTER
FALSE

1
4

/******************************** main *********/

main()
{

ToolBoxinit();
Ma keSound ( ) ;

/*********************************** ToolBoxinit */

Tool Box I nit()
I

InitGraf( &thePort );
I nit Fonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWi ndows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();
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/******************************** MakeSound *********/
MakeSound()
{

Handle soundHandl e;
if ( (

sound Hand l e

=

Get Resource ( ' s nd ' . BEEP_ SN D ) )

==

NI L_ P0 I NT ER

ErrorHandler( CANT_LOAD_BEEP_SND );
SndPlay( NIL_SOUND_CHANNEL, soundHandle, SYNCHRONOUS );
if ( ( soundHandle = GetResource( 'snd '. MONKEY_SND ) )
NIL_POINTER )
ErrorHandler( CANT_LOAD_MONKEY_SND );
SndPlay( NIL_SOUND_CHANNEL, soundHandle, SYNCHRONOUS );
if ( ( soundHandle = GetResource( 'snd '. KLANK_SND ) )
NI L_PO INTER )
ErrorHandler( CANT_LOAD_KLANK_SND );
SndPlay( NIL_SOUND_CHANNEL, soundHandle, SYNCHRONOUS );
if ( ( soundHandle = GetResource( 'snd '. BOING_SND ) )
NIL_POINTER )
ErrorHandler( CANT_LOAD_BOING_SND );
SndPlay( NIL_SOUND_CHANNEL, soundHandle. SYNCHRONOUS );

/******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stri ngNum;
{

StringHandle errorStringH;
if (
else

errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING,
NIL_STRING );

{

Hlock( errorStringH );
ParamText( *errorStringH, NIL_STRING. NIL_STRING. NIL_STRING );
HUnlock( errorStringH );
}

StopAlert( ERROR_ALERT_ID. NIL_POINTER );
Exi tToShel l ();
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Walking through the Sounder Code
Sounder is short and sweet. These #def i nes should be familiar to you
Chapter 7 cognoscenti.

#define
#define
#define
#define
#define

NI L_PO INTER
BASE_RES_ID
REMOVE_ALL_EVENTS
NIL_SOUND_CHANNEL
SYNCHRONOUS

#define
#define
#define
#define
#define

ERROR_ALERT _ID
CANT_LOAD_BEEP_SND
CANT_LOAD_MONKEY_SND
CANT_LOAD_KLANK_SND
CANT_LOAD_BOING_SND

BASE_RES_ID+l
BASE_RES_ID
BASE_RES_ID+l
BASE_RES_ID+2
BASE_RES_ID+3

#define
#define

NIL_STRING
HOPELESSLY_FATAL_ERROR

"\p"
"\pGame over. man!"

#define
#define
#define
#define

BEEP_SND
MONKEY_SND
KLANK_SND
BOING_SND

OL
400
0

NIL_POINTER
FALSE

1

2
3
4

Make the usual call to Too 1 Box In it ( ) .Then call Ma keSound ( ) .
/******************************** main *********/

main ( )
{

Tool Boxlnit();
MakeSound();

/*********************************** ToolBoxlnit */

Tool Boxlnit()
{

InitGraf( &thePort );
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();
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The key to this program is the Sound Manager routine Sn d Pl a y ( ) . Load
each of the four ' s nd ' resources normally found in the system file, and
play them with SndPl ay ().
Since the Mac System file didn't always use • s nd ' resources, older
systems may cause an error ALRT to appear. Check out the Sound
Manager (Chapter 27) in Inside Macintosh, Volume V, for more detail.
The first parameter to Sn d Pl a y ( ) is the Sn d Ch a n n el Pt r. By passing
NI L_PO INTER, you've told Snd Play ( ) to allocate a channel for you. The
secondparameteristhe' snd' handle. Thethirdparametertells SndPl ay ()
whether or not to play the sound asynchronously. When you pass NI Las the
Sn d Ch an n el Pt r, you must pass FALSE as the third parameter. That is, if
you ask Sn d Pl a y ( ) to allocate a channel for you, you must play the sound
synchronously. If you cannot find the ' s nd ' resource, go to the beloved
ErrorHandl er().
/******************************** MakeSound *********/

MakeSound()
{

Handle soundHandle:
soundHandle = GetResource( 'snd ·, BEEP_SND )
== NIL_POINTER )
ErrorHandler( CANT_LOAD_BEEP_SND ):
SndPlay( NIL_SOUND_CHANNEL, soundHandle, SYNCHRONOUS ):
if ( (

soundHandle = GetResource( 'snd ·, MONKEY_SND ) )
NIL_POINTER )
ErrorHandler( CANT_LOAD_MONKEY_SND );
SndPlay( NIL_SOUND_CHANNEL, soundHandle, SYNCHRONOUS );
if ( (

soundHandle = GetResource( 'snd '. KLANK_SND ) )
NIL_POINTER )
ErrorHandler( CANT_LOAD_KLANK_SND ):
SndPlay( NIL_SOUND_CHANNEL. soundHandle, SYNCHRONOUS):
if ( (

soundHandle = GetResource( 'snd ·. BOING_SND ) )
NIL_POINTER )
ErrorHandler( CANT_LOAD_BOING_SND );
SndPlay( NIL_SOUND_CHANNEL, soundHandle, SYNCHRONOUS ):
if ( (
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The error-handling routine is similar to what you've seen in the other
Chapter 7 programs:

!******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum;
{

StringHandle errorStringH;
if ( ( errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING. NIL_STRING,
NIL_STRING );
else
I

Hlock( errorStringH );
ParamText( *errorStringH, NIL_STRING, NIL_STRING, NIL_STRING );
HUnlock( errorStringH );

}

StopAlert( ERROR_ALERT_ID, NIL_POINTER );
ExitToShel 1 <);

_J

In Review
We covered a lot of ground in this chapter. Each of the four programs we
presented involved a different part of the Mac Toolbox. If you're unsure
about any of the concepts discussed, take the time to read about them in
their respective Inside Macintosh chapters. The Scrap Manager is covered
in Volume I, Chapter 15. The Standard File Package is covered in Volume
I, Chapter 20 and updated in Volume IV, Chapter 15. The File Manager is
covered in Volume IV, Chapter 19. (Warning: Don't be fooled by imitations!
The File Manager section in Volume II, Chapter 4, has been completely
replaced by Chapter 19 ofVolume IV.) The Printing Manager is covered in
Volume II, Chapter 5.
The Control Manager is covered in Volume I, Chapter 10. Scroll bars
make up a small part of this chapter, but the concepts implemented in
Pager will carry through to other types of controls.
Finally, the Sound Manager is covered in Volume V, Chapter 27. An
authoritative version of this chapter has been published by Macintosh
Developer Technical Support under the title "The Sound Manager." If
you're really interested in sound on the Mac, read the Sound Driver chapter
(Volume I, Chapter 8). This was the way sound originally worked on the
Mac, and many of the basic concepts are still supported.
Chapter 8 introduces the wonderful world of ResEdit. See you there!

8

Using ResEdit
ResEdit provides a simple, yet powerful
way to edit resources. This chapter shows
you how to use this tool to create the
Finder resources necessary to turn your
projects into standalone applications.

BY Now, You should have a good grip on the most important aspects of
Macintosh application programming. We've described how to handle events,
access files, and display pictures and text. You've worked with menus,
windows, and dialogs. In this chapter we'll discuss some issues that become
important after you have your basic programming problems in hand.
After you compile your debugged application, but before you announce
your first stock offering, you need to take care of a few loose ends. For
example, you'll want to turn your code into a standalone application. You'll
want to design your own custom icon. These finishing touches require the
creation of six resources known as the Finder resources. These resources
do not affect the operation of the application; rather, they affect the way
your application interfaces with the Finder. This chapter discusses how to
add the six Finder resources to your application.
If any readers are still shaky about the use of ResEdit, this discussion
on the installation of Finder resources is for you. After installing the
resources in this chapter, you should feel comfortable using ResEdit.
Why use ResEdit to edit resources? Because ResEdit creates resources graphically, whereas the others build resources by describing
them textually. For example, here is a text description of a WIND
resource:

TYPE WIND
.128
My Window
40 40 200 472

Visible GoAway
0
0

the resource number
the window title
the window rect (top left
bottom right)
resource flags
• , window definition ID
refcon (points to user call)

This is the way that RMalter, another Apple resource editor, maltes
resources. RMalter also comes with THINK C.
ResEdit's WI ND editor looks like Figure 8.1. When you're creating
resources for the first time, ResEdit's graphic approach has many
advantages: It's more intuitive, and it gives you a chance-with many
resource types-to examine the appearance of a resource without
actually running your program. You can use RMaker and ResEdit
interchangeably; see the appendix in THINK C's User Manual if
you're interested in using RMaker.
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§0

WI ND ID

=

6583 from wind

Figure 8.1 Graphic representation of
WI ND resource.

First, you'll compile an application in THINK C. Then, you'll use
ResEdit to add the six Finder resources to it. You can use the procedure in
this chapter for any project you wish; the tutorial uses the Hello2 project
that we created in Chapter 3.
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The Finder Resources
Apple recommends that software developers install six special resources in
their applications. Each resource plays an essential role in your application's interface to the Finder. They are grouped into three categories:
• Application icon: The ICN#, FREF, BNDL,andsignatureresourcesare
used to add a unique icon to an application as it appears on the desktop.
' Application version information: The vers resource contains general information used by the Finder, including the specific version of an
application, the country for which it is localized, and its creation date.
• Application MultiFinder requirements: The SI ZE resource designates the recommended and minimum application memory size needed
for an application, and also contains further details on the application's
level of MultiFinder compatibility.

_J

Completing a Standalone Application:
Hello2 Revisited
The first step is to create a standalone application from a working project.
You'll do this by compiling Hello2, the first program in Chapter 3. Open up
the Hello2 Project. Select Set Project Type ... from the Project menu. You
should see something like Figure 8.2. There are four project options in the
dialog box. Make sure the Application radio button is selected in the
dialog; click on OK. See THINK C's User Manual or Appendix C for a
description of the other three project types.
Now choose Build Application from the Project menu. If the project is up
to date, it should prompt you for an application name (Figure 8.3). Call the
application He 11 o2. (The Smart Link check box should be checked.) When
you click on Save, THINK C will build the Hello2 application. When it's
completed, quit THINK C and try double-clicking on the Hello2 application
created in your He l l o 2 folder. It should display the text He l l o , Wo r l d in
a window (Figure 8.4).
Now that you have a working standalone program, you're ready to add
the Finder resources. Click the mouse button to quit Hello2.

® Application
0 Desk Accessory
0 Deuice Driuer
0 Code Resource

File Type
Creator

IAPPL
IP'"I

D Separate STRS

Partition (K) ~

MF Rttrs ~
OK

]

Figure 8.2 Project Type dialog box.
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la Hello2 I
[)
L)

H<~Ho2
H<~Uo2

Pro j
Pro j .. Hi-rc

c=i

Hard Disk

[jH1

D Hello2,<

Brii.ie

Saue application as:

(

Saue

)

IHello2

(

Cancel

)

18] Smart Link
Figure8.3 Build Application dialog box.

.,
Hello2 Windo w

Hell o, World

Figure 8.4 Running Hello2.
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Notes on Using ResEdit
Although you can u se ResEdit in MultiFinder, it is more robust (i.e., doesn't
crash as much) in the regular Finder. We suggest that you not u se
MultiFinder when creating resources for this book. If you do, make sure
that the application memory size used by ResEdit is at least 512K (Figure
8.5).
You can't edit resources in files that are currently in use, such as the
Finder file. This is not much of a disadvantage, as editing open files is not
recommended anyway.
It's a good idea to make a copy of any file you plan to edit. It is very easy
to modify resources irrevocably. Be careful. If you're planning on entering
more than one or two resources in a single ResEdit session, save your file
periodically.
Although ResEdit works with all resource types, it may have difficulty
performing some operations on large resources, such as sound resources
( ' s nd ') that exceed a few hundred Kin size. In these cases, proceed with
caution.
These guidelines are a little like the sign posted at swimming pools about
waiting 30 minutes after you eat: Most of the time, they're not necessary.
ResEdit is generally quite well-mannered and will quickly become an
indispensable programming tool.

Info
Locked

0

ResEdit

Kind: appl ication
Size: 275 ,007 bytes used, 270K on disk
Yhere: Hard Disk, SCSI

Created : Mon, Sep 19, 1988, 10 :35 PM
Modified: Fri, Jan 6, 1989, 10 :20 AM
Version : 1.2, ©Apple Computer, Inc.
1984-1988

Suggested Memory Size (K) : 300
Application Hemory Size (K):
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Figure 8.5 Setting ResEclit
to 512K.
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How ResEdit Works
Before you start using ResEdit to install the Finder resources, let's examine
how ResEdit accomplishes the job of creating, editing, and deleting resources in files. Double-click on ResEdit to start it up.
A window is displayed for every storage device currently available. Each
window lists all the folders and files on that storage device (see Figure 8.6).
To open a folder, double-click on the folder name. To close a folder, click on
the close box of the folder's window.
The Macintosh has a number of different types of storage devices
available for use. If files are available on a storage device (known as
a volume), it's called a mounted volume. Mounted volumes include:
•
•
•
•

Floppy disks currently in an internal or external drive
Hard disk drives, both serial and SCSI
Tapes currently mounted on or in a tape drive
Remote file systems, currently mounted via AppleShare, TOPS,
and so on

Notice that an empty floppy disk drive is not a mounted volume. An
initialized floppy disk, however, once inserted into the drive, is a
mounted volume.

" s

Fil e

Edit
Hard Disk

D §0
Floppy Disk
~ ~ Desktop

~-----·

D DHell o, World
D DHello2
D DMondrien
DPeg er
D ShowCli p
DShowPi c t
D Text File
DTimer w/Me nus

Figure 8.6 ResEdit with two volumes open.
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ResEdit has two menus, File and Edit. When you're editing some
resources, an additional menu will appear. As you've seen in earlier
chapters, you can create new resource files by selecting New from the File
menu.
To create a new resource, create a new resource file or open an existing
one. To open an existing file, double-click on its name. Figure 8. 7 shows the
resource window for Hello2. Choose New from the File menu to add a new
resource to the current file. The Type dialog box (Figure 8.8) appears: This
allows you to select the type of resource you wish to build. You can either
select from the scrolling window or type in the name of the new resource
type.
If you have just selected a new resource type, or have double-clicked on
an existing resource type, the Resource Picker window is displayed. This
window shows all resources of the selected type in the resource file. To
create an individual resource of the type indicated in the Picker window
(Figure 8.9), select New from the File menu again.
An editor window will now appear. The methods by which the editor
works vary with the resource type. Some resource types have a MacPaint
"fat bits" editor (I C0 N, IC N#). Many types simply display named fields for
you to input (FRE F, BN DL, MENU, MBAR). Other resource types can be resized
and positioned graphically (WIND, DITL, DLOG). If ResEdit doesn't know
how to handle a certain resource type, it defaults to a hexadecimal editor.

r

•

File

D
lk'l D

~D D

Hard Disk

THINK C

src

D D
D ~ ~§0
D (kl
D (kl
CODE
D D
D (kl DATA
D D
D OREL
~ D
SIZE
~ D
WIND
D D
ZERO
DD
D

Figure 8.7

.,

Edit

Hello2
Hello 2

Hello2 resource window.

363

Using ResEdit

Select New Type
STR

fg ~1~i

n

OK

D

wctb

( Cancel )

Figure 8.8 The Resource Type dialog box.

r

S File Edit
Hard Disk

THINK C

Figure 8.9 WIN 0 Picker window in the Hello2 application.
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To get things started, let's take a look at the way you'd create a WI ND
resource. Start by creating a new resource file or opening an existing one.
Figure 8.10 shows the empty Hello2 Proj.Rsrc file. Select New from the File
menu. The Type dialog box is displayed, which allows you to select the type
of resource that you plan to create (Figure 8.11). Type in WI ND, or select
WIND from the scrolling list. Click on OK.
The WIND Picker window is now displayed. This shows all the WIND
resources currently in the file. Since we haven't added any to Hello2.Rsrc
yet, the window should be empty. Select New from the File menu again to
create your first WIND resource (Figure 8.12). The WIN Deditor displays the
new window in a miniaturized version of the screen. Click and drag the
window around the mini desktop to change its global coordinates (Figure
8.13). Click and drag on the lower right corner of the window to resize it
(Figure 8.14).
Finally, select the Display as Text item in the WI ND menu. This shows
another way to enter the parameters for your WI ND resource. If you make
changes here and select Display Graphically from the WI ND menu, the
adjusted window will be positioned correctly on the mini desktop.
Certain information about each resource can be edited in the resource's
Get Info window. To edit this information, click on the resource in the
Resource Picker window and select Get Info from the File menu. ResEdit
assigns new resources a random resource ID number. The most important
piece of information in this window is the resource ID . Because you use the
resource ID number to specify the resource you plan to use, it's important
to change the resource ID number to match your program design.

,. s

File

Edit

Figure 8.10 Heilo2 Proj.Rsrc resource file.
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OK
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Figure 8.11 The Resource Type dialog Box.
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File

Edit

WIND

Figure 8.12 The lH ND editor.
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Figure 8.13 Changing the WI ND coordinates.

Figure 8.14 Resizing the WIN D resource.

This is all you need to know to use most of ResEdit's functionality.
ResEdit is probably the most popular resource editor available. Apple has
constantly updated it and has published a manual called Using ResEdit. If
you'd like more technical information about how ResEdit works, you can
procure the manual from APDA (see Chapter 9 for more information).
That's the end of the ResEdit overview. Next, we'll talk about t he six
special Finder resources, and add them to your application.
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The ResEdit Tutorial:
Installing the Finder Resources
Completing a Standalone Application
Double-click on ResEdit. Double-click on the THINK C folder to open it up.
Then, double-click on the source code folder inside the THINK C folder
( ' s r c ' in our figures). Finally, double-click on the He 11 o 2 folder that you
created back in Chapter 3. You should see something like Figure 8.15.
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If you double-click on the new Hello2 application file that you built
earlier, the resource window of the application will appear. These are the
resources that THINK C created when it compiled the application (Figure
8.16). The CODE resources are your executable code. The WI ND resource
(which you built with ResEdit) is used to build Hello2's window. The DATA,
OR EL, and ZE RO resources are created by the compiler: Don't mess with
them. The SIZE resource is one of the Finder resources; THINK C created
it for you, so you don't need to. We'll look at it later.
Click on the close box to close the resource list window. Make sure Hello2
is still highlighted, and select Get Info from the File menu (Figure 8.17).
This dialog contains information that the system has on your new application.
APPL is short for application. Files having type APP L are recognized as
applications by the Finder.
Start the installation of your Finder resources by changing the Creator
from???? to HELO. Be careful: ResEdit discriminates between upper and
lower case. Now close the window by clicking in the close box and save your
changes.

The four-charactor Creator name HELOwill be used when the Finder
looks for the application's icon. If, by chance, another application with
a defined icon has the same Creator, the first icon the Finder finds will
be used. Be careful in your choice of Creator names. If you plan to
market a Macintosh application, register the Creator name with
Macintosh Developer Technical Support, who can tell you whether or
not others have used this Creator tag. We registered HELO, so go
ahead and use it for Primer applications.
r

S

File

Edit

Hard Disk

Figure 8.15 ResEdit, open to the Hello2 Folder.
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.,

,.. S File Edit
Hard Disk

THINK C

Figure 8.16 Hello2's resource window.
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,.. S File Edit

Creator I????

O Locked O I nuisible 181 Bundle
D Busy
D Shared O No I nits 1811 nited

O On Desk O Boz o

D

O System
O Changed

Alway s switch launch

O File Busy O File Lock O File Protect
O Resource map is read only
O Printer driuer i s Multifinder compatib le
Created

2/ 16/ 4 9:54:40 AM

Modified

1/ 6/ 89 12:49:48 PM

Resource fork size = 1686 bytes
Dato fork size = O bytes

Figure 8.17 Hello2's Get Info window.
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The flags displayed in the File Information window are information that
the Finder keeps regarding your application. Normally, you should not
change them.
Here is a brief description of the Finder flags found in the File Info box
(see Figure 8.18).
The Locked flag is no longer implemented.
If the Invisible bit is set, the file is not displayed by the Finder.

ResEdit can see it, however, as well as Finder substitutes like
DiskTop.
The Bundle flag is set by the Finder if you have a BND L resource
in the file. We'll talk more about BNDLs later in this chapter.
The System bit indicates that the file cannot be renamed, and that
a warning will be given when the file is dragged to the trash.
If the file is on the Desktop (i.e., not in any folder), then the On
Desk flag is set.
The Bozo flag was an early attempt to implement copy protection
on the Mac. Ifit is set, the Finder will not copy the file. Since ResEdit
can turn the Bozo bit off, however, you can defeat this copy protection
scheme. Current protected software uses more sophisticated copy
protection schemes.
The Busy bit is currently not implemented.
The Changed flag tells you that your file has been modified since
it was opened. ResEdit uses that information to prompt you to save
your changes when you quit.
If the Shared flag is set, the application can be opened more than
once.
The Inited bit is set by the Finder when it determines the file's
location and window.
If the File Busy bit is set, the file is open. You see this if you
examine a running application with ResEdit while in MultiFinder.
If the File Lock bit is set, the file cannot be renamed (although it
can be thrown away).
The File Protect flag is not currently used.
If the Resource map is read only check box is checked, the
resources in the file cannot be changed.
The Printer driver is MultiFinder compatible is set only for
printer drivers that work with MultiFinder.
The File Information dialog box also contains created and
modified dates for the application.
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At the bottom, the dialog box displays the size of the resource fork
and the data fork. As was discussed in Chapter 2, all Macintosh
applications have a resource fork and a data fork. The resource fork
contains resources. The data fork may store information about user
preferences or anything else you desire.
r

s

File

.,

Edit

111--===~
" ~D

I

Creator HELO

0 Locked D I nuisible 181 Bundle
D On Desk D Bozo
0 Busy

D System
D Changed

D Shared O No I nits 181 lnited
O Rlways switch launch
O File Busy O File Lock O File Protect
O Resource map is read only
O Printer driuer is Multiflnder compatible
Created

2/ 16/ 4 9:54:40 RM

Modified

1/ 6/89 12:49:48 PM

Resource fork size = 1686 bytes
Data fork size = O bytes

Figure 8.18 Finder flags.
As stated earlier, the Finder resources are broken down into three
groups. One set of resources sets up the icon, another resource contains
version information, and the last resource contains MultiFinder information. First, you'll create the resources that add an icon to the Hello2
application.

Adding an Icon to Hello2
Adding your own icon to Hello2 is an involved procedure. Four resources
must be placed into your application file to get the Finder to replace the
generic application icon with a unique icon.
Begin by creating the graphic icon used to identify the application on the
desktop. Open up Hello2 with ResEdit, and choose New from the File menu.
The Type dialog box appears. Either key in ICN# or select it from the
scrolling list. Figure 8.19 shows the I CN# Picker window.

371

Using ResEdit
r

S File Edit

..,

Figure 8.19 ICN# Picker window.

A desktop icon (I CNf/) actually consists of an icon and its mask. The
mask is used to change the appearance of the icon to indicate a change
in condition (TN:55). Resources that contain an icon without the mask
are ofresource type I CON .

Build your first icon by again selecting New in the File Menu. An IC N#
editing window should be displayed. The special editor for I CN# resources
allows you to build your icon graphically. With a little expe1imentation, you
should be able to draw lines and circles with the mouse (Figure 8.20).
The ICN# Resource Editor in ResEdit allows you to preview the icon
on both a light and a dark background. It also shows you what the icon
will look like if the application is unavailable. (This commonly occurs
ifyou ejected the disk with the program on it using Command E. Ifthe
application was on the desktop, it will still show up but will be
dimmed, indicating that it can't be used).
The IC NI/ editor is like the Fat Bits mode in MacPaint. The pane on the
left is the icon displayed by the application. The pane on the right is the
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Figure 8.20 The ICN# editor.

mask, and governs the change in the application's icon when selected.
Figure 8.21 shows how THINK C's application icon looks in the IC N# editor.
When you're comfortable drawing figures with the bit map editor, try
creating an icon for your application. If you prefer, use the icon in Figure
8.22, which will be used in the rest of the tutorial screen shots. When you'r e
done with your icon, select Data->Mask from the I CN# menu. This will
automatically draw a mask for your application in the right pane of the
window. When the icon is complete, examine the title bar. You should see
something like the text in Figure 8.23, except that the resource ID number
will probably be different. Click on the close window ofyour Hello2 icon, and
select Get Info in the File menu (Figure 8.24). Change the ID to 128. It is
a Macintosh convention to u se 128 as the application's I CN# ID number.

Your version ofResEdit may contain a second I CN# menu item that
rotatesbetween Disp l ay Using Ol d Method and Di splay Using
New Method .Makesureitshows Display Using New Method . This
will ensure that your icon looks good on the desktop. With system
Version 6, changes were made that could cause the old method of
displaying icons on the desktop to be aesthetically unappealing
(TN:147).
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Figure 8.21 The THINK C I CN#.
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Figure 8.22 The Primer I CN#.
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lo

ICN# ID

12566 from Hello2

Figure 8.23 New resources are assigned random resource IDs.

~D

Type:
ID:

Name:

Info for I CN# 128 from Hello2
ICN#

Size:

256

1120
Owner type

Attributes:
0 System Heap
0 Purgeable

O Locked

O Preload

O Protected

Figure 8.24 Get Info window of ICN# resource.

Here's a brief description of the resource fields in this window.
Owner Type: Special programs such as desk accessories must be
handled differently. If you click on Owner Type, your resource ID
changes. Resources in desk accessories must have IDs within certain
ranges to work properly.
Owner ID and Sub ID are used when you are sharing the resource
with other programs.
The Hello2 icon is automatically set to Preload and Purgeable by
the Finder. PreLoad resources are loaded into memory as soon as your
application starts running. Purgeable resources are removed from
memory if the Memory Manager needs to reclaim that space.
If System Heap is selected, the resource will be loaded into the
System Heap instead of the Application Heap. If the resource is
Locked, the Memory Manager cannot move it around when it is
rearranging memory. If the resource is Protected, the Resource
Manager can't modify it.
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Now that you've created an icon for your application, you have to create
the resources that will link your icon to your application's creator name.

Building the File Reference Resource
Now we'll build the FR EF(short for File Reference) resource. First, close the
IC N# Get Info window, then close the IC N# Picker window. Select New from
the File menu and select FREF from the scrolling window (or type it in).
While you're in the FR EF Picker window, select New from the File menu
aga in. The FREF resource appears. It contains three pieces of information
about the application:

• File Type: You saw this in the Get Info dialog box of your application.
• icon local ID: The local ID number that other resources (like BND L) will
use when looking for the icon. Don't confuse this with the IC NII resource
ID.
fileName: This field is not currently used.
Type APP Lfor file type. Put a 0 in the icon Local ID field. The fileN ame is
not currently used; you can leave it blank. Click in the close box to close the
FR EF window (Figure 8.25). Now, select Get Info so that you can change the
FR EF resource number ID. As you did with the IC N# r esource, change the
ID of the FRE F to 128 (Figure 8.26). You have now completed the I CN# and
FREF resources ofHello2.

D

FREF ID

File Type

lnPPL

icon locallD

I~

fileName

Figure 8.25

[

1933 from Hello2

I

I

Completed FR EF fields.

J
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Info for FREF 128 from Hello2
Type:

FREF

Size:

O

ID:
Name:
Owner type

Attributes:

D System Heap
D

Purgeable

D
D

Locked
Protected

D Preload

Figure 8.26 Get Info window of FR EF 12 8 ,

Remember, the resource ID is not the same as the local ID. Your
application's code will call a resource by its resource ID; the local ID
is used by the Finder to correctly load Finder resources into the
Desktop file (TN:48).

Building the Bundle Resource
Your next task is to build a bundle resource. The BND L keeps track of the
resource IDs and local IDs used by the application.
Select New from the File menu. Key in BND L, or click on it in the scrolling
window (Figure 8.27). Click on OK.
The BNDL resource, like the FREF youjust built, is edited with the text
editor. BND Ls, however, have a variable number offields, depending on how
many resources are being bundled together. This particular editing operation is not intuitive for most people, so we'll go very slowly. The next time
you need to create a resource with a variable number of fields, you'll be
ready.
To create the BND L resource, select New again from the File menu. Type
in HE LOfor OwnerName. Put a 0 into the owne r ID field (Figure 8.28).
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Select New Type

R

OK

D

( Cancel )

Figure 8.27 BND L selected
Resource Type dialog box.

:o

BNDL ID

OwnerName
owner ID
numTypes

5 400 from Hello2

IHELO

:=====---.
l._o______,
-1

*****

8.28 BND L fields, part 1.

HELO is Hello2's Creator name.The BNDL field OwnerName
corresponds to the a pplication's Creator name. The BND L field ownerID is the resource ID of the signature resource (which you'll build
next).
Click on the row of asterisks at the bottom of the listing. The asterisks
should be highlighted by a rectangle (Figure 8.29). Select New from the File
menu bar . You can now add the first resource that the BND Lis su pposed to
track. Enter I CN# in the new type field. Then, click on the row of dashes.
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_0

BNOL ID

5400 from Hello2

OwnerNome

I HELO

ownerlD

lo....____--'

::=======~

numTypes

-1

I*****

Figure 8.29 Highlighted asterisks.

It should be highlighted with a rectangle (Figure 8.30). Select New from the
File menu again. Type in 0 for the Loe al ID and 128 for the rs re ID for the
I CN# resource. Scroll down to the bottom of the window using the scroll bar
on the right. Select the asterisks again (Figure 8.31). (Since the windows in
ResEdit are not resizable, you will often need to scroll down to find
additional fields in a resource. This is the only time we'll discuss scrolling
in the text.)

-0

BNDL I 0 - 5400 from Hello2

OwnerName
ownerl D
numTypes

*****
type
#of type

IHELO

::====:::::!.......,
o______.
._I

0

I1cN#
0

1----local ID
rsrclD

Figure 8.30 Highlighted dashes.
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::D

BNDL ID

ownerlD
numTypes

*****
type
#of type

local ID

lo

5400 from Hello2

J

0

IICN#
0

lo

rsrclD

I*****
Figure 8.31 Asterisks highlighted again.

Now that you've put the IC Nff information into the BND L, let's add the
FR EF resource information. Use the same techniques that you just used for
the IC Nft information to complete the BND Las shown in Figure 8.32. Select
Get Info from the File menu and change the BND L's resource ID to 12 8. By
convention, Macintosh applications have a single BND Lwith resource ID =
128. Now, close the edit window and save your changes.
ResEdit does some basic error checking with the data that you type in,
so it's possible that you will get an alert box complaining about something.
For example, ResEdit will check to make sure you have no more than four
characters in your type fields; if you get the alert in Figure 8.33 when you
close the resource, go back to the two type fields and make sure you have
only four characters (including spaces).
One way to make sure your fields are clear of nonprinting characters is
to double-click on the field to highlight it and then clear the field with the
backspace/delete key. Then, input the field again. Use the tab key or the
mouse to get between fields, not the <Return> key.
Click on the close box and you're done with bundles. Now, you're just one
resource away from iconization.
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-o

BNDL ID - 5400 from Hello2
rsrclD

1120

j

*****
type
#of type

IFREF
0

local ID

lo

rsrclD

I120

*****
8.32 Completed BND L fields.

4 characters eHpected for Type name.

I

OK

8.33 ResEdit error alert.

Adding the Signature Resource
You've now added three of the four resources needed to attach an icon to
Hello2. The last one to be added is the signature resource. The signature
resource is somewhat different from the other resources, which all have
fixed names. The signature resource type is actually the Creator name that
you assigned to Hello2 at the beginning of this chapter.
At this point, use ResEdit to display the resources that you've already
installed (Figure 8.34). Select New from the File menu. Since the Creator
name you used was HE LO, type HE LO and click on OK. (Because HE LO is not
a standard resource, it's not in the scrolling window; you'll have to type it
in, as shown in Figure 8.35.)
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Select New Type
actb ~
a cur
ALRT
APPL
BNDL
cctb
clut IQ

I

IHELO I

n

OK

l)

( Cancel )
Figure 8.35 Type dialog box
with ' HE LO' typed in.

With the HELO Picker window open, select New from the File menu. So
far, you've edited resources textually (like FREFand BNDL), and you've used
a bit map editor (IC N#). Each resource in ResEdit has a template that
specifies how the resource should be edited. If ResEdit does not have a
template for the resource selected, it defaults to the hexadecimal editor
(Figure 8.36). This general-purpose editor allows you to type in h exadecimal information on the left side of the window and ASCII text on the right
side. You can force the use of the h exadecimal editor on any resource by
choosing Open General instead of Open in the File menu.
The signature resource is used to supply the Creator ID name to the
Finder, so you don't actually type anything in. Close the window and select
Get Info from the File menu while the HE LO resource is selected. Change the
resource ID to 0 and close the Get Info Box. You should have the resources
shown in Figure 8.37 displayed in Hello2.
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§0

HELO ID

=

29817 fro m Hello2

000000
000008
000010
000018
000020
000028
000030
000038
000040
000048

~

000050

;

000058
000060
000068

Figure 8.36 ResEdit's hexadecimal editor.

0
BNDL
CODE
DATA
DREL
FREF

Hello2

HELO

ICN#
SIZE
WIND
ZERO

Figure 8.37 Hello2 with
Finder resources.

You're done! The four required Finder resources are installed int o your
Hello2 application. To see ifit worked, save your changes and quit ResEdit.
If you succeeded (Figure 8.43), you may proceed to the ve r s resource
discussion. If the situation resembles Figure 8.38, read on.
The s i gn at u re resource used to have an additional function. Ifyou
typed text into it, the text would be displayed when the Get Info menu
item was selected in the Finder with the application highlighted. This
function has been eliminated by the v er s resource, which now
supports the Get Info call in the Finder. Ifthe v er s resource is missing
in a file, the Finder will alternatively use the information in your
signature resource. For example, if you typed the text of Figure 8.39
into Hello2's HE LO resource, the Finder would display the Get Info
window in Figure 8.40. The first character in the HEL0 resource
(shown as a hex 3 6 or an ASCII 6) is the length of the Get Info text.
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~D~ Hello2 ~0~
4 items 86 ,412K in disk 1 ,599

iJ

Hello2 Proj

He11o2

He 11o2 Pro j .Rsrc

He 11o2 .c

Figure 8.38 Hello2 application icon (unchanged).
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0000 10
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P648
312E
2073
6170
696F
2074
2050

656C
3020
6160
706C
6E20
6865
7269

o from Hello2
6C6F
6973
706C
6963
6672
2040
6065

3220 6Hel l o2
206 1 1.0 is a
6520 sample
6174 appl ical
6F60 ion from
6163
t he Mac
72
Pr i mer

F igure 8.39 A complete
HE L0 resource.

Info
Locked

0

He11o2

Kind : application
Size : 2 ,672 bytes used, 3K on disk
Yhere : Hard Disk, SCS I

Created : Tue, Feb 16 , 1904, 9 :54 AM
Modified : Fri , J an 6, 1989, 2 :59 PM
Vers ion : He11o2 1 .0 is a sample application
from the Mac Primer

S ugges ted Memory S ize (K) : 384
Application Memory Size (K) :

~

Figure 8.40 The Get Info
window corresponding to
F igure 8.39.
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If your new icon appeared, great! If not, don't despair; use ResEdit to
check each of the four resources you created. Make sure the resource IDs
are correct. Ifthis is true and the icon still doesn't appear, try rebooting your
machine. This almost always works. The final alternative is rebuilding
your Desktop. Before you go downstairs for the hammer and nails, read the
next section.

_J

Rebuilding the Desktop
The icon you made failed to show up in the Finder when you quit ResEdit.
The reason was that the Desktop file needs to be rebuilt after you modify
the Finder resources. The Desktop file is the Finder's application database.
Among other things, the Desktop file holds information about the volume's
file bundles. When a volume's Desktop is rebuilt, the entire volume is
searched, and the Desktop database is reconstructed. One way to rebuild
the Desktop is to clear the Desktop file using ResEdit (you can't do this in
MultiFinder). Rebuilding the Desktop does one irrevocable thing, (so if
you're not a person who likes to do seven irrevocable things before breakfast, please read carefully); it causes the loss ofthe information that has been
placed in the text box of the Get Info window for all your applications.
One way to avoid rebuilding your Desktop file is to add the resources
to a copy ofHello2 on a floppy and then copy it to the target disk. This
should cause the Desktop file on the target disk to update itself.

1

In ResEdit, highlight the Desktop file by clicking on it once. If you have
two storage devices mounted, each disk will contain a Desktop file that
keeps track ofthings for that disk. Make sure you've chosen the Desktop file
that's on the diskette or hard drive containing Hello2. Select Clear from the
Edit menu (Figure 8.41). At this point, you'll be asked to confirm the file
deletion (Figure 8.42). Click on OK if everything looks right. Select Quit
from the File menu. After a few moments (the bigger your drive, the longer
it will take), the Desktop file will be rebuilt with the new information about
Hello2 (Figure 8.43).
Did your icon show up correctly? If not, you might want to check the
resources again. Each step is crucial in making sure the Finder figures out
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.,
:)(:l.

Hord Disk
OApp s
~ ResEdit

Figure 8.41 Deleting the Desktop file.

Do you really want to delete
the file 'Desktop' ?

KCancel B

OK
Figure 8.42 Last chance alert.

4 items 86,42 1K in disk 1,590

[i)
Hello2 Proj

Hello2

Hello2 Proj.Rsrc Hello2 .c

Figure 8.43 The new
Hello2 icon is displayed.
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what the icon is supposed to be. If one of the resources has an error, correct
it and try rebuilding the Desktop again. One good debugging technique is
to compare your resources with those in an application that displays its icon
properly, like THINK C.
Adding icons to your application depends on the correct relationship of
the resources you have added. One mistake in a resource ID or field is all
it takes. If you have made mistakes in the Finder resources, the Finder
won't complain; it will just go on using the standard application icon until
it finds the resources it needs.
Once you understand how to install the Finder resources, you'll find
it easier to add them directly to your .rsrc file of your project, instead
of adding them to completed applications. That way, each time you
build a standalone application from your project, THINK C will
automatically add the Finder resources to it.

The vers Resource
The next Finder resource that you'll add is the vers resource, which stores
information about the current version of an application. Fire up ResEdit
and open up Hello2. Create a new resource of type vers (Figure 8.44). As you
can see, the vers is edited like the FR EFs or BND Ls you have already seen.
Key in the fields as shown in Figure 8.45. Then close the ver s edit window
and change the resource ID to 1.
The information you put in tells the Finder more about your application.
Most of this additional information refers to the application's version. The
version is designated using Apple's intricate numbering system for program releases, which works like this. A new program has Version 1.0. If
there is a minor revision to the program, it is then labeled Version 1.1. If
there's a bug fix to Version 1.1, it's designated 1.1.1. So, if you have a
program that just had a second bug fix to a third minor revision, it would
be Version 1.3.2. If there's a major revision to the program, the first
number is incremented. If the program has gone through a major revision,
four minor revisions, and six bug fixes, the current version is 2.4.6.
There's also a development suffix, which is added to indicate how far
along the product is. There are three different stages: The earliest is d for
"development" (for example, l.Od). The next level is a (for "alpha"-1.0a).
Then, the b (''beta") version comes out (l.Ob). Theoretically, the released
version would then be 1.0. If you have a product labeled 1.3dl.2, it's the
second bug fix of the first development version of the third revision of the
first release of the product.
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Uersion
Number
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Figure 8.44

ver s resource editor.
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Uersion
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Reuision
Stage

Ison
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Number
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1 from Hello2

Rbbrieuiated 11.0
string
Get Info
string

IHello2 1.0 from the Mac Primer

Figure 8.45 Completed v er s resource.
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Now that we've said all that, it's unlikely that you'll need as complex a
version number as that, unless you own Microsoft.
This relates to the ver s resource fields as follows:
•
•
•
•

The version number is the first number, the "1" in 1.0.
The revision number is the second number, the "3" in 4.3.1.
The revision stage is the development level, the ''b" in 1.0b2.
The build number is the number following the development suffix, the
"5" in 2.3a5.

• The language integer refers to the country to which this version of the
program is headed. The United States is O; see Figure 8.46 for a list of
numbers for other countries.
• The abbreviated string is the whole version strung together, like
1.2bl.l.
• The Get Info string is the text that is put in the Get Info box when you're
in the Finder.

us

France
Britian
Germany
Italy
Netherlands
Belgium
Sweden
Spain
Denmark
Portugal
French Canada
Norway
Israel
Japan
Australia
Arabia
Finland
French Swiss
German Swiss
Greece
Iceland
Malta
Cyprus

Turkey
Yugoslavia

0
1
2
3
4
5
6
7
8
9
10
11

12
13
14
15
16
17
18
19
20
21
22
23
24
25

Figure 8.46 Country numbers.
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Test the resource by saving and quitting ResEdit. Then, click on the
Hello2 application and choose Get Info from the File menu of the Finder
(Figure 8.4 7). The dialog box should show what you put into the ver s
resource. Currently, the Finder doesn't use any of the information except
for the Get Info string, which is placed in the Get Info box. The ver s
resource type is a relatively recent addition to the Finder resources; Apple
will have plans for it in the future, so put it in your applications (TN:189).
Some ofyou may be confused by the fact that the s i gn at u re resource
seems to put information into the Get Info box in the same way that
the ve r s resource does. You're right, and here's what happened: The
s i gnat u r e resource was the old way of attaching the icon to the
application and putting information in the Get Info box. The ve r s
resource type is intended to supply the Finder with extra information,
including the Get Info data, about your application. Ifthere is no ve r s
resource, the Get Info information in the s i gn at u r e resource is used.
If there is, the s i gnat u r e resource is ignored, and the vers Get Info
field is used. In any event, don't dump the s i gnat u re resource! It still
is used to identify the desktop icon for the application. There doesn't
have to be anything in it however; just create it, change the resource
ID to 0, and close it.

Info

~

locked

D

Hello2

Kind: application
Size : 2 ,682 bytes used , 3K on disk
Yhere : Hard Disk , SCS I

Created : Tue, Feb 16 , 1904, 9 :54 AM
Modified : Fri, Jan 6, 1989 , 4 :32 PM
Version : Hello2 1 .0 from the Mac Primer

Suggested Memo r!J Size (K) : 38 4
Application Memor!J Size (K) :

§.:=J

Figure 8.47 Hello2's
Get Info window.
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Ifyou have avers resource with a resource ID number of 2, it can be used
to link a set of files together. Apple has used this number to identify the
current system level of the files in their disks. Figure 8.48 shows how this
system information is displayed.
In the bottom of the Get Info box, there are two other fields, Mininum and
Suggested Memory Size for the application. These fields are filled by the
SIZE resource, which is discussed next.

Last of the Finder Resources: The SIZE Resource
The last Finder resource is the SIZE resource, which contains MultiFinder
information. As you saw earlier, THINK C installs the SIZE resource for
you when it compiles your application. Open the S I ZE resource in Hello2
and examine the fields. Figure 8.49, suitably elongated, shows the fields
that the S I ZE resource contains.
The following is a brief description of these fields:
• Save screen (Switcher): A flag used by the Switcher, an early version
of MultiFinder.
• Accept Suspend/Resume events: If your application handles Suspend/Resume events, set this flag.
• Disable option: Another flag used by Switcher.
Can Background: A MultiFinder flag set if your application uses null
events while in the background.
• MultiFinder aware: If you use WaitNextEvent() in your programs, set
this flag.
• Only Background: This flag is set if your application runs only in the
background and has no user interface (i.e., Backgrounder in the System
folder).
• Get Front Clicks: If set, this flag allows your applications to receive
mouse clicks even if it is working in the background. If this is not set,
clicking on your application window will only make the application
active, and not pass on the click.
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D

Info

0

Locked
Finder
System Software Version 6 .0.2 ........._
Kind: System document
Size : 107 ,390 bytes used, 1OSK on disk
Yhere: Hard Disk, SCSI

Created : Sat, Apr 30, 1988, 12 :00 PM
Modified : Sat, Dec 17, 1988, 4 :55 AM
Version : 6 .1 , Copy right App le Computer,
Inc. 1983-88

Suggested Memory Size (K) :
Application Memory Size (K):

160

EJ

Figure 8.48 Illustration of
ver s 2 resource.

The rest of the bits are reserved by Apple. This is just a brief description of
the flags in the S I ZE resource. For a detailed discussion of the SI ZE
resource, read The Programmer's Guide to MultiFinder, available from
Apple through APDA.
In most cases, the only bits tha t need concern you are th e ones that you
can set from THINK C in the Project dialog box.
As we go to press, two SI ZE resource flags have been reserved by Apple
(the two Switcher flags), and two n ew flags: getChildDiedEvents and
32Bitcompatible. The SIZE editor in your copy of ResEdit may be
updated to include these ch anges. (TN:180,205).

The next section demonstrates how intrinsic resources are to the Macintosh. We now present Minimalist, a program that contains nothing except
two CODE resources and a WIN Dresource, all created with ResEdit.

_J

Minimalist, the ResEdit Program
Minimalist could be charitably described as a very small, useless program.
It demonstrates, however, how resources make Macintosh programs work.
In ResEdit, create a new file named Minimalist. Using the Get Info menu
i tern, change the file type to APPL. Then, create a new resource of type C0 DE
(Figure 8.50). The general hexadecimal editor appears.
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Reserned bit
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0 1

Reserned bit
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0 1
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@O

01

Reserned bit
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0 1

Size

11393216

Min size

1393216

Figure 8.49 The S I ZE resource fields.
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Type in the hex in Figure 8.51. As you're typing, alphanumeric characters will appear on the right. When you're done, click on the close box.
Change the ID of the resource by choosing Get Info from the File menu.
Change the ID to 0. Build the second C0 DE resource with the hex in Figure
8.52. Change the resource ID number of the second COD E resource ID to 1.
Finally, build a WI ND resource with a resource ID of 400 . Use any size or
window type that you prefer, but make sure that the Vis i bl e and
goAwayFl ag checkboxes are checked. Save the WI ND and the two CODE
resources.
You now have an application. If you double-click on Minimalist, it will
display the window you created. Clicking anywhere on the screen will
return you to the Finder.
r
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File

Edit
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Find
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Figure 8.50 Blank C0 0 E resource in Minimalist.
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Figure 8.51 Minimalist's CODE 0 resource.
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§0

CODE ID

000000
000008
000010
000018
000020
000028
000030
000038
000040
000048
000050
000058
000060
000068

0000
A86E
594F
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554F
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= 1 from Minimalist
0001
A8FE
3F3C
FFFF
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FFFC DDDDHmDD
A850 it)nit)OSIDilP
42A7 YO?<DeBll
A9BD /<DDDDSIQ
67F8 UOSltJDgD

~

SID

;

Figure 8.52 Minimalist's C0 DE 1 resource.

To get the C0 DE hex, we wrote a short assembly language program that
does initialization, draws a window, and quits on a mouse click. Here's the
code:

include 'Traps.a'
main
pea -4(A5)
_InitGraf
_InitFonts
InitWindows
InitCursor
subq #4.sp
move #400,-(sp)
clr.l -<sp)
move.l #-1.-<sp)
_GetNewWindow
Try Button
subq #2.sp
_Button
tst.b (Sp)+
beq.s TryButton
ExitToShell
end
We don't, in general, recommend this strategy for program development.
It's best to leave CODE resources to THINK C.
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In Review
Chapter 8 discussed the steps necessary to install the Finder resources into
your applications. It provided a tutorial for new ResEdit users.
Chapter 9 discusses the issues you'll face as you start developing your
own Macintosh applications. We'll start by taking a look at a few Mac
periodicals you may find useful. We'll talk about Inside Macintosh and
other Apple technical references. We'll look at Apple's support apparatus
for Macintosh programmers and developers.
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The Final
Chapter
To successfUlly develop software for the
Macintosh, you need current technical information. You need to know how to use
the standard Macintosh references effectively. You also need to know about the
different technical support programs
Apple offers. In this chapter, we'll
discuss these and other Macintosh
development issues.

THE BASICS OF programming the Macintosh have been laid out in the eight
preceding chapters. Familiarity with these basics is half the job of becoming a successful developer. The other half is understanding how the
Macintosh programming world works and knowing where to get the
information you, as a Macintosh software developer, will need.
To succeeed in developing software for the Macintosh, you need current
technical information. You need to be able to use the standard Macintosh
references effectively. You also need to know about the different technical
support programs Apple offers.
In this chapter, we'll investigate the periodicals that are your link to the
Macintosh community. We'll look at Inside Macintosh and other Mac
technical texts. We'll look at software tools, from compilers to debuggers.
We'll also examine Apple's support programs for Macintosh software
developers.
The Macintosh Programming Primer is your passport to Mac application
programming. When you've finished reading this book, join a local Macintosh user's group, and buy a copy of the best Mac programmer's magazine,
MacTutor. Get involved and write some code!

_J

Macintosh Periodicals
Whether you're interested in making a commercial product or a shareware
product, or just want to know the inside stories of the Mac community, get
the trades. Mac Week is great, and PCWeek and Info World are good, ifless
oriented to the Macintosh computer line. All three magazines deliver
timely dollops of news: the new software packages, scoops on company
goings-on, and juicy industry gossip.
The Macintosh programming journal is MacTutor, an invigorating
monthly discourse on the art of Mac programming. Popular Mac magazines
includeMacUserandMacWorld.Theirbroadviewpointcanshowyouwhat
is of interest to Macintosh users, and what's available.
While you wait for the idea that will make you the seventh richest person
in the world, you need to learn the Macintosh inside out. To do this, you
need Inside Macintosh.

The Essential Inside Macintosh
The Inside Macintosh technical reference series is written by Apple and
published by Addison-Wesley. There are six books in the Inside Mac series
(Volumes I-Vand the Inside MacintoshX-Ref). In Chapter 1, we suggested
that you could get by with Volumes I and V.
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We lied. Get them all.
Volumes I, II, and III represent the Mac technical world as it was before
the Mac Plus was introduced. All three volumes focus on the original 128K
Mac, describing interfaces to the ROM routines, memory management,
hardware specs, and more.
Volume IV was released after the Mac Plus and the Mac 512KE were
introduced. Both of these new Macs sported 128K RO Ms (as opposed to the
128K Macintoshes' 64K ROMs). These larger ROMs contain the routines
that handle the new, hierarchical file system (HFS), routines that interface
to the SCSI (Small Computer System Interface) port, and updates to most
of the 64K ROM routines. Volume IV covers all these changes.
Volume V was released after the introduction of the Mac SE and the Mac
II. The Mac II and the SE have 256K ROMs and support features like popup, hierarchical, and scrolling menus; a sophisticated sound manager; new
text edit routines; and more. Perhaps the biggest change of all was the
addition ofcolor support to the Mac II ROMs. Volume V covers both the Mac
SE and the Mac II.

The Typical Inside Mac Chapter
One of the best features of the Inside Mac volumes is their consistency.
Each chapter starts with a table of contents, followed by the "About This
Chapter" section which gives an overview of what the chapter covers and
what you should already be familiar with before you continue.
The next section or sections give an overview of the chapter's technical
premise-for example, "About the Event Manager" or "About the Window
Manager." The fundamental concepts are explained in great detail. At first,
you may be overwhelmed by the wealth of detail, but after a few readings
(and a little experimentation), you'll warm to the concept.
Then the chapter's data structures, constants, and essential variables
are detailed. These are presented in Pascal and/or assembly language.
ijack in Chapter 2, we presented a set of rules for translating Inside Mac's
Pascal data structures and calling sequences into C.
Next come the chapter's Toolbox routines. Each routine's calling
sequence is presented in Pascal, along with a detailed explanation of the
uses of the routine. This section includes notes and warnings, as appropriate.
Some chapters follow the Toolbox routines section with a few additional
sections. Among these extras are a description of the resources pertinent to
that chapter and, perhaps, a description of extensions available to the
advanced programmer.
Finally, there's a chapter summary, with its unadorned lists of constants, data types, routines, and variables.
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Appendices and Special Sections
Inside Macintosh, Volume I, Chapter 1, contains a road map that gives you
a feel for the basics ofthe Macintosh and how the Inside Mac volumes work.
The road map suggests you read Chapters 1 through 4, then read the
chapters that are relevant to your current development effort. This is sage
advice. These chapters offer an excellent grounding in Mac basics (or an
excellent review if you've been at it for awhile).
Volume III contains three chapters, some appendixes, a glossary, and an
index. Chapter 1 discusses the Finder (with an emphasis on Finder-related
resources). Chapter 2 discusses the pre-Mac Plus hardware. Chapter 3 is
a compendium ofall the summary sections from Volumes I and II. Appendix
A is a handy, if occasionally inaccurate, table of result codes from the
functions defined in Volumes I and II. The rest of the appendixes in Volume
III have been superseded by the appendices in the Inside Macintosh X-Ref.
The Inside Mac X-Ref starts off with a general index covering all five
Inside Mac volumes, the Macintosh Technical Notes, Programmer's Introduction to the Macintosh Family, Technical Introduction to the Macintosh
Family, and Designing Cards and Drivers for the Macintosh II and Macintosh SE. The general index is followed by an index of constants and field
names. Appendix A of theX-Reflists every Toolbox routine that may move
or purge memory.
AppendixB ofInside Mac consists oftwo lists. The first is a list ofToolbox
routines presented alphabetically by name, with each name followed by the
routine's trap address, which is the four-byte instruction the compiler
generates to call the routine. The second is a list of the trap addresses, in
order, with each trap address followed by the routine name. This information is extremely useful if you ever have to look at code in hexadecimal
format, a likely event if you use TMON or MacsBug, two Mac debuggers.
Appendix C lists most of the operating system global variables, with
their memory location and a brief description. Finally, Appendix C is
followed by a glossary of terms presented in Volumes I through V.

_J

Apple Technical References
In the first few years of the Mac era, Inside Macintosh was the only
definitive reference on the Macintosh. Recently, however, Apple has published some additional reference texts for the Macintosh, including Technical Introduction to the Macintosh Family, Programmer's Introduction to
the Macintosh Family, and Designing Cards and Drivers for the Macintosh
II and Macintosh SE. These books are all part of Addison-Wesley's Apple
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Technical Library. Another excellent source of technical information are
the Macintosh Technical Notes.

Macintosh Technical Notes
Macintosh Technical Notes are published on a regular basis by Apple and
distributed to developers free of charge. The Tech Notes are a necessity for
serious Mac developers. They contain technical information that was not
yet available when the latest volume ofInside Macintosh went to press. For
example, Tech Note #184 describes the Notification Manager (used in
chapter 6). Without this Tech Note, developers wouldn't even know the
Notification Manager existed, let alone know how to use it.
A timely way to receive Tech Notes ifyou are not a developer is to become
a member of APDA, the Apple Programmer's and Developer's Association
(developers are automatically members of APDA). APDA charges $20 per
year for membership and they sell most of the technical references mentioned in this chapter. They sell the Tech Notes in both hard copy and disk
formats. For more information on APDA, contact:

Apple Programmer's and Developer's Association
Apple Computer, Inc.
20525 Mariani Avenue, MS: 33-G
Cupertino, CA 95014-6299
APDA was formerly an organization independent of Apple and has just
recently been returned to the fold, so changes in its operation may be
imminent.
Ifyou're not either a developer of a member of APDA, you can still get
Tech Notes by downloading them from Mac-oriented bulletin boards
around the country.

Other Books
There are a number of excellent books on Mac programming. One of the
most popular is the Macintosh Revealed series, written by Stephen Chernicoff. Volume I of Macintosh Revealed dives right into the Toolbox,
providing an in-depth tour of the Mac ROM routines. Volume II continues
the exploration of ROM routines, and additional texts are planned.
Another excellent reference is Scott Knaster's How to Write Macintosh
Software. This book is little too advanced for the beginner, but it's worth the
struggle to get through it. Ifyou plan on writing a lot of Mac code, read this
book.
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We're also hard at work on a sequel to the Macintosh Programming
Primer. We'll address concepts like color QuickDraw, I NIT s, CD EV s, and
other interesting Toolbox routines with lots of examples and code
walkthroughs.
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Apple's Developer Programs
Apple has recently replaced the Certified Developer Program with the
Apple Partners program. This new program provides additional technical
support from Apple. Developers accepted into the new Apple Partners
program receive complete Apple technical documentation, system software
updates, membership in APDA, access to training classes, and discounts on
Apple hardware and software. Developers also get a year's subscription to
AppleLink, Apple's electronic communication network, and access to
Macintosh Developer Technical Support (see below). However, the orginal
Certified Developer yearly rate ($0) has also been enhanced to cover the
services provided ($600).
You don't have to be a Fortune 500 company to qualify as an Apple
Partner, but Apple is looking specifically for developers of Apple hardware
and software who intend to resell their products. It you are interested in
developing software, but don't have an immediate plan to market it, you
might consider the Apple Associates Program, a new support program from
Apple.
The Apple Associates Program is aimed at educators, in-house developers and shareware programmers. It provides a basic level of support,
including AppleLink (one month prepaid), system software upgrades,
APDA, Tech Notes, and access to other technical information. The Associates program has a yearly charge of $350.
If you plan on writing a product for the Mac, the information that you
receive in either program is invaluable. Call the Developer Programs
Hotline at (408) 974-4897 and ask them to send you an application.
As a developer, there's nothing more satisfying than talking to people
who have solved, or at least are aware of the technical programs you
encounter in writing programs. At Apple, these people come from Macintosh Developer Technical Support, or MacDTS.
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Macintosh Developer Technical Support
and AppleLink
Macintosh Developer Technical Support is composed of talented Mac
software engineers dedicated to helping developers with their technical
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problems. To work with MacDTS, send them a message via MCI Mail. Or
you can use AppleLink.
AppleLink is Apple's electronic communication network. It gives access
to information about Apple products, prices, programs, and policy information. You can write to Developer Technical Support at MacDTS on AppleLink, and they will make every possible effort to answer your question
within twenty-four hours. (If they can't solve the problem, they'll give you
a very chic button to wear.)
Both Apple Partners and Apple Associates receive subscriptions to
AppleLink: Apple Partners receive a full year's subscription with the
minimum monthly fees prepaid; Apple Associates receive one month of the
minimum monthly fee prepaid.
Besides access to MacDTS, AppleLink affords access to a lot of other
services. You can download the new system utilities or look at the Help
Wanted ads posted on the bulletin board. You can send beta versions ofyour
products to your evangelist at Apple or to other developers. AppleLink
makes you a part of the developer community.

_J

Software Development Tools
All the applications presented in this book were written in C using the
THINK C development environment from Symantec. The advantages of
THINK C lie primarily in its ease of use and the THINK C Debugger.
Symantec also makes a powerful, yet friendly, Pascal development environment called THINK Pascal.
Both THINK environments are basically nonextensible. This means
that you can't create shell scripts to back up your files automatically, or
rebuild an older version of your project. You also can't create custom menu
items that automate your development process. Lightspeed handles most
of the development cycle so thoroughly that you may not miss these
features. If you do, you may want to take a look at the Macintosh
Programmer's Workshop (MPW) from Apple.

MPW from Apple
MPW is an extremely powerful developme.nt environment that is totally
extensible-so extensible, in fact, that several third parties have produced
compilers that run under MPW. MPW is like a Mac-based UNIX shell. You
can write shell scripts, tie them to your own menus, and create tools that
have total access to the Toolbox, yet run inside the Toolbox environment
with access to all your data. The catch is that MPW is more complex than
THINK C and, therefore, more difficult to master. MPW also is not cheap,
typically costing more than three times as much as THINK C or Pascal.
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Both MPW and THINK have a lot of followers and are supported by
MacDTS. Whichever way you go, you'll be in good company.

The THINK C Debugger, TMON, and MacsBug
Debugging on any computer can be a tedious and frustrating experience.
Luckily, there are some excellent tools that you can use to fix up your code.
THINK C 3.0 comes with a source-level debugger. Assuming you use
MultiFinder with at least two megabytes ofRAM, this debugger fits the bill
for most bugs. We discuss its capabilities in Appendix D.
MacsBug is an object-level debugger developed by Motorola for the
68000 family of processors. For a long time, it was the only debugger
available for the Mac. If, however, you need a little more horsepower,
consider TMON.
TMON is the pro's debugger. Instead of running as a separate program
under MultiFinder, TMON takes over the processor when it runs. TMON
preserves your program's run-time environment by not calling any of the
Mac Toolbox routines (which might alter the state of your program).
Instead, the folks at ICOM Simulations cleverly wrote their own window
and menu handlers. Although TMON is somewhat difficult to learn, it's
worth it. When you run into an exasperatingly unexplainable bug, pop into
TMON and step through your program. You can set breakpoints, disassemble your executable image, and even make changes to your program
and data. For debugging drivers, IN IT s, and DAs, TMON can't be beat.

_J
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To Boldly Go
The Macintosh world is accelerating.
New hardware and software are being designed and marketed faster
than ever before. Each successive system software version paves the way
to wonderful things: multimedia, image processing, CD-quality sound,
voice recognition. There's a feeling that everything is finally arriving. This
vision may seem daunting, but remember-a few years ago, the Mac was
an intriguing experiment; the people who gambled on it won big.
The changes that Apple is making are setting the stage for machines that
will be as big a jump as the Macintosh was from the Apple II line. In the Mac
world, you're close to the edge.
Enjoy it!

Appendix A

Glossary
access path: A description of the route that the File Manager follows to
access a file; created when a file is opened.
access path buffer: Memory used by the File Manager to transfer data
between an application and a file.
action procedure: A procedure, used by the Control Manager function
TrackControl, that defines an action to be performed repeatedly for as
long as the mouse button is held down.
activate event: An event generated by the Window Manager when a
window changes from active to inactive or vice versa.
active control: A control that will respond to the user's actions with the
mouse.
active end: In a selection, the location to which the insertion point moves
to complete the selection.
active window: The frontmost window on the desktop.
address: A number used to identify a location in the computer's address
space. Some locations are allocated to memory, others to 1/0 devices.
alert: A warning or report ofan error, in the form ofan alert box, sound from
the Macintosh's speaker, or both.
alert box: A box that appears on the screen to give a warning or report an
error during a Macintosh application.
alert template: A resource that contains information from which the
Dialog Manager can create an alert.
alert window: The window in which an alert box is displayed.
allocate: To reserve an area of memory for use.
application font: The font your application will use unless you specify
otherwise-Geneva, by default.
application list: A data structure, kept in the Desktop file, for launching
applications from their documents in the hierarchical file system. For
Source: Inside MacintoshX-Ref© 1988 Apple Computer, Inc. Reprinted with permission of
Addison-Wesley Publishing Company.
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each application in the list, an entry is maintained that includes the
name and signature of the application, as well as the directory ID of the
folder containing it.
application window: A window created as the result of something done
by the application, either directly or indirectly (as through the Dialog
Manager).
asynchronous execution: After calling a routine asynchronously, an
application is free to perform other tasks until the routine is completed.
auto-key event: An event generated repeatedly when the user presses
and holds down a character key on the keyboard or keypad.
auto-key rate: The rate at which a character key repeats after it's begun
to do so.
auto-key threshold: The length of time a character key must be held
down before it begins to repeat.
background activity: A program or process that runs while the user is
engaged with another application.
bit image: A collection of bits in memory that have a rectilinear representation. The screen is a visible bit image.
bit map: A set of bits that represent the position and state of a corresponding set of items; in QuickDraw, a pointer to a bit image, the row width
of that image, and its boundary rectangle.
boundary rectangle: A rectangle, defined as part of a QuickDraw bit
map, that encloses the active area of the bit image and imposes a
coordinate system on it. Its top left corner is always aligned around the
first bit in the bit image.
bundle: A resource that maps local IDs of resources to their actual
resource IDs; used to provide mappings for file references and icon lists
needed by the Finder.
button: A standard Macintosh control that causes some immediate or
continuous action when clicked or pressed with the mouse. See also
radio button.
catalog tree file: A file that maintains the relationships between the files
and directories on a hierarchical directory volume. It corresponds to
the file directory on a flat directory volume.
cdev: A resource file containing device information, used by the Control
Panel.
channel: A queue that's used by an application to send commands to the
Sound Manager.
character code: An integer representing the character that a key or
combination of keys on the keyboard or keypad stands for.
character key: A key that generates a keyboard event when pressed; any
key except Shift, Caps Lock, Command, or Option.
character style: A set of stylistic variations, such as bold, italic, and
underline. The empty set indicates plain text (no stylistic variations).
character width: The distance to move the pen from one character's
origin to the next character's origin.
check box: A standard Macintosh control that displays a setting, either
checked (on) or unchecked (oft). Clicking inside a check box reverses its
setting.
Chooser: A desk accessory that provides a standard interface for device
drivers to solicit and accept specific choices from the user.
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clipping: Limiting drawing to within the bounds of a particular area.
clipping region: Same as clipRgn.
cl i pRgn:Theregion towhichanapplicationlimitsdrawingina g ra f Po rt.
closed file: A file without an access path. Closed files cannot be read from
or written to.
compaction: The process of moving allocated blocks within a heap zone in
order to collect the free space into a single block.
content region: The area of a window that the application draws in.
control: An object in a window on the Macintosh screen with which the
user, moving the mouse, can cause instant action with visible results
or change settings to modify a future action.
Control Manager: The part of the Toolbox that provides routines for
creating and manipulating controls (such as buttons, check boxes, and
scroll bars).
control definition function: A function called by the Control Manager
when it needs to perform type-depend~nt operations on a particular
type of control, such as drawing the control.
control definition ID: A number passed to control-creation routines to
indicate the type of control. It consists of the control definition function's resource ID and a variation code.
control list: A list of all the controls associated with a given window.
control record: The internal representation of a control, where the
Control Manager stores all the information it needs for its operations
on that control.
control template: A resource that contains information from which the
Control Manager can create a control.
coordinate plane: A two-dimensional grid. In QuickDraw, the grid
coordinates are integers ranging from -32,767 to 32,767, and all grid
lines are infinitely thin.
current resource file: The last resource file opened, unless you specify
otherwise with a Resource Manager routine.
cursor: A 16-by-16 bit image that appears on the screen and is controlled
by the mouse; called the "pointer" in Macintosh user manuals.
cursor level: A value, initialized by InitCursor, that keeps track of the
number of times the cursor has been hidden.
data fork: The part of a file that contains data accessed via· the File
Manager.
data mark: In a sector, information that primarily contains data from an
application.
date/time record: An alternate representation of the date and time
(which is stored on the clock chip in seconds since midnight, January
1, 1904).
default button: In an alert box or modal dialog, the button whose effect
will occur if the user presses Return or Enter. In an alert box, it's boldly
outlined; in a modal dialog, it's boldly outlined or the OK button.
default directory: A directory that will be used in File Manager routines
whenever no other directory is specified. It may be the root directory,
in which case the default directory is equivalent to the default volume.
default volume: A volume that will receive I/O during a File Manager
routine call, whenever no other volume is specified.
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dereference: To refer to a block by its master pointer instead ofits handle.
Desk Manager: The part of the Toolbox that supports the use of desk
accessories from an application.
desk accessory: A "mini-application," implemented as a device driver,
that can be run at the same time as a Macintosh application.
desk scrap: The place where data is stored when it's cut (or copied) and
pasted among applications and desk accessories.
desktop: The screen as a surface for doing work on the Macintosh.
Desktop file: A resource file in which the Finder stores the version data,
bundle, icons, and file references for each application on the volume.
device driver event: An event generated by one of the Macintosh's device
drivers.
device driver: A program that controls the exchange of information
between an application and a device.
dial: A control with a moving indicator that displays a quantitative setting
or value. Depending on the type of dial, the user may be able to change
the setting by dragging the indicator with the mouse.
dialog: Same as dialog box.
dialog box: A box that a Macintosh application displays to request
information it needs to complete a command, or to report that it's
waiting for a process to complete.
Dialog Manager: The part of the Toolbox that provides routines for
implementing dialogs and alerts.
dialog record: The internal representation of a dialog, where the Dialog
Manager stores all the information it needs for its operations on that
dialog.
dialog template: A resource that contains information from which the
Dialog Manager can create a dialog.
dialog window: The window in which a dialog box is displayed.
dimmed: Drawn in gray rather than black.
directory ID: A unique number assigned to a directory, which the File
Manager uses to distinguish it from other directories on the volume.
(It's functionally equivalent to the file number assigned to a file; in fact,
both directory IDs and file numbers are assigned from the same set of
numbers.)
directory: A subdivision of a volume that can contain files as well as other
directories; equivalent to a folder.
disabled: A disabled menu item or menu is one that cannot be chosen; the
menu item or menu title appears dimmed. A disabled item in a dialog
or alert box has no effect when clicked.
Disk Initialization Package: A Macintosh package for initializing and
naming new disks; called by the Standard File Package.
disk-inserted event: An event generated when the user inserts a disk in
a disk drive or takes any other action that requires a volume to be
mounted.
display rectangle: A rectangle that determines where an item is displayed within a dialog or alert box.
document window: The standard Macintosh window for presenting a
document.
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double-click time: The greatest interval between a mouse-up and mousedown event that would qualify two mouse clicks as a double-click.
draft printing: Printing a document immediately as it's drawn in the
printing grafPort.
drag delay: A length of time that allows a user to drag diagonally across
a main menu, moving from a submenu title into the submenu itself
without the submenu disappearing.
drag region: A region in a window frame. Dragging inside this region
moves the window to a new location and makes it the active window
unless the Command key was down.
drive number: A number used to identify a disk drive. The internal drive
is number 1, the external drive is number 2, and any additional drives
will have larger numbers.
empty handle: A handle that points to a NIL master pointer, signifying
that the underlying relocatable block has been purged.
end-of-file: See logical end-of-file or physical end-of-file.
event: A notification to an application of some occurrence that the application may want to respond to.
event code: An integer representing a particular type of event.
Event Manager: See Toolbox Event Manager.
event mask: A parameter passed to an Event Manager routine to specify
which types of events the routine should apply to.
event message: A field of an event record containing information specific
to the particular type of event.
event queue: The Operating System Event Manager's list of pending
events.
event record: The internal representation of an event, through which
your program learns all pertinent information about that event.
exception: An error or abnormal condition detected by the processor in the
course of program execution; includes interrupts and traps.
external reference: A reference to a routine or variable defined in a
separate compilation or assembly.
file: A named, ordered sequence of bytes; a principal means by which data
is stored and transmitted on the Macintosh.
file catalog: A hierarchical file directory.
file control block: A fixed-length data structure, contained in the filecontrol-block buffer, where information about an access path is stored.
file directory: The part of a volume that contains descriptions and
locations of all the files and directories on the volume. There are two
types of file directories: hierarchical file directories and flat file directories.
File Manager: The part of the Operating System that supports file 1/0.
file name: A sequence of up to 255 printing characters, excluding colons(:),
that identifies a file.
file number: A unique number assigned to a file, which the File Manager
uses to distinguish it from other files on the volume. A file number
specifies the file's entry in a file directory.
file reference: A resource that provides the Finder with file and icon
information about an application.
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file type: A four-character sequence, specified when a file is created, that
identifies the type of file.
Finder information: Information that the Finder provides to an application upon starting it up, telling it which documents to open or print.
font: A complete set of characters of one typeface, which may be restricted
to a particular size and style, or may comprise multiple sizes, or
multiple sizes and styles, as in the context of menus.
Font Manager: The part of the Toolbox that supports the use of various
character fonts for QuickDraw when it draws text.
font number: The number by which you identify a font to QuickDraw or
the Font Manager.
font size: The size of a font in points; equivalent to the distance between
the ascent line of one line of text and the ascent line of the next line of
single-spaced text.
fork: One of the two parts of a file; see data fork and resource fork.
free block: A memory block containing space available for allocation.
full pathname: A pathname beginning from the root directory.
global coordinate system: The coordinate system based on the top left
corner of the bit image being at (0,0).
go-away region: A region in a window frame. Clicking inside this region
of the active window makes the window close or disappear.
graf Port: A complete drawing environment, including such elements as
a bit map, a subset of it in which to draw, a character font, patterns for
drawing and erasing, and other pen characteristics.
graphics device: A video card, a printer, a display device, or an offscreen
pixel map. Any of these device types may be used with Color QuickDraw.
Gray Rgn: The global variable that in the multiple screen desktop describes
and defines the desktop, the area on which windows can be dragged.
grow image: The image pulled around when the user drags inside the grow
region; whatever is appropriate to show that the window's size will
change.
grow region: A window region, usually within the content region, where
dragging changes the size of an active window.
handle: A pointer to a master pointer, which designates a relocatable block
in the heap by double indirection.
heap: The area of memory in which space is dynamically allocated and
released on demand, using the Memory Manager.
hierarchical menu: A menu that includes, among its various menu
choices, the ability to display a submenu. In most cases the submenu
appears to the right of the menu item used to select it, and is marked
with a filled triangle indicator.
highlight: To display an object on the screen in a distinctive visual way,
such as inventing it.
hotSpot: The point in a cursor that's aligned with the mouse location.
icon: A 32-by-32 bit image that graphically represents an object, concept,
or message.
icon list: A resource consisting of a list of icons.
icon number: A digit from 1 to 255 to which the Menu Manager adds 256
to get the resource ID of an icon associated with a menu item.
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inactive control: A control that won't respond to the user's actions with
the mouse. An inactive control is highlighted in some special way, such
as dimmed.
inactive window: Any window that isn't the frontmost window on the
desktop.
indicator: The moving part of a dial that displays its current setting.
interface routine: A routine called from Pascal whose purpose is to trap
to a certain Toolbox or Operating System routine.
International Utilities Package: A Macintosh package that gives you
access to country-dependent information such as the formats for
numbers, currency, dates, and times.
invert: To highlight by changing white pixels to black and vice versa.
invisible control: A control that's not drawn in its window.
invisible window: A window that's not drawn in its plane on the desktop.
item: In dialog and alert boxes, a control, icon, picture, or piece of text, each
displayed inside its own display rectangle. See also menu item.
item list: A list of information about all the items in a dialog or alert box.
item number: The index, starting from 1, of an item in an item list.
IWM: "Integrated Woz Machine"; the custom chip that controls the 3 1/2inch disk drives.
job dialog: A dialog that sets information about one printing job; associated with the Print command.
jump table: A table that contains one entry for every routine in an
application and is the means by which the loading and unloading of
segments is implemented.
key code: An integer representing a key on the keyboard or keypad,
without reference to the character that the key stands for.
key-down event: An event generated when the user presses a character
key on the keyboard or keypad.
key-up event: An event generated when the user releases a character key
on the keyboard or keypad.
keyboard equivalent: The combination of the Command key and another
key, used to invoke a menu item from the keyboard.
keyboard event: An event generated when the user presses, releases, or
holds down a character key on the keyboard or keypad; any key-down,
key-up, or auto-key event.
List Manager: The part ofthe Operating System that provides routines for
creating, displaying, and manipulating lists.
local coordinate system: The coordinate system local to a graf Port,
imposed by the boundary rectangle defined in its bit map.
local I D: A number that refers to an icon list or file reference in an
application's resource file and is mapped to an actual resource I 0 by a
bundle.
localization: The process of adapting an application to different languages, including converting its user interface to a different script.
lock: To temporarily prevent a relocatable block from being moved during
heap operation.
lock bit: A bit in the master pointer to a relocatable block that indicates
whether the block is currently locked.
locked file: A file whose data cannot be changed.
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locked volume: A volume whose data cannot be changed. Volumes can be
locked by either a software flag or a mechanical setting.
logical end-of-file: The position of one byte past the last byte in a file;
equal to the actual number of bytes in the file.
main event loop: In a standard Macintosh application program, a loop
that repeatedly calls the Toolbox Event Manager to get events and then
responds to them as appropriate.
main screen: On a system with multiple display devices, the screen with
the menu bar is called the main screen.
main segment: The segment containing the main program.
master pointer: A single pointer to a relocatable block, maintained by the
Memory Manager and updated whenever the block is moved, purged,
or reallocated. All handles to a relocatable block refer to it by double
indirection through the master pointer.
Memory Manager: The part of the Operating System that dynamically
allocates and releases memory space in the heap.
menu: A list of menu items that appears when the user points to a menu
title in the menu bar and presses the mouse button. Dragging through
the menu and releasing over an enabled menu item chooses that item.
menu bar: The horizontal strip at the top of the Macintosh screen that
contains the menu titles of all menus in the menu list.
menu definition procedure: A procedure called by the Menu Manager
when it needs to perform type-dependent operations on a particular
type of menu, such as drawing the menu.
menu ID: A number in the menu record that identifies the menu.
menu item: A choice in a menu, usually a command to a current application.
menu list: A list containing menu handles for all menus in the menu bar,
along with information on the position of each menu.
Menu Manager: The part of the Toolbox that deal with setting up menus
and letting the user choose from them.
menu title: A word or phrase in the menu bar that designates one menu.
modal dialog: A dialog that requires the user to respond before doing any
other work on the desktop.
modeless dialog: A dialog that allows the user to work elsewhere on the
desktop before responding.
mounted volume: A volume that previously was inserted into a disk drive
and had descriptive information read from it by the File Manager.
mouse-down event: An event generated when the user presses the mouse
button.
mouse-up event: An event generated when the user releases the mouse
button.
network event: An event generated by the AppleTalk Manager.
null event: An event reported when there are no other events to report.
offspring: For a given directory, the set of files and directories for which
it is the parent.
on-line volume: A mounted volume with its volume buffer and descriptive
information contained in memory.
open file: A file with an access path. Open files can be read from and
written to.
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open permission: Information about a file that indicates whether the file
can be read from, written to, or both.
Operating System: The lowest-level software in the Macintosh. It does
basic tasks such as 1/0, memory management, and interrupt handling.
Operating System Utilities: Operating System routines that perform
miscellaneous tasks such as getting the date and time, finding out the
user's preferred speaker volume and other preferences, and doing
simple string comparison.
page rectangle: The rectangle marking the boundaries of a printed page
image. The boundary rectangle, portRect, and clipRgn of the printing
grafPort are set to this rectangle.
panel: An area of a window that shows a different interpretation of the
same part of a document.
part code: An integer between 1 and 253 that stands for a particular part
of a control (possibly the entire control).
partial pathname: A pathname beginning from any directory other than
the root directory.
path reference number: A number that uniquely identifies an individual
access path; assigned when the access path is created.
pathname: A series of concatenated directory and file names that identifies a given file or directory. See also partial pathname and full
pathname.
pattern: An 8-by-8 bit image, used to define a repeating design (such as
stripes) or tone (such as gray).
physical end-of-file: The position ofone byte past the last allocation block
of a file; equal to 1 more than the maximum number ofbytes the file can
contain.
picture: A saved sequence of QuickDraw drawing commands (and, optionally, picture comments) that you can play back later with a single
procedure call; also, the image resulting from these commands.
pixel: A dot on a display screen. Pixel is short for picture element.
plane: The front-to-back position of a window on the desktop.
point: The intersection of a horizontal grid line and a vertical grid line on
the coordinate plane, defined by a horizontal and a vertical coordinate;
also, a typographical term meaning approximately 1172 inch.
polygon: A sequence of connected lines, defined by QuickDraw linedrawing commands.
pop-up menu: A menu not located in the menu bar, which appears when
the user presses the mouse button in a particular place.
port: See grafPort.
portBits: The bit map of a grafPort.
portRect: A rectangle, defined as part of a grafPort, that encloses a subset
of the bit map for use by the grafPort.
post: To place an event in the event queue for later processing.
print record: A record containing all the information needed by the
Printing Manager to perform a particular printing job.
Printer Driver: The device driver for the currently installed printer.
printer resource file: A file containing all the resources needed to run the
Printing Manager with a particular printer.
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Printing Manager: The routines and data types that enable applications
to communicate with the Printer Driver to print on any variety of
printer via the same interface.
printing grafPort: A special grafPort customized for printing instead of
drawing on the screen.
purgeable block: A relocatable block that can be purged from the heap.
queue: A list of identically structured entries linked together by pointers.
QuickDraw: The part of the Toolbox that performs all graphic operations
on the Macintosh screen.
radio button: A standard Macintosh control that displays a setting, either
on or off, and is part of a group in which only one button can be on at
a time.
RAM: The Macintosh's random access memory, which contains exception
vectors, buffers used by hardware devices, the system and application
heaps, the stack, and other information used by applications.
reallocate: To allocate new space in the heap for a purged block, updating
its master pointer to point to its new location.
reference number: A number greater than 0, returned by the Resource
Manager when a resource file is opened, by which you can refer to that
file. In Resource Manager routines that expect a reference number, 0
represents the system resource file.
region: An arbitrary area or set of areas on the QuickDraw coordinate
plane. The outline of a region should be one or more closed loops.
release. To free an allocated area of memory, making it available for reuse.
relocatable block: A block that can be moved within the heap during
compaction.
resource: Data or code stored in a resource file and managed by the
Resource Manager.
resource attribute: One of several characteristics, specified by bits in a
resource reference, that determine how the resource should be dealt
with.
resource data: In a resource file, the data that comprises a resource.
resource file: The resource fork of a file.
resource fork: The part of a file that contains data used by an application
(such as menus, fonts, and icons). The resource fork of an application
file also contains the application code itself.
resource header: At the beginning of a resource file, data that gives the
offsets to and lengths of the resource data and resource map.
resource ID: A number that, together with the resource type, identifies a
resource in a resource file. Every resource has an ID number.
Resource Manager: The part of the Toolbox that reads and writes
resources.
resource name: A string that, together with the resource type, identifies
a resource in a resource file. A resource may or may not have a name.
resource specification: A resource type and either a resource ID or a
resource name.
resource type: The type of a resource in a resource file, designated by a
sequence of four characters (such as 'MENU' for a menu).
result code: An integer indicating whether a routine completed its task
successfully or was prevented by some error condition (or other special
condition, such as reaching the end of a file).
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resume procedure: A procedure within an application that allows the
application to recover from system errors.
ROM: The Macintosh's permanent Read-Only Memory, which contains the
routines for the Toolbox and Operating System, and the various system
traps.
root directory: The directory at the base of a file catalog.
row width: The number of bytes in each row of a bit image.
Scrap Manager: The part of the Toolbox that enables cutting and pasting
between applications, desk accessories, or an application and a desk
accessory.
scrap: A place where cut or copied data is stored.
scrap file: The file containing the desk scrap (usually named "Clipboard
File").
SCSI: See Small Computer Standard Interface.
SCSI Manager: The part of the Operating System that controls the
exchange of information between a Macintosh and peripheral devices
connected through the Small Computer Standard Interface (SCSI).
segment: One of several parts into which the code of an application may
be divided. Not all segments need to be in memory at the same time.
selection range: The series of characters (inversely highlighted), or the
character position (marked with a blinking caret), at which the next
editing operation will occur.
signature: A four-character sequence that uniquely identifies an application to the Finder.
Small Computer Standard Interface (SCSI): A specification of mechanical, electrical, and functional standards for connecting small
computers with intelligent peripherals such as hard disks, printers,
and optical disks.
solid shape: A shape that's filled in with any pattern.
Sound Driver: The device driver that controls sound generation in an
application.
sound procedure: A procedure associated with an alert that will emit one
of up to four sounds from the Macintosh's speaker. Its integer parameter ranges from 0 to 3 and specifies which sound.
source transfer mode: One of eight transfer modes for drawing text or
transferring any bit image between two bit maps.
stack: The area ofmemory in which space is allocated and released in LIFO
(last-in-first-out) order.
Standard File Package: A Macintosh package for presenting the standard user interface when a file is to be saved or opened.
startup screen: When the system is started up, one of the display devices
is selected as the startup screen, the screen on which the "happy
Macintosh" icon appears.
structure region: An entire window; its complete "structure."
style: See character style.
style dialog: A dialog that sets options affecting the page dimensions;
associated with the Page Setup command.
subdirectory: Any directory other than the root directory.
submenu delay: The length of time before a submenu appears as a user
drags through a hierarchical main menu; it prevents rapid flashing of
submenus.
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System Error Handler: The part of the Operating System that assumes
control when a fatal system error occurs.
system error alert: An alert box displayed by the System Error Handler.
system error ID: An ID number that appears in a system error alert to
identify the error.
system event mask: A global event mask that controls which types of
events get posted into the event queue.
system font: The font that the system uses (in menus, for example). Its
name is Chicago.
system font size: The size of text drawn by the system in the system font;
12 points.
system heap: The portion of the heap reserved for use by the Operating
System.
system resource: A resource in the system resource file.
system resource file: A resource file containing standard resources,
accessed if a requested resource wasn't found in any of the other
resource files that were searched.
system window: A window in which a desk accessory is displayed.
target device: An SCSI device (typically an intelligent peripheral) that
receives a request from an initiator device to perform a certain operation.
thumb: The Control Manager's term for the scroll box (the indicator of a
scroll bar).
tick: A sixtieth of a second.
Toolbox: Same as User Interface Toolbox.
Toolbox Event Manager: The part of the Toolbox that allows your
application program to monitor the user's actions with the mouse,
keyboard, and keypad.
Toolbox Utilities: The part of the Toolbox that performs generally useful
operations such as fixed-point arithmetic, string manipulation, and
logical operations on bits.
transfer mode: A specification of which Boolean operation QuickDraw
should perform when drawing or when transferring a bit image from
one bit map to another.
trap dispatcher: The part of the Operating System that examines a trap
word to determine what operation it stands for, looks up the address of
the corresponding routine in the trap dispatch table, and jumps to the
routine.
trap word: An unimplemented instruction representing a call to a Toolbox
or Operating System routine.
type coercion: Many compilers feature type coercion (also known as
typecasting), which allows a data structure of one type to be converted
to another type. In many cases, this conversion is simply a relaxation
of type-checking in the compiler, allowing the substitution of a differently typed but equivalent data structure.
unlock: To allow a relocatable block to be moved during heap compaction.
unmounted volume: A volume that hasn't been inserted into a disk drive
and had descriptive information read from it, or a volume that previously was mounted and has since had the memory used by it released.
unpurgeable block: A relocatable block that can't be purged from the
heap.

Appendix A: Glossary

417

update event: An event generated by the Window Manager when a
window's contents need to be redrawn.
update region: A window region consisting of all areas of the content
region that have to be redrawn.
User Interface Toolbox: The software in the Macintosh ROM that helps
you implement the standard Macintosh user interface in your application.
version data: In an application's resource file, a resource that has the
application's signature as its resource type; typically a string that gives
the name, version number, and date of the application.
vertical blanking interval: The time between the display ofthe last pixel
on the bottom line of the screen and the first one on the top line.
virtual key codes: The key codes that appear in keyboard events.
visible control: A control that's drawn in its window (but may be
completely overlapped by another window or other object on the
screen).
visible window: A window that's drawn in its plane on the desktop (but
may be completely overlapped by another window or object on the
screen).
visRgn: The region of the grafPort, manipulated by the Window Manager,
that's actually visible on the screen.
volume: A piece of storage medium formatted to contain files; usually a
disk or part of a disk. A 3.5-inch Macintosh disk is one volume.
volume attributes: Information contained on volumes and in memory
indicating whether the volume is locked, whether it's busy (in memory
only), and whether the volume control block matches the volume
information (in memory only).
volume name: A sequence of up to 27 printing characters that identifies
a volume; followed by a colon (:) in File Manager routine calls, to
distinguish it from a file name.
window: An object on the desktop that presents information, such as a
document or a message.
window class: In a window record, an indication of whether a window is
a system window, a dialog or alert window, or a window created directly
by the application.
window definition function: A function called by the Window Manager
when it needs to perform certain type-dependent operations on a
particular type of window, such as drawing the window frame.
window definition ID: A number passed to window-creation routines to
indicate the type of window. It consists of the window definition
function's resource ID and a variation code.
window frame: The structure region ofa window minus its content region.
window list: A list of all windows ordered by their front-to-back positions
on the desktop.
Window Manager: The part of the Toolbox that provides routines for
creating and manipulating windows.
Window Manager port: A grafPort that has the entire screen as its
portRect and is used by the Window Manager to draw window frames.
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window record: The internal representation of a window, where the
Window Manager stores all the information it needs for its operations
on that window.
window template: A resource from which the Window Manager can
create a window.
word wraparound: Keeping words from being split between lines when
text is drawn.
working directory: An alternative way ofreferring to a directory. When
opened as a working directory, a directory is given a working directory
reference number that's used to refer to it in File Manager calls.
working directory control block: A data structure that contains the
directory ID of a working directory, as well as the volume reference
number of the volume on which the directory is located.
working directory reference number: A temporary reference number
used to identify a working directory. It can be used in place of the
volume reference number in all File Manager calls; the File Manager
uses it to get the directory ID and volume reference number from the
working directory control block.
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Code Listings
The following pages contain complete
listings of all the source code presented
in Chapters 1-9. The listings are presented in order by Chapter. Each listing
contains comments detailing the new
features found in that program. Remember, you can send in the coupon in the
back of the book for a disk containing
the complete set of Macintosh
Primer applications.

Chapter 2, Hello.c
#include <stdio.h>
main ( )
I

printf ("Hello, World");

/*

The Unix way ...

*/

Chapter 3, Hello2.c
#define
#define
#define
#define

BASE_RES_IO
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

400
OL
-lL
0

#define HORIZONTAL_PIXEL
#define VERTICAL_PIXEL
WindowPtr

30
50

gPictureWindow:

/*

We'll draw in this window

*/

/*********************** Main *************/
main ( )
I

ToolBoxlnit(): /*
Windowlnit(); /*

Standard Toolbox initialization
Setup the window */

while ( !Button() ) : /*

~Jait

*/

for a press of the mouse */
button ...

I*

/*********************************** ToolBoxlnit */
Tool Box I nit()
I

InitGraf( &thePort ):
I nit Fonts():
FlushEvents( everyEvent. REMOVE_ALL_EVENTS ):
InitWindows():
InitMenus():
TEinit():
InitDialogs( NIL_POINTER );
InitCursor():

/*********************Windowlnit**************/
Windowlnit()
I

420

gPictureWindow = GetNewWindow( BASE_RES_ID , NIL_POINTER.
MOVE_TO_FRONT );
/* Load the WIND resource */

*I
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ShowWindow( gPictureWindow ); /* Make the WIND
visible */
SetPort( gPictureWindow );
/* We'll start drawing in
gPictureWindow */
MoveTo( HORIZONTAL_PIXEL, VERTICAL_PIXEL );
DrawString{"\pHello, World");

Chapter 3, Mondrian.c
#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

ndowPtr
long

~Ji

400
OL
-lL
0

gDrawWindow;
gFillColor = blackColor:

/******************************** main *********/

main ( )
I

ToolBoxinit();
Windowlnit():
Mainloop();

/*********************************** ToolBoxlnit */

ToolBoxinit()
I

InitGraf{ &thePort ) ;
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows():
InitMenusC):
TEI nit();
InitDialogs( NIL_POINTER );
InitCursor():

/******************************** Windowlnit *********/

Windowlnit()
I

gDrawWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT ) ;
ShowWindow( gDrawWindow ):
SetPort( gDrawWindow );
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/******************************** Mainloop *********/
Mainloop()
I

GetDateTime( &randSeed );
while ( ! Button() )
I

/*Use the current time as a
seed for the random number generator

DrawRandomRect():
/*
if ( gFillColor == blackColor )
gFillColor
whiteColor:
else
gFillColor = blackColor;

Draw a random shape */
/* Alternate drawing */
/* between black and */
/*white ...

*/

*I

/******************************** DrawRandomRect *********/
DrawRandomRect()
(

Rect

myRect:

RandomRect( &myRect, gDrawWindow ); /*Generate a random rectangle
that fits within the bounds of gDrawWindow *I
ForeColor( gFillColor );
Pai ntOva 1( &my Re ct ) : /* Paint an oval filled with gFillColor,
the size of myRect. We could call
other shape drawing routines (like
PainRect()) instead of PaintOvalC) ...

*I

/******************************** RandomRect *********/
RandomRect( myRectPtr, boundingWindow
Rect
*myRectPtr:
l~i ndowPt r
boundingWindow:
I

I*
*
*I

A window's portRect is a Rect the size of the window ...
myRectPtr->left = Randomize( boundingWindow->portRect.right
- bound i ngWi ndow- >po rt Rect. 1eft ) :
myRectPtr->right = Randomize( boundingWindow->portRect.right
- boundi ngWi ndow- >portRect. left ) :
myRectPtr->top = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top );
myRectPtr->bottom = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top );

/******************************** Randomize *********/
Randomize ( range )
int
range:
I

long
rawResult:
rawResul t = Random(); /*

Random() returns a random number
between -32767 and 32767 */
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rawResult < 0 ) rawResult *= -1: /* We could call abs(),
but abs() is not part of the Toolbox. If
you need it, make sure to add the math
1i bra ry to your project. Otherwise. your
project won't link ... */
return( CrawResult * range) I 32768 ); /* We'll return a number
between 0 and range-1
*/

if

<

Chapter 3, ShowPict.c
#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

PicHandle
WindowPtr

400
OL
-ll

0

gThePicture;
gPictureWindow:

/******************************** main *********/

main ( )
I

ToolBoxlnit();
Windowlnit();
LoadPi cture();
DrawMyPicture( gThePicture, gPictureWindow );
while ( !Button() ) ;

/*********************************** ToolBoxlnit */

ToolBoxlnit()
I

InitGraf ( &the Port ) :
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor();

/******************************** Windowlnit *********/

Windowinit()
I

gPictureWindow = GetNewWindow( BASE_RES_IO, NIL_POINTER,
MOVE_ TO_FRONT ) :
ShowWindow( gPictureWindow >:
SetPort( gPictureWindow );
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!******************************** LoadPicture *********/
LoadPicture()
I

gThePicture = GetPicture( BASE_RES_ID ):

/******************************** DrawMyPicture *********/
DrawMyPicture( thePicture, pictureWindow
PicHandle
thePicture:
WindowPtr
pictureWindow;
I

Rect

myRect:

myRect = pictureWindow->portRect:
CenterPict< thePicture. &myRect >: /* Pass the window's portRect
to CenterPict() via myRect, as well as a handle
to the picture to be centered. CenterPict()
will modify myRect to be a Rect the size of the
Picture, centered in the window. */
DrawPicture( thePicture, &myRect >:

/******************************** CenterPict *********/
CenterPict( thePicture, myRectPtr
thePicture:
PicHandle
Rect
*myRectPtr:
I

Rect

wi ndRect. pi ctureRect:

windRect = *myRectPtr:
pictureRect = (**( thePicture )).picFrame: /* Two interesting
facts:
1) picFrame is a field in the picture
data structure. It is a Rect, the
size of the picture, with the same
coordinates as the picture had when
it was created.
2) ANSI C allows the direct assignment of
one data structure to another of the
same type. This allows us to copy
one Rect to another with one
statement. Some compi 1ers may not
support this feature. It sure makes
life easier! */
myRectPtr->top = (windRect.bottom - windRect.top CpictureRect.bottom - pictureRect.top))/ 2 +
windRect.top;
myRectPtr->bottom = myRectPtr->top +
CpictureRect.bottom - pictureRect.top):
myRectPtr->left = (windRect.right - windRect.left (pictureRect.right - pictureRect.left))/ 2 +
windRect.left:
myRectPtr->right = myRectPtr->left + CpictureRect.right pictureRect.left);
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Chapter 3, Flying Line.c
I*

*
*
*

Try using different values for NUM_LINES. gDeltaTop, gDeltaBottom.
gDeltaLeft, and gDeltaRight. This will alter the shape and
behavior of the Flying Line.

*/

#define
#define
#define
#define
#define
#define
//define
#define
#define

NUM_LINES
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS
NIL_STRING
NIL_TITLE
VI SIBLE
NO_GO_AWAY
NIL_REF_CON

WindowPtr
Re ct
int
int
int

50
OL

/*

Try 100 or 150

-ll
0
"\p"

NIL_STRING
TRUE
FALSE
NIL_POINTER

gLineWindow;
glines[ NUM_LINES ]:
gDeltaTop=3. gDeltaBottom=3: /* These four are the */
gDeltaleft=2. gDeltaRight=6: /* key to flying line! */
gOldMBarHeight;

/******************************** main *********/

main ( )
I

ToolBoxlnit();
Wi ndowlnit():
Lineslnit();
MainLoop();

/*********************************** ToolBoxlnit */

Tool Boxlnit()
I

InitGraf( &thePort );
I nit Fonts():
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindowsC>:
InitMenus<>:
TEinit();
InitDialogs( NIL_POINTER );
InitCursor():

/******************************** Windowlnit *********/

Wi ndowlnit()
I

*/

Re ct
RgnHandle

totalRect, mBarRect:
mBarRgn:
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gOldMBarHeight = MBarHeight:
MBarHeight = O;
glineWindow = NewWindow< NIL_POINTER. &CscreenBits.bounds),
NIL_TITLE, VISIBLE, plainDBox. MOVE_TO_FRONT, NO_GO_AWAY,
NI L_REF _CON ) :
I*

*
*
*
*

We use NewWindowC) instead of GetNewWindow() because we want a
window the size of the screen. NewWindow() allows you to specify
the size of your window. With GetNewWindow(), the window size is
pulled from the WIND resource.

*I

SetRect( &mBa rRect. screenBi ts. bounds.left. screenBi ts. bounds. top,
screenBits.bounds.right, screenBits.bounds.top+gOldMBarHeight ):
I*

*
*
*

*I

The following 4 lines of code are for demonstration purposes only.
The thought police have prohibited the modification of a window's
visRgn under MultiFinder. Reuse this code at your own risk!!!
mBarRgn = NewRgn():
RectRgn( mBarRgn, &mBarRect );
UnionRgn( gLineWindow->visRgn, mBarRgn, gLineWindow->visRgn >:
DisposeRgn( mBarRgn );
SetPort( gLineWindow >:
FillRect< &CgLineWindow->portRect), black >: /* Change black to
ltGray. *I
PenMode( patXor ):
/*
<-and comment out this line */

/******************************** Lineslnit *********/
Lineslnit()
I

int i:
HideCursor():
GetDateTimeC &randSeed ); /*Reseed the random number generator*/
RandomRect( &Cglines[ 0 ]), gLineWindow >:
Drawline( 0 ): /*Generate and draw the first line*/
for ( i=l; i<NUM_LINES: i++ )
I

glines[ i J = glines[ i-1 ]; /* Copy the previous line, */
/* modify it, */
Recalcline( i >:
Drawl i ne( i ) : I* and draw the new line *I

/******************************** Mainloop *********/
Mainloop()
I

int i:
while
I

! Button () )
Drawline( NUM_LINES - 1 );

/* Erase the last line (because
we used patXor mode) */
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for ( i=NUM_LINES-1; i>O; i-)
glines[ i J = glines[ i-1 J: /*Bump each line one*/
Recalcline( 0 );
/* Modify the first line and */
Drawline( 0 ); /* redraw it */
I

MBarHeight = gOldMBarHeight;

I*

Once the button is clicked,
we better reset the menubar
height, else we won't be able
to click in it */

/******************************** RandomRect *********/
RandomRect( myRectPtr, boundingWindow
Re ct
*myRectPt r:
WindowPtr
boundingWindow:
{

myRectPtr->left = Randomize( boundingWindow->portRect.right
- bound i ngWi ndow- >po rt Re ct.left ) :
myRectPtr->right = Randomize( boundingWindow->portRect.right
- boundingWindow->portRect.left );
myRectPtr->top = Randomize( boundingWindow->portRect.bottom
- boundingWindow->portRect.top );
myRectPtr->bottom = Randomize( bound i ngWi ndow- >portRect. bottom
- boundingWindow->portRect.top );

/******************************** Randomize *********/
Randomize( range )
int
range:
{

1 ong

rawResul t;

rawResult =Random();
if ( rawResult < 0 ) rawResult *= -1:
return( (rawResult * range) I 32768 ):

/******************************** Recalcline *********/
Recalcline( i )
int i:
{

g Li nes [ i ] . top += gDelta Top ;
if ( ( glines[ i ].top< gLineWindow->portRect.top) II
( glines[ i ].top > gLineWindow->portRect.bottom ) )
gDe ltaTop *= -1;
g Li nes [ i ] . top += 2*gDel ta Top :
gLines[ i ].bottom += gDeltaBottom:
if ( ( glines[ i ].bottom < gLineWindow->portRect.top ) I I
( glines[ i ].bottom > glineWindow->portRect.bottom ) )
gOeltaBottom *= -1:
glines[ i ].bottom+= 2*gDeltaBottom:
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gLines [ i ] . 1eft += gDe 1ta Left;
if<< gLines[ i ].left< gLineWindow->portRect.left) II
( glines[ i ].left> gLineWindow->portRect.right
gDeltaleft *= -1:
glines[ i ].left+= 2*gDeltaLeft:
gLines[ i ].right += gDeltaRight:
if ( < glines[ i ].right< gLineWindow->portRect.left ) I I
C gLines[ i ].right > gLineWindow->portRect.right
gDeltaRight *= -1:
gLines[ i ].right += 2*gDeltaRight:

!******************************** DrawLine *********/
DrawLineC i )
int
i:
I

MoveToC gLines[

].left. glines[ i ].top >:/*Move to first

LineToC gLines[

].right, gLines[ i ].bottom ):

Chapter 4, EventTutor.c
/idefi ne
/idef i ne
#define
/idef i ne

BASE_RES_ID
NI L_PO INTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

400

OL
-ll
0

/fdef i ne LEAVE_WHERE_IT_IS
#define NORMAL_UPDATES

FALSE
TRUE

/idef i ne
#define
lfdef i ne
#define
/!define
/fdefi ne
/fdefi ne

OL
OL
Ox60
Ox9F
OxOOOl

SLEEP
NIL_MOUSE_REGION
WNE_TRAP_NUM
UNIMPL_TRAP_NUM
SUSPEND_RESUME_BIT
ACTIVATING
RESUMING

1
1

/idefi ne TEXT_FONT_SIZE

12

#define
/fdef i ne
#define
/fdefi ne

DRAG_THRESHOLD
MIN_WINDOW_HEIGHT
MIN_WINDOW_WIDTH
SCROLL_BAR_PIXELS

30

/idefi ne
#define
lfdef i ne
/idefi ne

ROWHEIGHT
LEFTMARGIN
STARTROW
HORIZONTAL_OFFSET

15
10

50
50

16

0
0

/*

point */
Draw line to
second point */
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PicHandle
WindowPtr
Boolean
EventRecord
int
Re ct

gPictureHandle:
gPi ctWi ndow. gEventWi ndow:
gDone, gWNEimplemented;
gTheEvent:
gCurRow. gMaxRow:
gDragRect. gSizeRect:

/******************************** main *********/
main ( )
I

ToolBoxlnit();
WindowlnitC>:
LoadPictureC>:
SetUpDragRect():
SetUpSizeRect():
Mainloop():

/*********************************** ToolBoxlnit */
Tool Box I nit(>
{

InitGraf ( &the Port ) :
InitFonts<>:
FlushEvents( everyEvent. REMOVE_ALL_EVENTS >:
InitWindows();
I nitMenus ():
TElnit():
lnitDialogs( NIL_POINTER ):
InitCursor():

/******************************** Windowlnit *********/
Wi ndowlnit()
(

I*

*Start by loading the two windows from the resource file ...
*/

gPictWindow = GetNewWindow( BASE_RES_ID. NIL_POINTER,
MOVE_TO_FRONT ) :
gEventWindow = GetNewWindow( BASE_RES_ID+l, NIL_POINTER,
MOVE_TO_FRONT ) :
SetPort( gEventWindow ):
SetupEventWindow():

/*

*

*/

/*

*

Make both windows visible ...
ShowWindow( gEventWindow ):
ShowWindow( gPictWindow ):
Finally, make gEventWindow the active window ...

*/

SelectWindow< gEventWindow ):
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/******************************** SetupEventWindow *********/

SetupEventWindow()
{

Rect

eventRect:

/*

*
Set up gMaxRow: it determines when gEventWindow is scrolled.
* Set up gCurRow: it holds the current vertical pixel value.

*I

I*
*
*

eventRect = gEventWindow->portRect;
gMaxRow
eventRect.bottom - eventRect.top - ROWHEIGHT:
gCurRow
STARTROW:
Set the gEventWindow font to monaco, and the gEventWindow
text size to TEXT_FONT_SIZE ...

*/

TextFontC monaco );
TextSize( TEXT_FONT_SIZE );

/******************************** LoadPicture *********/

LoadPicture()
{

I*

Load the picture <to center in gPictWindow)
gPictureHandle = GetPictureC BASE_RES_ID );

*/

/******************************** SetUpDragRect *********/

SetUpDragRect()
{

I*
*

*
*
*

*

*
*I

We'll use gDragRect to limit the dragging area of a window. This
means that when a user clicks on the title bar of a window and
drags it around the screen, they will be forced to leave
DRAG_THRESHOLD pixels of the window on the screen. This prevents
the user from dragging all but a few pixels of a window off the
screen (which makes that window mighty tough to find later on).
gDragRect = screenBits.bounds:
gDragRect.left += DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD:
gDragRect.bottom -= DRAG_THRESHOLD:

/******************************** SetUpSizeRect *********/

SetUpSizeRect()
(

/*

*

*
*

*
*
*I

We'll use gSizeRect to control the size of a window. This
means that when a user tries to resize a window with a grow box
(like gPictWindow) gSizeRect will determine the minimum height
and width of the window, and the maximum height and width of the
window.
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gSizeRect.top = MIN_WINDOW_HEIGHT;
gSizeRect.left = MIN_WINDOW_WIDTH;
gSizeRect.bottom
gSizeRect.right

=
=

screenBits.bounds.bottom screenBits.bounds.top;
screenBits.bounds.right screenBits.bounds.left;

/******************************** MainLoop *********/
MainLoop()
{

gDone

I*

*

*
*
*I

=

FALSE;

Is WaitNextEvent() implemented? If it is, the address of the
WaitNextEvent() trap will be different than the standard,
"unimplemented" trap ...
gWNEimplemented

=

(

NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) );

I*
* Don't wait for a mouse click.
instead!
*
*I
while ( gDone == FALSE

Retrieve and process events

{

HandleEvent();

/************************************* HandleEvent

*/

HandleEvent()
{

I*
*
*
*I

We'll see this routine in all "proper" Macintosh applications.
First. we' 11 retrieve an event ...
if ( gWNEimplemented )
WaitNextEvent( everyEvent, &gTheEvent, SLEEP.
NIL_MOUSE_REGION );
else
{

SystemTask();
GetNextEvent( everyEvent, &gTheEvent );

I*
*
*I

... then. we' 11 process the event.
switch

gTheEvent.what )

{

case nullEvent:
/*DrawEventSt ring ( "\pnul l Event" ) ; *I
/*
Uncomment the previous line for a burst of
flavor! */
break;
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case mouseDown:
DrawEventString( "\pmouseDown" );
HandleMouseDown():
break;
case mouseUp:
DrawEventString( "\pmouseUp" ):
break:
case keyDown:
DrawEventString( "\pkeyDown" ):
break:
case keyUp:
DrawEventStri ng( "\pkeyUp" ) :
break:
case autoKey:
DrawEventStringC "\pautoKey" );
break:
case updateEvt:
if ( (WindowPtr)gTheEvent.message

==

gPictWindow )

{

else

DrawEventString( "\pupdateEvt: gPictWindow" ):
BeginUpdate( gTheEvent.message );
DrawMyPicture(gTheEvent.message,gPictureHandle):
EndUpdateC gTheEvent.message );
DrawEventString( "\pupdateEvt: gEventWindow" ):
BeginUpdateC gTheEvent.message );
I*

*
We won't handle
* but we still need to
* Update Region so the
* queueing UpdateEvts.
*
We do this with
*and EndUpdate().

updates to gEventWindow,
empty the gEventWindow
Window Manager will stop
calls to BeginUpdate()

*I

EndUpdate( gTheEvent.message );
I

break:
case diskEvt:
DrawEventString( "\pdi skEvt" ) :
break:
case activateEvt:
if ( (WindowPtr)gTheEvent.message

==

gPictWindow )

l
I*

*
*
*

If gPictWindow was activated or deactivated, we better redraw the
grow box (as well as the scroll bar outlines. We do this because
active and inactive windows have different looking grow boxes.

*I

DrawGrowlconC gTheEvent.message );
if ( C gTheEvent.modifiers & activeFlag )
ACTIVATING )

DrawEventString(
"\pactivateEvt: activating gPictWindow"):
I

else

DrawEventString(
"\pactivateEvt: deactivating gPictWindow"
)

:
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else
if ( ( gTheEvent.modifiers & activeFlag ) ==
ACTIVATING )
DrawEventString(
"\pactivateEvt: activating gEventWindow"
)

else

:

DrawEventString(
ff\pactivateEvt: deactivating gEventWindow"
) ;

l

break:
case networkEvt:
DrawEventString(
break;
case driverEvt:
DrawEventStri ng (
break:
case applEvt:
DrawEventString(
break:
case app2Evt:
DrawEventString(
break:
case app3Evt:
DrawEventStri ng (
break:
case app4Evt:
I*

*
*
*

*
*

ff\pnetworkEvt" );
"\pdri verEvt" ) :
"\papplEvt" ) :
"\papp2Evt" );
"\papp3Evt" ) :

app4Evts are like Trojan horses for suspend, resume, and mouse
moved events. The actual event type is specified by the
appropriate bit in the event's message field. For more info
on these events (especially on mouse moved events) read Apple's
"Programmer's Guide to MultiFinder".

*I

if (

gTheEvent.message & SUSPEND_RESUME_BIT ) ==
RESUMING )
DrawEventString( "\pResume event" );

else

OrawEventString( "\pSuspend event" );

break:

/**********************************

DrawEventString

*******/

DrawEventString( s )
Str255 s:
I
/*

if we're at the bottom of gEventWindow, scroll the window.
if
gCurRow > gMaxRow )
I

ScrollWindow();

I

else
I
I

gCurRow

+=

ROWHEIGHT:

MoveTo( LEFTMARGIN, gCurRow );
DrawStri ng( s ) :

*/
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/**********************************

ScrollWindow

*******/

Scrol lWindow()
I

RgnHandle

tempRgn;

tempRgn = NewRgn();
/*

*

*
*
*
*

*I

We use ScrollRect() to scroll all the pixels in gEventWindow
up one row. The newly created rectangular region at the bottom of
the window will be stored in tempRgn. We could use tempRgn to
do some smart updating of our window. only refreshing the area
of the window specified by tempRgn.
ScrollRect( &gEventWindow->portRect. HORIZONTAL_OFFSET, ROWHEIGHT, tempRgn );
DisposeRgn( tempRgn ); /* Free up the memory used by tempRgn */

!************************************* HandleMouseDown */

HandleMouseDown()
I

WindowPtr
short int
long
Graf Ptr

whichWindow;
thePart;
windSize:
oldPort:

/*

*
First. find out which window the mouse click occurred in.
*Then, find out what part of the window the mouse click
*
occurred in.
*I
thePart = FindWindow( gTheEvent.where, &whichWindow ):
switch ( thePart )
I

case inSysWindow :

/*

*

*I

I*
I*
I*

I*

Probably a desk accessory window ...
SystemClick( &gTheEvent, whichWindow ):
break:
case i nDrag :
Drag the window around the screen, limited by gDragRect */
DragWindow( whichWindow, gTheEvent.where. &gDragRect);
break;
case inContent:
Bring the clicked on window to the front */
SelectWindow( whichWindow );
break:
case inGrow:
First. let the user specify the new size of the window ... */
windSize = GrowWindow( whichWindow, gTheEvent.where.
&gSizeRect );
if ( windSize != 0 )
I

* ... If they resize the window. temporarily make the window the
window the current port, erase the window, and use InvalRect()
*
to make sure an update event is generated for the window.

*

*/
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GetPort( &oldPort );
SetPort( whichWindow ):
EraseRect( &whichWindow->portRect );
SizeWindow( whichWindow, LoWord( windSize ),
HiWord( windSize ), NORMAL_UPDATES );
I nva l Rect < &whi chWi ndow->portRect ) ;
SetPort( oldPort );
I

I*
*
*
*
*
*I

break:
case inGoAway
Important!!! Normally, we'll. only set gDone to TRUE when Quit is
selected from the File menu. For the currect handling of
the inGoAway case. refer to the WindowMaker application in
Chapter 7.
gDone = TRUE;
break:
case inZoomln:
case inZoomOut:

/*

*

*

*I

Handling a click in the zoom box is similar to handling the
resizing of a window.
if

TrackBox(whichWindow, gTheEvent.where, thePart) )

I

GetPort( &oldPort );
SetPortC whichWindow );
EraseRect( &whichWindow->portRect ):
ZoomWindow( whichWindow, thePart,
LEAVE_WHERE_IT_IS );
InvalRect< &whichWindow->portRect );
SetPort( oldPort );

I

break:

/******************************** DrawMyPicture *********/

OrawMyPicture( drawingWindow, thePicture )
WindowPtr
drawingWindow;
PicHandle
thePicture;
{

Rect
drawi ngCl i pRect. myRect:
Graf Ptr ol dPort;
RgnHandle
tempRgn:

I*
*
*
*
*
*I

We start by temporarily making the window specified in the
drawingWindow parameter the current port. We also store the
window's clipping region in tempRgn. Next, we erase the window
and redraw the Growlcon.
GetPort( &oldPort );
SetPort( drawingWindow ):
tempRgn = NewRgnC>:
GetClip( tempRgn ):
EraseRect( &drawingWindow->portRect ) ;
DrawGrowlcon( drawingWindow ):
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Next. we create a clip rectangle that doesn't cover the scroll
bar areas (or the size box either). We use this rectangle as
our clipping region and center and draw the picture.
drawingClipRect = drawingWindow->portRect;
drawingClipRect.right ·= SCROLL_BAR_PIXELS;
drawingClipRect.bottom ·= SCROLL_BAR_PIXELS;
myRect = drawingWindow·>portRect;
Center Pi ct( thePi cture, &myRect ) :
ClipRect( &drawingClipRect );
DrawPictureC thePicture, &myRect >:

/*

*

*

*I

Finally, we restore the original clip region, free up the memory
used by tempRgn, and reset the original port.
SetClip( tempRgn );
DisposeRgn( tempRgn );
SetPort( oldPort );

!**~*****************************

CenterPict *********/

CenterPict( thePicture, myRectPtr
PicHandle
thePicture;
Rect
*myRectPtr:
I

Rect

wi ndRect, pi ctureRect;

windRect = *myRectPtr;
pictureRect = (**( thePicture )).picFrame;
myRectPtr->top = CwindRect.bottom - windRect.top ·
CpictureRect.bottom - pictureRect.top))/ 2 +
windRect.top;
myRectPtr->bottom = myRectPtr->top +
(pictureRect.bottom - pictureRect.top):
myRectPtr->left = (windRect.right - windRect.left ·
CpictureRect.right - pictureRect.left))/ 2 +
windRect.left:
myRectPtr->right = myRectPtr->left + CpictureRect.right pictureRect.left):

Chapter 5, Timer.c
#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

#define
#define
#define
#define
#define
#define
#define

PLAIN
PLAIN_ITEM
BOLD_ITEM
ITALIC_ITEM
UNDERLINE_ITEM
OUTLINE_ITEM
SHADOW_ITEM

400
OL
-ll

0
0
I
2
3
4
5
6
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//define INCLUDE_SECONDS

TRUE

//define ADO_CHECK_MARK
//define REMOVE_CHECK_MARK

TRUE
FALSE

1/defi ne DRAG_THRESHOLD

30

1/define MIN_SLEEP
/ldefi ne NIL_MOUSE_REGION

OL
OL

#define WNE_TRAP_NUM
#define UNIMPL_TRAP_NUM

Ox60
Ox9F

//define
/ldefi ne
/ldefi ne
#define
#define
//define
1/define

OUIT_ITEM
ABOUT_ITEM
NOT_A_NORMAL_MENU
APPLE_MENU_ID
FI LE_MENU_ID
FONT_MENU_ID
STY LE_MENU_I D

1
1
-1

BASE_RES_ID
BASE_RES_ID+l
100
101

/ldefi ne CLOCK_LEFT
#define CLOCK_ TOP
I/define CLOCK_SIZE

12
25
24

#define ABOUT_ALERT

400

WindowPtr
Boolean
1ong
Event Record
MenuHandle
int
Rect
Style

gClockWindow:
gDone. gWNEimplemented:
gCurrentTime. gOldTime:
gTheEvent:
gAppleMenu. gFontMenu, gStyleMenu:
glastFont:
gDragRect:
gCurrentStyle = PLAIN:

!******************************** main *********/

main ( )
{

ToolBoxinit():
Windowinit():
SetUpDragRect();
MenuBarinit():
Mainloop():

!*********************************** ToolBoxinit */

Tool Box I nit()
{

InitGraf( &thePort ) :
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
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InitWindows();
InitMenus();
TEini t();
InitDialogs( NIL_POINTER );
Ini tCursor():

/************************************ Windowlnit

*/

Windowlnit()
I

gClockWindow = GetNewWindow( BASE_RES_IO, NIL_POINTER,
MOVE_ TO_FRONT ) ;
SetPort( gClockWindow );
ShowWindow( gClockWindow );
TextSize( CLOCK_SIZE );

!******************************** SetUpDragRect *********/

SetUpDragRect()
I

gDragRect = screenBits.bounds;
gDragRect.left += DRAG_THRESHOLD;
gOragRect.right -= DRAG_THRESHOLD;
gOragRect.bottom -= DRAG_THRESHOLD:

/*********************************** MenuBarlnit

*/

MenuBarlnit()
I

I*

*

*
*
*
*I

I*
*
*
*
*
*I
I*
*
*I

Handle

myMenuBar;

First. we'll load the MBAR resource, which specifies the MENUs
to use in myMenuBar. Next. make myMenuBar the current menu bar.
Put handles to their respective menus in the globals gAppleMenu.
gFontMenu, and gStyleMenu for later use.
myMenuBar = GetNewMBar( BASE_RES_IO ):
SetMenuBar( myMenuBar ):
gAppleMenu = GetMHandle( APPLE_MENU_ID );
gFontMenu = GetMenu( FONT_MENU_ID ):
gStyleMenu = GetMenu( STYLE_MENU_ID );
Add the heirarchical menu, gFontMenu, to the menu list.
We set up the Special MENU resource so that the Font and
Style menus would automatically be added as hierarchical
submenus to the Special menu.
InsertMenu( gFontMenu, NOT_A_NORMAL_MENU );
We also add all the FONTs to the font menu.
AddResMenu( gFontMenu. 'FONT' >:
InsertMenu( gStyleMenu, NOT_A_NORMAL_MENU ):
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I*
*
*
*I
I*
*
*

*

*I

Put a check mark next to Plain on the Style submenu and
Add all the desk accessory names to the apple menu.
Checkltem( gStyleMenu, PLAIN_ITEM. TRUE );
AddResMenu( gAppleMenu, 'DRVR' );
DrawMenuBar();
We' 11 start off using the first font on the menu. By
calling HandleFontChoice(), we simulate the user selecting
the first font from the font menu ...
gLastFont = 1:
Handl eFontChoi ce( gLastFont ) :

/******************************** MainLoop *********/

Main Loop ()
I

gDone = FALSE:
gWNEimplemented

NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) );
while ( gDone == FALSE )
I

=

(

HandleEvent();

/************************************* HandleEvent

*/

HandleEvent()
I

char

theCha r:

if ( gWNEimplemented )
WaitNextEvent( everyEvent. &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
else
{

SystemTask<>:
GetNextEvent( everyEvent. &gTheEvent );

switch ( gTheEvent.what
{

I*
*
*
*
*I

case nullEvent:
Since the clock needs to be updated on a regular basis <and not
just when an update event is generated), we'll check the clock
every time we get a null event.
Handl eNul 1 ():
break:
case mouseDown:
HandleMouseDown();
break:
case keyDown:
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case autoKey:
theChar = gTheEvent.message & charCodeMask:
if (( gTheEvent.modifiers & cmdKey ) != 0)
HandleMenuChoice( MenuKey( theChar ) );
break;
case updateEvt:
/*

*
*
*

*

*
*

We don't need to do anything about updateEvts but we must
call Begin and EndUpdate() so the Window Manager won't keep
generating update events. The problem is, if the Window
Manager keeps generating updateEvts, the event queue will
eventually fill up, and the Event Manager won't be able to
generate any nullEvts.

*I

BeginUpdate( gTheEvent.message );
EndUpdateC gTheEvent.message );
break:

/******************************** HandleNull *********/

HandleNull()
I
I*

*
*
*

Check the time, compare it against the last time you
checked. If the time (which is measured in seconds)
changed, update the clock.

*/

GetDateTime( &gCurrentTime );
if < gCurrentTime != gOldTime
I

DrawClock( gClockWindow ):

/******************************** DrawClock *********/

DrawClock( theWindow )
WindowPtr
theWindow:
I

Str255

myTimeString;

IUTi meStri ng ( gCurrentTi me. I NCLUDE_SECONDS, my Ti meStri ng ) :
EraseRect( &C theWindow->portRect ) ):
MoveTo( CLOCK_LEFT. CLOCK_TOP );
Drawstring( myTimeString );
gOldTime = gCurrentTime:

/************************************* HandleMouseDown */

HandleMouseDown()
{

WindowPtr
short int
1ong int

whichWindow:
thePart:
menuChoice, windSize:
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thePart = FindWindow( gTheEvent.where, &whichWindow );
switch ( thePart )
I

case inMenuBar:
menuChoice = MenuSelect( gTheEvent.where );
HandleMenuChoice( menuChoice ):
break:
case inSysWindow :
SystemClick( &gTheEvent, whichWindow ):
break:
case i nDrag :
DragWi ndow( whi chWi ndow. gTheEvent. where. &gDragRect):
break:
case inGoAway :
gDone = TRUE:
break:

/************************************* HandleMenuChoice */

HandleMenuChoice( menuChoice
long int
menuChoice:
I
I*

*

*

*

menuChoice is 4 bytes. 2 bytes of which contain the resource
ID of the selected menu, and 2 bytes of which contain the
selected item number.

*/

int
int
if

theMenu:
the Item:
menuChoice != 0 )

(

theMenu = HiWord( menuChoice ):
theltem = LoWord( menuChoice );
switch ( theMenu )
I

case APPLE_MENU_ID :
HandleAppleChoice( the Item ) :
break:
case FI LE_MENU_ID :
HandleFileChoice< theltem ) :
break;
case FONT_MENU_ID :
HandleFontChoice( the Item ) ;
break:
case STYLE_MENU_ID:
HandleStyleChoice( the Item ) :
break:

I

HiliteMenu( 0

)

:

/********************************

HandleAppleChoice( theltem )
int
the Item:
(

HandleAppleChoice

*******/
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St r255 accName;
int
accNumber;
short int
itemNumber:
DialogPtr
AboutDialog;
switch ( theltem )
I

case ABOUT_ITEM

I*
*
*
*I

Alerts are extremely easy to do. Dialog boxes are
much more complex (they're explained in Chapter 6).

I*
*
*
*I

If the selection was not "About
Desk Accessory ...

NoteAlert( ABOUT_ALERT, NIL_POINTER );
break:
default :
open the selected

Getltem( gAppleMenu, theltem, accName ):
accNumber = OpenDeskAccC accName );
break:

/********************************

HandleFileChoice

*******/

HandleFileChoice( theltem
int
the Item:
I

switch ( theltem )

I*

*

*
*I

I

This is the correct way to exit an application:
selecting Quit from the File menu!

by

case QUIT_ITEM :
gDone = TRUE:
break;

/********************************

HandleFontChoice

*******/

HandleFontChoice( theltem )
int
the Item:
I

I*

I*

int
fontNumber:
Str255 font Name:
Uncheck the old font, check the newly selected font */
Checkltem( gFontMenu, gLastFont, REMOVE_CHECK_MARK );
Checkltem( gFontMenu, theltem. ADD_CHECK_MARK );
gLastFont = theltem;
Getltem< gFontMenu , theltem , fontName );
GetFNum( fontName , &fontNumber );
Change the font to the selected font ... */
TextFont( fontNumber );
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/********************************

HandleStyleChoice

*******/

HandleStyleChoice( theltem )
int
the Item:
{

I*

*
*
*I

gCurrentStyle accumulates the style changes made via the
Style menu.
switch( theitem
{

case PLAIN_ITEM:
gCurrentStyle = PLAIN:
break:
case BOLD_ITEM:
if ( gCurrentStyle & bold )
gCurrentStyle
bold:
else
gCurrentStyle I= bold:
break:
case ITALIC_ITEM:
if ( gCurrentStyle & italic )
gCurrentStyle
italic;
else
gCurrentStyle I= italic:
break:
case UNDERLINE_ITEM:
if ( gCurrentStyle & underline )
gCurrentStyle
underline;
else
gCu rrentStyl e I= under 1i ne:
break:
case OUTLINE_ITEM:
if ( gCurrentStyle & outline )
gCurrentStyle
outline;
else
gCurrentStyle I= outline:
break:
case SHADOW_ITEM:
if ( gCurrentStyle & shadow )
gCurrentStyle
shadow:
else
gCurrentStyle I= shadow:
break;
I*

*
*
*

*I

Check or uncheck the appropriate items from the Style
menu, then change the current text face to that encoded
in gCurrentStyle.
CheckStyles();
TextFace( gCurrentStyle ):

/********************************

CheckStyles

*******/

CheckStyles()
I
I*

*

*

*I

Check or uncheck each item on the Style menu, depending on
the contents of gCurrentStyle.
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Checkltem(
Checkltem(
Checkltem(
Checkltem(
Checkltem(
Checkltem(

gStyleMenu,
gStyleMenu.
gStyleMenu.
gStyleMenu.
gStyleMenu.
gStyleMenu.

PLAIN_ITEM. gCurrentStyle == PLAIN );
BOLO_ITEM. gCurrentStyle & bold >:
ITALIC_ITEM. gCurrentStyle & italic );
UNDERLINE_ITEM. gCurrentStyle & underline>:
OUTLINE_ITEM, gCurrentStyle & outline );
SHADOW_ITEM, gCurrentStyle & shadow );

Chapter 5, Popup.c
/fdefi ne
I/define
I/define
I/define

BASE_RES_I 0
NI L_PO INTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

400

OL
-ll
0

I/define MIN_SLEEP
/fdefi ne NIL_MOUSE_REGION

OL
OL

#define DRAG_ THRESHOLD

30

//define WNE_TRAP_NUM
I/define UNIMPL_TRAP_NUM

Ox60
Ox9F

#define POPUP_MENU_ID
#define NOT_A_NORMAL_MENU

BASE RES_ID

I/define
#define
#define
I/define
//define
//define
//define
I/define
fldef i ne

POPUP_LEFT
POPUP _TOP
POPUP_RIGHT
POPUP_BOTTOM
SHADOW_PIXELS
RIGHT_MARGIN
BOTTOM_MARGIN
LEFT_MARGIN
PIXEL_FOR_TOP _ LINE

Boolean
int
MenuHandle
Event Record
Re ct

-1
100

35
125
52
1
5
4
5

1

gDone. gWNEimplemented;
gPopUpltem = 1, gPopUpLabelWidth:
gPopUpMenu:
gTheEvent;
gPopUpRect, gLabelRect, gDragRect;

!*********************** Main *************/

main ( )
I

Tool Boxlnit();
Windowlnit():
SetUpDragRect < >:
MenuBarlnit();
DrawPopUp();
Main Loop ( ) :
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/*********************************** ToolBoxlnit */
Tool Box I nit()
I

InitGraf{ &thePort >:
InitFonts():
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus C):
TEinit();
lnitOialogs( NIL_POINTER );
lnitCursor<):

/*********************Windowlnit**************/
Windowlnit()
{

WindowPtr

popUpWindow:

GetNewWindow( BASE_RES_IO , NIL_POINTER,
MOVE_TO_FRONT ) ;
ShowWindow< popUpWindow >:
SetPortC popUpWindow );
TextFont( systemFont );
TextModeC srcCopy );
popUpWindow

/******************************** SetUpOragRect *********/
SetUpOragRectC)
{

gOragRect = screenBits.bounds:
gOragRect.left += ORAG_THRESHOLD:
gOragRect.right -= DRAG_THRESHOLO;
gOragRect.bottom -= ORAG_THRESHOLO;

/*********************MenuBarlnit**************/
MenuBarlnit()
I
I*

*
*
*

*
*

*I

Just as we did with the hierarchical menus in Timer,
we load the MENU, and add it to the menu list via the
call to InsertMenu(). Next, we get the popup label
from the menu data structure and calculate its width in
pixels. We'll use this information later.
gPopUpMenu = GetMenu( POPUP_MENU_IO );
InsertMenuC gPopUpMenu, NOT_A_NORMAL_MENU );
Hlock( gPopUpMenu >:
gPopUplabe l Width = Stri ngWi dth ( (**gPopUpMenu). menuData ) :
HUnl ock( gPopUpMenu ) :
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/********************* DrawPopUp **************/
DrawPopUp()
{

I*

*
*
*
*

*I

DrawPopUp() will draw the popup outline, its 1-pixel
drop shadow, the popup label, and set glabelRect,
which we'll invert when the popup is selected. DrawPopUp()
will also be called to handle updateEvts.
SetRect( &gPopUpRect, POPUP_LEFT, POPUP_TOP,
POPUP_RIGHT, POPUP_BOTTOM );
FrameRect( &gPopUpRect );
MoveTo( gPopUpRect.left+SHADOW_PIXELS, gPopUpRect.bottom );
LineTo< gPopUpRect.right, gPopUpRect.bottom >:
LineTo( gPopUpRect.right, gPopUpRect.top+SHADOW_PIXELS );
MoveTo( gPopUpRect.left - gPopUplabelWidth - RIGHT_MARGIN,
gPopUpRect.bottom - BOTTOM_MARGIN );
Hlock( gPopUpMenu );
Drawstring( C**gPopUpMenu) .menuData ) :
HUnlock( gPopUpMenu >:
glabelRect.top ~ gPopUpRect.top + PIXEL_FOR_TOP_LINE;
gLabelRect.left = gPopUpRect.left - gPopUpLabelWidth
- LEFT_MARGIN - RIGHT_MARGIN;
gLabelRect.right = gPopUpRect.left:
gLabelRect.bottom = gPopUpRect.bottom:

I*

*
*

After the background is drawn, we can draw the current
menu value, in this case, a number.

*/

DrawPopUpNumber();

/********************* DrawPopUpNumber **************/
DrawPopUpNumber()
{

Str255 menultem;
int
itemleftMargin;
I*

*

*

*I

Get the menu item corresponding to gPopUpltem,
calculate the margin, and draw it ...
Getltem( gPopUpMenu, gPopUpltem, &menultem );
itemLeftMargin = ( gPopUpRect.right - gPopUpRect.left StringWidth( menultem ) ) I 2;
MoveTo( gPopUpRect.left + itemLeftMargin,
gPopUpRect.bottom - BOTTOM_MARGIN );
Drawstring( menultem );
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/******************************** MainLoop *********/

MainLoop()
{

gDone = FALSE:
gWNElmplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) );
while ( gDone == FALSE )
{

HandleEvent();

/************************************* HandleEvent

*/

HandleEvent()
I

if ( gWNEimplemented )
WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP.
NIL_MOUSE_REGION );
else
{

SystemTask();
GetNextEvent( everyEvent, &gTheEvent );
switch
I

C

gTheEvent.what )

case mouseDown:
HandleMouseDown():
break:
case updateEvt:
Begi nUpdate( gTheEvent. message ) :
DrawPopUp ():
EndUpdate( gTheEvent.message >:
break:

/************************************* HandleMouseDown */

HandleMouseDown()
I

WindowPtr
short int
long int
Point

whichWindow:
thePart. i:
theChoice:
myPoi nt. popUpUpperLeft:

thePart = FindWindow( gTheEvent.where, &whichWindow >:
switch < thePart )
I
I*

*
*
*

*I

case inContent:

If the mouse was clicked in the window. copy the Point.
convert it to the window's local coordinate system, and
check to see if its inside gPopUpRect. If so ...
myPoint = gTheEvent.where:
GlobalToLocal( &myPoint ):
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if ( PtlnRect( myPoint, &gPopUpRect ) )
(

I*

*
*

... Invert the label, call PopUpMenuSelect, uninvert the
label. Finally, handle the selection.

*I

InvertRect( &glabelRect );
popUpUpperLeft.v = gPopUpRect.top +
PIXEL_FOR_TOP_LINE:
popUpUpperLeft.h = gPopUpRect.left:
LocalToGlobal( &popUpUpperleft ):
theChoice = PopUpMenuSelect( gPopUpMenu,
popUpUpperleft.v, popUpUpperleft.h,
gPopUpltem ):
InvertRect( &glabelRect );
if ( LoWordC theChoice ) > O )
I

gPopUpltem = LoWord( theChoice ):
DrawPopUpNumber():
for ( i=O; i<gPopUpltem: i++ )
SysBeepC 20 ):

l

break;
case inSysWindow:
SystemClick( &gTheEvent. whichWindow ):
break:
case inDrag:
DragWindowC whichWindow, gTheEvent.where, &gDragRect):
break:
case inGoAway :
I*

*
*

Again, this is not the way "proper" Macintosh applications
exit. We would normally use a Quit item in the File menu.

*/

gDone = TRUE;
break:

Chapter 6, Reminder.c
//define
/ldefi ne
/ldefi ne
//define
/ldefi ne
/ldefi ne

BASE_RES_ID
ABOUT_ALERT
BAD_SYS_ALERT
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

//define MIN_SLEEP
//define NIL_MOUSE_REGION

400
401
402
OL
-ll

0
OL
OL

/ldefi ne DRAG_THRESHOLD 30
/ldefi ne
/ldefi ne
/ldefi ne
I/define
//define

SAVE_BUTTON
CANCEL_BUTTON
TIME_FIELD
S_OR_M_FIELD
SOUND_ON_BOX

1
2
4

5
6
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#define
#define
//define
#define

ICON_ON_BOX
ALERT_ON_BOX
SECS_RAD IO
MINS_RADIO

7

8

10
11

//define DE FAUL T_SECS_ID
#define DEFAULT_MINS_ID

401
402

#define ON
#define OFF

0

1

#define SECONDS
#define MINUTES
#define SECONDS_PER_MINUTE

60

#define TOP
#define LEFT

12

0
1

25

//define MARK_APPLICATION
#define APPLE_MENU_ID
#define FI LE_MENU_ID
//define ABOUT _I TEM_ID
#define
//define
//define
//define

CHANGE_ ITEM
START _STOP _ITEM
KI LL_I TEM
OUIT_ITEM

#define SYS_VERSION
DialogPtr
Re ct
Boolean
char
StringHandle
NM Rec
MenuHandle
EventRecord

BASE_RES_ID
BASE_RES_ID+l
1
1
2
3
4
I* Version Number of SysEnvirons */

gSettingsDialog:
gDragRect:
gDone, gCounting, gNotify_set:
gSeconds_or_minutes = SECONDS:
gNoti fyStrH. gDefaultSecsH. gDefaultMi nsH:
gMyNMRec:
gAppleMenu, gFileMenu:
gTheEvent:

struct
{

Str255 timeString;
int
sound:
int
icon:
int
alert;
int
secsRadio:
int
minsRadio:
savedSettings:
/******************************** main *********/

main< )
I

ToolBoxlnit();

I*

*

*

*I

Since we'll be using the Notification Manager. we have to make
sure System 6.0 or later is installed.
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if

Sys60rlater () )

I

Dialoglnit();
MenuBarlnit();
SetUpOragRect();
Notifylni t();
Mainloop();

/*********************************** ToolBoxlnit */

ToolBoxlnit()
I

InitGraf( &thePort ) ;
Ini tFonts():
Fl ushEvents ( everyEvent, REMOVE_ALL_EVENTS ) ;
I ni tWi ndows ();
I nitMenus ();
TEinit();
InitDialogs( NIL_POINTER );
Ini tCursor();

/******************************** Sys60rlater *********/

int
I

Sys60rlater()
OS Err
SysEnvRec

I*

*
*

*I

status;
SysEnvOata;

SysEnvirons() is documented in (V:5-6).
the systemVersion field.

We're interested in

status = SysEnvirons( SYS_VERSION. &SysEnvData );
if (( status != noErr ) I I < SysEnvData.systemVersion < Ox0600 ))
I

StopAlert( BAD_SYS_ALERT, NIL_POINTER );
return( FALSE ) :

I

else

return( TRUE );

/******************************** Dialoglnit *********/

Di a1 og In it ( )
I

I*

int
Re ct
Handle

itemType;
itemRect;
itemHandle;

These 2 'STR 's hold the default values for minutes
and seconds */
gOefaultSecsH
GetString( OEFAULT_SECS_IO );
gOefaultMinsH = GetString( DEFAULT_MINS_IO );
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I*

*
*
*
*

Load gSettingsDialog with GetNewDialog{). You can treat
it like a WindowPtr. If you want to draw in the Dialog
window, use SetPort first to make the dialog port the current
port.

*/

gSettingsDialog = GetNewDialog( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT ) :
I*

*

*

Get a handle to the dialog items to be initialized with
GetDitem{), use SetCtlValue{) to set the control's value.

*/

GetDitemC gSettingsDialog, SECS_RADIO, &itemType, &itemHandle,
&i temRect ) :
SetCtlValue< itemHandle, ON >:
GetDitem< gSettingsDialog, SOUND_ON_BOX. &itemType, &itemHandle,
&itemRect );
SetCtlValue{ itemHandle, ON >:
GetDitem( gSettingsDialog, ICON_ON_BOX, &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, ON >:
GetDitem( gSettingsDialog, ALERT_ON_BOX. &itemType, &itemHandle,
&itemRect >:
SetCtlValue< itemHandle, ON );

!*********************************** MenuBarlnit

*/

MenuBarlnit()
{

Handle

myMenuBar:

myMenuBar = GetNewMBar{ BASE_RES_ID );
SetMenuBar( myMenuBar ):
gAppleMenu = GetMHandle( APPLE_MENU_IO );
AddResMenu< gAppleMenu, 'DRVR' ):
gFileMenu = GetMHandle( FILE_MENU_ID );
DrawMenuBar();

/******************************** SetUpDragRect *********/

SetUpDragRect()
{

gDragRect = screenBits.bounds:
gDragRect.left += DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD:
gDragRect.bottom -= DRAG_THRESHOLO;

/******************************** Notifylnit *********/

Notifylnit()
I
I*

Initialize the notification data structure */
gNotifyStrH = GetString{ BASE_RES_ID ); I* The Alert string */
gMyNMRec.qType = nmType;
/* All notifs use this type */
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gMyNMRec.nmMark
entry in
gMyNMRec.nmResp
routine

= MARK_APPLICATION: /* mark the applications
the apple menu */
= NIL_POINTER: /* don't use a response
*/

/******************************** MainLoop *********/

MainLoop()
I
I*

*
*

gCounting is TRUE while the countdown is happening.
is TRUE while the notification is set.

gNotify_set

*/

gDone = FALSE:
gCounting = FALSE:
gNotify_set = FALSE;
while ( gDone == FALSE
I

HandleEvent();

/************************************* HandleEvent

*/

HandleEvent()
I

char

theCha r:

/*

*

*

Because we're running System 6.0 or later, we don't need
to check for WaitNextEvent().

*/

WaitNextEvent( everyEvent, &gTheEvent. MIN_SLEEP.
NIL_MOUSE_REGION );
switch ( gTheEvent.what )
!

case mouseDown:
HandleMouseDown();
break:
case keyDown:
case autoKey:
theChar = gTheEvent.message & charCodeMask;
if (( gTheEvent.modifiers & cmdKey ) != O )
HandleMenuChoice( MenuKey( theChar ) >:
break;

/************************************* HandleMouseDown */

HandleMouseDown()
I

WindowPtr
short int
1ong int

whichWindow:
thePart;
menuChoice, windSize:
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thePart = FindWindow( gTheEvent.where, &whichWindow );
switch C thePart )
I

case inMenuBar:
menuChoice = MenuSelect( gTheEvent.where );
HandleMenuChoice( menuChoice );
break:
case inSysWindow :
SystemClick( &gTheEvent. whichWindow ):
break:
case inDrag :
DragWindow( whichWindow, gTheEvent.where, &gDragRect);
break:
case inGoAway :
gDone = TRUE:
break;

/************************************* HandleMenuChoice */

HandleMenuChoice( menuChoice
long int
menuChoice:
I

int
int
if

theMenu:
the Item:
menuChoice != 0 )

I

theMenu = HiWord( menuChoice ):
theltem = LoWord( menuChoice );
switch ( theMenu )
I

case APPLE_MENU_ID :
HandleAppleChoice( theltem ):
break:
case FILE_MENU_ID :
HandleFileChoice( theltem ):
break:

}

HiliteMenu( 0 ):

/********************************

HandleAppleChoice

*******/

HandleAppleChoice< theltem )
int
the Item:
{

Str255
int
short int
switch
I

<

accName:
accNumber:
itemNumber:
theltem )

case ABOUT_ITEM_ID :
NoteAlert( ABOUT_ALERT, NIL_POINTER );
break:
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default :
Getltem( gAppleMenu. theltem. accName >:
accNumber = OpenDeskAccC accName );
break:

/********************************

HandleFileChoice

*******/

HandleFileChoice( theltem )
int
the Item:
{

Str255
long
int
Rect
Handle

timeString:
countDownTime:
i temType:
i temRect:
itemHandl e:

switch ( theltem )
(

case CHANGE_ITEM :
I* Change Settings */
HandleDialog();
break:
case START_STOP_ITEM :
I* Start or Stop the Countdown */
if ( gCounting ) /* Stop Countdown

*/

(

Setltem( gFileMenu,theltem,"\pStart Countdown"):
gCounting = FALSE:
else
/* Start Countdown */
/*

*

*
*
*

*I

I*

Start the countdown by unhilighting the menu, getting the time
field from the settings dialog, disabling the "Change Settings"
menu item, changing "Start Countdown" to "Stop Countdown" and.
finally. calling CountDown().
HiliteMenu( 0 );
GetDitem( gSettingsDialog. TIME_FIELD.
&itemType, &itemHandle, &itemRect );
GetlText( itemHandle, &timeString );
StringToNum( timeString, &countDownTime );
Disableltem( gFileMenu, CHANGE_ITEM );
/* Disable Change Settings */
SetitemC gFileMenu, theltem,"\pStop Countdown"):
CountDown( countDownTime );
Once Countdown() returns. reenable "Change Settings",
change "Stop Countdown" to "Start Countdown" */
Enableltem( gFileMenu, CHANGE_ITEM );
/* Reenable Change Settings */
Setltem( gFileMenu,theltem,"\pStart Countdown");
I

break:
case KI LL_ITEM :
I* Kill Notification */
NMRemove( &gMyNMRec >:
HUn 1ock ( gNot i fyStrH ) :

455

Appendix B: Code Listings

Disableltem( gFileMenu, KILL_ITEM );
gNotify_set = FALSE:
break:
case QUIT_ITEM :
I*

*
*
*
*
*

There is a call to HandleEvent() inside Countdown(), so the Quit
item might be selected during the countdown. Setting gCounting
to FALSE will cause us to drop out of the Countdown() event
loop. Setting gDone to TRUE will drop us out of the main event
1oop.

*I

gCounting = FALSE:
gOone = TRUE:
break:

!******************************** HandleDialog *********/

HandleDialog()
I

int

itemHit, dialogDone
alarmDelay:
Str255 delayString:
int
itemType:
Re ct
itemRect:
Handle itemHandle:
1ong

FALSE;

ShowWindow( gSettingsDialog );
SaveSettings();
while ( dialogDone

FALSE

I
I*

*
*

*I

call ModalDialog() to find out which item was hit, then
process that item.
ModalDialog( NIL_POINTER, &itemHit );
switch ( itemHit )
I

/*

case SAVE_BUTTON:
HideWindow( gSettingsDialog ):
dialogDone = TRUE:
break:
case CANCEL_BUTTON:
Hi deWi ndow( gSett i ngsOi a 1og ) :
RestoreSettings();
dialogDone = TRUE:
break:
case SOUND_ON_BOX:
GetDltem( gSett i ngsDi a 1og. SOUND_ON_BOX.
&itemType, &itemHandle, &itemRect );
This is a nice technique for flipping the value of checkboxes */
SetCtlValue( itemHandle.
! GetCtlValue< itemHandle ) >:
break:
case ICON_ON_BOX:
GetDitem( gSettingsDialog, ICON_ON_BOX.
&itemType, &itemHandle, &itemRect >:
SetCtlValue( itemHandle,
! GetCtlValue( itemHandle ) );
break:
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case ALERT_ON_BOX:
GetDitem( gSettingsDialog, ALERT_ON_BOX.
&itemType, &itemHandle. &itemRect );
SetCtlValue( itemHandle.
! GetCtlValue( itemHandle ) );
break:
case SECS_RADIO:
I*

*

*

Turn off the minutes radio button, turn on the seconds
radio button. Change the string from ·minutes" to ·seconds".

*I

I*

*
*

gSeconds_or_minutes = SECONDS:
GetDitem( gSettingsDialog, MINS_RADIO,
&itemType, &itemHandle, &itemRect
SetCtlValue< itemHandle, OFF );
GetDitem( gSettingsDialog, SECS_RADIO,
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle, ·oN );
GetD I tern( gSet ti ngsDi a1og. S_OR_M_F I ELD.
&itemType, &itemHandle. &itemRect
SetIText< itemHandle. "\pseconds" >:
GetDitem( gSettingsDialog, TIME_FIELD.
&itemType, &itemHandle, &itemRect
HLock( gDefaultSecsH );
SetIText( itemHandle, *gDefaultSecsH );
HUnlockC gDefaultSecsH );
break:
case MINS_RADIO:

);
);
);

Turn off the seconds radio button. turn on the minutes
radio button. Change the string from ·seconds" to "minutes".

*I

gSeconds_or_minutes = MINUTES:
GetDitem( gSetti ngsDi al og, SECS_RADIO,
&itemType, &itemHandle, &itemRect
Set Ct 1Va1 ue( i temHandl e. OFF ) :
GetDitem( gSettingsDialog, MINS_RADIO.
&itemType, &itemHandle, &itemRect
SetCtlValue( itemHandle, ON);
GetDitem( gSettingsDialog, S_OR_M_FIELD,
&itemType, &itemHandle, &itemRect
SetlText( itemHandle, ·\pminutes" );
GetDitem( gSettingsDialog, TIME_FIELD,
&itemType, &itemHandle, &itemRect
HLock( gDefaul tMi nsH ) :
Set!Text( itemHandle. *gDefaultMinsH );
HUnl ock( gDefaul tMi nsH ) :
break:

/************************************* SaveSettings */
SaveSettings()
I

);

int
i temType:
Rect
itemRect:
Handle itemHandl e:

);
);
);
);
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/*

*

*

*I

Fill the savedSettings data structure with all the current
settings. If the user Cancels, we can restore the data.
GetDitem( gSettingsDialog, TIME_FIELD. &itemType, &itemHandle,
&itemRect >:
Get!Text( itemHandle, &CsavedSettings.timeString) );
GetDitem( gSettingsDialog, SOUND_ON_BOX, &itemType, &itemHandle,
&itemRect );
savedSettings.sound = GetCtlValue( itemHandle );
GetDitem< gSettingsDialog, ICON_ON_BOX, &itemType, &itemHandle,
&itemRect );
savedSettings.icon = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle,
&itemRect );
savedSettings.alert = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, SECS_RADIO. &itemType, &itemHandle,
&itemRect );
savedSettings.secsRadio = GetCtlValue( itemHandle );
GetDitem( gSettingsDialog, MINS_RADIO, &itemType. &itemHandle,
&itemRect );
savedSettings.minsRadio = GetCtlValue( itemHandle );

/************************************* RestoreSettings */

RestoreSettings()
{

int
i temType;
Rect
i temRect;
Handle itemHandle:
/*

*
*

*

*/

Use the information in the savedSettings data structure to
restore the fields in the settings dialog. Usually occurs
as the result of the user hitting the Cancel button.
GetDitem( gSettingsDialog, TIME_FIELD, &itemType. &itemHandle,
&itemRect );
Set!Text( itemHandle, savedSettings.timeString );
GetDitem( gSettingsDialog. SOUND_ON_BOX. &itemType, &itemHandle,
&itemRect );
SetCtlValue( itemHandle, savedSettings.sound >:
GetDitem( gSett i ngsDi a1og. ICON_ON_BOX. &i temType. &itemHandl e.
&itemRect );
SetCtlValue( itemHandle, savedSettings.icon );
GetDitem< gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle,
&itemRect >:
SetCtlValue( itemHandle, savedSettings.alert );
GetDltem( gSettingsDialog, SECS_RADIO. &itemType, &iternHandle,
&itemRect >:
SetCtlValue( itemHandle, savedSettings.secsRadio >:
GetDitem< gSettingsDialog, MINS_RADIO, &itemType. &itemHandle,
&itemRect >:
SetCtlValue( itemHandle, savedSettings.minsRadio );
if
I

savedSettings.secsRadio == ON )
GetDitem( gSettingsDialog, S_OR_M_FIELD, &itemType,
&itemHandle, &itemRect );
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else

Set IT ext ( itemHandl e, "\pseconds" ) ;
GetDitem( gSettingsDialog, S_OR_M_FIELD, &itemType,
&itemHandle. &itemRect );
SetIText( itemHandle, "\pminutes" >:

/********************************

Count Down

*******/

CountDownC numSecs
long numSecs:
I

long
Str255
WindowPtr

I*

I*

*

*

*

*I

I*

myTime, oldTime, difTime;
myTimeString;
countDownWindow:

Load the countDownWindow. set its attributes ... */
countDownWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER.
MOVE_TO_FRONT ) ;
SetPort( countDownWindow );
ShowWindow( countDownWindow >:
TextFace< bold >:
TextSi ze< 24 ) :
Get the time in seconds. Convert countdown time to seconds
if it's in minutes. Finally, turn on the countdown flag,
so the rest of the program knows we're counting ...
GetDateTime( &myTime );
oldTime = myTime:
if ( gSeconds_or_minutes == MINUTES )
numSecs *= SECONDS_PER_MINUTE:
gCounting =TRUE:
The counting event loop ... */
while ( ( numSecs > 0 ) && ( gCounting ) )
(

HandleEvent():
if C gCounting )
I

MoveTo( LEFT, TOP );
GetDateTime( &myTime ):
if ( myTime != oldTime )
I

difTime = myTime - oldTime;
numSecs = numSecs - difTime;
oldTime = myTime:
NumToString( numSecs , myTimeString );
EraseRect ( &CcountDownWindow->portRect) ) :
Drawstring( myTimeString );
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I*

If we haven't canceled, set the notification, turn off
the counting flag. hide the counting window ...
if C gCount i ng )
SetNotification();
gCounting = FALSE:
HideWindow< countDownWindow ):

/********************************

SetNotification

*/

*******/

SetNotification()
I

int
itemType:
Rect
i temRect:
Handle itemHandle:

I*
*
*
*I

If there was already a notification set, remove it,
unlock the notify string.
if
I

I*

gNotify_set )
NMRemoveC &gMyNMRec ):
HUnlock( gNotifyStrH );

Set the various fields of the notification data structure ... */
GetDitem( gSettingsDialog, ICON_ON_BOX. &itemType. &itemHandle,
&itemRect ):
if < GetCtlValue( itemHandle ) )
gMyNMRec.nmSicon = GetResource( "SICN', BASE_RES_ID );
else
gMyNMRec.nmSicon = NIL_POINTER:
GetDitem( gSettingsDialog, SOUND_ON_BOX. &itemType, &itemHandle,
&i temRect ) :
if < GetCtlValueC itemHandle ) )
gMyNMRec. nmSound
GetResource( • snd · BASE RES_ID ) :
else
gMyNMRec.nmSound = NIL_POINTER:
GetDitem( gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle,
&itemRect );
if C GetCtlValueC itemHandle > )
(

I*
*
*
*
*
*I

Since we'll be dereferencing the Handle to a Pointer, we better
lock gNotifyStrH. First, we'll call MoveHHi() to defragment
the heap as much as possible. If we were using the handle as is,
or using the handled data (as a value). we wouldn't need to lock
the handle.
MoveHHi ( gNot i fyStrH ) :
Hlock( gNotifyStrH >:
gMyNMRec.nmStr
*gNotifyStrH:
I

else

I*

*
*

*I

gMyNMRec.nmStr = NIL_POINTER;

Install the notification on the notification queue, enable the
"Kill Notification" item, turn on the notification flag.
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NMinstall( &gMyNMRec );
Enableltem( gFileMenu, KILL_ITEM );
gNotify_set = TRUE;

Chapter 7, WindowMaker.c
/ldefine
I/define
#define
I/define

BASE_RES_ID
NI L_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

400
OL
-ll
0

#define APPLE_MENU_ID
//define FILE_MENU_ID

400
401

/ldefine ABOUT_ITEM
/ldefine ABOUT_ALERT
I/define ERROR_ALERT_ ID

1
400
401

I/define
#define
#define
//define

NO_MBAR
NO_MENU
NO_PICTURE
NO_WIND

BASE_RES_ID
BASE_RES_ID+l
BASE_RES_ID+2
BASE_RES_ID+3

//define NEW_ ITEM
//define CLOSE_ITEM
//define QUIT_ITEM

1
2
3

I/define DRAG_ THRESHOLD

30

//define WINDOW_HOME_LEFT
I/define WINDOW_HOME_TOP
//define NEW_WINDOW_OFFSET

5
45

//define MIN_SLEEP
//define NIL_MOUSE_REGION

OL
OL

#define LEAVE_WHERE_IT_IS

FALSE

/ldefi ne WNE_TRAP_NUM
//define UNIMPL_TRAP_NUM

Ox60
Ox9F

20

#define NIL_STRING
"\p"
#define HOPELESSLY_FATAL_ERROR
Boolean
Event Record
MenuHandle
PicHandle
Re ct
int

"\pGame over, man!"

gDone, gWNEimplemented;
gTheEvent;
gAppleMenu:
gMyPicture:
gDragRect;
gNewWindowleft = WINDOW_HOME_LEFT,
gNewWindowTop = WINDOW_HOME_TOP;
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/******************************** main *********/

main()
I

ToolBoxlnit():
MenuBarlnit():
LoadPicture();
SetUpDragRect ():
Mainloop();

/*********************************** ToolBoxlnit */

ToolBoxlnit()
{

InitGraf( &thePort >:
I nit Fonts ():
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindowsC):
InitMenus<):
TEinit(}:
lnitDialogs( NIL_POINTER >:
InitCursor();

!*********************************** MenuBarlnit

*/

MenuBarlnit()
I

Handle

I*

*
*
*
*
*
*
*

*I

myMenuBar:

This is an example of error handling in a Macintosh program.
If you want to write an application for public consumption,
you must do error handling. The question is, how much is
enough? The answer: you should feel pretty certain that a
user will never get the dreaded bomb box. Even if your
application reaches a point of no return, you should at the
least put up a fatal error alert. then exit to the Finder.
if ( ( myMenuBar = GetNewMBar( BASE_RES_ID ) )
NIL_POINTER
ErrorHandler( NO_MBAR >:
SetMenuBar( myMenuBar ):
if ( ( gAppleMenu = GetMHandleC APPLE_MENU_ID ) ) == NIL_POINTER )
ErrorHandlerC NO_MENU );
AddResMenu( gAppleMenu. 'DRVR' >:
DrawMenuBarC>:

/******************************** LoadPicture *********/

LoadPicture()
{

I*

*
*

*I

Functions that return error codes are great candidates
for error checking!
if ( ( gMyPicture = GetPicture( BASE_RES_ID ) )
ErrorHandlerC NO_PICTURE );

==

NIL_POINTER )
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!******************************** SetUpDragRect *********/

SetUpDragRect()
I

gDragRect = screenBits.bounds;
gDragRect.left += DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD:
gDragRect.bottom -= DRAG_THRESHOLD;

/******************************** MainLoop *********/

MainLoop()
{

gOone = FALSE;
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) );
while ( gDone == FALSE )
{

HandleEvent();

/************************************* HandleEvent

*/

HandleEvent()
I

char

theCha r:

if ( gWNEimplemented )
WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
else
I

SystemTask();
GetNextEvent( everyEvent, &gTheEvent );

switch C gTheEvent.what )
I

case mouseDown:
HandleMouseDown();
break;
case keyDown:
case autoKey:
theChar = gTheEvent.message & charCodeMask:
if (( gTheEvent.modifiers & cmdKey ) != 0)
HandleMenuChoice( MenuKey( theChar ) );
break;
case updateEvt:
BeginUpdate( gTheEvent.message );
DrawMyPictureC gMyPicture, gTheEvent.message );
EndUpdate( gTheEvent.message );
break;

463

Appendix B: Code Listings
/************************************* HandleMouseDown */

HandleMouseDown()
I

WindowPtr
short int
long int

whichWindow;
thePart;
menuChoice, windSize;

thePart = FindWindow( gTheEvent.where, &whichWindow );
switch < thePart )
{

case inMenuBar:
menuChoice = MenuSelectC gTheEvent.where );
HandleMenuChoice( menuChoice );
break;
case inSysWindow:
SystemClick( &gTheEvent, whichWindow );
break;
case inDrag:
DragWindow( whichWindow, gTheEvent.where, &gDragRect);
break;
case inGoAway:
I*

*
*

*
*
*
*

In previous programs, we've used the goAway box to exit the
application. This was evil and incorrect! The goAway box is
a signal to close the window and should behave just as if the
user selected Close from the File menu. We'll use
DisposeWindow() to close the window and free up the memory used
by the window.

*I

DisposeWindow( whichWindow );
break;

/************************************* HandleMenuChoice */

HandleMenuChoice( menuChoice
long int
menuChoice:
I

int
int
if
I

theMenu:
the Item:
menuChoice != 0

>

theMenu = HiWord( menuChoice );
theltem = LoWord( menuChoice );
switch ( theMenu )
I

case APPLE_MENU_ID :
HandleAppleChoice( theltem );
break:
case FILE_MENU_ID :
HandleFileChoice( theltem );
break;

}

HiliteMenu( 0 );
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/********************************

HandleAppleChoice

*******/

HandleAppleChoice( theitem )
int
the Item:
I

Str255
int

accName:
accNumber:

switch
I

theltem )
case ABOUT_ITEM :
NoteAlert( ABOUT_ALERT, NIL_POINTER );
break:
default :
GetitemC gAppleMenu. theltem. accName >:
accNumber = OpenDeskAcc< accName );
break:

/********************************

HandleFileChoice

*******/

HandleFileChoiceC theltem )
int
the Item:
I

WindowPtr
whichWindow:
switch < theltem )
I

I*

case NEW_ITEM :
CreateWindow<):
break:
case CLOSE_ITEM :
if ( ( whichWindow = FrontWindow() ) != NIL_POINTER
DisposeWindow( whichWindow );
break;
case OUIT_ITEM :
This is the corect time to exit the application! */
gDone = TRUE:
break:

!************************************ CreateWindow

*/

CreateWindow()
I

WindowPtr

theNewestWindow:

/*

*
*

*
*
*

*
*

*I

One of the most important features of this application is its
ability to create a large number of windows, limited only
by the memory available on the machine. We put up an error
message if we can't allocate enough memory to open the window.
Your application may want to put up an Alert, but allow the
user to continue. The true test of your application us. how
well it performs under stress.
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if ( ( theNewestWindow = GetNewWindowC BASE_RES_ID. NIL_POINTER.
MOVE_TO_FRONT ) ) == NIL_POINTER
ErrorHandler< NO_WIND );
I*

*
*

*

*!

New windows are created down and to the right by NEW_WINDOW_OFFSET
pixels. If the new window will be created too close to the edge
of the screen, move back to the upper left ...
if (((screenBits.bounds.right-gNewWindowleft) < DRAG_THRESHOLD) I I
((screenBits.bounds.bottom-gNewWindowTop) < DRAG_THRESHOLD))
gNewWindowleft = WINDOW_HOME_LEFT:
gNewWindowTop = WINDOW_HOME_TOP:
MoveWindowC theNewestWindow, gNewWindowLeft. gNewWindowTop,
LEAVE_WHERE_IT_IS ):
gNewWindowleft += NEW_WINDOW_OFFSET:
gNewWindowTop += NEW_WINDOW_OFFSET:
ShowWindow( theNewestWindow );

/******************************** DrawMyPicture *********/
DrawMyPicture( thePicture, pictureWindow
PicHandle
thePicture:
WindowPtr
pictureWindow;
I

Rect

myRect:

myRect = pictureWindow->portRect;
CenterPictC thePicture, &myRect >:
SetPortC pictureWindow ):
DrawPicture( thePicture. &myRect ):

!******************************** CenterPict *********/
CenterPict( thePicture. myRectPtr
thePicture:
PicHandle
Rect
*myRectPtr;
I

Rect

windRect, pictureRect:

windRect = *myRectPtr:
pictureRect = (**( thePicture )).picFrame:
myRectPtr->top = CwindRect.bottom - windRect.top CpictureRect.bottom - pictureRect.top))/ 2
windRect.top;
myRectPtr->bottom = myRectPtr->top +
CpictureRect.bottom - pictureRect.top);
myRectPtr->left = CwindRect.right - windRect.left CpictureRect.right - pictureRect.left))/ 2 +
wi ndRect. 1eft:
myRectPtr->right = myRectPtr->left + (pictureRect.right pictureRect.left);

+
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/******************************** ErrorHandler *********/
ErrorHandl er( stri ngNum )
int
stringNum:
I

StringHandle

/*

errorStringH:

Load the error message from the resource fork. Use ParamText()
to make it the first parameter. This will replace "AO" in a
text item of a dialog box. If we couldn't get the string, we're
in deep trouble, so we put up the HOPELESSLY_FATAL_ERROR ...

*

*

*
*

*I

if

errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING,
NIL_STRING );

else
I

HLock( errorStringH ):
ParamText( *errorStringH, NIL_STRING, NIL_STRING,
NIL_STRING );
HUnlockC errorStringH ) :

I

I*

StopAlert( ERROR_ALERT_ID, NIL_POINTER );
ExitToShell() returns to the calling program immediately.
ExitToShell <):

Chapter 7, ShowClip.c
#define
#define
#define
#define

BASE_RES_ID
NIL_POINTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS

/tdef i ne ERROR_ALERT_ID
#define NO_WIND
#define EMPTY_SCRAP

400

OL

-ll
0

BASE_RES_ID
BASE_RES_ID
BASE_RES_ID+l

#define NIL_STRING
#define HOPELESSLY_FATAL_ERROR
WindowPtr

"\p"

"\pGame over, man!"

gClipWindow:

/******************************** main *********/
main()
I

ToolBoxlnit():
Windowlnit():
Mainloop():

*/

Appendix B: Code Listings
/******************************** ToolBoxlnit *********/

Tool Boxlnit()
I

lnitGraf( &thePort ) :
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor():

/******************************** Windowlnit *********/

Windowlnit()
I

if ( ( gClipWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER,
MOVE_TO_FRONT ) ) == NIL_POINTER )
ErrorHandler( NO_WIND );
ShowWindow( gClipWindow );
SetPort( gClipWindow ):

/******************************** Mainloop *********/

Mainloop()
I

Re ct
Handle
1ong int
clipHandle

I*

*
*

*
*

*I

myRect;
clipHandle:
1ength, offset:
NewHandle( 0 ):

GetScrap() resizes clipHandle to hold the scrap data of the
specified type. While TEXT and PICT are the primary types, you
can design your own scrap type or use other folks' types, but
if you do, you better know what's at the other end of the handle.
if ( ( length= GetScrapC clipHandle, 'TEXT'. &offset ) ) < O
I

if (( length= GetScrapC clipHandle, 'PICT' .&offset )) < 0 )
ErrorHandler( EMPTY_SCRAP );
else
I

myRect = gClipWindow->portRect;
CenterPictC clipHandle, &myRect >:
DrawPicture( clipHandle, &myRect ):

I

else
I
/*

*
*

*I

HLock( clipHandle ):

We used TextBox() to draw the text in the current port {that's
why we used the OuickDraw global thePort), left justified.
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TextBox( *clipHandle, length. &CthePort->portRect),
teJustLeft );
HUnlock( clipHandle );
while ( !Button() ) ;

/******************************** CenterPict *********/
CenterPict( thePicture, myRectPtr
PicHandle
thePicture;
Rect
*myRectPtr;
I

Rect

wi ndRect, pi ctureRect;

windRect = *myRectPtr:
pictureRect = (**( thePicture )).picFrame:
myRectPtr->top = (windRect.bottom - windRect.top CpictureRect.bottom - pictureRect.top))/ 2 +
windRect.top;
myRectPtr->bottom = myRectPtr->top +
(pictureRect.bottom - pictureRect.top);
myRectPtr->left = CwindRect.right - windRect.left CpictureRect.right - pictureRect.left))/ 2 +
windRect.left:
myRectPtr->right = myRectPtr->left + CpictureRect.right pictureRect.left);

/******************************** ErrorHandler *********/
ErrorHandlerC stringNum )
int
stringNum;
I

StringHandle
if C
else
I

I

errorStringH;

errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamTextC HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING,
NIL_STRING ):
HLockC errorStri ngH ) ;
ParamText( *errorStringH, NIL_STRING, NIL_STRING,
NIL_STRING );
HUnlock( errorStringH ) ;

StopAlert( ERROR_ALERT_ID, NIL_POINTER );
ExitToShell();
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Chapter 7, PrintPICT.c
I*

Notice the #include of "PrintMgr.h". LightspeedC will not
*
automatically include this one for you.
*
*I
#include "PrintMgr.h"
#define
#define
#define
//define

HEADER_SIZE
NIL_POINTER
BASE_RES_ID
REMOVE_ALL_EVENTS

512
OL
400

//define
#define
#define
//define
//define
//define
//define

ERROR_ALERT_ID
CANT_OPEN_FILE
GET_EOF _ERROR
HEADER_TOO_SMALL
OUT_OF_MEMORY
CANT_READ_HEADER
CANT_READ_PICT

BASE_RES_ID
BASE_RES_ID
BASE_RES_ID+ 1
BASE_RES_ID+2
BASE_RES_ID+3
BASE_RES_ID+4
BASE_RES_ID+5

#define NIL_PRPORT
//define NI L_IOBUFFER
#define NIL_DEVBUF
#define
#define
#define
#define
#define
#define

0

NIL_POINTER
NIL_POINTER
NI L_PO INTER

NIL_STRING
IGNOREO_STRING
NIL_FILE_FILTER
NIL_DIALOG_HOOK
DONT_SCALE_OUTPUT
HOPELESSLY_FATAL_ERROR

"\p"

NI L_STRING
NIL_POINTER
NIL_POINTER
NI L_POINTER
"\pGame over. man!"

DoDialogs();
gPrintRecordH:

Boolean
THPrint

/******************************** main *********/

main()
I

SFReply

reply:

ToolBoxlnit():
Printlnit();
· GetFileNameC &reply ):
if ( reply.good )
/* The User didn't hit Cancel
I
if

I

*/

DoDialogs() ) /* Again, the User didn't hit Cancel
PrintPictFile( &reply>:

*/
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/*********************************** ToolBoxlnit */
ToolBoxlnit()
I

InitGraf{ &thePort ) ;
Initfonts();
Fl ushEvents( everyEvent, REMOVE_ALL_EVENTS ) :
In it Wi ndow s ( ) ;
I nitMenus ();
TEinit();
InitDialogs( NIL_POINTER );
Ini tCursor();

/********************************

~rintlnit

*********/

Pri ntinit()
I
/*

*

*

*I

Allocate a new print record, open the chosen printer driver and
load the default values from the printer resource file ...
gPrintRecordH = CTHPrint)NewHandle( sizeof( TPrint ) );
PrOpen():
PrintDefault( gPrintRecordH ) ;

/********************************

GetFileName

*******/

GetFileName( replyPtr )
SFReply
*replyPtr:
{

Point
SFTypel i st
int
I*

*
*

*

*I

myPoint:
typelist:
numTypes:

Prompt the user to open a file of type 'PICT', putting the dialog
myPoint. IGNORED STRING is a prompt parameter that is ignored
by SFGetFile().
myPoint.h = 100;
my Point. v = 100:
typeList[ 0 ] = 'PICT';
numTypes = 1;
SFGetFil e( my Point, I GNORED_STRI NG, NI L_FI LE_F IL TER, numTypes,
&typelist, NIL_DIALOG_HOOK, replyPtr ):

/********************************

DoDialogs

*******/

Boolean DoDialogs()
I
/*

*
*
*
*

PrStlDialog() puts up the standard Page Setup dialog box,
recording the changes in the print record handled by
gPrintRecordH. PrJobDialog() puts up the print job dialog box,
letting the user set things like number of copies, page ranges,
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*
*
*

*I

etc., depending on the printer type. PrJobDialog() will return
TRUE if the user wants to continue with the print (didn't
hit the Cancel button).
Pr St lDi al og( gPri ntRecordH ) :
return< PrJobOialog( gPrintRecordH ) );

/********************************

PrintPictFile *******/

PrintPictFile( replyPtr )
SFReply
*replyPtr:
I

int
TPPrPort
TPrStatus
PicHandle
char
long

srcFile;
printPort:
printStatus:
thePict;
pictHeader[ HEADER_SIZE ]:
pictSize, headerSize:

/*

*
*
*
*
*I

FSOpen() opens the PICT file. GetEOF() sets pictSize to the
size of the file. FSRead() attempts to read the 512 byte header
that describes the rest of the file. Once the header is read,
we're ready to read the rest of the picture in.
if ( FSOpen( (*replyPtr).fName, (*replyPtr).vRefNum, &srcFile )
!= noErr )
ErrorHandler( CANT_OPEN_FILE );
if ( GetEOF< srcFile, &pictSize ) != noErr
ErrorHandler( GET_EOF_ERROR );
headerSize = HEADER_SIZE:
if ( FSRead( srcFile, &headerSize, pictHeader
ErrorHandler( CANT_READ_HEADER );

!= noErr )

/*

*
*
*

*

*I

Make sure there were at least HEADER_SIZE bytes in the file. If
not, exit via ErrorHandler(). We won't use the header info in
this program, so we'll adjust pictSize to the size of the picture
without the header.
if ( ( pictSize -= HEADER_SIZE ) <= 0 )
{

ErrorHandler( HEADER_TOO_SMALL );
/*

Allocate enough memory for the picture ... */
if < ( thePict = (PicHandle)NewHandleC pictSize ) )
== NIL_POINTER )
ErrorHandler( OUT_OF_MEMORY ):

/*

Lock the picHandle. since we'll need to dereference it to a
Pointer to use in the call to FSRead(). */
Hlock( the Pi ct ) :

I*

Read in the Picture, and close the file ...

*/
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if ( FSRead( srcFile, &pictSize, *thePict
ErrorHandler( CANT_READ_PICT );

!= noErr )

FSClose( srcFile );
/*

*
*

*

*I

Open a new print document, and a new page within that doc.
Draw the picture on the print page, close the page, and close
the doc. Finally, print the print doc. Wasn't that easy!!!
printPort = PrOpenDoc( gPrintRecordH, NIL_POINTER, NIL_POINTER );
PrOpenPage( printPort, DONT_SCALE_OUTPUT );
DrawPicture< thePict, &(**( thePict )).picFrame );
PrCl osePage( pri ntPort ) :
PrCloseDoc( printPort ):
PrPicFile( gPrintRecordH, NIL_PRPORT, NIL_IOBUFFER, NIL_DEVBUF,
&pri ntStatus ) :

!******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum:
{

StringHandle
if

C

else
I

errorStringH;

errorStringH = GetString{ stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING,
NIL_STRING );
Hlock( errorStringH );
ParamText( *errorStringH, NIL_STRING, NIL_STRING,
NIL_STRING ) :
HUnlock( errorStringH );

)

StopAlert( ERROR_ALERT_ID, NIL_POINTER );
ExitToShel l ():

Chapter 7, Pager.c
//define
//define
//define
#define
#define
#define
//define

BASE_RES_ID
NI L_PO INTER
MOVE_TO_FRONT
REMOVE_ALL_EVENTS
SCROLL_BAR_PIXELS
DRAG_THRESHOLD
NI L_ACT ION_PROC

400

OL

-ll

0
16
30
NIL - POINTER

//define MIN_SLEEP
//define NIL_MOUSE_REGION

OL
OL

#define WNE_TRAP_NUM
#define UNIMPL_TRAP_NUM

Ox60
Ox9F
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#define
#define
#define
#define

BASE_RES_ID
BASE_RES_ID
BASE_RES_ID+l
BASE_RES_ID+2

ERROR_ALERT_ID
NO_WIND
NO_PICTS
CANT_LOAD_PICT

#define NIL_STRING
#define NIL_TITLE
/Ide f i ne VI SI BLE
#define START_VALUE
#define MIN_VALUE
#define NIL_REF_CON
#define HOPELESSLY_FATAL_ERROR
WindowPtr
Control Handle
Boolean
Event Record
Re ct
pascal void

"\p"

NIL_STRING
TRUE
1
1

NI L_PO INTER
"\pGame over, man!"

gPictWindow:
gScrollBarHandle;
gDone, gWNEimplemented;
gTheEvent;
gDragRect;
Scroll Proc():

!******************************** main *********/

main ( )
(

ToolBoxlnit();
Windowlnit();
SetUpDragRect ();
SetUpScrollBar();
Mainloop();

/*********************************** ToolBoxlnit */

ToolBoxlnit()
(

InitGraf ( &thePort ) :
InitFonts();
FlushEvents( everyEvent, REMOVE_ALL_EVENTS );
InitWindows();
InitMenus();
TEinit();
InitDialogs( NIL_POINTER );
InitCursor<):

/******************************** Windowlnit *********/

Windowlnit()
I

if ( ( gPictWindow

GetNewWindow( BASE_RES_ID, NIL_POINTER.
MOVE_TO_FRONT ) ) == NIL_POINTER )
ErrorHandler( NO_WIND );
SelectWindow( gPictWindow );
ShowWindow( gPictWindow );
SetPort( gPictWindow );
~
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/******************************** SetUpDragRect *********/

SetUpDragRect()
I

gDragRect = screenBits.bounds;
gOragRect.left += DRAG_THRESHOLD;
gDragRect.right -= DRAG_THRESHOLD;
gDragRect.bottom -= DRAG_THRESHOLD:

/**********************************

SetUpScrollBar *******/

SetUpScrollBar()
I

Rect
int

I*
*

*
*

*

vScrollRect;
numPictures;

Find out how many PICT resources are available. Remember.
will be available from any open resource files,
including the System file and the application·s resource
fork.
re~ources

*/
I*

I*

if C < numPictures = CountResources( 'PICT'))<= 0)
ErrorHandler( NO_PICTS );
Set up the scroll bar Rect. Make it fit within the window */
vScrollRect = gPictWindow->portRect:
vScrollRect.top -= l;
vScrollRect.bottom +=l;
vScrollRect.left = vScrollRect.right-SCROLL_BAR_PIXELS+l;
vScrollRect.right += 1:
Create a new scroll bar with NewControl () */
gScrollBarHandle = NewControl( gPictWindow, &vScrollRect.
NIL_TITLE, VISIBLE, START_VALUE, MIN_VALUE.
numPictures. scrollBarProc, NIL_REF_CON);

/******************************** Mainloop *********/

Mai hloop()
I

gDone = FALSE;
gWNEimplemented = C NGetTrapAddressC WNE_TRAP_NUM, ToolTrap ) !=
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) );
while ( gDone == FALSE )
I

HandleEvent();

/************************************* HandleEvent

*/

HandleEvent()
I

if ( gWNEimplemented )
WaitNextEventC everyEvent. &gTheEvent, MIN_SLEEP,
NIL_MOUSE_REGION );
else
I
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Systemlask();
GetNextEvent( everyEvent, &glheEvent );
switch ( gTheEvent.what )
I

case mouseDown:
HandleMouseDown();
break;
case updateEvt:
/*

*
*

DrawControls() draws all the controls currently visible in the
specified window. We then update the window contents.

*I

Beg i nUpdate < gTheEvent. message ) ;
DrawControls< gTheEvent.message );
UpdateMyWindow( gTheEvent.message );
EndUpdate( gTheEvent.message );
break;

/************************************* HandleMouseDown */

HandleMouseDown()
I

WindowPtr
whichWindow;
short int
thePart;
Point
thePoint;
Control Handle theControl;
thePart = FindWindow( gTheEvent.where. &whichWindow );
switch ( thePart )
I

case inSysWindow :
SystemClick( &gTheEvent, whichWindow ):
break;
case i nDrag :
DragWi ndow( wh i chWi ndow, gTheEvent. where. &gOragRect);
break;
case inContent:

/*

*
*

FindControl () is very similar to FindWindow() in that it
determines which control. if any, thePoint was found in ...

*/

thePoint = gTheEvent.where;
GlobalToLocal( &CthePoint) );
thePart = FindControl( thePoint. whichWindow,
&theControl ) :
if
theControl == gScrollBarHandle )
I
I*

*
*
*
*
*
*
*
*

*I

If thePoint was in our control, find out if it was in the thumb.
If it was. call TrackControl() to drag an outline of the thumb up
and down (in this case) the scroll bar. ~~hen the thumb is
released, update the window using the new control value. If any
other part of the control was used, call TrackControl() with a
pointer to ScrollProc(), since we may need to scroll before
the user releases the mouse button (for example, if they click
in the scroll bar arrows.
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if

thePart == inThumb )

{

thePart = TrackControl( theControl,
thePoint, NIL_ACTION_PROC );
UpdateMyWindow( whichWindow ):
I

else
I

thePart

TrackControl( theControl,
the Point, &Scro 11 Proc ) :
UpdateMyWindow( whichWindow );
=

I

break:
case inGoAway
gDone = TRUE:
break:

/**********************************

ScrollProc

*******/

pascal void ScrollProc(theControl, theCode)
Control Handle theControl:
int
theCode:
I

int

I*

*
*
*

*
*

*I

curControlValue, maxControlValue, minControlValue;

Get the min, max. and current values of the scroll bar. If the
page down or down button areas were pressed, increase the value
of the control. If the page up or up button areas were pressed,
decrease the value of the control. Finally, update the control
to this new value with SetCtlValue() ...
maxControlValue
curControlValue
minControlValue

Get Ct l Max ( theContro l ) :
GetCtlValue( theControl >:
GetCtlMin( theControl >:

switch ( theCode

>

{

case inPageDown:
case inDownButton:
if ( curControlValue < maxControlValue
I

curControlValue += 1:

I

break:
case inPageUp:
case inUpButton:
if ( curControlValue > minControlValue
I
I

curControlValue -= 1:

SetCtlValue( theControl, curControlValue >:
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/**********************************

UpdateMyWindow *******/

UpdateMyWindowC drawingWindow )
WindowPtr
drawingWindow:
I

PicHandle
Re ct
RgnHandle

currentPicture:
drawi ngCl i pRect. myRect:
tempRgn;

/*

*
*
*

*
*

*I

UpdateMyWindow() works in a similar fashion to the DrawPicture()
routine in EventTutor <Chapter 4). Basically, we temporarily
reset the windows clipping region to not include the area covered
by the scroll bar. We center the picture, draw it, and reset the
original clip region.
tempRgn = NewRgn():
GetClip( tempRgn >:
myRect = drawingWindow->portRect:
myRect.right -= SCROLL_BAR_PIXELS:
EraseRect( &myRect >:
currentPicture

=

(PicHandle)GetlndResource( 'PICT'.
GetCtlValue( gScrollBarHandle ) >:

if ( currentPicture == NIL_POINTER )
ErrorHandler( CANT_LOAD_PICT );
CenterPict( currentPicture, &myRect >:
drawingClipRect = drawingWindow->portRect:
drawingClipRect.right -= SCROLL_BAR_PIXELS:
Cl i pRect( &drawi ngCl i pRect ) :
DrawPicture( currentPicture, &myRect );
Set Clip ( tempRgn ) :
DisposeRgnC tempRgn );

/******************************** CenterPict *********/
CenterPictC thePicture, myRectPtr
PicHandle
thePicture:
Rect
*myRectPtr:
I

Rect

wi ndRect. pi ctureRect:

windRect = *myRectPtr:
pictureRect = (**( thePicture )).picFrame;
myRectPtr->top = CwindRect.bottom - windRect.top CpictureRect.bottom - pictureRect.top))/ 2 +
windRect.top;
myRectPtr->bottom = myRectPtr->top +
(pictureRect.bottom - pictureRect.top);
myRectPtr->left = (windRect.right - windRect.left CpictureRect.right - pictureRect.left))/ 2 +
wi ndRect. 1ef t:
myRectPtr->right = myRectPtr->left + (pictureRect.right pictureRect.left);
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!******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum;
{

StringHandle
if (
else

errorStringH;

errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR. NIL_STRING, NIL_STRING,
NIL_STRING );

{

Hlock( errorStri ngH ) :
ParamText( *errorStringH, NIL_STRING, NIL_STRING.
NIL_STRING );
HUnl ock( errorStri ngH ) ;
}

StopAlert( ERROR_ALERT_ID, NIL_POINTER );
ExitToShel l <);

Chapter 7, Sounder.c
#define
//define
//define
//define
//define

NIL_POINTER
BASE_RES_ID
REMOVE_ALL_EVENTS
NI L_SOUNO_CHANNEL
SYNCHRONOUS

//define ERROR_ALERT_ID
/fdefi ne CANT_LOAD_BEEP _SNO
//defineCANT_LOAO_MONKEY_SNO
//define CANT_LOAO_KLANK_SND
//defineCANT_LOAD_BOING_SND

DL
400
0

NIL_POINTER
FALSE

BASE_RES_ID
BASE_RES_ID
BASE_RES_ID+l
BASE_RES_I0+2
BASE_RES_ID+3

//define NIL_STRING
"\p"
//defineHOPELESSLY_FATAL_ERROR"\pGame over. man!"
//define BEEP _SNO
/ldefi ne MONKEY _SND
/fdefi ne KLANK_SNO
/ldefi ne BO I NG_SND

1
2
3

4

/******************************** main *********/
main ( )
I

Tool Box I nit();
Ma keSound ();

/*********************************** ToolBoxlnit */
ToolBoxlnit()
I

InitGraf( &thePort );
InitFontsC):
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Fl ushEvents ( everyEvent. REMOVE_ALL_EVENTS ) :
I nitWi ndows ():
InitMenus();
TEinit();
InitDialogs( NIL_POINTER ) :
lnitCursor():

/******************************** MakeSound *********/
MakeSound()
I

Handle soundHandl e:

/*

*
*
*
*
*
*

*I

The key to this program is the sound routine SndPlay(). We
are loading the 'snd · resources normally found in the system
file. Since the Mac System file didn't always have these 'snd •
resources, older systems may cause the error messages to appear.
Check out the Sound Manager (Chapter 27) in Volume V for more
detail ...
if ( ( soundHandl e = GetResource( · snd ·• BEEP _SND )
== NIL_POINTER )
ErrorHandler( CANT_LOAO_BEEP_SND );
SndPl ay( NI L_SOUND_CHANNEL. soundHandl e. SYNCHRONOUS ) ;
if< ( soundHandle

=

GetResource( 'snd •. MONKEY_SND ) )
== NI L_POI NTER )
ErrorHandler( CANT_LOAO_MONKEY_SND ):
SndPl ay ( NIL_SOUND_CHANNEL. soundHandl e, SYNCHRONOUS ) ;
if ( ( soundHandle

=

if<< soundHandle

=

GetResource( 'snd ·. KLANK_SND))
== NIL_POINTER )
ErrorHandler( CANT_LOAD_KLANK_SND );
SndPl ay( NIL_SOUND_CHANNEL. soundHandl e. SYNCHRONOUS ) ;
GetResource( 'snd ·. BOING_SND))
== NIL_POINTER )
ErrorHand 1er ( CANT _LOAD_BO I NG_SND ) ;
SndPl ay( NI L_SOUND_CHANNEL. soundHandl e. SYNCHRONOUS ) ;

/******************************** ErrorHandler *********/
ErrorHandler( stringNum )
int
stringNum:
I

StringHandle
if (
else
I

I

errorStringH;

errorStringH = GetString( stringNum ) ) == NIL_POINTER )
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING,
NIL_STRING );
Hlock( errorStringH );
ParamText( *errorStringH, NIL_STRING, NIL_STRING,
NIL_STRING ) ;
HUnlock( errorStringH );

StopAlert( ERROR_ALERT_ID. NIL_POINTER );
ExitToShell ():

AppendixC

THINKC
Command
Summary
This appendix summarizes some of the
basic operations of THINK C, Version 3.0

C Is a simple but powerful programming environment. This appendix
provides an overview of its operations.

THINK

The Project Menu
THINK C keeps track of all of the library files and code files that you are using in
a Project file. To create a project, select New Project from the Project menu, and
type in a project name. (Create a folder for your project first to keep your files
together.) To open an existing project, use Open Project. Ifyou have a project open,
and you want to look at another project, use Close Project. If you choose Close &
Compact, the project file will be compressed. This makes it smaller, but means
that it takes longer to open. The Set Project Type ••• menu item brings up a dialog
box, which allows you to define the kind of project that you want to have (Figure
C.1). There are four types of projects: applications, desk accessories, device drivers
and code resources.
APPLICATIONS
Normally, the first radio button should be clicked on, as standalone applications are
usually what you'll be building in THINK C. You can key in the File Type and
Creator for your application. The default for the File Type is APPL: your applications should use this. Other types of projects may have other File Types. In the
Primer, we have been selecting the Creator name using ResEdit. You can do it here
instead.

® Rpplication
O Desk Rccessory
O Deuice Driuer
O Code Resource

File Type
Creator

IRPPL
IRIMI

D Separate STRS

Partition (K) ~
MF Rttrs

((

OK

J)

~

I0000 I
(

Figure C.1 Project Type dialog box.

482

Cancel

J

483

Appendix C: THINK C Command Summary

The Project Type dialog box also lets you select the level of MultiFinder
friendliness that you intend your application to have (Figure C.2).
The pop-up menu allows you to set three flags. MultiFinder Aware means that
your application will conform to Apple's MultiFinder guidelines. This means that
your application will respond properly to suspend/resume events. Background
Null Events means that your program will get null events when it is running in the
background, and Suspend and Resume Events means that your program will get
suspend/resume events as well as the normal activate/deactivate events. The
MultiFinder flags may also be keyed in hex in the field to the right.

Early versions of THINK C 3.0 had a bug where the Suspend and Resume
Events and the MultiFinder Aware flags were swapped. To check for this
problem, examine the SI ZE resource in your THINK C-created application.
All MultiFinder options are currently stored in the SI ZE resource, and may
be easily changed in ResEdit.

In the Partition field, you can key in the preferred amounts of RAM that your
application will need in MultiFinder. If the Separate STRS check box is checked,
THINK C will place string literals and floating point constants in a ST Rff resource
instead of a DAT A resource. Do this if you think you'll have more than 32K worth of
string literals or floating point constants.

® Application
O Desk Accessory
0 Oeuice Driuer

File Type

O Code

0

Resource
Partition (K)

Y"'Background Null Euents
Y"'Suspend & Resume Euents

Creator

IAPPL
lf'''"I

Separate STRS

~

lseoo I
(

Cancel

Figure C.2 MultiFinder flags pop up menu.

)
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DESK ACCESSORIES AND DEVICE DRIVERS
If your project is a desk accessory, or a device driver (like a printer driver), your
dialog box is somewhat different (Figure C.3).
Both desk accessories and device drivers have the same fields; desk accessories
have a default File Type and Creator of DFI L and OMO V. The Multi-Segment
check box allows you to have up to 31 segments on your device driver or desk
accessory.
The Name field contains the name of the desk accessory or device driver
resource. THINK C will add a null byte to the beginning of your desk accessory (a
convention). It will also place a period before the device driver name if you don't put
one there.
The Type ofresource created is defaulted to DR VRfor both kinds of projects. The
ID of the resource for desk accessories is defaulted to 12. The Font DIA Mover will
handle ID number conflicts, so this number need not be changed.

CODE RESOURCE
THINK C allows you to build C0 DE resources. This comes in really handy for
building I NIT s, WDEF s and c de vs. The code resource project type has the same
basic fields as the desk accessories. If the Custom Header check box is unchecked,
THINK C builds a 16-byte header for your C0 DE resource that places the address
ofyour resource into register AO and branches to your ma i n ( ) function. The At tr s
field allows you to select the standard resource attributes for your code resource.
You can also use ResEdit to set these flags.

O Application
® Desk Accessory
0 Oeuice Driuer

File Type

IOF IL

Creator

IDMOU

O Code Resource

D Multi-Segment

Name 11
Type

(

lonun
OK

I

ID _11_2_ _

)

((

Cancel

]

Figure C.3 Desk Accessories/Device Drivers dialog box.
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MORE ON THE PROJECT MENU

The next few menu items on the Project menu are Remove Objects, Bring up to
Date and Check Link.
Remove Objects will remove object code for all files in your project. Be sure to
do this for all your projects built with older versions of THINK C. By removing all
the objects from a project, you are dramatically reducing the size ofthe project (until
you put the objects back in) and you are also ensuring that your project uses the
current version of all your link libraries (like MacTraps). Bring Up to Date
compiles source code and loads library files thathaven,t been compiled or loaded yet.
Check Link checks the link-worthiness of your project without running it.
Build Library takes the current project and saves it as a binary library, so it
can be used by other projects. Build Application ••• (or Desk Accessory, Device
Driver, or Code Resource) saves the project as a standalone application (or desk
accessory, device driver, or C0 DE resource), depending on the project type chosen.
Ifyou set the Use Debugger flag, the debugger will automatically run when you
run your application (in MultiFinder). The final menu item, Run, runs your
application. If you run your application under MultiFinder, THINK C runs your
application as a separate entity.

The File Menu
Once you've created your project, you're ready to type in your source code. THINK
Chas a number of formatting facilities that should save you some time. Most of the
options in the File menu are self-explanatory (Figure C.4).

New
XN
Open...
XO
Open Selection XO
Close
Saue
XS
Saue Rs .••
Soue R Copy As •.•
Reuert
Page Setup •••
Print •••
Transfer •••
Quit

XQ

Figure C.4 THINK C's File menu.
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To create a new file, select New. To open an existing file, choose Open. You can
also open a file by double-clicking its name in the Project window. If a file name is
highlighted in an edit window, Open Selection will open the file. Close will close
your file; you are prompted to save or discard your changes if any have been made.
Save will save the current file you're working on. Save As will save your current
file under a new name and change the name in the Project window. Save A Copy
As will save your current file under a different name and use the original file.
Revert will return the current file to the saved version of that file. Print Setup
puts up the standard Print Setup dialog box to choose printing options. Print prints
your current file with the name, date, time and page number at the top. Transfer
allows you to go directly to another program without going back to the Finder. Quit
allows you to leave THINK C; you are prompted to save changes in your current
files.

The Edit Menu
The Edit Menu provides options for working on your current file (Figure C.5).
The Undo, Cut, Copy, Paste, Clear, and Select All menu items are the
standard text editing options available on most Macintosh applications. Set Tabs
& Font ••• (Figure C.6) puts up a dialog box that allows you to select the tab size
(usually, one tab every four character positions), as well as the font type and size.

Undo

HZ

Cut
Copy
Paste
Clear
Select Rll

HH
HC
HU

Set Tabs & Font •••
Shift Left
H[
Shift Right
HI
Balance
HB
Options •••

Figure C.5 THINK C's Edit menu.
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Tabs:
Font:

-

~

OK

~I

Monaco

D

( Cancel )

9

The quick brown fox jumps over the lazy dog.

Figure C.6 Tabs & Font dialog box.

Shift Left and Shift Right will move selected text one tab to the right or left.
Balance will highlight the code balanced by the nearest(), [], or (} before and after
the cursor position.
The Options ••• menu item (Figure C. 7) brings up a dialog box that allows you
to set the default options for five different areas of THINK C.
Search Options has three options to set. These all affect the defaults used by
options under the Search menu. Selecting the Match Words check box lets you
search for whole words instead of parts of words. Wrap Around means that the
entire file will be searched, not just from the cursor to the end of the file. Ignore
Case lets you ignore upper and lower case in searching.
Preferences lets you set four options (Figure C.8). The Confirm Auto-Make
check box, when checked, always brings up the Br i ng Pro j e ct up to Date?
dialog box when the project is being compiled. If it is not checked, THINK C will
automatically update the project. When not checked, Confirm Saves always saves
changes to the current document without asking. Always Compact always saves

®This Project

»Copy»

® Search Options

O Preferences
O Code Generation
O Compiler Flags

0

New Projects

D Match Words
D Wrap Around
1811 gnore Case

O Source Debugger
OK

l

Figure C. 7 Search options.

(

Cancel

J
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®This Project

»Copy»

O Search Options
® Preferences

O Code Generation
0 Compiler Flags
0 Source Debugger
OK

0

New Projects

181 Confirm Auto-Make
181 Confirm Saues
D Always Compact
D More Memory

(

Cancel

J

Figure C.8 Preferences.
the current project using a compression algorithm. When checked, More Memory
will cause THINK C to try to work around a Mac that keeps running out of memory.
Code Generation (Figure C.9) allows you to set five options. The Macsbug
Symbols should be set if you plan to use a symbolic debugger like MacsBug or
TMON. When Profile is checked, THINK C collects timing statistics about your
functions. If the 68020 flag is set, THINK C will use the 020 instruction set, when
the 68881flag is set, floating point coprocessor code will be generated as well. If the
<MacHeaders> option is set, THINK C automatically uses the MacHeaders file for
every project.
Compiler Flags (Figure C.10) has two options. If Check Pointer Types is
selected, THINK C generates compiler errors for pointer types that don't match.
The Require Prototypes flag makes THINK C strict about type checking with
respect to function calls and their arguments.

®This Project

»Copy»

0 Search Options
O Preferences
® Code Generation

O Compiler Flags
O Source Debugger
OK

Figure C.9 Code generation.

O New Projects

181 Macsbug Symbols
D Profile
D 68020
D 68881
181 <MacHeaders>
(

Cancel

J
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»Copy»

®This Project

O Search Options
O Preferences
O Code Generation

O New Projects

181 Check Pointer Types
D Require Prototypes

® Compiler Flags

O Source Debugger
OK

(

Cancel

J

Figure C.10 Compiler flags.

Source Debugger(Figure C.11) has three options. Use Debugger starts your
project off with the Use Debugger item checked under the Project menu. IfUse 2nd
Screen is checked, THINK C will place the debugger windows on a second monitor
if the Mac being used is equipped with one. If Update Windows is set, the
Debugger will try to update your windows for you when execution of the code is
stopped. (This option really eats up memory, so you may want to increase the
debugger's MultiFinder partition.)

The Search Menu
The Search menu (Figure C.12) has a number of functions that allow you to find
and change text in your files.

®This Project

»Copy»

O Search Options
O Preferences
O Code Generation
O Compiler Flags

0 New Projects

D Use Debugger
181 Use 2nd Screen
D Update Windows

® Source Debugger

OK

J)

Figure C.11 Source debugger.
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Find...
Enter Selection
Hnd H~}<lin
Replace
H•~Ph~C(~ (~ rind Ht.it~in
Ht~phH~<~ HU

OOF
OOE

:u:H
OOP

:c:w
Figure C.12 Search menu.

The Find •.. menu item puts up a dialog box, as shown in Figure C.13. The Find
dialog box allows you to enter in the string to search for and, optionally, the string
to replace it with. The three search options, Match Words, Wrap Around, and
Ignore Case were described in the discussion of Search Options. If Grep is
checked, a utility similar to the Grep utility in UNIX is run. If Multi-File Search
is checked, a dialog box is put up to allow you to select which files to search.
Enter Selection will take highlighted code and place it in the Search for field
in the Find dialog box. Find Again searches for the next occurrence of the Search
For: text without bringing up the dialog box again. Replace replaces the highlighted string; ifthere is no string in the Replace With field, the highlighted text is
deleted. Replace and Find Again will replace the highlighted string in the code
and highlights the next occurrence of the Search For: string. Replace All replaces
all occurrences of the sought string. Find In Next File is used in conjunction with
the Multi-File Search check box; it puts up a dialog box so the next files to search
may be selected.

Replace with:

Search for:
1

......._l_ _______.II.......___ ______.
D Match

D Grep

Words

D Wrap Rround
1811 gnore Case
Figure C.13 Find dialog box.

1: ind

D f'i.1um···rn<~

~·~l~rct~

mDon't Find m Cancel

)
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The Source Menu
The Source menu (Figure C.14) deals with the files currently in the project. Add
and Remove will add or remove the currently selected file in the Project window.
If Add is dimmed, the current window has not been saved, or does not have the . c
suffix. Get Info provides a dialog that displays information about the current file,
such as number of lines of code and data and string resources used. Other files may
be examined by clicking on the next or previous buttons. Check Syntax compiles
a file to check syntax without adding it to the project. Precompile ••• creates a
precompiled header (like <MacHeaders>) for your project. It may not have code or
data definitions. Debug sends the currently edited file to the Source window of the
debugger. Compile will compile the currently selected file and place it in the project
window. Load Library will take the currently edited library and add it to the
current project. Add ••• displays a dialog box that allows you to add other files into
the project. Make ••• puts up a dialog box listing the current files in the project. You
can then compile any file or load libraries directly instead ofhaving THINK C figure
it out for you.

Add
Remoue
Get Info
8€1
Check SyntaH 8€Y
Precompile •••
Debug
8€6
Compile
Load Library
Add •••
Make •••

8€K

8€M

-----------------

Figure C.14 THINK C's Source menu.
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The Windows Menu
The Windows menu (Figure C.15) controls the windows of THINK C. Clean Up
resizes and stacks currently opened windows. Zoom resizes the current window to
fill the screen; ifselected again, the window returns to the previous size. Full Titles
puts the full path of each file on the top of its window. Close All closes all edit
windows. Save All saves all edit windows. Project window brings the Project
window to the front. The menu items will contain the project title (e.g., He 11 o
pro j ). Following the Project windows is a list of all currently opened windows in the
project. Selecting a window on the list will bring it to the front.
This appendix is meant to provide an overview to THINK Conly. For detailed
information about THINK C, read Think's THINK C User's Manual and Standard
Libraries Reference.

Clean Up
Zoom
38/
Full Titles
Close All
Saue All
Sample 380
Untitled 381

Figure C.15 THINK C's Windows menu.
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The Debugger
Command
Summary
This appendix summarizes some of the
basic operations of the THINK C sourcelevel code debugger. The descriptions are
specific to Version 3.0 of THINK C.

THIN KC Now has a debugger that provides a powerful way to test applications. The
Debugger runs exclusively under MultiFinder and needs at least two megabytes to
work properly.
When an application is run inside THINK C, and the Use Debugger flag has
been set, the windows shown in Figure D.1 are displayed. Each of the two windows
that are part of the Debugger has a specific function. First, take a look at the Source
window.

The Source Window of the Debugger
The Source window displays the code of the file that is currently being run. In
Figure D.l, the arrow to the left of the code indicates where the Debugger has
stopped. At this point, you can Step to the next line, step In to the function at which
the arrow points, or step Out of the function to the next line of the calling function.
If you click on Go, the program will run until it hits a breakpoint or until the Stop
button is clicked on. The Trace button is like the Step button, except that it will step
into the current function if the code is available for it; Step stays at the same level
of your program.
To set up a breakpoint, just click on the diamond to the left of the statement at
which you want to stop, then click Go (Figure D.2). The program will halt execution
when it reaches the breakpoint. To clear a breakpoint, click on the diamond again.
To set up a temporary breakpoint, hold down the command or option key when you
click on the diamond of the statement at which you want to stop. When you reach
the breakpoint and then click Go, the breakpoint is cleared.
Ifyou want to examine a file other than the one in the Source window, select the
Project window to bring it to the front, choose the file you want to debug, and select
Debug from the Source menu of THINK C. The file will then appear in the Source
window. The field in the bottom left-hand corner of the Source window displays the
name of the current file.
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Figure D.l Bullseye project with the Debugger running.
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FigureD.2 Breakpoint selected.
The button actions can also be selected from the Debug menu of the Debugger.
The debug menu also has some other debugging actions. Go Until Here is the same
as setting a temporary breakpoint. If you click on a line of source code and select Go
Until Here, the Debugger will run until that line of code is reached. Skip To Here
allows you to skip execution of portions of your code. Be careful that whatever you
are testing doesn't depend on the code you are skipping.
You can step or trace continuously through your program if you click on these
buttons with either the command or the option key depressed. To cancel the action,
click on the Stop button.
Monitor invokes the currently installed monitor (low-level debuggers like
Macsbug or TMON). ExitToShell halts execution of your program and quits to
THINKC.
If you want to get information about the values of your variables as your code
executes, use the Debugger's Data window.

The Data Window of The Debugger
The Data window lets you find out the values of your variables as the program
runs. To use it, type in a C expression in the data entry area just under the title bar,
and the value of the expression will be displayed in the right-hand column. For
example, Figure D.3 shows the value of a string variable. As you can see, the string
variable was displayed in hex format. To view the data correctly, click on the
variable of interest in the left column, pull down the Data menu, and select Pascal
String. The data are now displayed as a Pascal string. Figure D.4 lists the possible
data format types with examples.
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Figure D.3 Data window with expression.

Decimal
HeHadecimal
Character
Pointer
Address
C string
Pascal string
Floating Point

7569994, -5000
0HB11E1520
'a', 'Chuck'
0H7A7000
[) 0H09FE44, struct 0H08FC14
"GoodbyeCruel\nWorld\ 33"
" \ pGoodbyeCruel\nWorld\ 33"
90983.611

Figure D.4 Data formats in the Debugger.

In the Data menu, you can also Show Context, which will display the context
for the expression selected in the Data window in the Source window.lfyou select
a line in the Source window, you can then Set Context to change the context to the
line highlighted in the Source window. Ifyou want to make sure that an expression
doesn't change its value, select Lock in the Data menu with the desired variable
highlighted (Figure D.6).
This appendix is meant to provide an overview of the Debugger. For more
detailed information, read Symantec's THINK C User's Manual and Standard Libraries Reference.
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Set ConteHt
Show ConteHt
Decimal
HeHadecimal
Character
Pointer
Rddress
C String
Pascal String
Floating Point
Lock

Figure D.5 Data menu in the Debugger.

Doto

i 0

Figure D.6 Locked variables in the Debugger.

AppendixE

Debugging
Techniques
One of the most frustrating experiences
in programming is running up against a
really tough bug. In this appendix, we'll
discuss some techniques for hunting
down bugs, and some others for avoiding
them in the first place.

Compilation Errors
you're likely to encounter will pop up during compilation, when
you've typed in your code and select Run from the Project menu. When THINK C
asks you if you'd like to rebuild your project, click Yes.
THINK C is now compiling your code. You'll see a dialog box similar to the one
in Figure E.1:

THE FIRST BUGS

TYPING MISTAKES

The first sign that something's amiss is the appearance of a bug alert. The one in
Figure E.2 crops up a lot and seems frustratingly uninformative. Syntax errors are
usually indicative of a misspelled keyword or bad programming grammar. For
example, if you misspell #def i ne or type something like:

EventRecord = theEvent;
instead of

Event Record

theEvent:

you'll end up with a syntax error. This happens frequently. Carefully review the line
of code with the blinking cursor in the left-hand column. If you still can't find the
bug, check the previous line. Is there a semicolon at the end of the line? Is there
supposed to be one?

Compiling

bullWindows.c

Lines:

156

Total:

156

Figure E.1 Compiling dialog box.

II

A

syntaH error

Figure E.2 Syntax Error dialog box.
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Missing semicolons can cause several different types of bugs. For example, in
Chapter 4's Event Tutor . c, we took the semicolon away from the end of three
different lines and got three different errors-an i n v a 1 i d de c 1 a rat i on, a
syntax error, and finally, am i s s i n g ; . C compilers are very tricky.
Another popular error meassage is the xx x ha s not been de c 1a red alert.
Sometimes this is the result of a missing declaration, but often it's the result of a
misspelled variable name. Remember, in C, upper and lower case are crucially
different when it comes to identifiers. The variables my Pi ct u re and My Pi ct u re
are completely different. Check your case.
Another indicator of a typing error is the i l l e g a 1 token error message.
Usually, this means you have a character in your code that shouldn't be there.
Here's an example:
myVar

$ = 27:

In this case, the $ was the illegal token. If you try repeatedly but still can't find
the illegal token, try deleting and retyping the line in question. Ifthat doesn't work,
check the previous line.

INDIRECT COMPILER ERRORS

An example of a indirect compiler error is caused by a missing If i n cl ude file. For
example, the printing program presented in Chapter 7 depended on the #i n c 1 ude
file Pr i n t Mgr . h. This file is not one of the standard If i n c 1 u des automatically
included by THINK C. If you leave out this If i n c 1 ude, you get an i n v a 1 i d
dee 1 a ration error, and the cursor moves to the line:
THPrint

printRecordH;

It turns out that TH Pr i n t is a special type declared in Pr i nt Mgr . h. The real
trick is to figure out which file to/fi nc 1 ude. Chapter 7 lists all the #inc 1 udes not
automatically included by THINK C. You'll find these files in the Mac /Ii nc 1 udes
folder on your THINK C disk. The files are well named, so picking a likely candidate
shouldn't be too hard. Use the THINK C Find facility to search for the missing type
or global variable.
Another indirect compiler error stems from not closing your comment blocks. For
example:
/*my 1st comment *
int i :
/*my 2nd comment *I
i = 10:

This code will lead to an ' i · wa s not de c 1 a red error. The declaration ofi was
swallowed up by the my 1 st co mm en t comment block, which was never closed.
LINKER ERRORS
If you call a procedure or function in your program that was never declared, you'll
get a 1 ink failed error and a Fa i 1 ed Lin ks window will appear, listing the
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routines that were called but that the linker couldn't locate. This error is often the
result of a misspelled procedure name. For example:
sysBeep< 20 ) :

The compiler will accept this line because it will assume that you've written a
routine called sys Beep ( ) that will be provided at link time.

Improving Your Debugging Technique
Once your program compiles, your next step is to get the bugs out. One of the best
ways to debug a Mac program is to use a debugger like the THINK C Debugger
described in Appendix D, or the TMON debugger from ICOM Simulations. Debuggers are real life-savers.
No matter which debugging tool you use, there are some things you can do to
improve your debugging technique.
BEING A GOOD DETECTIVE
When your program crashes or exhibits some unusual behavior, you have to to be
a detective. Did the system error occur just before your dialog box was scheduled to
appear? Did those wavy lines start appearing immediately after you clicked on the
OK button?
The key to being a good detective is having a good surveillance technique. Try to
establish a definite pattern in your program's misbehavior. Can you pinpoint
exactly where in your code things started to go awry? These clues will help you home
in on the offending code.
If you can't tell by observation exactly when things went sour, don't give up. You
can always use the binary method of bug control.
Tlf~

BINARY METHOD

The key to the binary method lies in establishing good boundary conditions for the
bug. First, you'll need to establish a lower limit, a place in your code at which you
feel fairly certain the bug has not yet occurred. You'd like the lower limit to be as
·close to the actual bug as possible, but make sure the bug has not yet happened.
Next, establish an upper limit in your code, a point by which you're certain the
bug has occurred (because the system has crashed, or the screen has turned green,
or whatever).
To use the binary method, split the difference between the upper and lower
limits. If the bug still has not occurred, split the difference again. Now, if the bug
has occurred, you have a new upper limit. By repeating this procedure, you'll
eventually locate the exact line of source code where the bug occurs.
There are several different ways to split the difference between two lines of
source code. If you're using a debugger, you can set a breakpoint halfway between
the lines of code representing the upper and lower limits. Did you hit the breakpoint
without encountering the bug? If so, set a new breakpoint, halfway between this one
and the upper limit.
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Ifyou don't have a debugger, use a ROM call like Sys Beep ( ) to give you a clue.
Did you hear the beep before the bug occurred? Ifso, put a new Sys Beep ( ) halfway
between the old one and the upper limit. The nice thing about using Sys Beep ( ) is
that it is reasonably nonintrusive, unlike putting up a new window and drawing
some debugging information in it, which tends to interfere with your program's
basic algorithm.

Recommended Reading
In closing, we'd like to recommend some good reading material: your THINK C
User's Manual! The User's Manual is a treasure trove of valuable tips for writing
and debugging Mac programs. The more you know about the Macintosh and the
THINK C development environment, the better you'll be at debugging your
programs.

AppendixF

Building
Hypercard
XCMDs
The introduction of HyperCard in
August 1987 caused quite a stir in the
Macintosh world. A complete programming environment in its own right,
HyperCard became even richer with the
addition of XCMDs and XFCNs. Now
you can access the raw power of
THINK C from inside HyperCard.

HYPERCARD CoMESWITH its own powerful programming language: HyperTalk.
The designers of HyperTalk thoughtfully provided a mechanism for adding extensions to the HyperTalk command set. These extensions are code resources of type
XCMD and XFCN.
XCMDs (X-Commands) take a parameter block as input from HyperCard,
perform some calculations, put the results back into the parameter block, and
return to the calling script. XFCNs (X-functions) take the same parameter block as
input, perform the same types of calculations, but return the results as a C or Pascal
function would.
We've written an XCMD (called XChooser) that puts the Chooser name in the
parameter block and returns to HyperCard. A typical call of XChooser looks like
this:

XChooser
Put the result into card field 1
We also created an XFCN(called FChooser) that performs the same service. A
typical call of FCh o o s e r looks like this:

Put FChooser() into card field 1
The source code for FChoose r and XChooser is identical. One is saved as an
XFCN and the other as an XCMD. In addition to the XFCN. c and XCMD. c files, you'll
also need a set ofHyperCard service routines and the XCMD type definition include
file. The service routines and the #i nc 1 ude file were kindly provided by the
THINK C folks. We've included all the source code (as well as a HyperCard test
stack and a resource mover stack) on the Mac Primer source code disk (use the
coupon on the last page). All the source code is also presented in this Appendix,
however, so the more intrepid among you can type it right in.
There are 28 HyperCard service routines, each in its own source code file. You
don't need to type in all 28 at once. In the example, you'll need only the routine in
the file PasToZero. c. You may want to type that one in now. In addition, put the
#include file, HyperXCmd. h, in thesamefolderastheotherMac/li nc 1 udes.All
of the source code can be found later in this appendix.

The XChooser XCMD
Create a new project. Add MacTraps and the file Pas To Zero . c. Next, type in
this source code, save it as XCM D. c, and add it to the project:
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#include "HyperXCmd.h"
pascal void main(XCmdBlockPtr);
/******************************** main *********/
pascal void main( paramPtr )
XCmdBlockPtr
paramPtr:
I
StringHandle
chooserStr255H;
chooserStr255H = GetString( -16096 ) :
Hlock( chooserStr255H );
paramPtr->returnVal ue = PasToZero( paramPtr. *chooserStr255H ) ;
HUnl ock( chooserStr255H ) :

Start by loading the Chooser name from resource ST Rwith ID= -16 0 9 6. Lock the
handle and pass it, along with the parameter block you receive from HyperCard, to
Pa s To Ze r o, which converts the Chooser name from a Pascal-based string to a zeroterminated string. Next, place the zero-terminated version of the Chooser name in
the return Va l ue field of the parameter block, and return.

Building the XCMD
Before compiling XChooser, you must first tell LightspeedC that you're building
an XCM D. Pull down the Project menu and select Set Project Type ... When the dialog
box appears, set the fields as they appear in Figure F.1:

O Application
O Desk Accessory
O Deuice Driuer
® Code Resource

File Type
Creator

I????
I????

D Custom Header

Name
Type IHCMD

OK

I Attrs ~ @!]

ID 1400
(

Cancel

Figure F.1 Set Project Type dialog box.

)
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Click the OK button. Pull down the Project menu and select Build Code
Resource ... The standard file dialog will appear, asking you to name your new
resource file. Call it XChooser.

Copying the XCMD Into a Stack
Once XChooser is built, use ResEdit to copy it into a stack. You can also copy the
XCMD directly into HyperCard, but work with a copy to stay on the safe side. Once
the XCMD is copied, you'll be able to access it from within any script.
To create an XFCN, change XCMD to XFCN in the Set Project Type ... dialog box.

HyperXCmd.h
I*

HyperXCmd.h Definitions for calling all standard
HyperCard callback routines from C.
©\pple Computer, Inc. 1987
All Rights Reserved.
See CFlash.C for an example of how to include this module in your
C program.

*I

#include <MacTypes.h>
typedef struct XCmdBlock
short pa ramCount;
Handle params[l6J;
Handle returnValue;
Boolean
pass Flag;
void (*entryPoint)(); I* to call back to HyperCard */
short
request;
short
result;
long i nArgs [8];
long outArgs[4J;
I XCmdBlock, *XCmdBlockPtr;
typedef unsigned char Str31[32J;
/*

typedef struct Str31 {
char guts[32J;
} Str31, *Str31Ptr:
*I

en um

};

xresSucc
0,
xresFail,
xresNotlmp
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I* request codes */
enum I
xreqSendCardMessage
xreqEvalExpr,
xreqStringLength.
xreqStringMatch,
xreqSendHCMessage,
xreqZeroBytes,
xreqPasToZero,
xreqZeroToPas.
xreqStrTolong,
xreqStrToNum.
xreqStrToBool.
xreqStrToExt,
xreqlongToStr.
xreqNumToSt r.
xreqNumToHex,
xreqBoolToStr,
xreqExtToStr,
xreqGetGlobal.
xreqSetGlobal.
xreqGetFieldByName,
xreqGetFieldByNum,
xreqGetFieldByID,
xreqSetFieldByName,
xreqSetFieldByNum,
xreqSetFieldByID,
xreqStringEqual.
xreqReturnToPas.
xreqScanToReturn.
xreqScanToZero = 39
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1,

/* was suppose to be 29! Oops! */

I;
I* Forward definitions of glue routines. Main program

must include XCmdGlue.inc.c. See XCmdGlue.inc.c for
documentation of each routine. */

typedef void (*MyProcPtr) ();
pascal void
pascal Handle
pascal long
pascal Ptr
pascal void
pascal Handle
pascal void
pasStr);
pascal long
pascal long
pascal Boolean
pascal void
pascal void
pascal void
pascal void
*mystr):
pascal void
pascal void
pascal Handle

SendCardMessage( XCmdBl ockPtr. Stri ngPtr msg):
EvalExpr(XCmdBlockPtr, StringPtr expr):
StringLength(XCmdBlockPtr. StringPtr strPtr):
StringMatch(XCmdBlockPtr, StringPtr pattern, Ptr target);
ZeroBytes ( XCmdB 1ockPt r . Pt r ds tPt r. long l ongCount);
PasToZero(XCmdBlockPtr, StringPtr pasStr):
ZeroToPas ( XCmdBl ockPtr, unsigned char *zeroStr, Stri ngPtr
StrTolong(XCmdBlockPtr, unsigned char * strPtr):
StrToNum(XCmdBlockPtr, unsigned char *str);
StrToBool(XCmdBlockPtr,unsigned char *str>:
StrToExt(XCmdBlockPtr.unsigned char *str. double *myext);
LongToStr(XCmdBlockPtr, long posNum. unsigned char *mystr);
NumToStr(XCmdBlockPtr. long num, unsigned char *mystr);
NumToHex(XCmdBlockPtr, long num. short nDigits, unsigned char
BoolToStr(XCmdBlockPtr, Boolean bool, unsigned char *mystr):
ExtToStr(XCmdBlockPtr, double *myext, unsigned char *mystr):
GetGlobal(XCmdBlockPtr, StringPtr globName):
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pascal void
SetGlobalCXCmdBlockPtr. StringPtr globName, Handle globValue):
pascal Handle GetFieldByName(XCmdBlockPtr, Boolean cardFieldFlag, StringPtr
fieldName);
pascal Handle GetFieldByNum(XCmdBlockPtr, Boolean cardFieldFlag, short fieldNum);
pascal Handle GetFieldByID(XCmdBlockPtr.Boolean cardFieldFlag, short fieldID);
pascal void
SetFieldByName(XCmdBlockPtr. Boolean cardFieldFlag, StringPtr
fieldName, Handle fieldVal);
pascal void
SetFieldByNum(XCmdBlockPtr, Boolean cardFieldFlag, short
fieldNum,Handle fieldVal);
pascal void
SetFieldByID(XCmdBlockPtr, Boolean cardFieldFlag, short
fieldID,Handle fieldVal):
pascal Boolean StringEqual(XCmdBlockPtr. unsigned char *strl. unsigned char *str2);
pa sea 1 void
ReturnToPa s ( XCmdB 1ockPtr. Ptr zeroSt r. St ri ngPtr pas Str);
pa sea 1 void
ScanToReturn ( XCmdBl ockPt r. Pt r *scanHndl):
pascal void
ScanToZero<XCmdBlockPtr. Ptr *scanHndl);

BoolToStr.c
#include "HyperXCmd.h"
I* Convert a boolean to 'true' or 'false'. Instead of returning

a new string, as Pascal does, it expects you to create mystr
and pass it in to be filled. */
pascal void
BoolToStr(paramPtr,bool ,mystr)
register XCmdBlockPtr paramPtr;
Boolean
bool:
St r 31 mys tr :
I

paramPtr->inArgs[OJ = (long)bool;
paramPtr->inArgs[lJ = (long)mystr;
paramPtr->request = xreqBoolToStr:
(*paramPtr->entryPoint)();

EvalExpr.c
#include <MacTypes.h>
#include "HyperXCmd.h"
I* Evaluate a HyperCard expression and return the answer. The answer is

a handle to a zero-terminated string.
*/

pas ca 1 Handle
EvalExpr(paramPtr.expr)
register XCmdBlockPtr paramPtr;
StringPtr
expr:
I

paramPtr->inArgs[OJ = (long)expr;
paramPtr->request = xreqEvalExpr;
(*paramPtr->entryPoint)();
return (Handle)paramPtr->outArgs[OJ;
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ExtToStr.c
#include "HyperXCmd.h"
I* Original comment:

Convert an extended long integer to decimal digits in a string.
Instead of returning a new string, as Pascal does, it expects
you to create mystr and pass it in to be filled. */

/* My comment:
I assume that an extended is supposed to be an 80-byte double.
which is declared as double in LSC. I've changed "extended" to
"double" to reflect this
*I

pascal void
ExtToStr(paramPtr,myext,mystr)
register XCmdBlockPtr paramPtr:
double
*
myext:
St r 31 mys t r :
I

paramPtr->inArgs[OJ = (long)myext:
paramPtr->inArgs[l] = (long)mystr:
paramPtr->request = xreqExtToStr;
(*paramPtr->entryPoint)();

GetFieldBylD.c
#include "HyperXCmd.h"
/* Return a handle to a zero-terminated string containing the value of
the field whise ID is fieldID. You must dispose of the handle.
*I

pascal Handle
GetFieldByID(paramPtr,cardFieldFlag,fieldID>
register XCmdBlockPtr paramPtr:
Boolean cardFieldFlag;
short fieldID:
I

paramPtr->inArgs[O] = (long)cardFieldFlag;
paramPtr->inArgs[l] = fieldlD;
paramPtr->request = xreqGetFieldBylD:
(*paramPtr->entryPoint)();
return (Handl e>paramPtr->outArgs[O]:

GetFieldByName.c
#include "HyperXCmd.h"
/* Return a handle to a zero-terminated string containing the value of
field fieldName on the current card. You must dispose the handle.
*/

pascal Handle
GetFieldByName(paramPtr.cardFieldFlag.fieldName)
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register XCmdBlockPtr paramPtr;
Boolean cardFieldFlag;
StringPtr
fieldName:
I

paramPtr->inArgs[O] = (long)cardFieldFlag;
paramPtr->inArgs[l] = (long)fieldName;
paramPtr->request = xreqGetFieldByName;
(*paramPtr->entryPoint)();
return (Handle)pararnPtr->outArgs[OJ:

GetFieldByNum.c
#include NHyperXCmd.h"
I* Return a handle to a zero-terminated string containing the value of

field fieldNum on the current card. You must dispose of the handle.

*I

pascal Handle
GetFieldByNum(paramPtr, cardFieldFlag,fieldNum)
register XCmdBlockPtr paramPtr:
Boolean cardFieldFlag;
short fieldNum;
I

paramPtr->inArgs[O] = Clong)cardFieldFlag;
paramPtr->inArgs[l] = fieldNum:
paramPtr->request = xreqGetFieldByNum:
C*paramPtr->entryPoint)();
return CHandle)paramPtr->outArgs[OJ;

GetGlobal.c
#include "HyperXCmd.h"
I* Return a handle to a zero-terminated string containing the value of

the specified HyperTalk global variable.

*/

pascal Handle
GetGlobal(paramPtr,globName)
register XCmdBlockPtr paramPtr;
StringPtr
globName;
I

paramPtr->inArgs[OJ = (long)globName;
paramPtr->request = xreqGetGlobal:
C*paramPtr->entryPoint)();
return CHandl e)paramPtr->outArgs[OJ:
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LongToStr.c
#include "HyperXCmd.h"
I* Convert an unsigned long integer to a Pascal string. Instead of

returning a new string, as Pascal does, it expects you to
create mystr and pass it in to be filled.

*I

pas ca 1 void
LongToStr(paramPtr, posNum. mystr)
register XCmdBlockPtr paramPtr;
long
posNum;
St r 31 mys tr :
I

paramPtr->inArgs[OJ = posNum:
paramPtr->inArgs[l] = (long)mystr;
paramPtr->request = xreqlongToStr;
C*paramPtr->entryPoint)();

NumToHex.c
#include "HyperXCmd.h"
/* Convert an unsigned long integer to a hexadecimal number and put it
into a Pascal string. Instead of returning a new string, as
Pascal does, it expects you to create mystr and pass it in to be filled.
*I

pas ca 1 void
NumToHex(paramPtr. num, nDigits. mystr)
register XCmdBlockPtr paramPtr;
long
num;
short
nDigits;
St r 31 mys t r ;
I

paramPtr->inArgs[OJ = num;
paramPtr->inArgs[l] = nDigits;
paramPtr->inArgs[2] = (long)mystr:
paramPtr->request = xreqNumToHex;
(*paramPtr->entryPoint)();

NumToStr.c
#include "HyperXCmd.h"
/*Convert a signed long integer to a Pascal string. Instead of
returning a new string, as Pascal does. it expects you to
create mystr and pass it in to be filled.
*I

pasca 1 void
NumToStr(paramPtr.num,mystr)
register XCmdBlockPtr paramPtr;
long
num:
St r 31 mys tr ;
I
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paramPtr->inArgs[O] = num:
paramPtr->inArgs[l] = (long)mystr:
paramPtr->request = xreqNumToStr:
(*paramPtr->entryPoint)();

PasToZero.c
#include "HyperXCmd.h"
I* Convert a Pascal string to a zero-terminated string. Returns a handle

to a new zero-terminated string. The caller must dispose the handle.
You'll need to do this for any result or argument you send from
your XCMD to HyperTalk. Note that if you use C-format strings, you won't
need to do this from C.
*/

pascal Handle
PasToZero{paramPtr,pasStr)
register XCmdBlockPtr paramPtr:
StringPtr
pasStr:
I

paramPtr->inArgs[O] = (long)pasStr;
paramPtr->request = xreqPasToZero:
{*paramPtr->entryPoint){);
return {Handle)paramPtr->outArgs[OJ:

ReturnToPas.c
#include "HyperXCmd.h"
I* zeroStr points into a zero-terminated string. Collect the

characters from there to the next carriage Return and return
them in the Pascal string pasStr. If a Return is not found.
collect chars until the end of the string.

*I

pascal void
ReturnToPas(paramPtr.zeroStr,pasStr)
register XCmdBlockPtr paramPtr;
Ptr
zeroStr:
StringPtr
pasStr:
I

paramPtr->inArgs[OJ = (long)zeroStr;
paramPtr->inArgs[lJ = (long)pasStr:
paramPtr->request = xreqReturnToPas;
(*paramPtr->entryPoint)();
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ScanToReturn.c
#include "HyperXCmd.h"
/* Move the pointer scanPtr along a zero-terminated
string until it points at a Return character
or a zero byte.
*I

pascal void
ScanToReturnCparamPtr,scanHndl)
register XCmdBlockPtr paramPtr;
Ptr * scanHndl:
I

paramPtr->inArgs[OJ = Clong)scanHndl;
pararnPtr->request = xreqScanToReturn;
(*paramPtr->entryPoint)();

ScanToZero.c
#include "HyperXCmd.h"
I* Move the pointer scanPtr along a zero-terminated

string until it points at a zero byte.

*/

pascal void
ScanToZero(paramPtr,scanHndl)
register XCmdBlockPtr paramPtr;
Ptr * scanHndl:
I

paramPtr->inArgs[OJ = (long)scanHndl:
paramPtr->request = xreqScanToZero;
(*paramPtr->entryPoint)();

SendCard.Message.c
#include "HyperXCmd.h"
/* Send a HyperCard message Ca command with arguments) to the current card.
msg is a pointer to a Pascal-format string.
*I

pascal void
SendCardMessage<paramPtr, msg)
register XCmdBlockPtr paramPtr;
StringPtr
msg;
I

paramPtr->inArgs[OJ = Clong)msg;
paramPtr->request = xreqSendCardMessage;
C*paramPtr->entryPoint)();
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SetFieldByID.c
#include "HyperXCmd.h"

I* Set the value of the field whose ID is fieldID to be the zeroterminated string in fieldVal. The contents of the Handle are
copied. so you must still dispose it afterwards.

*I

pascal void
SetFieldBylO(paramPtr,cardFieldFlag,fieldID.fieldVal)
register XCmdBlockPtr paramPtr:
Boolean cardFieldFlag;
short fieldID;
Handle fieldVal;
I

paramPtr->inArgs(OJ = (long)cardFieldFlag;
paramPtr->inArgs[l] = fieldID:
paramPtr->inArgs[2J = (long)fieldVal:
paramPtr->request = xreqSetFieldByID:
(*paramPtr->entryPoint)();

SetFieldByName.c
#include "HyperXCmd.h"

I* Set the value of field fieldName to be the zero-terminated string
in fieldVal. The contents of the Handle are copied, so you must
still dispose it afterwards.

*I

pascal void
SetFieldByName(paramPtr.cardFieldFlag.fieldName,fieldVal)
register XCmdBlockPtr paramPtr:
Boolean cardFieldFlag;
StringPtr
fieldName;
Handle fieldVal;
I

paramPtr->inArgs(OJ = (long)cardFieldFlag;
paramPtr->inArgs[l] = (long)fieldName;
paramPtr->inArgs[2J = (long)fieldVal:
paramPtr->request = xreqSetFieldByName;
(*paramPtr->entryPoint)();

SetFieldByNum.c
#include "HyperXCmd.h"

I* Set the value of field fieldNum to be the zero-terminated string
in fieldVal. The contents of the Handle are copied, so you must
still dispose it afterwards.

*/

pas ca 1 void
SetFieldByNum(paramPtr,cardFieldFlag,fieldNum.fieldVal)
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register XCmdBlockPtr paramPtr;
Boolean cardFieldFlag;
short fieldNum;
Handle fieldVal:
I

paramPtr->inArgs[OJ = (long)cardFieldFlag:
paramPtr->inArgs[l] = fieldNum:
paramPtr->inArgs[2J = (long)fieldVal:
paramPtr->request = xreqSetFieldByNum:
(*paramPtr->entryPoint)();

SetGlobal.c
#include "HyperXCmd.h"
/* Set the value of the specified HyperTalk global variable to be
the zero-terminated string in globValue. The contents of the
Handle are copied, so you must still dispose it afterwards.
*I

pascal void
SetGlobal(paramPtr.globName.globValue)
register XCmdBlockPtr paramPtr;
StringPtr
globName:
Handle globValue:
I

paramPtr->inArgs[OJ = (long)globName:
paramPtr->inArgs[lJ = Clong)globValue:
paramPtr->request = xreqSetGlobal:
(*paramPtr->entryPoint)();

StringEqual.c
#include "HyperXCmd.h"
/* Return true if the two strings have the same characters.
Case insensitive compare of the strings.
*I

pascal Boolean
StringEqual(paramPtr,strl.str2)
register XCmdBlockPtr paramPtr:
unsigned char * strl;
unsigned char * str2:
I

paramPtr->inArgs[OJ = Clong)strl:
paramPtr->inArgs[l] = (long)str2;
paramPtr->request = xreqStringEqual:
(*paramPtr->entryPoint)();
return CBoolean)paramPtr->outArgs[OJ:
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StringLength.c
#include "HyperXCmd.h"
/* Count the characters from where strPtr points until the next zero byte.
Does not count the zero itself. strPtr must be a zero-terminated string.
*/

pascal long
StringlengthCparamPtr.strPtr)
register XCmdBlockPtr paramPtr:
StringPtr
strPtr;
{

paramPtr->inArgs[OJ = Clong)strPtr;
paramPtr->request = xreqStringlength;
(*paramPtr->entryPoint)();
return paramPtr->outArgs[OJ;

StringMatch.c
#include "HyperXCmd.h

0

/* Perform case-insensitive match looking for pattern anywhere in
target, returning a pointer to first character of the first match,
in target or NIL if no match found. pattern is a Pascal string,
and target is a zero-terminated string.
*/

pascal Ptr
StringMatch(paramPtr, pattern. target)
register XCmdBlockPtr paramPtr;
StringPtr
pattern;
Ptr
target;
I

paramPtr->inArgs[OJ = (long)pattern;
paramPtr->inArgs[l] = Clong)target:
paramPtr->request = xreqStringMatch;
(*paramPtr->entryPoint)();
return CPtr)paramPtr->outArgs[OJ;

StrToBool.c
#include "HyperXCmd.h"
I* Convert the Pascal strings 'true· and 'false' to booleans.
*/

pascal Boolean
StrToBool(paramPtr,str)
register XCmdBlockPtr paramPtr;
Str31 str;
I

paramPtr->inArgs[OJ = (long)str;
paramPtr->request = xreqStrToBool:
(*paramPtr->entryPoint)();
return (Boolean)paramPtr->outArgs[OJ:
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StrToExt.c
#include "HyperXCmd.h"
I* Ori gi na 1 comment:

Convert a string of ASCII decimal digits to an extended long integer.
Instead of returning a new extended. as Pascal does. it expects you
to create myext and pass it in to be filled. */

/* My comment: extended, as far as I know. is an 80-bit double, not a
long integer. Since LSC doubles are 80-bit. I've changed myext to
a pointer to a double */
pascal void StrToExt(paramPtr, str, myext)
register XCmdBlockPtr paramPtr;
Str31 str;
double *
myext:
I

paramPtr->inArgs[OJ = Clong)str:
paramPtr->inArgs[lJ = Clong)myext:
paramPtr->request = xreqStrToExt;
C*paramPtr->entryPoint)():

l

FUNCTION StrToExt(str: Str31): Extended;
VAR x: Extended:
BEGIN
WITH paramPtrA DO
BEGIN
inArgs[lJ := ORDC@str):
i nAr gs [ 2 ] : = 0 RD (@x ) ;
request := xreqStrToExt;
DoJsr(entryPoint);
StrToExt
x:
END;
END; *I
I*

StrToLong.c
#include "HyperXCmd.h"
I* Convert a string of ASCII decimal digits to an unsigned long integer.
*/

pascal long
StrTolongCparamPtr, strPtr)
register XCmdBlockPtr paramPtr:
Str31 strPtr;
I

paramPtr->inArgs[O] = (long)strPtr:
paramPtr·>request = xreqStrTolong;
(*paramPtr->entryPoint)();
return (long)paramPtr->outArgs[O]:
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StrToNum.c
#include "HyperXCmd.h"

I* Convert a string of ASCII decimal digits to a signed long integer.
Negative sign is allowed.
*I
pascal long
StrToNum(paramPtr. str)
register XCmdBlockPtr paramPtr;
Str31 str;
I

paramPtr->inArgs[OJ = (long)str:
paramPtr->request = xreqStrToNum:
(*paramPtr->entryPoint)();
return paramPtr->outArgs[OJ:

ZeroBytes.c
#include "HyperXCmd.h"

I* Write zeros into memory starting at destPtr and going for longCount
number of bytes.
*I
pascal void
ZeroBytes (pa ramPt r, dst Pt r. 1ongCount)
register XCmdBlockPtr paramPtr:
Ptr
dstPtr;
long
longCount:
I

paramPtr->inArgs[O] = Clong)dstPtr:
paramPtr->inArgs[l] = longCount:
paramPtr->request = xreqZeroBytes:
(*paramPtr->entryPoint)();

ZeroToPas.c
#include "HyperXCmd.h"

I* Fill the Pascal string with the contents of the zero-terminated
string. Useful for converting the arguments of any XCMD to
Pascal strings.
*/

pascal void
ZeroToPas(paramPtr.zeroStr,pasStr)
register XCmdBlockPtr paramPtr:
unsigned char *zeroStr:
StringPtr
pasStr:
I

paramPtr->inArgs[OJ = Clong)zeroStr:
paramPtr->inArgs[l] = (long)pasStr:
paramPtr->request = xreqZeroToPas:
(*paramPtr->entryPoint)();
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Access path, 311
activateEvt,105,123,133-34
Add... , 491
Add and Remove, 491
Adding libraries, 4~1
AddResMenu(),175
AdjustMenus(),278,288-89
Alert (AL RT)
purpose of, 198
ResEdit and making, 207
resources, 218-19
resources for Pager, 331
resources for PrintPict, 313-14
resources for ShowClip, 298-99
resources for Sounder, 348
resources for WindMaker, 272
stages of, 207
in Timer, 159, 161, 163
types of, 206
a 1 tDBoxProc window, 49, 51
Always Compact, 487-88
& operator, 30-31
applEvt,106,133,134
app2Evt,106,133, 134
app3Evt,106, 133, 134
app4Evt, 106, 135
AppleLink, 402
Apple Programmer's and Developer's
Association (APDA), 25
Apple's Certified Developer
Program, 402
Application(s)
font, 69
icon, 357
in Project menu, 482-83
version information, 357

Application MultiFinder
requirements, 357
arrow, 67
autoKey,105
Aztec C, 7
Background Null Events, 483
Balance, 487
BeginUpdate(),131-32,136,176
Big long window technique, 45
Binary method, 502-3
BND L (bundle) resource, 369, 376-80
BoolToStr.c,510
Bozo flag, 369
Bring up to Date, 485
Build Application, 485
Build Library, 485
Bundle flag, 369
Bundle (BNDL) resource, 369, 376-80
Busy bit, 369
Buttons, 202
Caution alerts, 206
CenterPict()
in EventTutor, 122, 141, 436
in Pager, 338, 346, 477
in ShowClip, 302, 306, 468
in ShowPICT, 91, 424
in WindowMaker, 281, 293, 465
Changed flag, 369
Check boxes, 202
Check Item(), 175
Check Link, 485
CheckStyles(),170,182,443-44
Check Syntax, 491
Classic QuickDraw, 83
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Clean Up, 492
Clipboard, 295
Close, 486
Close All, 492
Close & Compact, 482
Close box, 48, 49
Close Project, 482
Code Generation, 488
C0 DE resources, 34, 484
Color ovals, changing, 82-83
Compile, 491
Compiler flags, 488
Confirm Auto-Make, 487
Confirm Saves, 487
Control Manager, 201, 327
Controls, dialog, 201-3
CountDown(),239,258-60,458-59
CreateWi ndow( ), 280, 291-92,
464-65
Creator, 484
CtoPstr( ), 29
Cursor control, I n i t Cursor ( ) , 68
Data forks, 34-35, 370
Data window of the Debugger,
495-97
dBoxProc window, 49, 51
deactivateEvt,124
Debug,491
Debugger(s)
MacsBug, 403
TMON,403-4
User, 485
Debugger, source-level, 8, 403, 489
data window of, 495-97
source window of, 494-95
summary of commands, 493-97
Debugging techniques
compilation errors, 500-501
how to improve, 502-3
illegal token, 501
illegal use of in-line Macintosh
function, 28
indirect compiler errors, 502
invalid declaration, 501
linker errors, 501-2
syntax,500-501
J/d e f i n e statement
in EventTutor, 125-26, 428-29
in Flying Line, 425
in Mondrian, 421
inPager,333,339,472-73
in PrintPICT, 316, 322, 469
purpose of, 28, 66
in Reminder, 229-30, 244-46,
448-49

in ShowClip, 300, 304, 466
in ShowPict, 423
in Sounder, 350, 352, 478
in Timer, 163-64, 172-73, 436-37
in WindowMaker, 274-75, 284,
460
in Zinger, 183, 190, 444
Desk accessories, 153, 484
Desk scrap, 295
Desktop, rebuilding the, 384-86
Device drivers, 484
Dialog boxes
adding, 207-12
buttons, 202
check boxes, 202
controls, 201-4
dials, 203-4
disabled items, 210
ellipsis and, 198
how they work, 199-201
modal, 199-200, 201
modeless, 200, 201
purpose of, 198
radio buttons, 202-3
ResEdit and making, 204-5
resources, 216-17
resources for Pager, 331
resources for PrintPict, 313
resources for ShowClip, 299
resources for Sounder, 348
resources for WindMaker, 270-71
Dialoglnit(),231,248,450-51
Dialog Item List (DI TL), 159, 161
Dialog Manager, 68
Dials, 203-4
d i s k Ev t, 105
Display as Text, 364
Display Graphically, 364
dlgHook,309
documentProc window, 48, 49, 50
DoDialogs(),318,324,470-71
Drag region, 48
DragWindow(),137
DrawClock(),167,177,440
DrawControls(), 328
DrawEventString(),120, 135,433
Drawing
lines, 55
pictures, 58
shapes, 56
text, 56-58
Drawl i ne ( ), 95, 101, 428
DrawMenuBar(),175
DrawMyPicture()
in EventTutor, 121-22, 140-41,
435-36
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in ShowPICT, 90-91, 424
in WindowMaker, 280, 293, 465
DrawPopUp(),185,191,193,446
DrawPopUpNumber(),185,193,446
DrawRandomRect(),77-78,422
driverEvt,106,133, 134
Edit Menu, 224, 226-27, 362,
486-89
Ellipsis, dialog boxes and, 198
EndUpdate(),131-32,176
ErrorHandler()
in Pager, 338, 346, 478
in PrintPICT, 319, 326, 472
in ShowClip, 302-3, 306-7, 468
in Sounder, 351, 354, 479
in WindowMaker, 281, 293-94,
466
Error messages. See Debugging
techniques
Eva l Expr. c, 510
Event(s)
background null, 483
definition of, 104
handling, 112-13
Manager, 104
masks, 111
queue,104
retrieving, 109-12
suspend and resume, 483
types, 105-7
EventRecord, 104, 111
EventTutor
code, 125-37,428-36
description of, 113-14
resources, 114-22
running, 122-25
setting up, 114
everyEvent, 111
Extern declaration, 28-29
ExtToStr. c, 511
File Busy bit, 369
fileFilter, 309
File information dialog box, 369
File Lock bit, 369
File Manager, 307, 309-11
File menu, 224-25, 362, 485-86
File Protect flag, 369
File Reference Resource (FR EF),
375-76
File Type, 484
Fi l l Re c t ( ) , 99
Fi nd Con t r o l ( ) , 328-29
Finder flags, 369-70

Finder resources, 356
BNDL,369,376-80
categories, 357
FREF,375-76
ICN#,371-74
installing, 366-80
signature, 357, 380-84, 389
SIZE,357,390-91
vers,357,382,386-90
FindWindow(),137,328-29
Flags,finder,369-70,488
FlushEvents(),67
Flying Line program
code,96-101,425-28
description of, 60, 92-95
running, 96
fName, 311
Folders, 310
Font, 56
application, 69
in Hello2 program, 69-70
InitFonts(),67
Manager, 67
system, 69
Fr am e Ar c ( ), 82
FrameRoundRect(),80
FR EF (File Reference Resource),
375-76
FSCl ose( ), 311
FSOpen ( ), 311
FSRead ( ), 311
Full Titles, 492
FUNCT I ONs, 27
gAppleMenu,172,175
gClockWindow,172
gCurrentStyle,172, 181
gCurrentTime, 172
gCurRow,126
gOone,126,172
gOragRect,126,172
Get Clip(), 140
GetDitem( ), 212
GetFieldByID.c,511
GetFieldByName.c,511-12
GetFieldByNum.c,512
Get Fil eName C ) , 318, 324, 470
GetGlobal .c,512
Get Info, 491
GetIText( ), 211
GetNewWindow(),26-27,52
GetNextEvent(), 109,110, 111-12
Get P i c t u re ( ) , 89
GetScrap( ), 297
gEventWindow,113,124,126
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gFontMenu, 172,175
gLastFont,172
Global coordinate system, 45
Global variables, 67
gMaxRow,126
Go-away box, 49
gOldTime, 172
gPictureHandle,126
gPictureWindow, 88,90
gPictWindow,124, 125, 126
gPopUpRect,195
Gra fPort data structure, 54
Grow box, 49
GrowWindow(), 138
g Size Re ct, 126
gStyleMenu, 172,175
gTheEvent, 126
gThePicture,88
gWNEimplemented,126,172
HandleAppleChoice()
in Reminder, 234, 252-53, 453-54
in Timer, 168, 179, 441-42
in WindowMaker, 279, 290, 464
HandleDialogC ),236-37,254-57,
455-56
HandleEditChoice(),280,291
HandleEvent(),109
in EventTutor, 118-20, 129-30,
431-33
inPager,335,342,474-75
in Reminder, 233, 250, 452
in Timer, 165, 176-77, 439-40
in WindowMaker, 276-77, 287,
462
in Zinger, 186, 194, 447
HandleFileChoice()
in Reminder, 235, 252-54, 454-55
in Timer, 169, 180, 442
in WindowMaker, 279, 290-91,
464
HandleFontChoiceC ),169,175,
180-81,442
HandleMenuChoice()
in Reminder, 234, 251-52, 453
in Timer, 168, 176, 178-79, 441
in WindowMaker, 278-79, 289-90,
463
HandleMouseDown()
in EventTutor, 120-21, 138,
434-35
inPager,335-36,342-43,475-76
in Reminder, 233, 251, 452-53
in Timer, 167, 176, 177-78, 440-41
in WindowMaker, 277, 288, 463
in Zinger, 186-87, 195, 447-48

HandleNul 1 ( ),167,176,177,440
Handles, 88-89, 256
Handl eStyl eChoi ce< ), 169-70,
181-82,443
Hello, World program
adding libraries, 40-41
creating a new project, 35-37
entering source code, 37-40
problem with, 41
running,41
Hello.c,420
Hello2.c,420-21
Hello2 program
adding an icon to, 370-75
changing fonts, 69-70
changing text size, 71
changing text style, 70-71
code,62-64,66-69
completing a standalone
application, 358-59
running, 65
setting up, 60-62
Hi deWi ndow( ), 52
Hierarchical Filing System (HFS),
307,310
Hierarchical menu, 146-47
Hierarchical submenu IDs, 157
HyperCard, 9
buttons, 202
XCM Os, 18, 505-20
HyperTalk, 506
HyperXCmd.h,508-10
ICN#,371-74
Icon
adding an, to Hello2, 370-75
application, 357
mask, 371
Icons ( ' S I CN' ), 220
ID, resource versus local, 376
Ignore Case, 487
#include statement, 28, 420
I n fo Sc r a p ( ) , 296
Info World, 398
I n i t Cu r s o r ( ) , 68
InitDi al ogs( ), 68
Inited bit, 369
In it Fonts C) , 67
In itGraf ( ), 67
InitMenus(),67,68
InitWindows(),67,68
InsertMenu( ),175
Inside Macintosh, 398-400
Interface, 2, 3-4
InvalRect(),138,139
I nvertArc ( ), 82
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InvertRoundRect(),81
Invisible bit, 369
IsDAWindow(),278,288,289
keyDown. 105
KeyRepThresh,105
Key Thresh, 105
keyUp, 105
Libraries, adding, 40-41
Lines,drawing,55
Lineslnit( ),94,99,426
Li n eTo ( ) , 55
Linker errors, 501-2
Lisa, 4
Load Library, 491
LoadPicture()
in EventTutor, 117, 128, 430
in ShowPICT, 90, 424
in WindowMaker, 276, 286,
461
Lo a d Sc r a p ( ) , 296
Local coordinate system, 46
LocalToGlobal(),195
Locked flag, 369
LongToStr.c,513
MacDraw, 58
Macintosh
background of, 2-3
books on, 401
compatibility of, 5
Developer Technical Support,
402
Filing System (MFS), 307,
310
periodicals, 398
Programmer's Workshop
(MPW), 7, 403
structure of a program, 59,
107-9
technical references for,
400-401
writing applications, 10
MacPaint, 58
MacsBug, 403
MacTraps, 40
MacTutor, 398
MacUser, 398
MacWeek, 398
MacWorld, 398
main ( )
in EventTutor, 116, 126, 129,
429
in Flying Line, 93, 97, 425

in Hello2, 66, 420
in Mondrian, 76, 421
in Pager, 333, 339, 4 73
in PrintPICT, 317, 323, 469
in Reminder, 230, 246-47, 449-50
in ShowClip, 301, 304, 466
in ShowPICT, 89, 423
in Sounder, 350, 352, 478
in Timer, 164, 173, 437
in WindowMaker, 275, 285, 461
in Zinger, 183, 191, 444
Main event loop, 108-9
Mainloop()
in EventTutor, 117, 431
in Flying Line, 94, 99-100, 426-27
in Mondrian, 77, 422
in Pager, 335, 341, 474
in Reminder, 232, 250, 452
in ShowClip, 301-2, 305-6, 467-68
in Timer, 166, 175, 439
in WindowMaker, 276, 287, 462
in Zinger, 185, 194, 447
Make ... ,491
MakeSound(),351,353,479
Managers, 4-5
See also under type of
Match Words, 487
MBAR, 149
resource for Reminder, 222-23
resource for Timer, 150-52
resource for WindMaker, 266
Menu(s)
adding, 148-49
bar, 144
creating your own, 147
edit,224,226-27,362,486-89
file,224-25,362,485-86
hierarchical, 146-47
hierarchical submenu IDs, 157
InitMenus(),67,68
items, 145
parts of, 144-46
pop-up,147
project, 482-85
pull down, 146
ResEdit, 362
resources for Reminder, 222-27
resources for WindowMaker,
266-73
search, 489-90
source, 491
tear-off, 148
window, 492
MenuBarlnit()
in Reminder, 232, 249, 451
in Timer, 165, 174-75, 438-39
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Menu Ba r I n i t ( ) (cont.)
in WindowMaker, 275, 285-86,
294-95,461
in Zinger, 184, 192, 445
Minimalist, 391-94
ModalDialog(),210
Modal dialogs, 199-200, 201
Modeless dialogs, 200, 201
Mode of text, 58
Mondrian program
code, 76-79,421-23
description of, 56, 57, 60, 73
resources, 73-75
running, 75-76
variants, 79-83
More Memory, 488
Mounted volume, 361
mouseDown,105,137-41
mouseMoved, 106
mouseRgn, 112
mouseUp,105
Multi-File Search, 490
MultiFinder
Aware, 483
-friendly applications, 242
Notification Manager and, 199
Printer driver, 369
purpose of, 109-10
SIZE resource, 357
Multi-Segment box, 484
Name field, 484
networkEvt,106,133, 134
New, 486
NewControl(),327-28
NewHandl e( ), 312
New Project, 482
NewWi ndow( ), 98
NM Inst a 11 ( ) , 214
NMRec,213-14
NMRemove( ), 214
noGrowDocProc window, 49, 50
Note alerts, 206
Notification Manager
MultiFinder and, 199
purpose of, 212
resources for, 220-22
structure, 213-14
Not i f y I n i t ( ) , 232, 249-50,
451-52
nullEvent,105,130, 176
NumToHex.c,513
NumToStr.c,513-14
On Desk flag, 369
Open, 486

Open Project, 482
Open Selection, 486
Options, 487
Owner ID, 374
Owner Type, 374
Pager
code,333-46,472-78
description of, 329
how it works, 338-46
resources for, 329-32
setting up, 329
Pa i nt Arc ( ) , 82
Pai n t 0 val ( ) , 78
PaintRect(),79,99
PaintRoundRect(),79
Parameters, passing, 30-31, 292
Pa ramText ( ), 211
Pascal
data type compared with C, 27-28
strings, 29
PasToZero.c,514
PC Week, 398
Pen, changing graphics, 53-54
P ICTs, 58
Pictures, drawing, 58
Pixels, 44
p 1 a in DB ox window, 49, 51
Pop-up menu, 147
PopUpMenuSelect(),195
PrCl ose( ), 312
PrCloseDoc(),312
PrClosePage(),312
Precompile... , 491
Preference, 487
Preload resources, 374
Print, 486
PrintDefault( ),323
Printer driver, 369
Printing Manager, 307, 312
Printlnit(),317,323-24,470
PrintPICT
code,314,316-19,322-26,469-72
description of, 312-13
File Manager, 307, 309-11
how it works, 321-26
resources for, 313-19
running, 320
setting up, 313
Standard File Package, 307-9
Pri ntPi ct Fi 1e( ), 318-19, 325,
471-72
Print Setup, 486
Pr Job Di a l o g ( ) , 312
PROCEDUREs, 27
Profile, 488
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Projectfile,8-9,36,62
Project menu, 482-85
Project Window, 492
Pr Open (), 312
PrOpen Doc ( ) , 312
PrOpenPage(),312
PrPicFile(),312,323,326
PrStlDialog(),312
Pt o Cs t r ( ) , 29
Pulldown menu, 146
Purgeable resources, 374
PutScrap(),296-97
QuickDraw
coordinate system, 44-48
programs, 60-69
purpose of, 11, 44
toolbox routines, 53-59
Quit, 486
Radio buttons, 202-3
Randomize()
in Flying Line, 95, 100, 427
in Mondrian, 79, 422-23
RandomRect()
in Flying Line, 94, 100, 427
in Mondrian, 77-78, 422
randSeed, 67, 77
rDocProc window,49,51
Recalcline(),95,101,427-28
Rect, 30
refNum, 311
Regions,defining,58, 136-37
Reminder
adding menu resources, 222-27
adding Notification Manager
resources,220-22
code,229-40,244-61,448-60
description of, 215
resources for, 216-28
running,241-44
setting up, 215
Remove Objects, 485
ResEdit
creating WI ND resource, 364
how it works, 361-66
installing finder resources, 366-80
making alerts in, 207
making dialogs in, 204-5
menus, 362
notes on using, 360
purpose of, 6, 25-26, 356
Resource(s)
adding menu, 222-27
alert, 218-19
bundle, 376-80

CODE,34,484
description of, 2, 5-6
dialog, 216-17
EventTutor, 114-22
File Reference, 375-76
forks, 34-35, 370
hierarchical submenu IDs, 157
ID number, 33
Manager, 341
map, 369
modifying, 211
Mondrian, 73-75
naming, 33-34
Notification Manager, 220-22
Pager,329-32
PrintPICT,313-19
Reminder, 216-19
ShowClip, 298-300
ShowPICT, 84-87
signature, 357, 380-84, 389
SIZE,357,390-91
Sounder,347-49
Timer, 150-63
type, 32-33
vers,357,382,386-90
WindowMaker, 265-73
Zinger, 183-90
See also Finder resources
RestoreSettings(),238,258,
457-58
ReturnToPas.c,514
Revert, 486
RgnHandle,136
RMaker,356
ROM (read-only memory), 32
Routines, naming, 32
Run, 485
Save,486
Save A Copy As, 486
Save All, 492
Save As, 486
Sa veSet tings ( ) , 237-38, 257,
456-57
ScanToZero.c,515
Scrap Manager, 295
GetScrap( ), 297
I n f o Sc r a p ( ) , 296
Lo a d Sc r a p < ) , 296
PutScrap(),296-97
UnloadScrap(),296
Ze r o Sc r a p ( ) , 296
screenBits, 67, 98
Scroll bars
how to set up, 327-29
purpose of, 48, 203
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Scro 11 Proe ( ) , 336-37, 344,
476
ScrollRect( ), 135, 136
Scro 11 Wi nd ow ( ) , 120, 135,
137,434
Search menu, 489-90
Search options, 48 7
SelectWindow(),137
SendCardMessage.c,515
Set Cl i p ( ) , 140
SetFieldByID.c,516
SetFieldByName.c,516
SetFieldByNum.c,516-17
SetGl oba 1 . c, 517
SetIText( ), 211
SetNotification(),240,
260-61,459-60
Set Po rt ( ) , 54, 99
Set Project Type... , 125, 482
Set Rec t ( ) , 98
SetUpDragRect()
in EventTutor, 117, 128-29,
137,430
in Pager, 334, 340, 474
in Reminder, 232, 249, 451
in Timer, 165, 174, 438
in WindowMaker, 276, 286,
462
in Zinger, 184, 192, 445
SetupEventWi ndow( ), 117,
128,430
Set UpSc r o 1 l Ba r ( ) , 334,
341,474
SetUpSizeRect( ),117, 129,
430-31
SFGetFi le(), 307, 308-9,
311
S FPut Fil e ( ) , 307
SFTypeL i st, 309
Shapes, drawing, 56
Shared flag, 369
Shift left and right, 487
ShowClip, 295
code,300-303,304-7,
466-68
description of, 297
how it works, 304-7
resources for, 298-300
running,303
setting up, 298
ShowPICT
code,88-90,423-24
description of, 60, 84
resources, 84-87

running,87-88
window setup, 90-91
ShowWi ndow< ), 52
Signature resource, 357, 380-84, 389
Size box, 48, 49
Size of text, 56
S I ZE resource, 357, 390-91
SizeWindow(),138,139
sleep, 112
Sn d P1 a y ( ) , 353
Sound (' snd '), 220
Sounder
code,350-54,478-79
description of, 347
resources,347-49
setting up, 347
Sound Manager, 347
Source Debugger, 489
Source files, 24
Source menu, 491
Source window of the Debugger,
494-95
Spacing, 56
srcBic,58
srcCopy,58
srcOr,58
Standard File Package, 307-9
Stop alerts, 206
Stri ngEqual. c, 517
Stringlength.c,518
StringMatch.c,518
Strings (' STR' ), 29
resources for Notification
Manager, 220
resources for Pager, 331, 332
resources for PrintPict, 313-14,
315
resources for ShowClip, 299-300
resources for Sounder, 348
resources for WindowMaker and,
272-73
StrToBool .c,518
StrToExt.c,519
StrToLong.c,519
StrToNum.c,520
Style, 56
Sub ID, 374
Suspend and Resume Events, 483
Syntax errors, 500-501
SysBeep< ), 195-96
SysEnvirons(),244
Sys60rlater(),231,247-48,450
System bit, 369
System font, 69
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System Heap, 374
SystemTask( ), 110
Tabs, set, 486
Tear-off menu, 148
Technical Notes, 401
TEini t( ), 68
Text
changing size, 71
changing style, 70-71
drawing,56-58
TextEdit, 68
Text Fon t ( ) , 69
thePort,67
THINKC
description of, 8-9
documentation for, 8
installing, 24-26
reasons for using, 7
standards for writing, 31-32
strings, 29
summary of commands, 481-92
Timer
ALRT (alert) resource, 159, 161,
163
Apple menu specifications, 152
code, 163-70, 172-82,436-44
description of, 149-50
DI TL (Dialog Item List), 159, 161
edit menu specifications, 153-55
file menu specifications, 152-53
font menu specifications, 159
resources, 150-63
running, 170-72
setting up, 150
special menu specifications,
155-59
TMON,403-4
Toolbox
assessing, 26-28
buttons, 202
description of, 2, 4-5
QuickDraw toolbox routines, 53-59
Tool Boxlni t()
in EventTutor, 116, 127, 429
in Flying Line, 93, 97, 425
in Hello2, 66, 420
in Mondrian, 76-77, 421
in Pager, 334, 340, 473
in PrintPICT, 317, 323, 470
in Reminder, 230, 247, 450
in ShowClip, 301, 304, 467
in ShowPICT, 90, 423
in Sounder, 350, 352, 478-79
in Timer, 164, 174, 437-38

in WindowMaker, 275, 285, 461
in Zinger, 184, 191, 445
TrackBox( ), 139
TrackControl(),329,343
Type ofresource, 484
UnloadScrap(),296
updateEvt
EventTutor and, 130-31, 132-33
importance of responding to, 176
queueing of, 105
Window Manager and 123, 136
UpdateMyWi ndow( ), 337, 344-45,
477
User Debugger, 485
Variables
global, 67
naming, 32
vers resource, 357, 382, 386-90
vis Rg n, 131-32
Volumes, 309-10
mounted, 361
v Re fNum, 311
WaitNextEvent()
calling, 110, 129
events and, 109, 111-12
MultiFinder friendliness and, 242
white, 67
White space, 37
Window(s)
big long window technique, 45
drawing in, 53-59
InitWindows(),67,68
Manager, 48, 123
menu, 492
parts, 48
setting the current, 54
setting up, 52-53
types, 49-53
visibility of, 52
Windowlnit()
in EventTutor, 116, 127, 429
in Flying Line, 93, 98, 425-26
in Hello2, 66, 68-69, 420-21
in Mondrian, 77, 421
in Pager, 334, 340, 4 73
in ShowClip, 301, 305, 467
in ShowPICT, 90-91, 423
in Timer, 165, 174, 438
in Zinger, 184, 192, 445
WindowMaker
code,274-81,284-95,460-66
description of, 264-65
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WindowMaker (cont.)
how it works, 283
resources for, 265-73
running, 281-82
setting up, 265
WI NDresource
creating a, 52, 364
for EventTutor, 114
for Hello2, 60
for Mondrian, 73-75
for Pager, 329, 330
for Reminder, 227-28
for ShowClip, 298
for ShowPICT, 84
for Timer, 150
for WindowMaker, 265
for Zinger, 183
Wrap Around, 487
XCMDs
BoolToStr.c,510
building, 507-8
copying the, into a stack, 508
Eva lExpr. c, 510
ExtToStr. c,511
GetFieldByID.c,511
GetFieldByName.c,511-12
GetFieldByNum.c,512
GetGl oba l . c, 512
HyperXCmd.h,508-10
LongToStr.c,513
NumToHex.c,513

NumToStr.c,513-14
PasToZero.c,514
purpose of, 18
ReturnToPas.c,514
ScanToZero.c,515
SendCardMessage.c,515
SetFieldByID.c,516
SetFieldByName.c,516
SetFieldByNum.c,516-17
SetGl oba l . c, 517
Stri ngEqua l. c, 517
Stringlength.c,518
StringMatch.c,518
StrToBool .c,518
StrToExt.c,519
StrTolong.c,519
StrToNum.c,520
XChooser,506-7
ZeroBytes.c,520
ZeroToPas.c,520
Xerox Alto machine, 4
XFCNs, 506
ZeroBytes.c,520
Ze r oSc r a p C) , 296
ZeroToPas.c,520
Zinger
code, 190-96,444-48
description of, 182
resources for, 183-90
Zoom box, 48, 492
ZoomWindowC ),139
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